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Filter Implementation and Analysis
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In this section...

“Filtering Overview” on page 1-2
“Convolution and Filtering” on page 1-2

“Filters and Transfer Functions” on page 1-3

“Filtering with the filter Function” on page 1-4

Filtering Overview

This section describes how to filter discrete signals using the MATLAB® fi lter function
and other Signal Processing Toolbox functions. It also discusses how to use the toolbox
functions to analyze filter characteristics, including impulse response, magnitude and
phase response, group delay, and zero-pole locations.

Convolution and Filtering

The mathematical foundation of filtering is convolution. The MATLAB conv function
performs standard one-dimensional convolution, convolving one vector with another:

conv([1 1 1],[1 1 1D
ans =
1 2 3 2 1

Note Convolve rectangular matrices for two-dimensional signal processing using the
conv2 function.

A digital filter's output y(k) is related to its input x(k) by convolution with its impulse
response h(k).

k=Y hxk-D)

[—

If a digital filter's impulse response A(k) is finite in length, and the input x(k) is also of
finite length, you can implement the filter using conv. Store x(k) in a vector X, hA(k) in a
vector h, and convolve the two:
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x = randn(5,1); % A random vector of length 5
h=1[1111]/4; % Length 4 averaging filter
y = conv(h,x);

The length of the output is the sum of the finite-length input vectors minus 1.

Filters and Transfer Functions

In general, the z-transform Y(z) of a discrete-time filter's output y(n) is related to the z-
transform X(2) of the input by

-1 _n
Y(2) = H2)X(2) = b1)+b62)z " +...+bn+1)z X(2)

aD+a@zt+. . +am+1z™

where H(z) is the filter's transfer function. Here, the constants b(i) and a(i) are the filter
coefficients and the order of the filter is the maximum of n and m.

Note The filter coefficients start with subscript 1, rather than 0. This reflects the
standard indexing scheme used for MATLAB vectors.

MATLAB filter functions store the coefficients in two vectors, one for the numerator and
one for the denominator. By convention, it uses row vectors for filter coefficients.

Filter Coefficients and Filter Names

Many standard names for filters reflect the number of a and b coefficients present:
* When n =0 (that is, b is a scalar), the filter is an Infinite Impulse Response (IIR), all-
pole, recursive, or autoregressive (AR) filter.

* When m =0 (that is, a is a scalar), the filter is a Finite Impulse Response (FIR), all-
zero, nonrecursive, or moving-average (MA) filter.

+ If both n and m are greater than zero, the filter is an IIR, pole-zero, recursive, or
autoregressive moving-average (ARMA) filter.

The acronyms AR, MA, and ARMA are usually applied to filters associated with filtered
stochastic processes.

1-3
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Filtering with the filter Function

It is simple to work back to a difference equation from the Z-transform relation shown
earlier. Assume that a(1) = 1. Move the denominator to the left side and take the inverse
Z-transform.

y(B)+a@)yk—1)+...+ a(m +1)y(k —m) = b(1)x(k) + b(2)x(k —1)+...+ b(n +Dx(k — n)

In terms of current and past inputs, and past outputs, y(k) is

y(R) =b)x(k) +b2)x(k -1 +...+b(n +)x(k—n)—a@)yk -1 —...—am +1)y(k—m)

This is the standard time-domain representation of a digital filter, computed starting
with y(1) and assuming a causal system with zero initial conditions. This representation's
progression is

(1) =b(Dx1)
y(2) = b(1)x(2) + b(2)x(1) —a(2)y(1)
y(3) = b(1)x(3) +b(2)x(2) + b(3)x(1) — a(2)y(2) —a(3)y(1)

A filter in this form is easy to implement with the i l'ter function. For example, a
simple single-pole filter (lowpass) is

B
A

1; % Numerator
[1 -0.9]; % Denominator

where the vectors B and A represent the coefficients of a filter in transfer function form.
Note that the A coefficient vectors are written as if the output and input terms are
separated in the difference equation. For the example, the previous coefficient vectors
represent a linear constant-coefficient difference equation of

¥(n)-0.9y(n—-1) = x(n)

Changing the sign of the A(2) coefficient, results in the difference equation

y(n) +0.9y(n -1) = x(n)

The previous coefficients are represented as:



Filter Implementation and Analysis

B 1; %Numerator
A [1 0.9]; %Denominator
and results in a highpass filter.

To apply this filter to your data, use
y = filter(B,A,X);

Filter gives you as many output samples as there are input samples, that is, the length
of y is the same as the length of x. If the first element of a is not 1, Filter divides the
coefficients by a(1) before implementing the difference equation.
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The filter Function

1-6

filter is implemented as the transposed direct-form II structure, where n—1 is the filter
order. This is a canonical form that has the minimum number of delay elements.

xlm]
bin] bi3) b2} Hl)
EELY S =L T—— oL vim)
Ip-Llml za(m) zilm
—aini —al3) —al2]

At sample m, Filter computes the difference equations

y(m) =b(Dx(m) + 2z (m -1
z1(m) = b(2)x(m) + zo(m —1) —a(2) y(m)

z,_o(m)=b(n—-1Dx(m)+z,_1(m-1)-aln—-1)y(m)

2p_1(m) = b(n)x(m) —a(n)y(m)

In its most basic form, Fi Iter initializes the delay outputs z(1), i =1, ..., n-1 to 0. This
1s equivalent to assuming both past inputs and outputs are zero. Set the initial delay
outputs using a fourth input parameter to Filter, or access the final delay outputs
using a second output parameter:

[y.zf] = filter(b,a,x,zi)

Access to initial and final conditions is useful for filtering data in sections, especially if
memory limitations are a consideration. Suppose you have collected data in two segments
of 5000 points each:

x1
X2

randn(5000,1); % Generate two random data sequences.
randn(5000,1);

Perhaps the first sequence, X1, corresponds to the first 10 minutes of data and the
second, X2, to an additional 10 minutes. The whole sequence is X = [x1;x2]. If there is
not sufficient memory to hold the combined sequence, filter the subsequences X1 and x2
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one at a time. To ensure continuity of the filtered sequences, use the final conditions from
X1 as initial conditions to filter x2:

[yl1,zf] = Filter(b,a,x1);
y2 = filter(b,a,x2,zf);

The filtic function generates initial conditions for Filter. Filtic computes the delay
vector to make the behavior of the filter reflect past inputs and outputs that you specify.
To obtain the same output delay values zF as above using Filtic, use

zf = filtic(b,a,flipud(yl),flipud(x1));

This can be useful when filtering short data sequences, as appropriate initial conditions
help reduce transient startup effects.
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Multirate Filter Bank Implementation

The upfirdn function alters the sampling rate of a signal by an integer ratio P/Q. It
computes the result of a cascade of three systems that performs the following tasks:

+ Upsampling (zero insertion) by integer factor p
* Filtering by FIR filter h

*  Downsampling by integer factor q

. | P X |Q L— w

For example, to change the sample rate of a signal from 44.1 kHz to 48 kHz, we first find
the smallest integer conversion ratio p/q. Set

d = gcd(48000,44100);
p = 48000/d;
q = 44100/d;

In this example, p = 160 and ¢ = 147. Sample rate conversion is then accomplished by
typing

y = upfirdn(x,h,p,q)

This cascade of operations is implemented in an efficient manner using polyphase
filtering techniques, and it is a central concept of multirate filtering. Note that the
quality of the resampling result relies on the quality of the FIR filter h.

Filter banks may be implemented using upfirdn by allowing the filter h to be a matrix,
with one FIR filter per column. A signal vector is passed independently through each FIR
filter, resulting in a matrix of output signals.

Other functions that perform multirate filtering (with fixed filter) include resample,
interp, and decimate.

1-8
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Frequency Domain Filter Implementation

Duality between the time domain and the frequency domain makes it possible to perform
any operation in either domain. Usually one domain or the other is more convenient for a
particular operation, but you can always accomplish a given operation in either domain.

To implement general IIR filtering in the frequency domain, multiply the discrete
Fourier transform (DFT) of the input sequence with the quotient of the DFT of the filter:

n
y

length(X);
ifFe(Fre(x) . *fft(b,n) . /fft(a,n));

This computes results that are identical to Fi lter, but with different startup transients
(edge effects). For long sequences, this computation is very inefficient because of the
large zero-padded FFT operations on the filter coefficients, and because the FFT
algorithm becomes less efficient as the number of points n increases.

For FIR filters, however, it is possible to break longer sequences into shorter,
computationally efficient FFT lengths. The function

y = FFtFilt(b,x)

uses the overlap add method to filter a long sequence with multiple medium-length
FFTs. Its output is equivalent to Filter(b,1,x).

1-9
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Anti-Causal, Zero-Phase Filter Implementation

In the case of FIR filters, it is possible to design linear phase filters that, when applied

to data (using Filter or conv), simply delay the output by a fixed number of samples.
For IIR filters, however, the phase distortion is usually highly nonlinear. The FiltFilt
function uses the information in the signal at points before and after the current point, in
essence “looking into the future,” to eliminate phase distortion.

To see how FiltFilt does this, recall that if the z-transform of a real sequence x(n) is
X(z), the z-transform of the time reversed sequence x(n) is X(1/z). Consider the processing
scheme.

Time Time
Xiz)— Hiz] —- Reverse ™ Hiz] —m- Reverse [ X(=IH(1/=IH(z)
Xi-1H(z]) X1/ -H 1) X1 H =1 H )

Image of Anti Causal Zero Phase Filter

When |z| = 1, that is z = €%, the output reduces to X(¢/*) | H(¢’®) | 2. Given all the samples
of the sequence x(n), a doubly filtered version of x that has zero-phase distortion is
possible.

For example, a 1-second duration signal sampled at 100 Hz, composed of two sinusoidal
components at 3 Hz and 40 Hz, is

fs = 100;
t = 0:1/Fs:1;
X = sin(2*pi*t*3)+.25*sin(2*pi*t*40);

Now create a 10-point averaging FIR filter, and filter X using both Fi lter and
Filtfilt for comparison:

b = ones(1,10)/10; % 10 point averaging Ffilter
y = filtfilt(b,1,x); % Noncausal filtering
yy = Filter(b,1,x); % Normal filtering

plot(t,x,t,y, " —-",t,yy,":")

1-10
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File Edit View Inset Tools Desktop Window Help N

A IR AR EID )

1.5 T T T T T T T T T

0.5

0 01 02 03 04 05 06 0¥ 08 09 1

Both filtered versions eliminate the 40 Hz sinusoid evident in the original, solid line.
The plot also shows how Filter and filtfilt differ; the dashed (FiltFilt) lineis in
phase with the original 3 Hz sinusoid, while the dotted (Filter) line is delayed by about
five samples. Also, the amplitude of the dashed line is smaller due to the magnitude
squared effects of FiltFilt.
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Filtfilt reduces filter startup transients by carefully choosing initial conditions, and
by prepending onto the input sequence a short, reflected piece of the input sequence. For
best results, make sure the sequence you are filtering has length at least three times the
filter order and tapers to zero on both edges.

1-12
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Impulse Response

The impulse response of a digital filter is the output arising from the unit impulse
sequence defined as

il = 1. n=10,
=0, n#0.

You can generate an impulse sequence a number of ways; one straightforward way is

imp = [1; zeros(49,1)];

The impulse response of the simple filter with &#f = 1 and # (1 —-0.9]j5 h(n) ”'EJ“,
which decays exponentially.

b =1;
a=1[1-0.9];
h = filter(b,a,imp);

stem(0:49,h)

1-13
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A simple way to display the impulse response is with the Filter Visualization Tool,
fvtool.

fvtool(b,a)
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Click the Impulse Response button, [], on the toolbar, select Analysis > Impulse
Response from the menu, or type the following code to obtain the exponential decay of

the single-pole system.

fvtool(b,a, "Analysis”, "impulse®)

1-15



1 Filtering, Linear Systems and Transforms Overview

1-16

Amplitude
s = @9
e n =]

o
&)

0.2

0.1

Impulse Response

\ b
& _
T.
Hille 4
»
L
»

i - i

L ]

I I i i I i i I i
10 20 30 40 50 60 70 8O 90
Samples



Frequency Response

Frequency Response

In this section...

“Digital Domain” on page 1-17

“Analog Domain” on page 1-19

Digital Domain

freqz uses an FFT-based algorithm to calculate the z-transform frequency response of a
digital filter. Specifically, the statement

[h,w] = freqz(b,a,p)

returns the p-point complex frequency response, H(¢®), of the digital filter.

B(1)+b(2)e /P + ...+ b(n + e /O

—jom

H(e/?) =

aD)+a@2)e 7/ +...+ a(m+ e

In its simplest form, Freqz accepts the filter coefficient vectors b and a, and an integer
p specifying the number of points at which to calculate the frequency response. freqz
returns the complex frequency response in vector h, and the actual frequency points in
vector w in rad/s.

freqz can accept other parameters, such as a sampling frequency or a vector of arbitrary
frequency points. The example below finds the 256-point frequency response for a 12th-
order Chebyshev Type I filter. The call to freqz specifies a sampling frequency fs of
1000 Hz:

[b,a]
[h.f]

Because the parameter list includes a sampling frequency, freqz returns a vector f that
contains the 256 frequency points between 0 and s/2 used in the frequency response
calculation.

cheby1(12,0.5,200/500);
freqz(b,a,256,1000);

Note This toolbox uses the convention that unit frequency is the Nyquist frequency,
defined as half the sampling frequency. The cutoff frequency parameter for all basic
filter design functions is normalized by the Nyquist frequency. For a system with a

1-17
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1000 Hz sampling frequency, for example, 300 Hz is 300/500 = 0.6. To convert normalized
frequency to angular frequency around the unit circle, multiply by m. To convert
normalized frequency back to hertz, multiply by half the sample frequency.

If you call Freqz with no output arguments, it plots both magnitude versus frequency
and phase versus frequency. For example, a ninth-order Butterworth lowpass filter with
a cutoff frequency of 400 Hz, based on a 2000 Hz sampling frequency, is

[b,a] = butter(9,400/1000);

To calculate the 256-point complex frequency response for this filter, and plot the

magnitude and phase with freqz, use

freqz(b,a,256,2000)
u Figure 1 | = | = £3 |
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freqz can also accept a vector of arbitrary frequency points for use in the frequency

response calculation. For example,




Frequency Response

w
h

linspace(0,pi);
freqz(b,a,w);

calculates the complex frequency response at the frequency points in w for the filter
defined by vectors b and a. The frequency points can range from 0 to 2m. To specify a
frequency vector that ranges from zero to your sampling frequency, include both the
frequency vector and the sampling frequency value in the parameter list.

Analog Domain

fregs evaluates frequency response for an analog filter defined by two input coefficient
vectors, b and a. Its operation is similar to that of freqz; you can specify a number

of frequency points to use, supply a vector of arbitrary frequency points, and plot the
magnitude and phase response of the filter.
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Magnitude and Phase

1-20

MATLAB functions are available to extract magnitude and phase from a frequency
response vector h. The function abs returns the magnitude of the response; angle
returns the phase angle in radians. To extract the magnitude and phase of a Butterworth
filter:

[z,p,k] = butter(9,400/1000);
fvtool (zp2sos(z,p,k))

and click the Magnitude and Phase Response button on the toolbar or select
Analysis > Magnitude and Phase Response to display the plot.

u Filter Visualization Tool - Figure 4: Magnitude Response (dB) and Phase Response l = | & Y |
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The unwrap function is also useful in frequency analysis. unwrap unwraps the phase
to make it continuous across 360° phase discontinuities by adding multiples of +360°, as
needed. To see how unwrap is useful, design a 25th-order lowpass FIR filter:



Magnitude and Phase
h = firl(25,0.4);

Obtain the filter's frequency response with freqz, and plot the phase in degrees:
[H,F] = freqz(h,1,512,2);

plot(f,angle(H)*180/pi)

grid
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It is difficult to distinguish the 360° jumps (an artifact of the arctangent function inside
unwrap eliminates the 360° jumps:

angle) from the 180° jumps that signify zeros in the frequency response.
plot(f,unwrap(angle(H))*180/pi)

Alternatively, you can use phasez to see the unwrapped phase:
phasez(h,1)
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Delay

The group delay of a filter is a measure of the average time delay of the filter as a
function of frequency. It is defined as the negative first derivative of a filter's phase

response. If the complex frequency response of a filter is H(¢/®), then the group delay is

_dé(w)
dw

Ty (@) =

where 6(®) is the phase, or argument of H(¢/*). Compute group delay with
[gd,w] = grpdelay(b,a,n)

which returns the n-point group delay, 7,(w), of the digital filter specified by b and a,
evaluated at the frequencies in vector w.

The phase delay of a filter is the negative of phase divided by frequency:

0@

7, @)=~ p

To plot both the group and phase delays of a system on the same FVTool graph, type

[z,p.k] = butter(10,200/1000);
fvtool (zp2sos(z,p,k), "Analysis®, "grpdelay”,
"OverlayedAnalysis®, "phasedelay”, "Legend”, "on")
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Zero-Pole Analysis

The zplane function plots poles and zeros of a linear system. For example, a simple filter

with a zero at -1/2 and a complex pole pair at (1.9« 2503 and 0.972703 ig

zer
pol

-0.5;

0.9%exp(J*2*pi*[-0-3 0.3]");

To view the pole-zero plot for this filter you can use zplane. Supply column vector
arguments when the system is in pole-zero form.

zplane(zer,pol)

0.8r

0.6

0.4 r

Imaginary Part

Real Part
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For access to additional tools, use fvtool. First convert the poles and zeros to transfer
function form, then call fvtool.

[b,a] = zp2tf(zer,pol,l);
fvtool(b,a)

Magnitude Response (dB)
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Magnitude (dB)
.

_5_ ™, —
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Mormalized Frequency (= rad/sample)

Click the Pole/Zero Plot toolbar button, select Analysis > Pole/Zero Plot from the
menu, or type the following code to see the plot.

fvtool(b,a, "Analysis®, "polezero®)

1-26



Zero-Pole Analysis

Pole/Zero Plot
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To use zplane for a system in transfer function form, supply row vector arguments. In
this case, zplane finds the roots of the numerator and denominator using the roots

function and plots the resulting zeros and poles.

zplane(b,a)
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See Linear System Models for details on zero-pole and transfer function representation of
systems.
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Linear System Models

Linear System Models

Available Models

Several Signal Processing Toolbox models are provided for representing linear time-
invariant systems. This flexibility lets you choose the representational scheme that
best suits your application and, within the bounds of numeric stability, convert freely to
and from most other models. This section provides a brief overview of supported linear
system models and describes how to work with these models in the MATLAB technical
computing environment.
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Discrete-Time System Models

The discrete-time system models are representational schemes for digital filters. The
MATLAB technical computing environment supports several discrete-time system
models, which are described in the following sections:

+  “Transfer Function” on page 1-30

+  “Zero-Pole-Gain” on page 1-30

+ “State Space” on page 1-31

+  “Partial Fraction Expansion (Residue Form)” on page 1-32

+ “Second-Order Sections (SOS)” on page 1-33

+  “Lattice Structure” on page 1-34

* “Convolution Matrix” on page 1-36

Transfer Function

The transfer function is a basic z-domain representation of a digital filter, expressing the
filter as a ratio of two polynomials. It is the principal discrete-time model for this toolbox.
The transfer function model description for the z-transform of a digital filter's difference
equation is

b +b(2)z  +.. +b(n+1)z"
2) = X(2)
aD+az 4. +am+z™

Here, the constants b(i) and a(i) are the filter coefficients, and the order of the filter is
the maximum of n and m. In the MATLAB environment, you store these coefficients in
two vectors (row vectors by convention), one row vector for the numerator and one for the
denominator. See “Filters and Transfer Functions” on page 1-3 for more details on the
transfer function form.

Zero-Pole-Gain

The factored or zero-pole-gain form of a transfer function is

Hiz - 492 _ G- qW)-g@)...(z~qm)
p(z)  (z— p)(z - p2)...(z - p(n))
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By convention, polynomial coefficients are stored in row vectors and polynomial roots

in column vectors. In zero-pole-gain form, therefore, the zero and pole locations for the
numerator and denominator of a transfer function reside in column vectors. The factored
transfer function gain % is a MATLAB scalar.

The poly and roots functions convert between polynomial and zero-pole-gain
representations. For example, a simple IIR filter is

b
a

[2 3 4];
[1331];

The zeros and poles of this filter are

q roots(b)
p roots(a)
% Gain Ffactor
k = b(1)/a(l)

Returning to the original polynomials,

k*poly (@)
poly(p)

bb
aa

Note that b and a in this case represent the transfer function:

2+3z +422 22243244

H(z)= 3

1+327 1 +822 42 - 22 +322+32+1

For b=[2 3 4], the roots function misses the zero for z equal to 0. In fact, it misses
poles and zeros for z equal to 0 whenever the input transfer function has more poles
than zeros, or vice versa. This is acceptable in most cases. To circumvent the problem,
however, simply append zeros to make the vectors the same length before using the
roots function; for example, b = [b 0].

State Space

It is always possible to represent a digital filter, or a system of difference equations, as
a set of first-order difference equations. In matrix or state-space form, you can write the
equations as

x(n+1)= Ax(n)+ Bu(n)
y(n) =Cx(n)+ Du(n)
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1-32

where U is the input, X is the state vector, and y is the output. For single-channel
systems, A is an m-by-m matrix where m is the order of the filter, B is a column vector,
C is a row vector, and D is a scalar. State-space notation is especially convenient for
multichannel systems where input u and output y become vectors, and B, C, and D
become matrices.

State-space representation extends easily to the MATLAB environment. A, B, C, and D
are rectangular arrays; MATLAB functions treat them as individual variables.

Taking the Z-transform of the state-space equations and combining them shows the
equivalence of state-space and transfer function forms:

Y(2) = H(z)U(z2), where H(2)= C(zI —-A) ' B+ D

Don't be concerned if you are not familiar with the state-space representation of linear
systems. Some of the filter design algorithms use state-space form internally but do
not require any knowledge of state-space concepts to use them successfully. If your
applications use state-space based signal processing extensively, however, see the
Control System Toolbox™ product for a comprehensive library of state-space tools.

Partial Fraction Expansion (Residue Form)

Each transfer function also has a corresponding partial fraction expansion or residue
form representation, given by

b(z) _ r@) - r(n)

= Tt I +k() + k(227 +...+k(m —n+ 1)z M)
a(Z) 1- p(]_)Z_ 1- p(n)z_

provided H(z) has no repeated poles. Here, n is the degree of the denominator polynomial
of the rational transfer function b(z)/a(z). If r is a pole of multiplicity s,, then H(z) has
terms of the form:

r(j) N r(j+1) N r(j+s. -1
1-p(zt a-p(HzH?  a-p(HzH*

The Signal Processing Toolbox residuez function in converts transfer functions to and
from the partial fraction expansion form. The “z” on the end of residuez stands for
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z-domain, or discrete domain. residuez returns the poles in a column vector p, the
residues corresponding to the poles in a column vector r, and any improper part of the
original transfer function in a row vector K. residuez determines that two poles are the
same if the magnitude of their difference is smaller than 0.1 percent of either of the poles'
magnitudes.

Partial fraction expansion arises in signal processing as one method of finding the
inverse Z-transform of a transfer function. For example, the partial fraction expansion of

-1
Hpe 8
1+6z7"+82z"
is
b = [-4 8];
a=[L68]:
[r.p.k] = residuez(b,a)

which corresponds to

-12 8
+

Hz)= 1 1
1+4z 1+2z~

To find the inverse Z-transform of H(z), find the sum of the inverse Z-transforms of the
two addends of H(z), giving the causal impulse response:

h(n)=-12(-4)" +8(-2)", n=0,1,2,...

To verify this in the MATLAB environment, type

imp = [1 00 0 0];

resptf = filter(b,a,imp)

respres = filter(r(1),[1 -p(D)].,imp)+...
filter(r(2),[1 -p(2)].,imp)

Second-Order Sections (SOS)

Any transfer function H(z) has a second-order sections representation
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1-34

L L -1 -2
bop +bypz +bgpz

H()=[[Hy2 =2 i - ok -
k=1 k=100 T Q132 ~ + Qg2

where L is the number of second-order sections that describe the system. The MATLAB
environment represents the second-order section form of a discrete-time system as an L-
by-6 array sos. Each row of sos contains a single second-order section, where the row
elements are the three numerator and three denominator coefficients that describe the
second-order section.

boi b1 bar g a1 ag

b b b a a a
508 = .02 .12 .22 .02 .12 .22

bor, bir, bar, aor @p agp

There are many ways to represent a filter in second-order section form. Through

careful pairing of the pole and zero pairs, ordering of the sections in the cascade, and
multiplicative scaling of the sections, it is possible to reduce quantization noise gain and
avoid overflow in some fixed-point filter implementations. The functions zp2sos and
S$s2s0s, described in “Linear System Transformations” on page 1-40, perform pole-

zero pairing, section scaling, and section ordering.

Note All Signal Processing Toolbox second-order section transformations apply only to
digital filters.

Lattice Structure

For a discrete Nth order all-pole or all-zero filter described by the polynomial coefficients
a(n), n =1, 2, ..., N+1, there are N corresponding lattice structure coefficients k(n),

n=1, 2, .., N. The parameters k(n) are also called the reflection coefficients of the filter.
Given these reflection coefficients, you can implement a discrete filter as shown below.
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For a general pole-zero IIR filter described by polynomial coefficients a and b, there are
both lattice coefficients k(n) for the denominator a and ladder coefficients v(n) for the

numerator b. The lattice/ladder filter may be implemented as
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Diagram of lattice/ladder filter

The toolbox function tF2latc accepts an FIR or IIR filter in polynomial form and
returns the corresponding reflection coefficients. An example FIR filter in polynomial
form is

b = [1.0000 0.6149 0.9899 0.0000 0.0031 -0.0082];
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This filter's lattice (reflection coefficient) representation is

k = tf2latc(b)

For IIR filters, the magnitude of the reflection coefficients provides an easy stability
check. If all the reflection coefficients corresponding to a polynomial have magnitude less
than 1, all of that polynomial's roots are inside the unit circle. For example, consider an
IIR filter with numerator polynomial b from above and denominator polynomial:

a=1[11/2 1/3];

The filter's lattice representation is

[k,v] = tFf2latc(b,a);

Because abs (k) < 1 for all reflection coefficients in K, the filter is stable.

The function latc2tf calculates the polynomial coefficients for a filter from its lattice
(reflection) coefficients. Given the reflection coefficient vector k, the corresponding
polynomial form is

b = latc2tf(k);

The lattice or lattice/ladder coefficients can be used to implement the filter using the
function latcfilt.

Convolution Matrix

In signal processing, convolving two vectors or matrices is equivalent to filtering one of
the input operands by the other. This relationship permits the representation of a digital
filter as a convolution matrix.

Given any vector, the toolbox function convmtx generates a matrix whose inner product
with another vector is equivalent to the convolution of the two vectors. The generated
matrix represents a digital filter that you can apply to any vector of appropriate length;
the inner dimension of the operands must agree to compute the inner product.

The convolution matrix for a vector b, representing the numerator coefficients for a
digital filter, is

b=1[123];
X = randn(3,1);
C = convmtx(b*,3);
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Two equivalent ways to convolve b with X are as follows.

C*x;
conv(b,x);

yl
y2
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Continuous-Time System Models
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The continuous-time system models are representational schemes for analog filters.
Many of the discrete-time system models described earlier are also appropriate for the
representation of continuous-time systems:
+ State-space form
+ Partial fraction expansion
* Transfer function
* Zero-pole-gain form
It is possible to represent any system of linear time-invariant differential equations as a
set of first-order differential equations. In matrix or state-space form, you can express the
equations as

x =Ax+ Bu

y=Cx+Du

where u is a vector of nu inputs, x is an nx-element state vector, and y is a vector of ny
outputs. In the MATLAB environment, A, B, C, and D are stored in separate rectangular
arrays.

An equivalent representation of the state-space system is the Laplace transform transfer
function description

Y (s)=H(s)U(s)
where
H(s)=C(sI-A)'B+D
For single-input, single-output systems, this form is given by

_bls) _ b)s" + B(2)s" L +.. +b(n+1)
as) q)s™ +a@)s™ .. +am+1)

H(s)

Given the coefficients of a Laplace transform transfer function, residue determines the
partial fraction expansion of the system. See the description of residue for details.
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The factored zero-pole-gain form is

2(s) —k (s—2(D)s—2(2))...(s—2(n))

H(s) = =
p(s) (s= p(D)s—p(2)...(s— pm))

As in the discrete-time case, the MATLAB environment stores polynomial coefficients in
row vectors in descending powers of s. It stores polynomial roots, or zeros and poles, in
column vectors.
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Linear System Transformations

A number of Signal Processing Toolbox functions are provided to convert between the
various linear system models.. You can use the following chart to find an appropriate
transfer function: find the row of the model to convert from on the left side of the chart
and the column of the model to convert to on the top of the chart and read the function
name(s) at the intersection of the row and column. Note that some cells of this table are

empty.

Transfer State- |Zero- Pole- |Partial Lattice  |Second- Order |Convolution

Function |Space |Gain Fraction Filter Sections Matrix
Transfer tf2ss |tf2zp residuez |tf2latc|none convmtx
Function roots
State- ss2tf Ss2zp none none SS2s0S none
Space
Zero-Pole- |zp2tf zZp2ss none none Zp2s0s none
Gain poly
Partial residuez |none |none none none none
Fraction
Lattice latc2tf |none |[none none none none
Filter
SOS sos2tf S0S2SSS0S2zp none none none

Note Converting from one filter structure or model to another may produce a result with
different characteristics than the original. This is due to the computer's finite-precision
arithmetic and the variations in the conversion's round-off computations.

Many of the toolbox filter design functions use these functions internally. For example,
the zp2ss function converts the poles and zeros of an analog prototype into the
state-space form required for creation of a Butterworth, Chebyshev, or elliptic filter.
Once in state-space form, the filter design function performs any required frequency
transformation, that is, it transforms the initial lowpass design into a bandpass,
highpass, or bandstop filter, or a lowpass filter with the desired cutoff frequency.
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Note All Signal Processing Toolbox second-order section transformations apply only to
digital filters.

141



1 Filtering, Linear Systems and Transforms Overview

Discrete Fourier Transform
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The discrete Fourier transform, or DFT, is the primary tool of digital signal processing.
The foundation of the Signal Processing Toolbox product is the fast Fourier transform
(FFT), a method for computing the DFT with reduced execution time. Many of the toolbox
functions (including z-domain frequency response, spectrum and cepstrum analysis, and
some filter design and implementation functions) incorporate the FFT.

The MATLAB environment provides the functions fFt and 1 FFt to compute the

discrete Fourier transform and its inverse, respectively. For the input sequence x and its
transformed version X (the discrete-time Fourier transform at equally spaced frequencies
around the unit circle), the two functions implement the relationships

N-1
Xk+D=Y xn+DWE,
n=0

and

1 N-1
xn+1) ==Y X(k+DWy™".
N k=0

In these equations, the series subscripts begin with 1 instead of 0 because of the
MATLAB vector indexing scheme, and

Wy = o J2n/N

Note The MATLAB convention is to use a negative j for the Fft function. This is an
engineering convention; physics and pure mathematics typically use a positive j.

TTt, with a single input argument, X, computes the DFT of the input vector or matrix.
If X is a vector, FFt computes the DFT of the vector; if X is a rectangular array, FFt
computes the DFT of each array column.

For example, create a time vector and signal:



Discrete Fourier Transform

t
X

0:1/100:10-1/100; % Time vector
sin(2*pi*15*t) + sin(@2*pi*40*t); % Signal

The DFT of the signal, and the magnitude and phase of the transformed sequence, are
then

y = fft(X); % Compute DFT of x
m = abs(y); % Magnitude
p = unwrap(angle(y)): % Phase

To plot the magnitude and phase, type the following commands:

f = (0:length(y)-1)*100/length(y); % Frequency vector
subplot(2,1,1)

plot(f,m)
title("Magnitude®)

ax = gca;

ax.XTick = [15 40 60 85];
subplot(2,1,2)
plot(f,p*180/pi)
title("Phase™)

ax = gca;

ax.XTick = [15 40 60 85];

1-43



1 Filtering, Linear Systems and Transforms Overview

'l e’
I

File Edit View Inset Tools Desktop Window Help N

A IR AR EID )

Magnitude
ﬁm 1 T T L]

400

A second argument to FFt specifies a number of points n for the transform, representing
DFT length:

y = ffe(x,n);

In this case, FFt pads the input sequence with zeros if it is shorter than n, or truncates
the sequence if it is longer than n. If n is not specified, it defaults to the length of the
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input sequence. Execution time for FFt depends on the length, n, of the DFT it performs;
see the FFt for details about the algorithm.

Note The resulting FFT amplitude is A*n/2, where A is the original amplitude and n is
the number of FFT points. This is true only if the number of FFT points is greater than
or equal to the number of data samples. If the number of FFT points is less, the FFT
amplitude is lower than the original amplitude by the above amount.

The inverse discrete Fourier transform function I FFt also accepts an input sequence
and, optionally, the number of desired points for the transform. Try the example below;
the original sequence X and the reconstructed sequence are identical (within rounding
error).

t = 0:1/255:1;
X = sin(2*pi*120*t);
y = real (ifft(FFt(x)));

This toolbox also includes functions for the two-dimensional FFT and its inverse, FFt2
and 1FFt2. These functions are useful for two-dimensional signal or image processing.
The goertzel function, which is another algorithm to compute the DFT, also is included
in the toolbox. This function is efficient for computing the DFT of a portion of a long
signal.

It is sometimes convenient to rearrange the output of the FFt or FFt2 function so the
zero frequency component is at the center of the sequence. The MATLAB function
fftshift moves the zero frequency component to the center of a vector or matrix.
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2 Filter Design and Implementation

Filter Requirements and Specification

Filter design is the process of creating the filter coefficients to meet specific filtering
requirements. Filter implementation involves choosing and applying a particular
filter structure to those coefficients. Only after both design and implementation have
been performed can data be filtered. The following chapter describes filter design and
implementation in Signal Processing Toolbox software.

The goal of filter design is to perform frequency dependent alteration of a data sequence.
A possible requirement might be to remove noise above 200 Hz from a data sequence
sampled at 1000 Hz. A more rigorous specification might call for a specific amount of
passband ripple, stopband attenuation, or transition width. A very precise specification
could ask to achieve the performance goals with the minimum filter order, or it could call
for an arbitrary magnitude shape, or it might require an FIR filter. Filter design methods
differ primarily in how performance is specified.

To design a filter, the Signal Processing Toolbox software offers two approaches: object-
oriented and non-object oriented. The object-oriented approach first constructs a filter
specification object, fdesign, and then invokes an appropriate design method. To
illustrate the object-oriented approach, design and implement a 5—th order lowpass
Butterworth filter with a 3—dB frequency of 200 Hz. Assume a sampling frequency of 1
kHz. Apply the filter to input data.

Fs=1000; % Sampling frequency

time = 0:(1/Fs):1; % Time vector

X = cos(2*pi*60*time)+sin(2*pi*120*time)+randn(size(time)); % Data vector

d=fdesign. lowpass("N,F3dB",5,200,Fs); % Lowpass filter specification object

Hd=design(d, "butter®); % Invoke Butterworth design method
y=Filter(Hd,x);

The non-object oriented approach implements the filter using a function such as butter
and Firpm. All of the non-object oriented filter design functions operate with normalized
frequencies. Convert frequency specifications in Hz to normalized frequency to use these
functions. The Signal Processing Toolbox software defines normalized frequency to be

in the closed interval [0,1] with 1 denoting m radians/sample. For example, to specify a
normalized frequency of /2 radians/sample, enter 0.5.

To convert from Hz to normalized frequency, multiply the frequency in Hz by two and
divide by the sampling frequency. To design a 5—th order lowpass Butterworth filter with
a 3—dB frequency of 200 Hz using the non-object oriented approach, use butter:

Wn = (2*200)/1000; %Convert 3-dB frequency
% to normalized frequency: 0.4*pi rad/sample
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[B,A] = butter(5,Wn, " low");
y = filter(B,A,x);
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IR Filter Design

2-4

In this section...

“IIR vs. FIR Filters” on page 2-4

“Classical IIR Filters” on page 2-4

“Other IIR Filters” on page 2-4

“IIR Filter Method Summary” on page 2-5

“Classical IIR Filter Design Using Analog Prototyping” on page 2-6

“Comparison of Classical IIR Filter Types” on page 2-8

IIR vs. FIR Filters

The primary advantage of IIR filters over FIR filters is that they typically meet a given
set of specifications with a much lower filter order than a corresponding FIR filter.
Although IIR filters have nonlinear phase, data processing within MATLAB software
is commonly performed “offline,” that is, the entire data sequence is available prior to
filtering. This allows for a noncausal, zero-phase filtering approach (via the filtfilt
function), which eliminates the nonlinear phase distortion of an IIR filter.

Classical IIR Filters

The classical IIR filters, Butterworth, Chebyshev Types I and II, elliptic, and Bessel, all
approximate the ideal “brick wall” filter in different ways.

This toolbox provides functions to create all these types of classical IIR filters in both the
analog and digital domains (except Bessel, for which only the analog case is supported),
and in lowpass, highpass, bandpass, and bandstop configurations. For most filter types,
you can also find the lowest filter order that fits a given filter specification in terms of
passband and stopband attenuation, and transition width(s).

Other IIR Filters

The direct filter design function yulewalk finds a filter with magnitude response
approximating a desired function. This is one way to create a multiband bandpass filter.

You can also use the parametric modeling or system identification functions to design ITR
filters. These functions are discussed in “Parametric Modeling” on page 7-17.
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The generalized Butterworth design function maxflat is discussed in the section
“Generalized Butterworth Filter Design” on page 2-15.

IR Filter Method Summary

The following table summarizes the various filter methods in the toolbox and lists the
functions available to implement these methods.

Toolbox Filters Methods and Available Functions

Filter Method Description Filter Functions

Analog Using the poles and zeros of Complete design functions:

Prototyping a classical lowpass prototype besself, butter, chebyl, cheby2, ellip
filter in the continuous (Laplace)
domain, obtain a digital Order estimation functions:
filter through frequency buttord, cheblord, cheb2ord, ellipord
transformation and filter )
et o S, Lowpass analog prototype functions:

besselap, buttap, cheblap, cheb2ap,
ellipap

Frequency transformation functions:
1p2bp, Ip2bs, 1p2hp, Ip21p

Filter discretization functions:
bilinear, impinvar

Direct Design Design digital filter directly in yulewalk
the discrete time-domain by
approximating a piecewise linear
magnitude response.

Generalized Design lowpass Butterworth maxflat
Butterworth filters with more zeros than
Design poles.
Parametric Find a digital filter that Time-domain modeling functions:
Modeling approximates a prescribed time |lpc, prony, stmcb
or frequency domain response.
(See System Identification Frequency-domain modeling functions:

Toolbox™ documentation for an |invfregs, invfreqz
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Filter Method Description Filter Functions

extensive collection of parametric
modeling tools.)

Classical IR Filter Design Using Analog Prototyping

The principal IIR digital filter design technique this toolbox provides is based on

the conversion of classical lowpass analog filters to their digital equivalents. The
following sections describe how to design filters and summarize the characteristics of
the supported filter types. See “Special Topics in IIR Filter Design” on page 2-39 for
detailed steps on the filter design process.

Complete Classical IIR Filter Design

You can easily create a filter of any order with a lowpass, highpass, bandpass, or
bandstop configuration using the filter design functions.

Filter Design Functions

Filter Type Design Function

Bessel (analog only) [b,a] = besself(n,Wn,options)
[z,p.k] = besself(n,Wn,options)

[A.B,C,D] = besself(n,Wn,options)

Butterworth [b,a] = butter(n,Wn,options)
[z,p,K] = butter(n,Wn,options)

[A,B,C,D] = butter(n,Wn,options)

Chebyshev Type 1 [b,a] = chebyl(n,Rp,Wn,options)
[z.p.k] = chebyl(n,Rp,Wn,options)

[A,B,C,D] = chebyl(n,Rp,Wn,options)

Chebyshev Type 11 [b,a] = cheby2(n,Rs,Wn,options)

[z,p,k] = cheby2(n,Rs,Wn,options)

[A,B,C,D] = cheby2(n,Rs,Wn,options)
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Filter Type Design Function
Elliptic [b,a] = ellip(n,Rp,Rs,Wn,options)

[z.p,.k] = ellip(n,Rp,Rs,Wn,options)

[A,B,C,D] = ellip(n,Rp,Rs,Wn,options)

By default, each of these functions returns a lowpass filter; you need only specify the
desired cutoff frequency Wn in normalized frequency (Nyquist frequency = 1 Hz). For

a highpass filter, append the string "high” to the function's parameter list. For a
bandpass or bandstop filter, specify Wn as a two-element vector containing the passband
edge frequencies, appending the string "stop” for the bandstop configuration.

Here are some example digital filters:

[b,a] = butter(5,0.4); % Lowpass Butterworth

[b,a] = chebyl(4,1,[0.4 0.7]); % Bandpass Chebyshev Type 1
[b,a] = cheby2(6,60,0.8,"high"); % Highpass Chebyshev Type 11
[b,a] = ellip(3,1,60,[0.4 0.7],"stop™); % Bandstop elliptic

To design an analog filter, perhaps for simulation, use a trailing "s" and specify cutoff
frequencies in rad/s:

[b,a] = butter(5,0.4,"s"); % Analog Butterworth filter

All filter design functions return a filter in the transfer function, zero-pole-gain, or state-

space linear system model representation, depending on how many output arguments are
present. In general, you should avoid using the transfer function form because numerical
problems caused by roundoff errors can occur. Instead, use the zero-pole-gain form which
you can convert to a second-order section (SOS) form using zp2sos and then use the SOS
form to analyze or implement your filter.

Note All classical ITR lowpass filters are ill-conditioned for extremely low cutoff
frequencies. Therefore, instead of designing a lowpass IIR filter with a very narrow
passband, it can be better to design a wider passband and decimate the input signal.

Designing IIR Filters to Frequency Domain Specifications

This toolbox provides order selection functions that calculate the minimum filter order
that meets a given set of requirements.
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Filter Type Order Estimation Function

Butterworth [n,Wn] = buttord(Wp,Ws,Rp,Rs)
Chebyshev Type I [n,Wn] = cheblord(Wp,Ws,Rp,Rs)
Chebyshev Type 11 [n,Wn] = cheb2ord(Wp,Ws,Rp,Rs)
Elliptic [n,wn] = ellipord(Wp,Ws,Rp,Rs)

These are useful in conjunction with the filter design functions. Suppose you want a
bandpass filter with a passband from 1000 to 2000 Hz, stopbands starting 500 Hz away
on either side, a 10 kHz sampling frequency, at most 1 dB of passband ripple, and at
least 60 dB of stopband attenuation. You can meet these specifications by using the
butter function as follows.

[n,Wn] = buttord([1000 2000]/5000,[500 2500]/5000,1,60)
[b,a] = butter(n,Wn);

n p—
12
Wn =
0.1951 0.4080

An elliptic filter that meets the same requirements is given by

[n,wn] = ellipord([1000 2000]/5000,[500 2500]/5000,1,60)
[b,a] = ellip(n,1,60,Wn);

n p—
5
Wn =
0.2000 0.4000

These functions also work with the other standard band configurations, as well as for
analog filters.

Comparison of Classical IIR Filter Types

The toolbox provides five different types of classical IIR filters, each optimal in some
way. This section shows the basic analog prototype form for each and summarizes major
characteristics.



0.9

0.8

0.7

06

0.5r-

Magnitude

0.4

0.3

021

01F

IIR Filter Design

Butterworth Filter

The Butterworth filter provides the best Taylor series approximation to the ideal lowpass
filter response at analog frequencies @ = 0 and Q = wo; for any order N, the magnitude

squared response has 2N — 1 zero derivatives at these locations (maximally flat at Q =0
and Q = «). Response is monotonic overall, decreasing smoothly from Q = 0 to Q = oo.
|H(jQ)|=1/V2 atQ=1.

0
107!

Chebyshev Type I Filter

10? 107
Frequency (rad/s)

The Chebyshev Type I filter minimizes the absolute difference between the ideal and

actual frequency response over the entire passband by incorporating an equal ripple
of Rp dB in the passband. Stopband response is maximally flat. The transition from
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passband to stopband is more rapid than for the Butterworth filter. |H(j<)|
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The Chebyshev Type II filter minimizes the absolute difference between the ideal and
actual frequency response over the entire stopband by incorporating an equal ripple of

Rs dB in the stopband. Passband response is maximally flat.

The stopband does not approach zero as quickly as the type I filter (and does not
approach zero at all for even-valued filter order n). The absence of ripple in the passband,

however, is often an important advantage. |H(jQ)|=10"8/20 at 9 = 1.

t



IIR Filter Design

0.8

Magnitude
o]
tn

0.2

01p

0

I _.-".'\ - — -1
| I.' \\.‘ / Tr— ]
1} LY

1 | i i i

107!

Elliptic Filter

10°
Frequency (rad/s)

Elliptic filters are equiripple in both the passband and stopband. They generally meet
filter requirements with the lowest order of any supported filter type. Given a filter
order n, passband ripple Rp in decibels, and stopband ripple Rs in decibels, elliptic filters
minimize transition width. |[H(jQ)|=107FP20 at Q=1
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Bessel Filter
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Analog Bessel lowpass filters have maximally flat group delay at zero frequency and
retain nearly constant group delay across the entire passband. Filtered signals therefore
maintain their waveshapes in the passband frequency range. Frequency mapped and
digital Bessel filters, however, do not have this maximally flat property; this toolbox
supports only the analog case for the complete Bessel filter design function.

Bessel filters generally require a higher filter order than other filters for satisfactory

stopband attenuation. |H(jQ)|< 1//2 at Q = 1 and decreases as filter order n increases.
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Note The lowpass filters shown above were created with the analog prototype functions
besselap, buttap, cheblap, cheb2ap, and el lipap. These functions find the zeros,
poles, and gain of an nth-order analog filter of the appropriate type with a cutoff
frequency of 1 rad/s. The complete filter design functions (besself, butter, chebyl,
cheby?2, and el lip) call the prototyping functions as a first step in the design process.
See “Special Topics in IIR Filter Design” on page 2-39 for details.

To create similar plots, use n =5 and, as needed, Rp = 0.5 and Rs = 20. For example, to
create the elliptic filter plot:

ellipap(5,0.5,20);
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w = logspace(-1,1,1000);

h = fregs(k*poly(z),poly(p),w);
semilogx(w,abs(h)), grid
xlabel ("Frequency (rad/s)")
ylabel (*"Magnitude®)

Direct IIR Filter Design

This toolbox uses the term direct methods to describe techniques for IIR design that find
a filter based on specifications in the discrete domain. Unlike the analog prototyping
method, direct design methods are not constrained to the standard lowpass, highpass,
bandpass, or bandstop configurations. Rather, these functions design filters with an
arbitrary, perhaps multiband, frequency response. This section discusses the yulewalk
function, which is intended specifically for filter design; “Parametric Modeling” on page
7-17 discusses other methods that may also be considered direct, such as Prony's
method, Linear Prediction, the Steiglitz-McBride method, and inverse frequency design.

The yulewalk function designs recursive IIR digital filters by fitting a specified
frequency response. yulewalk's name reflects its method for finding the filter's
denominator coefficients: it finds the inverse FFT of the ideal desired magnitude-
squared response and solves the modified Yule-Walker equations using the resulting
autocorrelation function samples. The statement

[b,a] = yulewalk(n,f,m)

returns row vectors b and a containing the n+1 numerator and denominator coefficients
of the nth-order IIR filter whose frequency-magnitude characteristics approximate those
given in vectors ¥ and m. ¥ is a vector of frequency points ranging from 0 to 1, where

1 represents the Nyquist frequency. m is a vector containing the desired magnitude
response at the points in f. ¥ and m can describe any piecewise linear shape magnitude
response, including a multiband response. The FIR counterpart of this function is Fir2,
which also designs a filter based on an arbitrary piecewise linear magnitude response.
See “FIR Filter Design” on page 2-17 for details.

Note that yulewalk does not accept phase information, and no statements are made
about the optimality of the resulting filter.

Design a multiband filter with yulewalk and plot the desired and actual frequency
response:

m=[0 0 1 1 O 0 1 1 o0 0];
f =1]00.10.20.30.40.50.60.70.81];
[b,a] = yulewalk(10,f,m);
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[h,w] = freqz(b,a,128)
plot(f,m,w/pi,abs(h))
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Generalized Butterworth Filter Design

The toolbox function maxflat enables you to design generalized Butterworth filters,
that is, Butterworth filters with differing numbers of zeros and poles. This is desirable
in some implementations where poles are more expensive computationally than zeros.
maxflat is just like the butter function, except that it you can specify two orders (one
for the numerator and one for the denominator) instead of just one. These filters are
maximally flat. This means that the resulting filter is optimal for any numerator and
denominator orders, with the maximum number of derivatives at 0 and the Nyquist

frequency o = m both set to 0.
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For example, when the two orders are the same, maxflat is the same as butter:
[b,a] = maxflat(3,3,0.25)
b =
0.0317 0.0951 0.0951 0.0317
o 1.0000 -1.4590 0.9104 -0.1978

[b,a] = butter(3,0.25)

0.0317 0.0951 0.0951 0.0317
1.0000 -1.4590 0.9104 -0.1978

However, maxflat is more versatile because it allows you to design a filter with more
zeros than poles:

[b,a] = maxflat(3,1,0.25)
b =
0.0950 0.2849 0.2849 0.0950

a =
1.0000 -0.2402

The third input to maxflat is the half-power frequency, a frequency between 0 and 1
with a desired magnitude response of 1/ V2 .

You can also design linear phase filters that have the maximally flat property using the
"sym*® option:

maxflat(4, “sym”,0.3)

ans =
0.0331 0.2500 0.4337 0.2500 0.0331

For complete details of the maxFflat algorithm, see Selesnick and Burrus [2].
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FIR Filter Design

In this section...
“FIR vs. IIR Filters” on page 2-17
“FIR Filter Summary” on page 2-17

“Linear Phase Filters” on page 2-18

“Windowing Method” on page 2-19

“Multiband FIR Filter Design with Transition Bands” on page 2-23
“Constrained Least Squares FIR Filter Design” on page 2-28

“Arbitrary-Response Filter Design” on page 2-33

FIR vs. IR Filters

Digital filters with finite-duration impulse response (all-zero, or FIR filters) have both
advantages and disadvantages compared to infinite-duration impulse response (IIR)
filters.

FIR filters have the following primary advantages:

* They can have exactly linear phase.

* They are always stable.

* The design methods are generally linear.

* They can be realized efficiently in hardware.

+ The filter startup transients have finite duration.

The primary disadvantage of FIR filters is that they often require a much higher filter

order than IIR filters to achieve a given level of performance. Correspondingly, the delay
of these filters is often much greater than for an equal performance IIR filter.

FIR Filter Summary

FIR Filters

Filter Design Description Filter Functions

Method

Windowing Apply window to truncated inverse Fourier |Firl, fir2,
transform of desired “brick wall” filter kaiserord
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Filter Design Description Filter Functions
Method
Multiband with Equiripple or least squares approach over Ffirls, firpm,

Transition Bands

sub-bands of the frequency range

firpmord

Constrained Least

Minimize squared integral error over entire

fircls, firclsl

Squares frequency range subject to maximum error
constraints
Arbitrary Arbitrary responses, including nonlinear cFirpm
Response phase and complex filters
Raised Cosine Lowpass response with smooth, sinusoidal rcosdesign

transition

Linear Phase Filters

Except for cFirpm, all of the FIR filter design functions design linear phase filters only.
The filter coefficients, or “taps,” of such filters obey either an even or odd symmetry
relation. Depending on this symmetry, and on whether the order n of the filter is even or
odd, a linear phase filter (stored in length n+1 vector b) has certain inherent restrictions
on its frequency response.

Linear Phase [Filter | Symmetry of Coefficients Response Hif), |Response
Filter Type Order f=0 Hif), f =1
(Nyquist)

Type I Even |even: No restriction | No restriction
bk)=bn+2-k), k=1,.,n+1

Type 11 Odd even: No restriction |[H(1) = 0
bk)y=bn+2-Fk), k=1,...n+1

Type II1 Even odd: H@O) =0 H1) =0
bk)=-bn+2-k), k=1,.,n+1

Type IV Odd odd: HO) = 0 No restriction
bk)=-bn+2-k), k=1,.,n+1

2-18
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The phase delay and group delay of linear phase FIR filters are equal and constant over
the frequency band. For an order n linear phase FIR filter, the group delay is n/2, and
the filtered signal is simply delayed by n/2 time steps (and the magnitude of its Fourier
transform is scaled by the filter's magnitude response). This property preserves the wave
shape of signals in the passband; that is, there is no phase distortion.

The functions Firl, fir2, firls, Firpm, Fircls, and firclsl all design type I and
II linear phase FIR filters by default. rcosdesign designs only type I filters. Both
firls and Firpm design type III and IV linear phase FIR filters given a "hilbert”
or "differentiator” flag. cFirpm can design any type of linear phase filter, and
nonlinear phase filters as well.

Note Because the frequency response of a type II filter is zero at the Nyquist frequency
(“high” frequency), Firl does not design type II highpass and bandstop filters. For odd-
valued n in these cases, Firl adds 1 to the order and returns a type I filter.

Windowing Method

Consider the ideal, or “brick wall,” digital lowpass filter with a cutoff frequency of @
rad/s. This filter has magnitude 1 at all frequencies with magnitude less than w, and
magnitude 0 at frequencies with magnitude between w and m. Its impulse response
sequence h(n) is

1 ¢n ‘ 1 (o0 sin @1
hin)=—| Hwe'"do=—/| é“do=—"-
) 277:""” @) 271"'."“0 n

This filter is not implementable since its impulse response is infinite and noncausal. To
create a finite-duration impulse response, truncate it by applying a window. By retaining
the central section of impulse response in this truncation, you obtain a linear phase FIR
filter. For example, a length 51 filter with a lowpass cutoff frequency wg of 0.4 m rad/s is

b = 0.4*sinc(0.4*(-25:25));

The window applied here is a simple rectangular window. By Parseval's theorem, this is
the length 51 filter that best approximates the ideal lowpass filter, in the integrated least
squares sense. The following command displays the filter's frequency response in FVTool:

fvtool(b,1)
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2-20

Magnitude squared

Note that the y-axis shown in the figure below is in Magnitude Squared. You can set this
by right-clicking on the axis label and selecting Magnitude Squared from the menu.

Magnitude Response {squared)
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Ringing and ripples occur in the response, especially near the band edge. This “Gibbs
effect” does not vanish as the filter length increases, but a nonrectangular window
reduces its magnitude. Multiplication by a window in the time domain causes a

convolution or smoothing in the frequency domain. Apply a length 51 Hamming window
to the filter and display the result using FVTool:

b = 0.4*sinc(0.4*(-25:25));
b = b.*hamming(51)";
fvtool(b,1)

Note that the y-axis shown in the figure below is in Magnitude Squared. You can set this
by right-clicking on the axis label and selecting Magnitude Squared from the menu.
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Magnitude Response (squared)
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Using a Hamming window greatly reduces the ringing. This improvement is at the
expense of transition width (the windowed version takes longer to ramp from passband

to stopband) and optimality (the windowed version does not minimize the integrated
squared error).

The functions Firl and Fir2 are based on this windowing process. Given a filter order
and description of an ideal desired filter, these functions return a windowed inverse
Fourier transform of that ideal filter. Both use a Hamming window by default, but they

accept any window function. See “Windows” on page 7-2 for an overview of windows
and their properties.

Standard Band FIR Filter Design: firl

Firl implements the classical method of windowed linear phase FIR digital filter design.
It resembles the IIR filter design functions in that it is formulated to design filters in
standard band configurations: lowpass, bandpass, highpass, and bandstop.

The statements
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=5
n =

O =5

0;
0.4;

= Firl(n,Wn);

create row vector b containing the coefficients of the order n Hamming-windowed filter.
This is a lowpass, linear phase FIR filter with cutoff frequency Wn. Wn is a number
between 0 and 1, where 1 corresponds to the Nyquist frequency, half the sampling
frequency. (Unlike other methods, here Wn corresponds to the 6 dB point.) For a highpass
filter, simply append the string "high® to the function's parameter list. For a bandpass
or bandstop filter, specify Wn as a two-element vector containing the passband edge
frequencies; append the string "stop” for the bandstop configuration.

b = firl(n,Wn,window) uses the window specified in column vector window for the
design. The vector window must be n+1 elements long. If you do not specify a window,
Firl applies a Hamming window.

Kaiser Window Order Estimation

The kaiserord function estimates the filter order, cutoff frequency, and Kaiser window
beta parameter needed to meet a given set of specifications. Given a vector of frequency
band edges and a corresponding vector of magnitudes, as well as maximum allowable
ripple, kaiserord returns appropriate input parameters for the firl function.

Multiband FIR Filter Design: fir2
The Fir2 function also designs windowed FIR filters, but with an arbitrarily shaped
piecewise linear frequency response. This is in contrast to Firl, which only designs

filters in standard lowpass, highpass, bandpass, and bandstop configurations.

The commands

n = 50;

f=1[0 .4 .51];
m=1][1 1 0 0];
b = fir2(n,f,m);

return row vector b containing the n+1 coefficients of the order n FIR filter whose
frequency-magnitude characteristics match those given by vectors ¥ and m. Fis a vector
of frequency points ranging from 0 to 1, where 1 represents the Nyquist frequency. m is
a vector containing the desired magnitude response at the points specified in f. (The IIR
counterpart of this function is yulewalk, which also designs filters based on arbitrary
piecewise linear magnitude responses. See “IIR Filter Design” on page 2-4 for details.)
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Multiband FIR Filter Design with Transition Bands

The Firls and Firpm functions provide a more general means of specifying the

ideal desired filter than the Firl and Fir2 functions. These functions design Hilbert
transformers, differentiators, and other filters with odd symmetric coefficients (type III
and type IV linear phase). They also let you include transition or “don't care” regions
in which the error is not minimized, and perform band dependent weighting of the
minimization.

The Firls function is an extension of the Firl and Fir2 functions in that it minimizes
the integral of the square of the error between the desired frequency response and the
actual frequency response.

The Firpm function implements the Parks-McClellan algorithm, which uses the Remez
exchange algorithm and Chebyshev approximation theory to design filters with optimal
fits between the desired and actual frequency responses. The filters are optimal in the
sense that they minimize the maximum error between the desired frequency response
and the actual frequency response; they are sometimes called minimax filters. Filters
designed in this way exhibit an equiripple behavior in their frequency response, and
hence are also known as equiripple filters. The Parks-McClellan FIR filter design
algorithm is perhaps the most popular and widely used FIR filter design methodology.

The syntax for Firls and firpm is the same; the only difference is their minimization
schemes. The next example shows how filters designed with firls and Firpm reflect
these different schemes.

Basic Configurations

The default mode of operation of Firls and Firpm is to design type I or type II linear
phase filters, depending on whether the order you desire is even or odd, respectively.
A lowpass example with approximate amplitude 1 from 0 to 0.4 Hz, and approximate
amplitude 0 from 0.5 to 1.0 Hz is

n = 20; % Filter order

f =[]0 0.4 0.5 1]; % Frequency band edges
a=[1 1 00]; % Desired amplitudes
b = firpm(n,f,a);

From 0.4 to 0.5 Hz, Firpm performs no error minimization; this is a transition band or
“don't care” region. A transition band minimizes the error more in the bands that you do
care about, at the expense of a slower transition rate. In this way, these types of filters
have an inherent trade-off similar to FIR design by windowing.
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To compare least squares to equiripple filter design, use Firls to create a similar filter
Type

bb = firls(n,f,a);

and compare their frequency responses using FVTool:
fuvtool(b,1,bb,1)

Note that the y-axis shown in the figure below is in Magnitude Squared. You can set this
by right-clicking on the axis label and selecting Magnitude Squared from the menu.
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The filter designed with firpm exhibits equiripple behavior. Also note that the Firls
filter has a better response over most of the passband and stopband, but at the band
edges (F=0.4 and ¥ =0.5), the response is further away from the ideal than the Firpm
filter. This shows that the Firpm filter's maximum error over the passband and stopband
is smaller and, in fact, it is the smallest possible for this band edge configuration and

filter length.
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Think of frequency bands as lines over short frequency intervals. Firpm and firls use
this scheme to represent any piecewise linear desired function with any transition bands.
firls and Firpm design lowpass, highpass, bandpass, and bandstop filters; a bandpass
example is

f
a

[0 0.3 0.4 0.7 0.8 1]; % Band edges in pairs
[0 O 1 1 0 (0] s % Bandpass filter amplitude

Technically, these ¥ and a vectors define five bands:

* Two stopbands, from 0.0 to 0.3 and from 0.8 to 1.0
+ A passband from 0.4 to 0.7
+ Two transition bands, from 0.3 to 0.4 and from 0.7 to 0.8

Example highpass and bandstop filters are

f=[00.7 0.8 1]; % Band edges in pairs
a=[0 O 1 1]; % Highpass filter amplitude
f=[00.3 0.4 0.5 0.8 1]; % Band edges in pairs
a=[1 1 0 0 1 1]; % Bandstop filter amplitude

An example multiband bandpass filter 1s

f
a

[0 0.1 0.15 0.25 0.3 0.4 0.45 0.55 0.6 0.7 0.75 0.85 0.9 1];
[L1 o o 1 1 o O 1 1 0 O 1 1];

Another possibility is a filter that has as a transition region the line connecting the
passband with the stopband; this can help control “runaway” magnitude response in wide
transition regions:

f=1]00.40.42 0.48 0.5 1];

a=1][110.80.200]; % Passband, linear transition,
% stopband

The Weight Vector

Both Firls and firpm allow you to place more or less emphasis on minimizing the error
in certain frequency bands relative to others. To do this, specify a weight vector following
the frequency and amplitude vectors. An example lowpass equiripple filter with 10 times
less ripple in the stopband than the passband is

20; % Filter order
[0 0.4 0.5 1]; % Frequency band edges

n
f
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a=1][1 1 0 0]; % Desired amplitudes
w = [1 10]; % Weight vector
b = firpm(n,f,a,w);

A legal weight vector is always half the length of the F and a vectors; there must be
exactly one weight per band.

Anti-Symmetric Filters / Hilbert Transformers

When called with a trailing "h* or "Hilbert” option, fFirpm and Firls design FIR
filters with odd symmetry, that is, type I1I (for even order) or type IV (for odd order)
linear phase filters. An ideal Hilbert transformer has this anti-symmetry property and
an amplitude of 1 across the entire frequency range. Try the following approximate
Hilbert transformers and plot them using FVTool:

b = firpm(21,[0.05 1],[1 1],°h"); % Highpass Hilbert
bb = Ffirpm(20,[0.05 0.95],[1 1],"h"); % Bandpass Hilbert
fvtool(b,1,bb,1)

Magnitude Response (dB)
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You can find the delayed Hilbert transform of a signal X by passing it through these
filters.

fs = 1000; % Sampling frequency
t = (0:1/fs:2)"; % Two second time vector
X = sin(2*pi*300*t); % 300 Hz sine wave example signal

xh = filter(bb,1,x); % Hilbert transform of x

The analytic signal corresponding to X is the complex signal that has X as its real part
and the Hilbert transform of X as its imaginary part. For this FIR method (an alternative
to the hi lbert function), you must delay x by half the filter order to create the analytic
signal:

xd
Xa

[zeros(10,1); x(1:length(x)-10)]; % Delay 10 samples
xd + j*xh; % Analytic signal

This method does not work directly for filters of odd order, which require a noninteger
delay. In this case, the hi lbert function, described in “Hilbert Transform” on page
7-47, estimates the analytic signal. Alternatively, use the resample function to delay
the signal by a noninteger number of samples.

Differentiators

Differentiation of a signal in the time domain is equivalent to multiplication of the
signal's Fourier transform by an imaginary ramp function. That is, to differentiate a
signal, pass it through a filter that has a response H(®) = jo. Approximate the ideal
differentiator (with a delay) using Firpmor firls with a "d" or "differentiator*
option:

b = firpm(21,[0 1],[0 pi],"d");

For a type III filter, the differentiation band should stop short of the Nyquist frequency,
and the amplitude vector must reflect that change to ensure the correct slope:

bb = firpm(20,[0 0.9],[0 0.9*pi],"d");

In the "d" mode, Firpm weights the error by 1/e in nonzero amplitude bands to

minimize the maximum relative error. Firls weights the error by (1/)? in nonzero
amplitude bands in the "d" mode.

The following plots show the magnitude responses for the differentiators above.

fvtool(b,1,bb,1)
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legend("0dd order®,"Even order®, "Location”,"best")
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Constrained Least Squares FIR Filter Design

The Constrained Least Squares (CLS) FIR filter design functions implement a technique
that enables you to design FIR filters without explicitly defining the transition bands

for the magnitude response. The ability to omit the specification of transition bands is
useful in several situations. For example, it may not be clear where a rigidly defined
transition band should appear if noise and signal information appear together in the
same frequency band. Similarly, it may make sense to omit the specification of transition
bands if they appear only to control the results of Gibbs phenomena that appear in the
filter's response. See Selesnick, Lang, and Burrus [2] for discussion of this method.

Instead of defining passbands, stopbands, and transition regions, the CLS method
accepts a cutoff frequency (for the highpass, lowpass, bandpass, or bandstop cases), or
passband and stopband edges (for multiband cases), for the desired response. In this way,
the CLS method defines transition regions implicitly, rather than explicitly.
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The key feature of the CLS method is that it enables you to define upper and lower
thresholds that contain the maximum allowable ripple in the magnitude response. Given
this constraint, the technique applies the least square error minimization technique
over the frequency range of the filter's response, instead of over specific bands. The error
minimization includes any areas of discontinuity in the ideal, “brick wall” response. An
additional benefit is that the technique enables you to specify arbitrarily small peaks
resulting from Gibbs' phenomena.

There are two toolbox functions that implement this design technique.

Description Function
Constrained least square multiband FIR filter design fircls

Constrained least square filter design for lowpass and highpass linear |Ffirclsl
phase filters

For details on the calling syntax for these functions, see their reference descriptions in
the Function Reference.

Basic Lowpass and Highpass CLS Filter Design

The most basic of the CLS design functions, Firclsl, uses this technique to design
lowpass and highpass FIR filters. As an example, consider designing a filter with order
61 impulse response and cutoff frequency of 0.3 (normalized). Further, define the upper
and lower bounds that constrain the design process as:

+  Maximum passband deviation from 1 (passband ripple) of 0.02.

+  Maximum stopband deviation from 0 (stopband ripple) of 0.008.

_m_m_ _m T =002 Y 7Y f & =0008
SEVAVEEES v o v aus

To approach this design problem using Firclsl, use the following commands:

n = 61;

wo = 0.3;

dp = 0.02;

ds = 0.008

h = firclsl(n,wo,dp,ds);
fvtool(h,1)
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Note that the y-axis shown below is in Magnitude Squared. You can set this by right-
clicking on the axis label and selecting Magnitude Squared from the menu.
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Multiband CLS Filter Design

Fircls uses the same technique to design FIR filters with a desired piecewise
constant magnitude response. In this case, you can specify a vector of band edges and

a corresponding vector of band amplitudes. In addition, you can specify the maximum
amount of ripple for each band.

For example, assume the specifications for a filter call for:

From 0 to 0.3 (normalized): amplitude 0, upper bound 0.005, lower bound —0.005
From 0.3 to 0.5: amplitude 0.5, upper bound 0.51, lower bound 0.49

From 0.5 to 0.7: amplitude 0, upper bound 0.03, lower bound —0.03

From 0.7 to 0.9: amplitude 1, upper bound 1.02, lower bound 0.98
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* From 0.9 to 1: amplitude 0, upper bound 0.05, lower bound —0.05

Design a CLS filter with impulse response order 129 that meets these specifications:

129;

[0 0.3 0.5
[00.501 ;
[0.005 0.51 0.03 1.02 0.05];
[-0.005 0.49 -0.03 0.98 -0.05];
h = fircls(n,f,a,up,10);

fvtool(h,1)
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Note that the y-axis shown below is in Magnitude Squared. You can set this by right-
clicking on the axis label and selecting Magnitude Squared from the menu.
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Weighted CLS Filter Design

Weighted CLS filter design lets you design lowpass or highpass FIR filters with relative
weighting of the error minimization in each band. The Firclsl function enables you to
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specify the passband and stopband edges for the least squares weighting function, as well

as a constant k that specifies the ratio of the stopband to passband weighting.

For example, consider specifications that call for an FIR filter with impulse response
order of 55 and cutoff frequency of 0.3 (normalized). Also assume maximum allowable
passband ripple of 0.02 and maximum allowable stopband ripple of 0.004. In addition,
add weighting requirements:

+ Passband edge for the weight function of 0.28 (normalized)

*  Stopband edge for the weight function of 0.32

*  Weight error minimization 10 times as much in the stopband as in the passband

To approach this using Firclsl, type

n = 55;

wo = 0.3;

dp = 0.02;

ds = 0.004;

wp = 0.28;

ws = 0.32;

k = 10;

h = firclsl(n,wo,dp,ds,wp,ws,k);
fvtool(h,1)

Note that the y-axis shown below is in Magnitude Squared. You can set this by right-
clicking on the axis label and selecting Magnitude Squared from the menu.
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Arbitrary-Response Filter Design

0.8

0.9

FIR Filter Design

The cFirpm filter design function provides a tool for designing FIR filters with arbitrary
complex responses. It differs from the other filter design functions in how the frequency
response of the filter is specified: it accepts the name of a function which returns the

filter response calculated over a grid of frequencies. This capability makes cFirpma
highly versatile and powerful technique for filter design.

This design technique may be used to produce nonlinear-phase FIR filters, asymmetric

frequency-response filters (with complex coefficients), or more symmetric filters with
custom frequency responses.

The design algorithm optimizes the Chebyshev (or minimax) error using an extended
Remez-exchange algorithm for an initial estimate. If this exchange method fails to obtain

the optimal filter, the algorithm switches to an ascent-descent algorithm that takes over
to finish the convergence to the optimal solution.
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Multiband Filter Design

Consider a multiband filter with the following special frequency-domain characteristics.

Band Amplitude Optimization Weighting
[~1 —0.5] 5 1] 1

[~0.4 +0.3] [2 2] 10

[+0.4 +0.8] [2 1] 5

A linear-phase multiband filter may be designed using the predefined frequency-response
function multiband, as follows:

b = cfirpm(38, [-1 -0.5 -0.4 0.3 0.4 0.8], -
{"multiband®, [51 2 2 2 1]}, [1 10 5]);

For the specific case of a multiband filter, we can use a shorthand filter design notation
similar to the syntax for firpm:

b = cfirpm(38,[-1 -0.5 -0.4 0.3 0.4 0.8],
[6512221], [1 10 5D;

As with Firpm, a vector of band edges is passed to cFirpm. This vector defines the
frequency bands over which optimization is performed; note that there are two transition
bands, from —0.5 to —0.4 and from 0.3 to 0.4.

In either case, the frequency response is obtained and plotted using linear scale in
FVTool:

fvtool(b,1)

Note that the range of data shown below is (-Fs/2,Fs/2). You can set this range by
changing the x-axis units to Frequency (Fs =1 Hz).
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The filter response for this multiband filter is complex, which is expected because of the
asymmetry in the frequency domain. The impulse response, which you can select from

the FVTool toolbar, is shown below.
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Impulse Response
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Filter Design with Reduced Delay

Consider the design of a 62-tap lowpass filter with a half-Nyquist cutoff. If we specify a
negative offset value to the lowpass filter design function, the group delay offset for the
design is significantly less than that obtained for a standard linear-phase design. This
filter design may be computed as follows:

b = cfirpm(61,[0 0.5 0.55 1],{"lowpass”,-16});

The resulting magnitude response is

fvtool(b,1)

Note that the range of data in this plot is (-Fs/2,Fs/2), which you can set changing

the x-axis units to Frequency. The y-axis is in Magnitude Squared, which you can set by
right-clicking on the axis label and selecting Magnitude Squared from the menu.
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The group delay of the filter reveals that the offset has been reduced from N/2 to N/2-16
(i.e., from 30.5 to 14 .5). Now, however, the group delay is no longer flat in the passband
region. To create this plot, click the Group Delay button on the toolbar.
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If we compare this nonlinear-phase filter to a linear-phase filter that has exactly

14.5 samples of group delay, the resulting filter is of order 2%¥14.5, or 29. Using

b = cfirpm(29,[0 0.5 0.55 1], "lowpass"), the passband and stopband ripple is
much greater for the order 29 filter. These comparisons can assist you in deciding which
filter 1s more appropriate for a specific application.
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Special Topics in IIR Filter Design

In this section...

“Classic IIR Filter Design” on page 2-39
“Analog Prototype Design” on page 2-39
“Frequency Transformation” on page 2-40

“Filter Discretization” on page 2-42

Classic IIR Filter Design

The classic IIR filter design technique includes the following steps.

1 Find an analog lowpass filter with cutoff frequency of 1 and translate this prototype
filter to the desired band configuration
2 Transform the filter to the digital domain.

3 Discretize the filter.

The toolbox provides functions for each of these steps.

Design Task Available functions

Analog lowpass prototype buttap, cheblap, besselap, el lipap, cheb2ap
Frequency transformation Ip2lp, Ip2hp, Ip2bp, Ip2bs

Discretization bilinear, impinvar

Alternatively, the butter, chebyl, cheb2ord, el lip, and bessel f functions perform
all steps of the filter design and the buttord, cheblord, cheb2ord, and el lipord
functions provide minimum order computation for IIR filters. These functions are
sufficient for many design problems, and the lower level functions are generally not
needed. But if you do have an application where you need to transform the band edges of
an analog filter, or discretize a rational transfer function, this section describes the tools
with which to do so.

Analog Prototype Design

This toolbox provides a number of functions to create lowpass analog prototype filters
with cutoff frequency of 1, the first step in the classical approach to IIR filter design.
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The table below summarizes the analog prototype design functions for each supported
filter type; plots for each type are shown in “IIR Filter Design” on page 2-4.

Filter Type Analog Prototype Function

Bessel [z,p,K] = besselap(n)
Butterworth [z,p,k] = buttap(n)
Chebyshev Type I [z.p.k] = cheblap(n,Rp)
Chebyshev Type 11 [z,p,k] = cheb2ap(n,Rs)
Elliptic [z,p,.k] = ellipap(n,Rp,Rs)

Frequency Transformation

The second step in the analog prototyping design technique is the frequency
transformation of a lowpass prototype. The toolbox provides a set of functions to
transform analog lowpass prototypes (with cutoff frequency of 1 rad/s) into bandpass,
highpass, bandstop, and lowpass filters of the desired cutoff frequency.

Frequency Transformation Transformation Function
Lowpass to lowpass [numt,dent] = Ip2lp (num,den,Wo)
s'=s/ [At,Bt,Ct,Dt] = Ip2lp (A,B,C,D,Wo)
Lowpass to highpass [numt,dent] = Ip2hp (num,den,Wo)
. [At,Bt,Ct,Dt] = Ip2hp (A,B,C,D,Wo)
S = —
s
Lowpass to bandpass [numt,dent] = Ip2bp (num,den,Wo,Bw)
S’_&(S/%)gﬂ [At,Bt,Ct,Dt] = Ip2bp (A,B,C,D,Wo,Bw)
"B, s/ay
Lowpass to bandstop [numt,dent] = Ip2bs (num,den,Wo,Bw)
, B, s/ap [At,Bt,Ct,Dt] = Ip2bs( A,B,C,D,Wo,Bw)

S =_CD—
@ (s/ wy)?+1
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As shown, all of the frequency transformation functions can accept two linear system
models: transfer function and state-space form. For the bandpass and bandstop cases

W =010

and
B, = wy -y
where w; 1s the lower band edge and w; is the upper band edge.

The frequency transformation functions perform frequency variable substitution. In the
case of Ip2bp and Ip2bs, this is a second-order substitution, so the output filter is twice
the order of the input. For Ip21p and Ip2hp, the output filter is the same order as the
input.

To begin designing an order 10 bandpass Chebyshev Type I filter with a value of 3 dB for
passband ripple, enter

[z,p,k] = cheblap(10,3);

Outputs z, p, and Kk contain the zeros, poles, and gain of a lowpass analog filter with
cutoff frequency Q. equal to 1 rad/s. Use the Ip2bp function to transform this lowpass
prototype to a bandpass analog filter with band edges Q; = /5 and &, = 1. First, convert
the filter to state-space form so the Ip2bp function can accept it:

[A,B,C,D] = zp2ss(z,p,k); % Convert to state-space form.

Now, find the bandwidth and center frequency, and call 1p2bp:

ul = 0.1*2*pi;

u2 = 0.5*2*pi; % In radians per second
Bw = u2-ul;

Wo = sqrt(ul*u2);

[At,Bt,Ct,Dt] = Ip2bp(A,B,C,D,Wo,Bw);

Finally, calculate the frequency response and plot its magnitude:

[b,a] = ss2tf(At,Bt,Ct,Dt); % Convert to TF form

w = linspace(0.01,1,500)*2*pi; % Generate frequency vector

h = fregs(b,a,w); % Compute frequency response
semilogy(w/2/pi ,abs(h)) % Plot log magnitude vs. freq
xlabel ("Frequency (Hz)")

grid
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Filter Discretization

Frequency (Hz)

The third step in the analog prototyping technique is the transformation of the filter
to the discrete-time domain. The toolbox provides two methods for this: the impulse
invariant and bilinear transformations. The filter design functions butter, chebyl,
cheby2, and el l'ip use the bilinear transformation for discretization in this step.

Analog to Digital

Transformation Function

Transformation

[numd,dend] = impinvar (num,den,fs)

Impulse invariance

Bilinear transform
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Analog to Digital Transformation Function
Transformation

[numd,dend] = bilinear (num,den,fs,Fp)

[Ad,Bd,Cd,Dd] = bilinear (At,Bt,Ct,Dt,fs,Fp)

Impulse Invariance

The toolbox function impinvar creates a digital filter whose impulse response is the
samples of the continuous impulse response of an analog filter. This function works
only on filters in transfer function form. For best results, the analog filter should have
negligible frequency content above half the sampling frequency, because such high
frequency content is aliased into lower bands upon sampling. Impulse invariance works
for some lowpass and bandpass filters, but is not appropriate for highpass and bandstop
filters.

Design a Chebyshev Type I filter and plot its frequency and phase response using
FVTool:

[bz,az] = impinvar(b,a,2);
fvtool (bz,az)

Click the Magnitude and Phase Response toolbar button.

2-43



2 Filter Design and Implementation

Magnitude Response (dB) and Phase Response
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Impulse invariance retains the cutoff frequencies of 0.1 Hz and 0.5 Hz.

Bilinear Transformation

The bilinear transformation is a nonlinear mapping of the continuous domain to the
discrete domain; it maps the s-plane into the z-plane by

H@=H®s)|

S=R——

z+1

Bilinear transformation maps the jQ-axis of the continuous domain to the unit circle of

the discrete domain according to

w=2tan"! (9)
k
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The toolbox function bi I inear implements this operation, where the frequency
warping constant k is equal to twice the sampling frequency (2*fs) by default, and

equal to 2nfp/tan(n p/fs ) if you give bilinear a trailing argument that represents a

“match” frequency Fp. If a match frequency Fp (in hertz) is present, bi linear maps the
frequency Q = 2mf, (in rad/s) to the same frequency in the discrete domain, normalized to
the sampling rate: @ = 2f,/f; (in rad/sample).

The bilinear function can perform this transformation on three different linear system
representations: zero-pole-gain, transfer function, and state-space form. Try calling
bilinear with the state-space matrices that describe the Chebyshev Type I filter from

the previous section, using a sampling frequency of 2 Hz, and retaining the lower band
edge of 0.1 Hz:

[Ad,Bd,Cd,Dd] = bilinear(At,Bt,Ct,Dt,2,0.1):
The frequency response of the resulting digital filter is

[bz,az] = ss2tf(Ad,Bd,Cd,Dd); % Convert to TF
fvtool (bz,az)

Click the Magnitude and Phase Response toolbar button.
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Magnitude Response (dB) and Phase Response
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The lower band edge is at 0.1 Hz as expected. Notice, however, that the upper band

edge is slightly less than 0.5 Hz, although in the analog domain it was exactly 0.5 Hz.
This illustrates the nonlinear nature of the bilinear transformation. To counteract this
nonlinearity, it is necessary to create analog domain filters with “prewarped” band edges,
which map to the correct locations upon bilinear transformation. Here the prewarped
frequencies ul and u2 generate Bw and Wo for the Ip2bp function:

=

Sampling frequency (hertz)

fs = 2;

ul = 2*fs*tan(0.1*(2*pi/fs)/2); % Lower band edge (rad/s)
u2 = 2*fs*tan(0.5*(2*pi/fs)/2); % Upper band edge (rad/s)
Bw = u2 - ul; % Bandwidth

Wo = sqrt(ul*u2); % Center frequency

[At,Bt,Ct,Dt] = Ip2bp(A,B,C,D,Wo,Bw);
A digital bandpass filter with correct band edges 0.1 and 0.5 times the Nyquist frequency
is

[Ad,Bd,Cd,Dd] = bilinear(At,Bt,Ct,Dt,fs);
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The example bandpass filters from the last two sections could also be created in one
statement using the complete IIR design function chebyl. For instance, an analog
version of the example Chebysheyv filter is

[b,a] = chebyl1(5,3,[0.1 0.5]*2*pi,"s");

Note that the band edges are in rad/s for analog filters, whereas for the digital case,
frequency is normalized:

[bz,az] = chebyl(5,3,[0.1 0.5]);

All of the complete design functions call bi linear internally. They prewarp the band
edges as needed to obtain the correct digital filter.
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Filtering Data With Signal Processing Toolbox Software

2-48

Lowpass FIR Filter -- Window Method

This example shows how to design and implement an FIR filter using two command line
functions, Firl and designfilt, and the interactive tool fdatool.

Create a signal to use in the examples. The signal is a 100 Hz sine wave in additive
N(0.1/4) white Gaussian noise. Set the random number generator to the default state
for reproducible results.

rng default

Fs = 1000;
t linspace(0,1,Fs);
X cos(2*pi*100*t)+0.5*randn(size(t));

The filter design is an FIR lowpass filter with order equal to 20 and a cutoff frequency of
150 Hz. Use a Kaiser window with length one sample greater than the filter order and

4 =3 See kaiser for details on the Kaiser window.

Use firl to design the filter. Firl requires normalized frequencies in the interval
[0,1], where 1 corresponds to m rad/sample. To use Firl, you must convert all frequency
specifications to normalized frequencies.

Design the filter and view the filter's magnitude response.

fc 150;
wn (2/Fs)*fc;
b = firl(20,Wn, "low",kaiser(21,3));

fvtool(b,1,"Fs",Fs)
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Apply the filter to the signal and plot the result
sinusoid.

y = filter(b,1,x);

plot(t(1:100),x(1:100))
hold on

plot(t(1:100),y(1:100))

xlabel("Time (s)")
ylabel ("Amplitude®)
legend("Original Signal®,"Filtered Data®)

for the first ten periods of the 100 Hz
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Design the same filter using designfi lt. Set the filter response to " lowpassfir® and
input the specifications as Name, Value pairs. With designfi I t, you can specify your

filter design in Hz.
Fs = 1000;
Hd =

designfilt(" lowpassfir®, "FilterOrder~,20, "CutoffFrequency®,150, ...
"DesignMethod”, "window", "Window" ,{@kaiser,3}, "SampleRate” ,Fs);

Filter the data and plot the result.
yl = filter(Hd,x);

figure
plot(t(1:100),x(1:100))
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hold on
plot(t(1:100),y1(1:100))

xlabel("Time (s)")

ylabel ("Amplitude®)
legend("Original Signal®,"Filtered Data®)
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Lowpass FIR Filter with FDATool

This example shows how to design and implement a lowpass FIR filter using the window
method with the interactive tool fdatool.

Start FDATool by entering fdatool at the command line.
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+ Set the Response Type to Lowpass.
*  Set the Design Method to FIR and select the Window method.
*  Under Filter Order, select Specify order. Set the order to 20.

+ Under Frequency Specifications, set Units to Hz, Fs to 1000, and Fec to 150.

B Filter Design & Analysis Taal - [untitled.fda *] EETES
File Edit Analysis Targets View Window Help
u - x = B - =1
b L] Jua o HE i H
NeEdER @<« id D HENEAL::0 BLARE
rCurrent Filter Information — Magnitude Response (dB)
D . T __ l . T T T T T T T l
,‘\\
Structure: Direct-Form FIR o Y
Tu .ure irect-Form S 20| \ ]
Order: 20 = I'| TN |
Stable: Yes = | VTN -
Source:  Designed ‘E 40k If ¥ ".II | Yo /'_'\‘ N A
o |f || \ \ W
w© | | | \ \f
= | Il ||' II' |
Bl NS B NN B DR R
i i i i i i i i i
[ Store Fitter ] 0 50 100 150 200 250 300 350 400 450
( Fitter Manager ... | Frequency (Hz)
—PResponseType—_ FitterOrder— _ Frequency Specifications — Magnitude Specifications
==l| @ |Lowpass v || @ specify order: |20 Units: |Hz v
Highpass -
S | anp: ! || ® winimum order Fs: [1000 The attenuation at cutoff
() Bandpass frequencies is fixed at § dB
| © Bandstop — Options Fe: 150 (half the passband gain)
7 /| Scale Passband
Differentiator - .
T%|| |- Design Methed — || Window: Kaiser x|
]| | O IR | Butterworth - = 05
L] -
Sl @ FR
@ Design Filter
Designing Filter ... Done

* Click Design Filter.
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+ Select File > Export... to export your FIR filter to the MATLAB® workspace as
coefficients or a filter object. In this example, export the filter as an object. Specify the
variable name as Hd.

-

.
|4 Export | = 2 |
— Export To
Workspace -
— Export Az
Objects =

— “ariable Hames

Dizcrete Fiter:  |Hd

|:| Owerwrite Wariables

[F_xpnrt] [C.Ius.e] [ Help ]

+ Click Export.

+ Filter the input signal in the command window with the exported filter object. Plot
the result for the first ten periods of the 100 Hz sinusoid.

y2 = filter(Hd,x);

figure
plot(t(1:100),x(1:100))
hold on
plot(t(1:100),y2(1:100))

xlabel("Time (s)")

ylabel ("Amplitude®)
legend("Original Signal”,"Filtered Data®)
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Select File > Generate MATLAB Code to generate a MATLAB function to create a
filter object using your specifications.

You can also use the interactive tool filterbuilder to design your filter.

Bandpass Filters -- Minimum-Order FIR and IR Systems

This example shows how to design a bandpass filter and filter data with minimum-order
FIR equiripple and IIR Butterworth filters. You can model many real-world signals as a
superposition of oscillating components, a low-frequency trend, and additive noise. For
example, economic data often contain oscillations, which represent cycles superimposed
on a slowly varying upward or downward trend. In addition, there is an additive noise

component, which is a combination of measurement error and the inherent random
fluctuations in the process.
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In these examples, assume you sample some process every day for one year. Assume the
process has oscillations on approximately one-week and one-month scales. In addition,

there is a low-frequency upward trend in the data and additive N0, 1/4) white Gaussian
noise.

Create the signal as a superposition of two sine waves with frequencies of 1/7 and 1/30

cycles/day. Add a low-frequency increasing trend term and N(0.1/4) white Gaussian
noise. Set the random number generator to the default state for reproducible results. The
data is sampled at 1 sample/day. Plot the resulting signal and the power spectral density
(PSD) estimate.

rng default

Fs = 1;

n = 1:365;

X = cos@*pi*(1/7)*n)+cos(2*pi*(1/30)*n-pi/4);
trend = 3*sin(2*pi*(1/1480)*n);

y = x+trend+0.5*randn(size(n));

[pxx,f] = periodogram(y,[].,length(y),Fs);

subplot(2,1,1)
plot(n,y)
xlim([1 365])
xlabel ("Days*®)
grid

subplot(2,1,2)
plot(f,10*1og10(pxx))
xlabel ("Cycles/day ™)
ylabel ("dB*)

grid
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The low-frequency trend appears in the power spectral density estimate as increased
low-frequency power. The low-frequency power appears approximately 10 dB above the
oscillation at 1/30 cycles/day. Use this information in the specifications for the filter
stopbands.

Design minimum-order FIR equiripple and ITR Butterworth filters with the following
specifications: passband from [1/40,1/4] cycles/day and stopbands from [0,1/60] and
[1/4,1/2] cycles/day. Set both stopband attenuations to 10 dB and the passband ripple
tolerance to 1 dB.

Hd1 = designfilt("bandpassfir”®,

"StopbandFrequencyl®,1/60, "PassbandFrequencyl”,1/40,
"PassbandFrequency2*,1/4 ,"StopbandFrequency2®,1/2 ,
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"StopbandAttenuationl®,10, "PassbandRipple”,1,

"StopbandAttenuation2®,10, "DesignMethod”, "equiripple”, "SampleRate” ,Fs);
Hd2 = designfilt("bandpassiir”, -

"StopbandFrequencyl*,1/60, "PassbandFrequencyl*®,1/40,

"PassbandFrequency2*,1/4 ,"StopbandFrequency2®,1/2 ,

"StopbandAttenuationl®,10, "PassbandRipple”,1,

"StopbandAttenuation2®,10, "DesignMethod®, "butter”, "SampleRate” ,Fs);

Compare the order of the FIR and IIR filters and the unwrapped phase responses.

fprintf("The order of the FIR filter is %d\n",Ffiltord(Hdl))
fprintf("The order of the IIR Filter is %d\n",filtord(Hd2))

[phifir,w]
[phifiir,w]

= phasez(Hd1,[1,1);
= phasez(Hd2,[1,1);
figure

plot(w,unwrap(phifir))

hold on

plot(w,unwrap(phiiir))

xlabel ("Cycles/Day")

ylabel ("Radians™)

legend("FIR Equiripple Filter®,"1IR Butterworth Filter")
grid

The order of the FIR filter is 78
The order of the 1IR filter is 8
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The IIR filter has a much lower order that the FIR filter. However, the FIR filter has
a linear phase response over the passband, while the IIR filter does not. The FIR filter
delays all frequencies in the filter passband equally, while the IIR filter does not.

Additionally, the rate of change of the phase per unit of frequency is greater in the FIR
filter than in the IIR filter.

Design a lowpass FIR equiripple filter for comparison. The lowpass filter specifications
are: passband [0,1/4] cycles/day, stopband attenuation equal to 10 dB, and the passband
ripple tolerance set to 1 dB.

Hdlow = designfilt("lowpassfir”,
"PassbandFrequency” ,1/4, " StopbandFrequency*®,1/2,
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"PassbandRipple”,1, "StopbandAttenuation®,10,
"DesignMethod®, "equiripple®, "SampleRate®,1);

Filter the data with the bandpass and lowpass filters.

yfir = filter(Hdl,y);
yiir = filter(Hd2,y);
ylow = Filter(Hdlow,y);

Plot the PSD estimate of the bandpass IIR filter output. You can replace yiir with yfir
in the following code to view the PSD estimate of the FIR bandpass filter output.

[pxx,¥f] = periodogram(yiir,[],length(yiir),Fs);

figure
plot(f,10*1og10(pxx))

xlabel ("Cycles/day™)

ylabel ("dB™)
grid
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The PSD estimate shows the bandpass filter attenuates the low-frequency trend and
high-frequency noise.

Plot the first 120 days of FIR and IIR filter output.

figure
plot(n(1:120),yfir(1:120))
hold on
plot(n(1:120),yiir(1:120))

axis([1 120 -2.8 2.8])

xlabel ("Days*®)

legend("FIR bandpass filter output®,”lIR bandpass filter output”®,
"Location®, "SouthEast*")
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The increased phase delay in the FIR filter is evident in the filter output.

Plot the lowpass FIR filter output superimposed on the superposition of the 7-day and 30-
day cycles for comparison.

figure
plot(n,x)
hold on
plot(n,ylow)

xhim([1 365])

xlabel ("Days*®)

legend("7-day and 30-day cycles®,"FIR lowpass filter output®, ...
"Location®, "NorthWest*")
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You can see in the preceding plot that the low-frequency trend is evident in the lowpass
filter output. While the lowpass filter preserves the 7-day and 30-day cycles, the
bandpass filters perform better in this example because the bandpass filters also remove
the low-frequency trend.

Zero-Phase Filtering
This example shows how to perform zero-phase filtering.

Repeat the signal generation and lowpass filter design with Firl and designfilt.
You do not have to execute the following code if you already have these variables in your
workspace.

rng default
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Fs = 1000;
t linspace(0,1,Fs);
X = cos(2*pi*100*t)+0.5*randn(size(t));

% Using firl

fc = 150;

Wn = (2/Fs)*fc;

b = firl(20,Wn, " low",kaiser(21,3));

% Using designfilt
Hd = designfilt("lowpassfir”,"FilterOrder~®,20, "CutoffFrequency”,150,
"DesignMethod”, "window", "Window" ,{@kaiser,3}, "SampleRate” ,Fs);

Filter the data using Filter. Plot the first 100 points of the filter output along with a
superimposed sinusoid with the same amplitude and initial phase as the input signal.

yout = Filter(Hd,x);
xin = cos(2*pi*100*t);

figure
plot(t(1:100),xin(1:100))
hold on
plot(t(1:100),yout(1:100))

xlabel ("Time (s)7)

ylabel ("Amplitude”)

legend("Input Sine Wave®,"Filtered Data”,
"Location”, "NorthEast")

grid
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Looking at the initial 0.01 seconds of the filtered data, you see that the output is delayed
with respect to the input. The delay appears to be approximately 0.01 seconds, which is
almost 1/2 the length of the FIR filter in samples (10> 0.001},

This delay is due to the filter's phase response. The FIR filter in these examples is a type
I linear-phase filter. The group delay of the filter is 10 samples.

Plot the group delay using Fvtool.

fvtool (Hd, "Analysis”®, "grpdelay®);
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In many applications, phase distortion is acceptable. This is particularly true when
phase response is linear. In other applications, it is desirable to have a filter with a zero-
phase response. A zero-phase response is not technically possibly in a noncausal filter.
However, you can implement zero-phase filtering using a causal filter with FiltFilt.

Filter the input signal using i ltFi lt. Plot the responses to compare the filter outputs
obtained with Filter and Filtfilt.

yzp = FiltfFilt(Hd,x);

figure
plot(t(1:100),xin(1:100))
hold on
plot(t(1:100),yout(1:100))
plot(t(1:100),yzp(1:100))
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xlabel("Time (s)")

ylabel ("Amplitude®)

legend("100-Hz Sine Wave®,"Filtered Signal~®,"Zero-phase Filtering~, ...
"Location®, "NorthEast*")
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Zero-phase Filtering

Amplitude
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In the preceding figure, you can see that the output of £ ltFfilt does not exhibit the
delay due to the phase response of the FIR filter.
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Practical Introduction to Digital Filtering

This example shows how to design, analyze, and apply a digital filter to your data. It will
help you answer questions such as: how do I compensate for the delay introduced by a
filter?, How do I avoid distorting my signal?, How do I remove unwanted content from my
signal?, How do I differentiate my signal?, and How do I integrate my signal?

Filters can be used to shape the signal spectrum in a desired way or to perform
mathematical operations such as differentiation and integration. In what follows you will
learn some practical concepts that will ease the use of filters when you need them.

This example focuses on applications of digital filters rather than on their design. If you
want to learn more about how to design digital filters see the "Practical Introduction to
Digital Filter Design" example.

Compensating for Delay Introduced by Filtering

Digital filters introduce delay in your signal. Depending on the filter characteristics,
the delay can be constant over all frequencies, or it can vary with frequency. The type
of delay determines the actions you have to take to compensate for it. The grpdelay
function allows you to look at the filter delay as a function of frequency. Looking at the
output of this function allows you to identify if the delay of the filter is constant or if it
varies with frequency (i.e. if it is frequency-dependent).

Filter delay that is constant over all frequencies can be easily compensated for by shifting
the signal in time. FIR filters usually have constant delay. On the other hand, delay

that varies with frequency causes phase distortion and can alter a signal waveform
significantly. Compensating for frequency-dependent delay is not as trivial as for the
constant delay case. IIR filters introduce frequency-dependent delay.

Compensating for Constant Filter Delay

As mentioned before, you can measure the group of delay of the filter to verify that it is a
constant function of frequency. You can use the grpdelay function to measure the filter
delay, D, and compensate for this delay by appending D zeros to the input signal and
shifting the output signal in time by D samples.

Consider a noisy electrocardiogram signal that you want to filter to remove high
frequency noise above 75 Hz. You want to apply an FIR lowpass filter and compensate
for the filter delay so that the noisy and filtered signals are aligned correctly and can be
plotted on top of each other for comparison.
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Fs
N

-
>
I 1nQ i

~+ X

= 500;

500;

default;

ecg(N) "+0.25*randn(N,1);
(0:N-1)/Fs;

%
%

%
%

sample rate in Hz
number of signal samples

noisy waveform
time vector

% Design a 70th order lowpass FIR Ffilter with cutoff frequency of 75 Hz.

Fno

rm = 75/(Fs/2);

%

Normalized frequency

df = designfilt("lowpassfir”, "FilterOrder®,70, "CutoffFrequency”,Fnorm);

Plot the group delay of the filter to verify that it is constant across all frequencies
indicating that the filter is linear phase. Use the group delay to measure the delay of the
filter.

grp

delay(df,2048,Fs) % plot group delay
D = mean(grpdelay(df)) % filter delay in samples
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Before filtering, append D zeros at the end of the input data vector, x. This ensures that
all the useful samples are flushed out of the filter, and that the input signal and the
delay-compensated output signal have the same length. Filter the data and compensate
for the delay by shifting the output signal by D samples. This last step effectively
removes the filter transient.

Filter(df,[x; zeros(D,1)]); % Append D zeros to the input data

y =
y = y(D+1l:end);
figure

% Shift data to compensate for delay

plot(t,x,t,y, "r","linewidth",1.5);
title("Filtered Waveforms®);
xlabel("Time (s)~°)
legend("Original Noisy Signal®,"Filtered Signal®);
grid on
axis tight
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Compensating for Frequency-Dependent Delay

Frequency-dependent delay causes phase distortion in the signal. Compensating for this
type of delay is not as trivial as for the constant delay case. If your application allows
off-line processing, you can remove the frequency-dependent delay by implementing
zero-phase filtering using the filtfilt function. filtfilt performs zero-phase filtering by
processing the input data in both the forward and reverse directions. The main effect is
that you obtain zero-phase distortion, i.e., you filter data with an equivalent filter that
has a constant delay of 0 samples. Other effects are that you get a filter transfer function
which equals the squared magnitude of the original filter transfer function, and a filter
order that is double the order of the original filter.
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Group delay (in samples)

Consider the ECG signal defined in the previous section. Filter this signal with and

without delay compensation.

% Design a 7th order lowpass IIR elliptic filter with cutoff frequency

% of 75 Hz.

Fnorm = 75/(Fs/2); % Normalized frequency
df = designfilt("lowpassiir”®, ...

"PassbandFrequency” ,Fnorm, . ..

"FilterOrder"®,7, ...
"PassbandRipple®,1,...
"StopbandAttenuation®,60);

Plot the group delay of the filter and notice that it varies with frequency indicating that

the filter delay is frequency-dependent.
grpdelay(df,2048, "half",Fs)

Group delay
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Filter the data and look at the effects of each filter implementation on the time signal.

yl = filter(df,x); % non-linear phase filter - no delay compensation
y2 = filtfilt(df,x); % zero-phase implementation - delay compensation
figure

plot(t,x);

hold on

plot(t,yl,"r","linewidth",1.5);

plot(t,y2,"g", "linewidth",1.5);

title("Filtered Waveforms®);

xlabel("Time (s)°)

legend("Original Signal®,"Non-linear phase IIR output®,.._.
"Zero-phase I1IR output®);

ax = axis;

axis([0.25 0.55 ax(3:49)])

grid on
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Filtered Waveforms
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Notice how zero-phase filtering effectively removes the filter delay.

Zero-phase filtering is a great tool if your application allows for the non-causal forward/
backward filtering operations, and for the change of the filter response to the square of
the original response.

Filters that introduce constant delay are linear phase filters. Filters that introduce
frequency-dependent delay are non-linear phase filters.

Removing Unwanted Spectral Content from a Signal
Filters are commonly used to remove unwanted spectral content from a signal. You

can choose from a variety of filters to do this. You choose a lowpass filter when you
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want to remove high frequency content, or a highpass filter when you want to remove
low frequency content. You can also choose a bandpass filter to remove low and high
frequency content while leaving an intermediate band of frequencies intact. You choose a
bandstop filter when you want to remove frequencies over a given band.

Consider an audio signal that has a power-line hum and white noise. The power-line
hum is caused by a 60 Hz tone. White noise is a signal that exists across all the audio
bandwidth.

Load the audio signal.

Fs = 44100; % Sample rate
y = audioread("noisymusic.wav”);

Plot the power spectrum of the signal. The red triangular marker shows the strong 60 Hz
tone interfering with the audio signal.

[P,F] = pwelch(y,ones(8192,1),8192/2,8192,Fs, "power");
helperFilterintroductionPlotl(F,P,[60 60],[-9-365 -9.365],---
{"Original signal power spectrum®, "60 Hz Tone"})
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You can first remove as much white noise spectral content as possible using a lowpass
filter. The passband of the filter should be set to a value that offers a good trade-off
between noise reduction and audio degradation due to loss of high frequency content.
Applying the lowpass filter before removing the 60 Hz hum is very convenient since you
will be able to downsample the band-limited signal. The lower rate signal will allow you
to design a sharper and narrower 60 Hz bandstop filter with a smaller filter order.
Design a lowpass filter with passband frequency of 1 kHz, and stopband frequency of 1.4
kHz. Choose a minimum order design.
Fp = 1e3; % Passband frequency in Hz
Fst = 1.4e3; % Stopband frequency in Hz
Ap = 1; % Passband ripple in dB
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Ast = 95; % Stopband attenuation in dB

% Design the filter

df = designfilt("lowpassfTir”®, "PassbandFrequency”,Fp, ...
"StopbandFrequency”,Fst, "PassbandRipple” ,Ap, - - .
"StopbandAttenuation® ,Ast, "SampleRate” ,Fs);

% Analyze the filter response
hfvt = fvtool(df, "Fs”,Fs, "FrequencyScale”,"log", - ..
"FrequencyRange®, "Specify freq. vector®, "FrequencyVector® ,F);
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% Filter the data and compensate for delay
D = mean(grpdelay(df)); % filter delay
ylp = Filter(df,[y; zeros(D,1)1);

ylp = ylp(D+1l:end);
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Fower Spectrum (dB)

close(hfvt)

Look at the spectrum of the lowpass filtered signal. Note how the frequency content

above 1400 Hz has been removed.

[Plp,FIp] = pwelch(ylp,ones(8192,1),8192/2,8192,Fs, “"power");

helperFilterintroductionPlotl(F,P,Flp,Plp, ...
{"Original signal®,"Lowpass filtered signal~})

Criginal signal
Lowpass fitered signal

1072 107" 10°
Frequency in kHz

101

From the power spectrum plot above, you can see that the maximum non-negligible
frequency content of the lowpass filtered signal is at 1400 Hz. By the sampling theorem,
a sample frequency of 2%1400 = 2800 Hz would suffice to represent the signal correctly,
you however, are using a sample rate of 44100 Hz which is a waste since you will need
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to process more samples than those necessary. You can downsample the signal to reduce
the sample rate and reduce the computational load by reducing the number of samples
that you need to process. A lower sample rate will also allow you to design a sharper and
narrower bandstop filter, needed to remove the 60 Hz noise, with a smaller filter order.

Downsample the lowpass filtered signal by a factor of 10 to obtain a sample rate of Fs/10
= 4.41 kHz. Plot the spectrum of the signal before and after downsampling.

Fs = Fs/10;
yds = downsample(ylp,10);

[Pds,Fds] = pwelch(yds,ones(8192,1),8192/2,8192,Fs, "power");
helperFilterintroductionPlotl(F,P,Fds,Pds, ...
{"Signal sampled at 44100 Hz", “Downsampled signal, Fs = 4410 Hz"})

Signal sampled at 44100 Hz
Downsampled signal, Fs = 4410 Hz

1072 107! 10? 10'
Frequency in kHz
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Magnitude (dB)

Now remove the 60 Hz tone using an IIR bandstop filter. Let the stopband have a width
of 4 Hz centered at 60 Hz. We choose an IIR filter to achieve a sharp frequency notch,
small passband ripple, and a relatively low order. Process the data using filtfilt to avoid
phase distortion.

% Design the filter

df = designfilt("bandstopiir”®, "PassbandFrequencyl®,55, ...
"StopbandFrequencyl*,58, "StopbandFrequency2*,62, . ..
"PassbandFrequency2®,65, "PassbandRipplel®,1, ...
"StopbandAttenuation®,60, "PassbandRipple2®,1, ...
"SampleRate” ,Fs, "DesignMethod®, "ellip®);

% Analyze the magnitude response

hfvt = fvtool(df, "Fs”",Fs, "FrequencyScale”,"log", - ..
"FrequencyRange”, "Specify freq. vector®, "FrequencyVector"®,Fds(Fds>F(2)));

Magnitude Response (dB)

T
0 —_— a——
gl

60

102 10! 10°
Frequency (kHz)

2-79



2 Filter Design and Implementation

2-80

Perform zero-phase filtering to avoid distortion.
ybs = FiltfFilt(df,yds);

Finally, upsample the signal to bring it back to the original audio sample rate of 44.1 kHz
which is compatible with audio soundcards.

interp(ybs,10);
Fs*10;

yf
Fs

Take a final look at the spectrum of the original and processed signals. Notice how the
high frequency noise floor and the 60 Hz tone have been attenuated by the filters.

[PFfinal ,FFinal] = pwelch(yf,ones(8192,1),8192/2,8192,Fs, "power™);
close(hfvt)
helperFilterintroductionPlotl(F,P,Ffinal,Pfinal, ...

{"Original signal®,"Final filtered signal*"})
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Listen to the signal before and after processing. As mentioned above, the end result is
that you have effectively attenuated the 60 Hz hum and the high frequency noise on the

audio file.

% Play the original signal
hplayer = audioplayer(y, Fs);
play(hplayer);

% Play the noise-reduced signal
hplayer = audioplayer(yf, Fs);
play(hplayer);
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Differentiating a Signal

The MATLAB diff function differentiates a signal with the drawback that you
can potentially increase the noise levels at the output. A better option is to use a
differentiator filter that acts as a differentiator in the band of interest, and as an
attenuator at all other frequencies, effectively removing high frequency noise.

As an example, analyze the speed of displacement of a building floor during an
earthquake. Displacement or drift measurements were recorded on the first floor of a
three story test structure under earthquake conditions and saved in the quakedrift.mat
file. The length of the data vector is 10e3, the sample rate is 1 kHz, and the units of the
measurements are cm.

Differentiate the displacement data to obtain estimates of the speed and acceleration
of the building floor during the earthquake. Compare the results using diff and an FIR
differentiator filter.

load quakedrift.mat

Fs = 1000; % sample rate
dt = 1/Fs; % time differential
t = (O:length(drift)-1)*dt; % time vector

Design a 50th order differentiator filter with a passband frequency of 100 Hz which is the
bandwidth over which most of the signal energy is found. Set the stopband frequency of
the filter to 120 Hz.

df = designfilt("differentiatorfir”, "FilterOrder~,50, ...
"PassbandFrequency*®,100, "StopbandFrequency*®,120, ...
"SampleRate” ,Fs);

The diff function can be seen as a first order FIR filter with response H(Z)=1-2 l.
Use FVTool to compare the magnitude response of the 50th order differentiator FIR
filter and the response of the diff function. Clearly, both responses are equivalent in
the passband region (from 0 to 100 Hz). However, in the stopband region, the 50th
order filter attenuates components while the diff response amplifies components. This
effectively increases the levels of high frequency noise.

hfvt = fvtool(df,[1 -1],1, "MagnitudeDisplay®, "zero-phase®, "Fs",Fs);
legend(hfvt, "50th order FIR differentiator”, "Response of diff function®);
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Differentiate using the diff function. Add zeros to compensate for the missing samples

due to the diff operation.

vl
al

vl
al

diff(drift)/dt;
diff(v1)/dt;

[0; vi];
[0; 0; al];

Differentiate using the 50th order FIR filter and compensate for delay.

D = mean(grpdelay(df)); % filter delay
filter(df,[drift; zeros(D,1)]);

v2
v2
a2
a2

v2(D+1l:end);

filter(df,[v2; zeros(D,1)]);

a2(D+1l:end);
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v2
a2

v2/dt;
az2/dt"N2;

Plot a few data points of the floor displacement. Plot also a few data points of the speed
and acceleration as computed with diff and with the 50th order FIR filter. Notice how

the noise has been slightly amplified in the speed estimates and largely amplified in the
acceleration estimates obtained with diff.

helperFilterintroductionPlot2(t,drift,vl,v2,al,a?)
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Integrating a Signal

A leaky integrator filter is an all-pole filter with transfer function H(Z)=1/[1-cZ” I]
where  is a constant that must be smaller than 1 to ensure stability of the filter. It is

no surprise that as ¢ approaches one, the leaky integrator approaches the inverse of the
diff transfer function. Apply the leaky integrator to the acceleration and speed estimates
obtained in the previous section to get back the speed and the drift respectively. Use the
estimates obtained with the diff function since they are noisier.

Use a leaky integrator with @ = (.994, Plot the magnitude response of the leaky
integrator filter. Notice that the filter acts as a lowpass filter effectively eliminating high
frequency noise.
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close(hfvt)
fvtool (1,[1 -.999], "Fs",Fs)
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Filter the velocity and acceleration with the leaky integrator.

v_original
a_original

vl;
al;

d_leakyint
v_leakyint

filter(1,[1 -0.999],v_original);
filter(1,[1 -0.999],a original);

% Multiply by time differential
d_leakyint = d_leakyint * dt;
v_leakyint = v_leakyint * dt;

Plot the displacement and speed estimates and compare to the original signals vl and al.
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helperFilterintroductionPlot3(t,drift,d_leakyint,v_original,v_leakyint)

'1 T T T T T T T T T
0.5 _E| .I_ | ] ; 4
[ ; { i .'I ! " - F
| Iy i 'l.. J A Y Y “
D |_I II ! 1 III II '. f II II -"I. II .Il_ \ ."'f 1.' oy = _
| | .=. i \ _,:';I I'. b - N S Y
05k i W Leaky integrator estimate |
Criginal displacement
__1 i ] ] ] ] i ] ] ]
120 12002 1204 12006 1208 1217 1212 1214 1216 1218 122
ED T T T T T T T T T
|l‘ -I - ” !
' i r i~ = I )
N (N Y . | A W | [ "W = \ LWL
or 1 i1 Ix . WS B i ! o
"-.‘ | o Leaky integrator estimate
Criginal speed
_5 D i ] ] ] ] i ] ] ]
120 12002 1204 12006 1208 1217 1212 1214 1216 121.8 122

Time in seconds

You can also integrate a signal using the cumsum and cumtrapz functions. Results will
be similar to those obtained with the leaky integrator.

Conclusions

In this example you learned about linear and nonlinear phase filters and you learned
how to compensate for the phase delay introduced by each filter type. You also learned
how to apply filters to remove unwanted frequency components from a signal, and
how to downsample a signal after limiting its bandwidth with a lowpass filter. Finally,
you learned how to differentiate and integrate a signal using digital filter designs.
Throughout the example you also learned how to use analysis tools to look at the
response and group delay of your filters.
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Further Reading

For more information on filter applications see the Signal Processing Toolbox. For more
information on how to design digital filters see the "Practical Introduction to Digital
Filter Design" example.

References: J.G. Proakis and D. G. Manolakis, "Digital Signal Processing. Principles,
Algorithms, and Applications", Prentice-Hall, 1996.

S. J. Orfanidis, "Introduction To Signal Processing", Prentice-Hall, 1996.
Appendix
The following helper functions are used in this example.

* helperFilterIntroductionPlotl.m
* helperFilterIntroductionPlot2.m
* helperFilterIntroductionPlot3.m
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This example shows how to design FIR and IIR filters based on frequency response
specifications using the designfi It function in the Signal Processing Toolbox® product.
The example concentrates on lowpass filters but most of the results apply to other
response types as well.

This example focuses on the design of digital filters rather than on their applications. If
you want to learn more about digital filter applications see the "Practical Introduction to
Digital Filtering" example.

FIR Filter Design
Lowpass Filter Specifications

The ideal lowpass filter is one that leaves unchanged all frequency components of a
signal below a designated cutoff frequency, +, and rejects all components above ',
Because the impulse response required to implement the ideal lowpass filter is infinitely
long, it is impossible to design an ideal FIR lowpass filter. Finite length approximations
to the ideal impulse response lead to the presence of ripples in both the passband

(& = wr) and the stopband (& = w&) of the filter, as well as to a nonzero transition width
between passband and stopband.

Both the passband/stopband ripples and the transition width are undesirable but
unavoidable deviations from the response of an ideal lowpass filter when approximated
with a finite impulse response. These deviations are depicted in the following figure:
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Practical FIR designs typically consist of filters that meet certain design
specifications, i.e_, that have a transition width and maximum passband and
stopband ripples that do not exceed allowable values. In addition, one must select
the filter order, or ,equivalently, the length of the truncated impulse response.

A useful metaphor for the design specifications in filter design is to think of each
specification as one of the angles in the triangle shown in the figure below.

Filter order

P

Transition peak passband/
width stopband ripple
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The triangle is used to understand the degrees of freedom available when choosing
design specifications. Because the sum of the angles is fixed, one can at most select the
values of two of the specifications. The third specification will be determined by the
particular design algorithm. Moreover, as with the angles in a triangle, if we make one of
the specifications larger/smaller, it will impact one or both of the other specifications.

FIR filters are very attractive because they are inherently stable and can be designed
to have linear phase. Nonetheless, these filters can have long transient responses and
might prove computationally expensive in certain applications.

Minimum Order FIR Designs

Minimum order designs are obtained by specifying passband and stopband frequencies as
well as a passband ripple and a stopband attenuation. The design algorithm then chooses
the minimum filter length that complies with the specifications.

Design a minimum order lowpass FIR filter with a passband frequency of 0.37*pi rad/
sample, a stopband frequency of 0.43*pi rad/sample (hence the transition width equals
0.06*pi1 rad/sample), a passband ripple of 1 dB and a stopband attenuation of 30 dB.

Fpass = 0.37;
Fstop = 0.43;
Ap = 1;

Ast = 30;

d = designfilt(" lowpassfir”®, "PassbandFrequency” ,Fpass,. - -
"StopbandFrequency”® ,Fstop, "PassbandRipple” ,Ap, "StopbandAttenuation” ,Ast);

hfvt = fvtool(d);
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The resulting filter order can be queried using the i Itord function.

N = filtord(d)

39

You can use the info function to get information about the parameters used to design
the filter
info(d)

ans =
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FIR Digital Filter (real)

Filter Length : 40
Stable : Yes
Linear Phase : Yes (Type 2)

Design Method Information
Design Algorithm : Equiripple

Design Specifications

Sample Rate : 2 (normalized)
Response : Lowpass
Passband Edge : 0.37

Stopband Edge : 0.43

Passband Ripple : 1 dB
Stopband Atten. : 30 dB

The designfilt function chooses an equiripple design algorithm by default. Linear-
phase equiripple filters are desirable because for a given order they have the
smallest possible maximum deviation from the ideal filter.

Note, however, that minimum-order designs can also be obtained using a Kaiser
window. Even though the Kaiser window method yields a larger filter order for the
same specifications, the algorithm is less computationally expensive and less likely to
have convergence issues when the design specifications are very stringent. This may
occur if the application requires a very narrow transition width or a very large stopband
attenuation.

Design a filter with the same specifications as above using the Kaiser window method
and compare its response to the equiripple filter.

dk = designfilt("lowpassfTir”, "PassbandFrequency” ,Fpass, - - .
"StopbandFrequency”® ,Fstop, "PassbandRipple” ,Ap, - ..
"StopbandAttenuation® ,Ast, "DesignMethod®, "kaiserwin®);

addfilter(hfvt,dk);
legend(hfvt, "Equiripple design®, "Kaiser window design®)

N = Filtord(dk)
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Specifying Frequency Parameters in Hertz

If you know the sample rate at which the filter will operate, you can specify the sample
rate and the frequencies in hertz. Redesign the minimum order equiripple filter for a
sample rate of 2 kHz.

Fpass
Fstop
Ap =
Ast = 30;

= 2000;

370;
430;
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d = designfilt(" lowpassfir”, "PassbandFrequency” ,Fpass, . - -
"StopbandFrequency*® ,Fstop, "PassbandRipple® ,Ap, - -.
"StopbandAttenuation® ,Ast, "SampleRate” ,Fs);

hfvt = fvtool(d);

Magnitude Response (dB)
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Fixed Order, Fixed Transition Width Designs

Fixed-order designs are useful for applications that are sensitive to computational load or
impose a limit on the number of filter coefficients. An option is to fix the transition width
at the expense of control over the passband ripple/stopband attenuation.

Consider a 30-th order lowpass FIR filter with a passband frequency of 370 Hz, a
stopband frequency of 430 Hz, and sample rate of 2 kHz. There are two design methods
available for this particular set of specifications: equiripple and least squares. Let us
design one filter for each method and compare the results.
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Magnitude (dB)

= 30;
Fpass 370;
Fstop = 430;

= 2000;

% Design method defaults to "equiripple® when omitted

deq = designfilt("lowpassfir®, "FilterOrder~,N, "PassbandFrequency”,Fpass, - .-

"StopbandFrequency” ,Fstop, "SampleRate” ,Fs);

dIs = designfilt("lowpassfir®, "FilterOrder~,N, "PassbandFrequency”,Fpass, - .-

"StopbandFrequency” ,Fstop, "SampleRate®,Fs, "DesignMethod®, " 1s");

hfvt = fvtool(deq,dls);
legend(hfvt, "Equiripple design®, "Least-squares design®)
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Equiripple filters are ideally suited for applications in which a specific tolerance must be
met, such as designing a filter with a given minimum stopband attenuation or a given
maximum passband ripple. On the other hand, these designs may not be desirable if

we want to minimize the energy of the error (between ideal and actual filter) in the
passband/stopband.

If we want to reduce the energy of a signal as much as possible in a certain
frequency band, least squares designs are preferable.

In the examples above, the designed filters had the same ripple in the passband and in
the stopband. We can use weights to reduce the ripple in one of the bands while keeping
the filter order fixed. For example, if you wish the stopband ripple to be a tenth of that in
the passband, you must give the stopband ten times the passband weight. Redesign the
equiripple filter using that fact.

degw = designfilt(" lowpassfTir®, “FilterOrder”,N, "PassbandFrequency”,Fpass, - ..
"StopbandFrequency*® ,Fstop, "SampleRate* ,Fs, . . .
"PassbandWeight®,1, "StopbandWeight®,10);

hfvt = fvtool(deq,deqgw);
legend(hfvt, "Equiripple design®, “Equiripple design with weighted stopband®)
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Fixed Order, Fixed Cutoff Frequency

You can design filters with fixed filter order and cutoff frequency using a window design

method.

You can use different windows to control the stopband attenuation while keeping
the filter order unchanged.

For example, consider a 100-th order lowpass FIR filter with a cutoff frequency of 60 Hz
and a sample rate of 1 kHz. Compare designs that result from using a Hamming window,
and a Chebyshev window with 90 dB of sidelobe attenuation.

dhamming = designfilt("lowpassfir”®, "FilterOrder”
"SampleRate*

,1000, "*Window", "hamming®);

,100, "CutoffFrequency”,60, - - .
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Magnitude (dB)

dchebwin = designfilt("lowpassfir®, "FilterOrder”
“SampleRate®”,1000, *Window" ,{"chebwin®,90});

hfvt = fvtool (dhamming,dchebwin);
legend(hfvt, "Hamming window®, "Chebyshev window")
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There are other ways in which you can specify a filter with fixed order: fixed cutoff
frequency, passband ripple, and stopband attenuation; fixed transition width; and fixed

half-power (3dB) frequency.
IIR Filter Design

One of the drawbacks of FIR filters is that they require a large filter order to meet some
design specifications. If the ripples are kept constant, the filter order grows inversely

,100, “"CutoffFrequency”,60, - - .
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proportional to the transition width. By using feedback, it is possible to meet a set of
design specifications with a far smaller filter order. This is the idea behind IIR filter
design. The term "infinite impulse response" (IIR) stems from the fact that, when an
impulse is applied to the filter, the output never decays to zero.

IR filters tend to be used when computational resources are at a premium.
However, stable, causal lIR filters cannot have perfectly linear phase. IIR filters
thus tend to be avoided when linearity of phase is a requirement.

Another important reason for using IIR filters is their small group delay relative to FIR
filters, which results in a shorter transient response.

Butterworth Filters

Butterworth filters are maximally flat IIR filters. The flatness in the passband and
stopband causes the transition band to be very wide. Large orders are required to obtain
filters with narrow transition widths.

Design a minimum order Butterworth filter with passband frequency 100 Hz, stopband
frequency 300 Hz, maximum passband ripple 1 dB, and 60 dB stopband attenuation. The
sample rate is 2 kHz.

Fp = 100;
Fst = 300;
Ap = 1;
Ast = 60;
Fs = 2e3

dbutter = designfilt(" lowpassiir”, "PassbandFrequency”,Fp, - -.
"StopbandFrequency”,Fst, "PassbandRipple” ,Ap, - ..
"StopbandAttenuation® ,Ast, "SampleRate” ,Fs, "DesignMethod”, "butter®);

Chebyshev Type I Filters

Chebyshev type I filters attain smaller transition widths than Butterworth filters of the
same order by allowing for passband ripple.

The stopband of a Chebyshevtype | filter is, as with Butterworth filters, maximally
flat. For a given filter order, the tradeoff is thus between passband ripple and
transition width.
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Design a Chebyshev type I filter with the same specifications as the Butterworth filter
above.

dchebyl = designfilt(" lowpassiir”®, "PassbandFrequency”,Fp, - ..
"StopbandFrequency”,Fst, "PassbandRipple” ,Ap, - ..
"StopbandAttenuation® ,Ast, "SampleRate” ,Fs, "DesignMethod®, "chebyl1®);

Chebyshev Type II Filters
Chebyshev type Il filters have maximally flat passband and equiripple stopband.

Since extremely large attenuations are typically not required, we may be able to attain
the required transition width with a relatively small order by allowing for some stopband
ripple.

Design a minimum order Chebyshev type II filter with the same specifications as in the
previous examples.

dcheby2 = designfilt(" lowpassiir”®, "PassbandFrequency”,Fp, - ..
"StopbandFrequency”,Fst, "PassbandRipple” ,Ap, - ..
"StopbandAttenuation® ,Ast, "SampleRate” ,Fs, "DesignMethod®, "cheby2");

Elliptic Filters

Elliptic filters generalize Chebyshev and Butterworth filters by allowing for ripple in
both the passband and the stopband. As ripples are made smaller, elliptic filters can
approximate arbitrarily close the magnitude and phase response of either Chebyshev or
Butterworth filters.

The extra degrees of freedom allow elliptic filters to have the smallest order for a
given transition width.

dellip = designfilt("lowpassiir-®, "PassbandFrequency”,Fp, ...
"StopbandFrequency*® ,Fst, "PassbandRipple®,Ap, - - .
"StopbandAttenuation® ,Ast, "SampleRate* ,Fs, "DesignMethod”, "ellip~);

Compare the response and the order of the four IIR filters.

For the same specification constraints, the Butterworth method yields the highest
order while the elliptic method yields the smallest.



Practical Introduction to Digital Filter Design

FilterOrders

FilterOrders

7

5

[filtord(dbutter) filtord(dchebyl) filtord(dcheby2) filtord(dellip)]

Magnitude (dB)

hfvt = fvtool(dbutter,dchebyl,dcheby2,dellip);

axis([0 1e3 -80 2]);

legend(hfvt, "Butterworth”, "Chebyshev type I",...
"Chebyshev type 11", Elliptic®, 1)

Magnitude Response (dB)
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Zoom into the passband to see the ripple differences.

axis([0 150 -3 2]);
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Matching Exactly the Passband or Stopband Specifications

With minimum-order designs, the ideal order needs to be rounded to the next integer.
This additional fractional order allows the algorithm to actually exceed the specifications.

We can use the 'MatchExactly parameter to constraint the design algorithmto
match one band exactly . The other band will exceed its specifications.

By default, Chebyshev Type I designs match the passband, Butterworth and Chebyshev
Type II match the stopband, and elliptic designs match both the passband and the
stopband (while the stopband edge frequency is exceeded):

dellipl = designfilt("lowpassiir®, "PassbandFrequency”,Fp, - - -
"StopbandFrequency”® ,Fst, "PassbandRipple® ,Ap, - - .
"StopbandAttenuation® ,Ast, "SampleRate” ,Fs, "DesignMethod®, "ellip®, ...



Practical Introduction to Digital Filter Design

Magnitude (dB)

"MatchExactly®, "passband®);

dellip2 = designfilt("lowpassiir®, "PassbandFrequency”,Fp, - - -
"StopbandFrequency”® ,Fst, "PassbandRipple® ,Ap, - - .
"StopbandAttenuation® ,Ast, "SampleRate” ,Fs, "DesignMethod®, "ellip®, ...
"MatchExactly®, "stopband®);

hfvt = fvtool(dellip, dellipl, dellip2);

legend(hfvt, "Matched passband and stopband®,*Matched passband”, ...
“"Matched stopband®, 1);

axis([0 1e3 -80 2]);
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The matched-passband and matched-both designs have a ripple of exactly 1 dB at the
passband frequency value of 100 Hz.

Group Delay Comparison
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With IIR filters, we need to consider not only the ripple/transition width tradeoff, but
also the degree of phase distortion. We know that it is impossible to have linear-phase
throughout the entire Nyquist interval. Thus we may want to see how far from linear the
phase response is. A good way to do this is to look at the (ideally constant) group delay

and see how flat it is."

Compare the group delay of the four IIR filters designed above.

If phase is an issue, keepin mind that Butterworth and Chebyshev Type Il designs
have the flattest group delay and thus introduce the least distortion.

hfvt = fvtool (dbutter,dchebyl,dcheby2,dellip, "Analysis”, "grpdelay”);
legend(hfvt, "Butterworth®, "Chebyshev type I",...
"Chebyshev type 117°,"Elliptic®, "Location”,"NorthEast")
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Conclusions

In this example, you learned how to use designfi It to obtain a variety of lowpass FIR
and IIR filters with different constraints and design methods. designfilt can also be
used to obtain highpass, bandpass, bandstop, arbitrary-magnitude, differentiator, and
Hilbert designs. See the "Filter Design Gallery" example and the documentation to learn
more about all the available options.

Further Reading
For more information on filter design and analysis, see the Signal Processing Toolbox®

software documentation. For more information on filter applications see the "Practical
Introduction to Digital Filtering" example.
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Filter Design Gallery

2-108

This example shows how to design a variety of FIR and IIR digital filters with the
designfilt function in the Signal Processing Toolbox® product.

The gallery is designed for you to identify a filter response of interest, view the code, and
use it in your own project. It contains examples for each of the available filter responses
offered by designfilt. Note, however, that these are only a few of the possible ways in
which you can design filters for each response type. For an exhaustive list of specification
sets, see the Signal Processing Toolbox documentation.

Except when noted otherwise, in this example all frequency units are in hertz, and all
ripple and attenuation values are in decibels.

Lowpass FIR Filters

Equiripple Design

Fpass = 100;
Fstop = 150;
Apass = 1;
Astop = 65;
Fs = 1e3;

d = designfilt(" lowpassfir”,
"PassbandFrequency” ,Fpass, "StopbandFrequency” ,Fstop,
"PassbandRipple” ,Apass, "StopbandAttenuation® ,Astop,
"DesignMethod®, "equiripple®, "SampleRate” ,Fs);

fvtool (d)
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Lowpass IIR Filters

Maximally Flat Design

Fpass = 100;
Fstop = 150;
Apass = 0.5;
Astop = 65;
Fs = 1e3;

d = designfilt( lowpassiir”,
"PassbandFrequency”,Fpass, "StopbandFrequency” ,Fstop,

"PassbandRipple” ,Apass, "StopbandAttenuation® ,Astop,
"DesignMethod”, "butter”, "SampleRate” ,Fs);

fvtool (d)
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Ripple in Passband and Stopband

N = 8;

Fpass = 100;
Apass = 0.5;
Astop = 65;
Fs = 1e3;

d = designfilt(" lowpassiir”,
"FilterOrder-~,N,
"PassbandFrequency” ,Fpass,
"PassbandRipple®,Apass, "StopbandAttenuation” ,Astop,
"SampleRate®,Fs);

fvtool (d)
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Highpass FIR Filters

Equiripple Design

Fstop = 350;
Fpass = 400;
Astop = 65;

Apass = 0.5;
Fs = 1e3;

d = designfilt("highpassfir”, "StopbandFrequency” ,Fstop, ...
“PassbandFrequency” ,Fpass, "StopbandAttenuation” ,Astop,
"PassbandRipple”,Apass, "SampleRate” ,Fs, "DesignMethod”, "equiripple™);

fvtool (d)
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Magnitude Response (dB)
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Highpass IIR Filters

Maximally Flat Design

Fstop = 350;
Fpass = 400;
Astop = 65;
Apass = 0.5;
Fs = 1e3;

d = designfilt("highpassiir”, "StopbandFrequency” ,Fstop ,--.
"PassbandFrequency” ,Fpass, "StopbandAttenuation® ,Astop,
"PassbandRipple” ,Apass, "SampleRate” ,Fs, "DesignMethod”, "butter™);

fvtool (d)
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Magnitude (dB)
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Ripple in Passband and Stopband

N = 8;

Fpass = 400;
Astop = 65;
Apass = 0.5;
Fs = 1e3;

d = designfilt("highpassiir”,
"FilterOrder-~,N,
"PassbandFrequency” ,Fpass,
"StopbandAttenuation® ,Astop, "PassbhandRipple”,Apass,
"SampleRate®,Fs);

fvtool (d)
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"StopbandAttenuationl” ,Astopl, "PassbandRipple”, Apass,
"StopbandAttenuation2® ,Astop2,

"DesignMethod”, *

fvtool (d)
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= 50;
Fstopl = 150;
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Wstopl = 3;
Wstop2 = 100;
Fs = 1e3;

350
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d = designfilt("bandpassfir”,

“FilterOrder-,N,

"StopbandFrequencyl”,Fstopl, "PassbandFrequencyl®, Fpassl,
"PassbandFrequency2” ,Fpass2, "StopbandFrequency2®, Fstop2,

"StopbandWeightl® ,Wstopl, "StopbandWeight2® ,Wstop2,

"DesignMethod”, "equiripple”, "SampleRate” ,Fs);

fvtool (d)
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Fpass2

150;
200;
300;

350

450



Filter Design Gallery

Fstop2 = 350;
Astopl = 65;
Apass = 0.5;
Astop2 = 65;
Fs = 1e3;

d = designfilt(“bandpassiir”, ...
"StopbandFrequencyl® ,Fstopl, "PassbandFrequencyl®, Fpassl,
"PassbandFrequency2” ,Fpass2, "StopbandFrequency2®, Fstop2,
"StopbandAttenuationl® ,Astopl, "PassbandRipple®, Apass,
"StopbandAttenuation2® ,Astop2, ...
"DesignMethod”, "butter*®, "SampleRate”, Fs);

fvtool (d)

Magnitude Response (dB)

—
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-150
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=250

0 50 100 150 200 250 300 350 400 450
Frequency (Hz)

Ripple in Passband and Stopband
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N = 8;

Fpassl = 200;
Fpass2 = 300;
Astopl = 65;
Apass = 0.5;
Astop2 = 65;
Fs = 1e3;

d = designfilt(“bandpassiir”, ...
“FilterOrder®,N, ...
"PassbandFrequencyl®, Fpassl, "PassbandFrequency2®, Fpass2, ...
"StopbandAttenuationl®, Astopl, "PassbandRipple®, Apass, ...
“StopbandAttenuation2®, Astop2, ...

"SampleRate®, Fs);

fvtool (d)
Magnitude Response (dB)
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Bandstop FIR Filters

Equiripple Design

Fpassl = 100;
Fstopl = 150;
Fstop2 = 350;
Fpass2 = 400;
Apassl = 0.5;
Astop = 65;
Apass2 = 0.5;
Fs = 1e3;

d = designfilt("bandstopfir”,
"PassbandFrequencyl”,Fpassl, "StopbandFrequencyl” ,Fstopl,
"StopbandFrequency2* ,Fstop2, "PassbandFrequency2” ,Fpass2,
"PassbandRipplel® ,Apassl, "StopbandAttenuation”,Astop,
"PassbandRipple2®, Apass2,
"DesignMethod”, "equiripple”, “SampleRate”, Fs);

fvtool (d)
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= 30;
Fpassl = 100;
Fstopl = 150;
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Wpassl = 1;
Wpass2 = 10;
Fs = 1e3;
d = designfilt("bandstopfir”,

"FilterOrder”,N
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"StopbandFrequency2” ,Fstop2, "PassbandFrequency2” ,Fpass2,

"PassbandWeightl® ,Wpassl, "PassbandWeight2® ,Wpass2,

400

450




Filter Design Gallery

Magnitude (dB)

"DesignMethod”, "equiripple”, "SampleRate”, Fs);

fvtool (d)
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Bandstop IIR Filters

Maximally Flat Design

Fpassl = 100;
Fstopl = 150;
Fstop2 = 350;
Fpass2 = 400;
Apassl = 0.5;
Astop = 65;
Apass2 = 0.5;
Fs = 1e3;
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d = designfilt("“bandstopiir”, ...
"PassbandFrequencyl® ,Fpassl, "StopbandFrequencyl” ,Fstopl,
"StopbandFrequency2” ,Fstop2, "PassbandFrequency2” ,Fpass2,
"PassbandRipplel”,Apassl, "StopbandAttenuation® ,Astop, --.-
"PassbandRipple2®, Apass2, ...
"DesignMethod”, "butter*®, "SampleRate”, Fs);

fvtool (d)

Magnitude Response (dB)
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N = 8;
Fpassl = 125;
Fpass2 = 375;

Apass = 0.5;
Astop = 65;
Fs = 1e3;
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Magnitude (dB)

d = designfilt("bandstopiir”,
“FilterOrder-,N,

"PassbandFrequencyl® ,Fpassl, "PassbandFrequency2” ,Fpass2,
"PassbandRipple®,Apass, "StopbandAttenuation®, Astop,
"SampleRate” ,Fs);

fvtool (d)
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Single-Band Arbitrary Magnitude Design
N = 300;

% Frequencies are in normalized units
F1 = 0:0.01:0.18;

450
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F2 = [-2 .38 .4 .55 .562 .585 .6 .78];
F3 = 0.79:0.01:1;
FregqvVect = [F1 F2 F3]; % vector of frequencies

% Define desired response using linear units

Al = _5+sin(2*pi*7.5*F1)/4; % Sinusoidal section
A2 = [.52.311-.2-.211]; % Piecewise linear section
A3 = _2+18*(1-F3)."2; % Quadratic section

AmpVect = [A1l A2 A3];

d = designfilt("arbmagfir®, ...
"FilterOrder® N, "Amplitudes”,AmpVect, "Frequencies”,FreqVect, . ..
"DesignMethod*, "fregsamp®);

fvtool (d, "MagnitudeDisplay”, "Zero-phase®)

Zero-phase Response
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Multiband Lowpass Design with Stepped Attenuation Levels on Stopband

N = 150;
B = 2; % Number of bands
% Frequencies are in normalized units

F1 = [0 .25]; % Passband

F2 = [.3 .4 .401 .5 .501 .6 .601 .7 .701 .8 .801 .9 .901 1]; % Stopband
Al = ones(size(F1)); % Desired amplitudes for band 1 in linear units
A2 = zeros(size(F2)); % Desired amplitudes for band 2 in linear units

% Vector of weights

W =10.~([0 O 55 10 10 15 15 20 20 25 25 30 30 35 35]/20);
Wl = w(1:2); % Weights for band 1

W2 = W(3:end); % Weights for band 2

d = designfilt("arbmagfir”,
“FilterOrder®,N, *NumBands"®,B, .
"BandFrequenciesl” ,F1, "BandAmplitudesl®, Al,
"BandFrequencies2”® ,F2, "BandAmplitudes2®,A2,
"BandWeightsl®,W1, "BandWeights2®, W2);

fvtool (d)
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Magnitude Response (dB)
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Differentiator FIR Filters

Full Band Design
N = 41;
Fs = 1e3;

d = designfilt("differentiatorfir”,

"FilterOrder”,N, "DesignMethod”,"equiripple”, "SampleRate”,Fs);

fvtool (d, "MagnitudeDisplay”, "zero-phase”, "OverlayedAnalysis”, "phase")
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Amplitude

Zero-phase Response and Phase Response
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Partial Band Design

N = 40;
Fpass = 100;
Fstop = 150;
Fs = 1e3;

d = designfilt("differentiatorfir®, ...
"FilterOrder-~,N,
"PassbandFrequency” ,Fpass, "StopbandFrequency” ,Fstop, ...
"DesignMethod”, "equiripple”, "SampleRate" ,Fs);

0.062

-10.622

-21.306

-31.989

Phase (radians)

42672

-53.355

-54.039

fvtool (d, "MagnitudeDisplay”, "zero-phase”, "OverlayedAnalysis”, "phase®)
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Zero-phase Response and Phase Response
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Equiripple Design

N = 40;
Tw = 50;
Fs = 1e3;

d = designfilt("hilbertfir-,
"FilterOrder® ,N, "TransitionWidth®,Tw, ...
"DesignMethod”, "equiripple”, "SampleRate” ,Fs);

fvtool (d, "MagnitudeDisplay”, "Zero-phase”, "OverlayedAnalysis”, "phase")
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Amplitude

se and Phase Response
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3 Designing a Filter in Fdesign — Process Overview

Process Flow Diagram and Filter Design Methodology

3-2

In this section...

“Exploring the Process Flow Diagram” on page 3-2
“Selecting a Response” on page 3-4

“Selecting a Specification” on page 3-4

“Selecting an Algorithm” on page 3-6

“Customizing the Algorithm” on page 3-7

“Designing the Filter” on page 3-8

“Design Analysis” on page 3-9

“Realize or Apply the Filter to Input Data” on page 3-9

Note: You must minimally have the Signal Processing Toolbox installed to use
fdesign and design. Some of the features described below may be unavailable if your
installation does not additionally include the DSP System Toolbox™ license. The DSP
System Toolbox significantly expands the functionality available for the specification,
design, and analysis of filters. You can verify the presence of both toolboxes by typing
ver at the command prompt.

Exploring the Process Flow Diagram

The process flow diagram shown in the following figure lists the steps and shows the
order of the filter design process.



Process Flow Diagram and Filter Design Methodology

Select Response
help fdesignéesponzes

Select Specification
zetizpecOh), 'specification”)

Select Algorithm
designmethods(specObj)

Customize Algorithm
help (specobj, butter')

llllllllllllllllll+lllllllllllllllllllllllllllllﬂ

Design Filter
help fdesignidesign

Analysis and
Verification
help diitfanalysis
help
mfitifunctiors

Realize or
Apply Filter
to Input

Data
help diitifiter

e

Fessssesseeeennnsennnnnnun®

> Specifications Object

Implementation Ohbject
> (rofiltidfilt)

The first four steps of the filter design process relate to the filter Specifications Object,
while the last two steps involve the filter Implementation Object. Both of these objects
are discussed in more detail in the following sections. Step 5 - the design of the filter, is
the transition step from the filter Specifications Object to the Implementation object. The
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3-4

analysis and verification step is completely optional. It provides methods for the filter
designer to ensure that the filter complies with all design criteria. Depending on the
results of this verification, you can loop back to steps 3 and 4, to either choose a different
algorithm, or to customize the current one. You may also wish to go back to steps 3 or 4
after you filter the input data with the designed filter (step 7), and find that you wish to
tweak the filter or change it further.

The diagram shows the help command for each step. Enter the help line at the MATLAB
command prompt to receive instructions and further documentation links for the
particular step. Not all of the steps have to be executed explicitly. For example, you could
go from step 1 directly to step 5, and the interim three steps are done for you by the
software.

The following are the details for each of the steps shown above.

Selecting a Response

If you type:

help fdesign/responses
at the MATLAB command prompt, you see a list of all available filter responses. The
responses marked with an asterisk require the DSP System Toolbox.

You must select a response to initiate the filter. In this example, a bandpass filter
Specifications Object is created by typing the following:

d = fdesign.bandpass

Selecting a Specification

A specification is an array of design parameters for a given filter. The specification is a
property of the Specifications Object.

Note: A specification is not the same as the Specifications Object. A Specifications Object
contains a specification as one of its properties.

When you select a filter response, there are a number of different specifications available.
Each one contains a different combination of design parameters. After you create a

filter Specifications Object, you can query the available specifications for that response.
Specifications marked with an asterisk require the DSP System Toolbox.
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>> d = fdesign.bandpass; % step 1 - choose the response
>> set (d, “specification®)

ans =

"Fstl,Fpl,Fp2,Fst2,Astl,Ap,Ast2”
“N,F3dB1,F3dB2*
"N,F3dB1,F3dB2,Ap*
“N,F3dB1,F3dB2,Ast"
"N,F3dB1,F3dB2,Astl,Ap,Ast2"
*N,F3dB1,F3dB2,BWp*"
“N,F3dB1,F3dB2,BWst*"
*N,Fcl,Fc2*

*N,Fpl,Fp2,Ap"
“N,Fpl,Fp2,Astl,Ap,Ast2*
*N,Fstl,Fpl,Fp2,Fst2*
“N,Fstl,Fpl,Fp2,Fst2,Ap*
“N,Fstl,Fst2,Ast"
“Nb,Na,Fstl,Fpl,Fp2,Fst2*

>> d=fdesign.arbmag;
>> set(d, "specification®)

ans =

“N,F,A"
"N,B,F,A"

The set command can be used to select one of the available specifications as follows:

>> d = fdesign.lowpass; % step 1

>> % step 2: get a list of available specifications
>> set (d, “specification®)

ans =

“"Fp,Fst,Ap,Ast"
“N,F3dB*
*N,F3dB,Ap*
"N,F3dB,Ap,Ast”
“N,F3dB,Ast"
“N,F3dB,Fst*
“N,Fc*
"N,Fc,Ap,Ast”
"N,Fp,Ap”
“N,Fp,Ap,Ast”
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*N,Fp,F3dB*
“N,Fp,Fst”
“N,Fp,Fst,Ap*
“N,Fp,Fst,Ast”
"N,Fst,Ap,Ast”
"N, Fst,Ast"
“*Nb,Na,Fp,Fst”

>> Ystep 2: set the required specification

>> set (d, “specification®, "N,Fc")

If you do not perform this step explicitly, Fdesign returns the default specification for
the response you chose in “Select a Response” on page 4-2, and provides default

values for all design parameters included in the specification.

Selecting an Algorithm

The availability of algorithms depends the chosen filter response, the design parameters,
and the availability of the DSP System Toolbox. In other words, for the same lowpass
filter, changing the specification string also changes the available algorithms. In the
following example, for a lowpass filter and a specification of *N, Fc®, only one algorithm
is available—window.

>> Ystep 2: set the required specification

>> set (d, “specification®, "N,Fc")
>> designmethods (d) %step3: get available algorithms

Design Methods for class fdesign.lowpass (N,Fc):

window

However, for a specification of "Fp,Fst,Ap,Ast", a number of algorithms are available.
If the user has only the Signal Processing Toolbox installed, the following algorithms are
available:

>>set (d, “"specification®, "Fp,Fst,Ap,Ast")
>>designmethods(d)

Design Methods for class fdesign.lowpass (Fp,Fst,Ap,Ast):

butter



Process Flow Diagram and Filter Design Methodology

chebyl

cheby?2

ellip

equiripple

kaiserwin

If the user additionally has the DSP System Toolbox installed, the number of available
algorithms for this response and specification string increases:

>>set(d, "specification”, "Fp,Fst,Ap,Ast")
>>designmethods(d)

Design Methods for class fdesign.lowpass (Fp,Fst,Ap,Ast):

butter

chebyl

cheby?2

ellip

equiripple

ifir

kaiserwin

multistage

The user chooses a particular algorithm and implements the filter with the design
function.

>>Hd=design(d, "butter®);
The preceding code actually creates the filter, where Hd is the filter Implementation
Object. This concept is discussed further in the next step.

If you do not perform this step explicitly, design automatically selects the optimum
algorithm for the chosen response and specification.

Customizing the Algorithm

The customization options available for any given algorithm depend not only on the
algorithm itself, selected in “Selecting an Algorithm” on page 3-6, but also on the
specification selected in “Selecting a Specification” on page 3-4. To explore all the
available options, type the following at the MATLAB command prompt:

help (d, "algorithm-name*)
where d is the Filter Specification Object, and algorithm-name is the name of the
algorithm in single quotes, such as "butter” or "chebyl”.
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The application of these customization options takes place while “Designing the Filter”
on page 3-8, because these options are the properties of the filter Implementation
Object, not the Specification Object.

If you do not perform this step explicitly, the optimum algorithm structure is selected.

Designing the Filter

This next task introduces a new object, the Filter Object, or dfi It. To create a filter, use
the design command:

>> % design Filter w/o specifying the algorithm

>> Hd = design(d);

where Hd is the Filter Object and d is the Specifications Object. This code creates a filter
without specifying the algorithm. When the algorithm is not specified, the software
selects the best available one.

To apply the algorithm chosen in “Selecting an Algorithm” on page 3-6, use the same
design command, but specify the Butterworth algorithm as follows:

>> Hd = design(d, "butter®);
where Hd is the new Filter Object, and d is the Specifications Object.

To obtain help and see all the available options, type:

>> help fdesign/design

This help command describes not only the options for the design command itself, but
also options that pertain to the method or the algorithm. If you are customizing the
algorithm, you apply these options in this step. In the following example, you design a
bandpass filter, and then modify the filter structure:

>> Hd = design(d, "butter®, "filterstructure®, "df2sos")
f =

FilterStructure: "Direct-Form 11, Second-Order Sections”
Arithmetic: “"double”
sosMatrix: [7x6 double]
ScaleValues: [8x1 double]
PersistentMemory: false

The filter design step, just like the first task of choosing a response, must be performed
explicitly. A Filter Object is created only when design is called.
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Design Analysis

After the filter is designed you may wish to analyze it to determine if the filter satisfies
the design criteria. Filter analysis is broken into three main sections:

*  Frequency domain analysis — Includes the magnitude response, group delay, and
pole-zero plots.
* Time domain analysis — Includes impulse and step response

* Implementation analysis — Includes quantization noise and cost
To display help for analysis of a discrete-time filter, type:

>> help dfilt/analysis
To display help for analysis of a farrow filter, type:

>> help farrow/functions
To analyze your filter, you must explicitly perform this step.

Realize or Apply the Filter to Input Data

After the filter is designed and optimized, it can be used to filter actual input data. The
basic filter command takes input data X, filters it through the Filter Object, and produces
output y:

>> y = filter (FilterObj, x)
This step is never automatically performed for you. To filter your data, you must
explicitly execute this step. To understand how the filtering commands work, type:

>> help dfilt/filter

Note If you have Simulink®, you have the option of exporting this filter to a Simulink
block using the realizemdl command. To get help on this command, type:

>> help realizemdl

3-9






Designing a Filter in the Filterbuilder
GUI

*  “Filterbuilder Design Process” on page 4-2

* “Designing a FIR Filter Using filterbuilder” on page 4-10

+ “Compensate for Delay and Distortion Introduced by Filters” on page 4-13
* “Comparison of Analog ITR Lowpass Filters” on page 4-20

+ “Frequency Response of an Analog Bessel Filter” on page 4-22

+  “Speaker Crossover Filters” on page 4-23



4 Designing a Filter in the Filterbuilder GUI

Filterbuilder Design Process

4-2

In this section...

“Introduction to Filterbuilder” on page 4-2
“Design a Filter Using Filterbuilder” on page 4-2
“Select a Response” on page 4-2

“Select a Specification” on page 4-5

“Select an Algorithm” on page 4-5

“Customize the Algorithm” on page 4-6

“Analyze the Design” on page 4-8

“Realize or Apply the Filter to Input Data” on page 4-8

Introduction to Filterbuilder

The Filterbuilder function provides a graphical interface to the fdesign object-
oriented filter design paradigm and is intended to reduce development time during the
filter design process. Filterbuilder uses a specification-centered approach to find the
best algorithm for the desired response.

Note: filterbuilder requires the Signal Processing Toolbox. The functionality of
filterbuilder is greatly expanded by the DSP System Toolbox. Many of the features
described or displayed below are only available if the DSP System Toolbox is installed.
You may verify your installation by typing ver at the command prompt.

Design a Filter Using Filterbuilder

The basic workflow in using Fi lterbui lder is to choose the constraints and
specifications of the filter, and to use those as a starting point in the design. Postponing
the choice of algorithm for the filter allows the best design method to be determined
automatically, based upon the desired performance criteria. The following are the details
of each of the steps for designing a filter with Filterbuilder.

Select a Response

When you open the Filterbuilder tool by typing:



Filterbuilder Design Process

Ffilterbuilder
at the MATLAB command prompt, the Response Selection dialog box appears, listing
all possible filter responses available in DSP System Toolbox.

' '
u Response Selection l . é]

Select a fiter response:

Lowpass -
Highpass

Bandpass

Bandstop

Differentiator

Hilbert Transformer

Arbitrary Response

Pulze Shaping

OK ] [ Cancel

Note This step cannot be skipped because it is not automatically completed for you by the
software. You must select a response to initiate the filter design process.

After you choose a response, say bandpass, you start the design of the Specifications
Object, and the Bandpass Design dialog box appears. This dialog box contains a Main
pane, a Data Types pane and a Code Generation pane. The specifications of your filter
are generally set in the Main pane of the dialog box.

The Data Types pane provides settings for precision and data types, and the Code
Generation pane contains options for various implementations of the completed filter
design.

For the initial design of your filter, you will mostly use the Main pane.
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T ™
G e

Bandpass Design

Design a bandpass filter.

Filter output variable name: Hbp2 View Filter Response

Main Code Generation

Filter specifications

Impulse response: IFIR v]

Order mode: l Minimum - ]

Frequency specifications

Frequency units: lNormaiized (0to 1) V]

Stopband frequency 1: .35 Passband frequency 1: .45

Passband frequency 2: .55 Stopband frequency 2: .65

Magnitude specifications

Magnitude units: dB

Stopband attenuation 1: 60 Passband ripple: 1

Stopband attenuation 2: 60

Algorithm

Design method: | Equiripple

» Design options

Filter implementation

Structure: | Direct-form FIR

The Bandpass Design dialog box contains all the parameters you need to determine
the specifications of a bandpass filter. The parameters listed in the Main pane depend
upon the type of filter you are designing. However, no matter what type of filter you have
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chosen in the Response Selection dialog box, the filter design dialog box contains the
Main, Data Types, and Code Generation panes.

Select a Specification

To choose the specification for the bandpass filter, you can begin by selecting an Impulse
Response, Order Mode, and Filter Type in the Filter Specifications frame of the
Main Pane. You can further specify the response of your filter by setting frequency and
magnitude specifications in the appropriate frames on the Main Pane.

Note Frequency, Magnitude, and Algorithm specifications are interdependent
and may change based upon your Filter Specifications selections. When choosing
specifications for your filter, select your Filter Specifications first and work your
way down the dialog box- this approach ensures that the best settings for dependent
specifications display as available in the dialog box.

Select an Algorithm

The algorithms available for your filter depend upon the filter response and design
parameters you have selected in the previous steps. For example, in the case of a
bandpass filter, if the impulse response selected is IIR and the Order Mode field is set
to Minimum, the design methods available are Butterworth, Chebyshev type I or II,
or ENliptic, whereas if the Order Mode field is set to Speci fy, the design method
available is IR least p-norm.
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T ™
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Bandpass Design

Design a bandpass filter.

Filter output variable name: Hbp2 View Filter Response

Main Code Generation

Filter specifications

Impulse response: ’I[R v]

Order mode: l Minimum - ]

Frequency specifications

Frequency units: lNormaiized (0to 1) V]

Stopband frequency 1: .35 Passband frequency 1: .45

Passband frequency 2: .55 Stopband frequency 2: .65

Magnitude specifications

Magnitude units: dB

Stopband attenuation 1: 60 Passband ripple: 1

Stopband attenuation 2: 60

Algorithm

Design method: |Butterworth

» Design options

Filter implementation

Structure: | Direct-form I SOS

ok || cancel || Help

Customize the Algorithm

By expanding the Design options section of the Algorithm frame, you can further
customize the algorithm specified. The options available will depend upon the algorithm
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and settings that have already been selected in the dialog box. In the case of a bandpass
IIR filter using the Butterworth method, design options such as Match Exactly are
available, as shown in the following figure.

(g ™y
e

Bandpass Design

Design a bandpass filter.

Filter output variable name: Hbp2 View Filter Response

Main Code Generation

Filter specifications

Impulse response: ’I[R v]

Order mode: l Minimum - ]

Frequency specifications

Frequency units: lNormaiized (0to 1) V]

Stopband frequency 1: .35 Passband frequency 1: .45

Passband frequency 2: .55 Stopband frequency 2: .65

Magnitude specifications

Magnitude units: dB

Stopband attenuation 1: &0 Passband ripple: 1

Stopband attenuation 2: 60

Algorithm

Design method: [Buﬂemorth

¥ Design options

Match exactly: [Stopband

Filter implementation

Structure: [Direct—form 11505
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Analyze the Design

To analyze the filter response, click on the View Filter Response button. The Filter
Visualization Tool opens displaying the magnitude plot of the filter response.

u Filter Visualization Tool - Figure 1: Magnitude Response (dB) l =N X
File Edit Analysis Inset View Debug Desktop Window Help ¥ Ax
D&R|LK|OTNNN\ 4| & <« &0 EE =] ]

EI R # 2 0 Bkl 0
Figure 1: Magnitude Response (dB)
Magnitude Response (dB)
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/ \
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Realize or Apply the Filter to Input Data

When you have achieved the desired filter response through design iterations and
analysis using the Filter Visualization Tool, apply the filter to the input data. Again,
this step is never automatically performed for you by the software. To filter your data,
you must explicitly execute this step. In the Bandpass Design dialog box, click OK and
the Signal Processing Toolbox software creates the filter coefficients and exports it to the
MATLAB workspace.

4-8



Filterbuilder Design Process

The filter is then ready to be used to filter actual input data. The basic filter command
takes input data X, filters it through the Filter Object, and produces output y:

y = filter(Hbs,x)
To understand how the filtering command works, type:

help dfilt/fTilter

Tip If you have Simulink, you have the option of exporting this filter to a Simulink block
using the realizemdl command. To get help on this command, type:

help realizemdl
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Designing a FIR Filter Using filterbuilder

FIR Filter Design

Example - Using Filterbuilder to Design a Finite Impulse Response (FIR) Filter

To design a lowpass FIR filter using Filterbuilder:

1  Open the Filterbuilder GUI by typing the following at the MATLAB prompt:
filterbuilder

The Response Selection dialog box appears. In this dialog box, you can select from
a list of filter response types. Select Lowpass in the list box.

«) Response Selectiol o ] |

Select a fiter responzse:

EBandpass

Bandztop

Iyoquist

Hailfhianc

Differentistar

Hilbert Transformer
Arbitrary Response
Cazcaded Integrator-Comib
CIC Compensator
Inverse-sinG Lowpass

oo [

2 Hit the OK button. The Lowpass Design dialog box opens. Here you can specify the
writable parameters of the Lowpass filter object. The components of the Main frame
of this dialog box are described in the section titled Lowpass Filter Design Dialog Box
— Main Pane. In the dialog box, make the following changes:

+  Enter a Fpass value of 0.55.

Enter a Fstop value of 0.65.
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J:Lowpass Design

Marmalized [0 ta 1] Input Fz:

E quiripple
Direct-form FIR .

Ay

Click Apply, and the following message appears at the MATLAB prompt:

The variable "HIp®" has been exported to the command window.

To check your design, click View Filter Response. The Filter Visualization tool
appears, showing a plot of the magnitude response of the filter.
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You can change the design and click Apply, followed by View Filter Response, as
many times as needed until your design specifications are met.
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Compensate for Delay and Distortion Introduced by Filters

Filtering a signal introduces a delay. This means that the output signal is shifted in time
with respect to the input.

When the shift is constant, you can correct for the delay by shifting the signal in time.

Sometimes the filter delays some frequency components more than others. This
phenomenon is called phase distortion. To compensate for this effect, you can perform
zero-phase filtering using the fi Itfilt function.

Take an electrocardiogram reading sampled at 500 Hz for 1 s. Add random noise. Reset
the random number generator for reproducible results

Fs = 500;
N = 500;

rng default

xXn
tn

ecg(N)+0.1*randn([1 ND);
(0:N-1)/Fs;

Remove some of the noise using a filter that stops frequencies above 75 Hz. Use
designTilt to design an FIR filter of order 70.

NFir = 70;
Fst = 75;

Firf = designfilt("lowpassfir”®, "FilterOrder” ,Nfir,
"CutoffFrequency” ,Fst, "SampleRate” ,Fs);

Filter the signal and plot it. The result is smoother than the original, but lags behind it.
xF = Filter(firf,xn);

plot(tn,xn,tn,xf)

title "Electrocardiogram®

xlabel "Time (s)”
legend("Original”,“"FIR Filtered®)
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Electrocardiogram
15 -

Original
FIR Filtered

X n.‘ || "|| * b

0.5 0.6 0.7 0.8 09
Time (s)

0 01 0.2 0.3 0.4

Use grpdelay to check that the delay caused by the filter equals half the filter order.
grpdelay(Firf,N,Fs)
delay = mean(grpdelay(Ffirf))

delay =

35
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Group delay
355 T T T T

35.4 n

353 B
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34 5 i i i i
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Frequency (Hz)

Line up the data. Shift the filtered signal by removing its first delay samples. Remove
the last delay samples of the original and of the time vector.

tt = tn(1:end-delay);
sn = xn(1l:end-delay);
st = xf;

sf(l:delay) = [1:
Plot the signals and verify that they are aligned.
plot(tt,sn,tt,sf)

title "Electrocardiogram”
xlabel ("Time (s)"), legend("Original Signal®, "Filtered Shifted Signal~®)
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Electrocardiogram
15 T T T T T T T T T
Criginal Signal
Filtered Shifted Signal
| | -
|
I
05 1

” MﬁHWWQ JhH H\, *W H'W M!WW‘M
v‘

_1 i i i i i i i i i

0 0.1 02 0.3 0.4 0.5 0.6 0.7 0.8 09 1
Time (s)

Repeat the computation using a 7th-order IIR filter.
Nilr = 7;

iir = designfilt("lowpassiir”,"FilterOrder” ,Niir, ...
"HalfPowerFrequency” ,Fst, "SampleRate” ,Fs);

Filter the signal. The filtered signal is cleaner than the original, but lags in time with
respect to it. It is also distorted due to the nonlinear phase of the filter.

xFilter = Filter(iir,xn);

plot(tn,xn,tn,xfilter)
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title "Electrocardiogram
xlabel "Time (s)*
legend("Original®,“Filtered™)
axis([0.25 0.55 -1 1.5])

Electrocardiogram
1.5 T T T T T
Criginal
Filtered
1r r' | ) 7
leﬁl Illll
> / A\ |
| AR
N AR P
hglf” ) ot
A ™
05 | | / ]
\ Iltx/,
\
_3.25 0.3 0.35 0.4 0.45 0.5
Time (s)

0.55
A look at the group delay introduced by the filter shows that the delay is frequency
dependent.

grpdelay(iir,N,Fs)
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Group delay

10 T

Group delay (in samples)
[5)]
\
1

0 50 100 150 200
Frequency (Hz)

Filter the signal using Fi I'tFilt. The delay and distortion have been effectively

removed. Use FiltFilt when it is critical to keep the phase information of a signal
intact.

xFiltfilt = Ffiltfilt(iir,xn);

plot(tn,xn)

hold on
plot(tn,xFilter)
plot(tn,xfiltfilt)

title "Electrocardiogram®

xlabel "Time (s)*
legend("Original ™, " "Filter =", " "filtfilt "")
axis([0.25 0.55 -1 1.5])
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Electrocardiogram
1.5 T T T T T
Original
filter'
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Comparison of Analog IIR Lowpass Filters

Design a 5th-order analog Butterworth lowpass filter with a cutoff frequency of 2 GHz.
Multiply by 27 to convert the frequency to radians per second. Compute the frequency
response of the filter at 4096 points.

n 5;

T 2e9;

[zb,pb,kb] = butter(n,2*pi*f,"s");
[bb,ab] = zp2tf(zb,pb,kb);

[hb,wb] = fregs(bb,ab,4096);

Design a 5th-order Chebyshev Type I filter with the same edge frequency and 3 dB of
passband ripple. Compute its frequency response.

[z1,pl1l,k1] = chebyl(n,3,2*pi*f,"s");
[bl,al] = zp2tf(zl,pl,kl);
[h1,wl] = fregs(bl,al,4096);

Design a 5th-order Chebyshev Type II filter with the same edge frequency and 30 dB of
stopband attenuation. Compute its frequency response.

[z2,p2,k2] = cheby2(n,30,2*pi*f,"s");
[b2,a2] zp2tf(z2,p2,k2);
[h2,w2] freqs(b2,a2,4096);

Design a 5th-order elliptic filter with the same edge frequency, 3 dB of passband ripple,
and 30 dB of stopband attenuation. Compute its frequency response.

[ze,pe,ke] = ellip(n,3,30,2*pi*f,"s");
[be,ae] = zp2tf(ze,pe,ke);
[he,we] freqs(be,ae,4096);

Plot the attenuation in decibels. Express the frequency in gigahertz. Compare the filters.

plot(wb/(2e9*pi) ,mag2db(abs(hb)))
hold on

plot(wl/(2e9*pi) ,mag2db(abs(hl)))
plot(w2/(2e9*pi) ,mag2db(abs(h2)))
plot(we/ (2e9*pi) ,mag2db(abs(he)))
axis([0 4 -40 5])

grid

xlabel ("Frequency (GHz)")
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Attenuation (dB)

ylabel ("Attenuation (dB)")
legend("butter”, "chebyl®, "cheby2®,"ellip®)

butter

. 7Y cheby1
e e '}*Jr cheby2

0 05 1 15 2 25 3 35 4
Frequency (GHz)

The Butterworth and Chebyshev Type II filters have flat passbands and wide transition
bands. The Chebyshev Type I and elliptic filters roll off faster but have passband ripple.
The frequency input to the Chebyshev Type II design function sets the beginning of the
stopband rather than the end of the passband.
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Frequency Response of an Analog Bessel Filter

Design a 5th-order analog lowpass Bessel filter with approximately constant group delay
up to 10" rad/s. Plot the magnitude and phase responses of the filter using fregs.

[b,a] = besself(5,10000);
freqs(b,a)

1|:|.'3' T T T ]

Magnitude

107
102 10° 10% 10°

Frequency (rad/s)
200 ———— —rr

1001

Fhase (degrees)
=
|

-200 —
102 10° 104 10°

Frequency (rad/s)
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Speaker Crossover Filters

This example shows how to devise a simple model of a digital three-way loudspeaker. The
system splits the audio input into low-, mid-, and high-frequency bands that correspond
respectively to the woofer, the midrange driver, and the tweeter. Typical values for the
normalized crossover frequencies that delimit the bands are (). 1367 rad/sample and
(1.317m rad/sample.

Create lowpass, bandpass, and higphass filters to generate the low-frequency, mid-
frequency, and high-frequency bands. Specify the frequencies.

lo
hi

0.136;
0.317;

Use a 6th-order Chebyshev Type I design for each filter. Specify a passband ripple of
1 dB, larger than the value for real speakers. The chebyl function doubles the order
of bandpass designs. Make all filters have the same order by halving the order of the
bandpass filter. Return the zeros, poles, and gain of each filter.

ord = 6;

rip = 1;

[zw,pw,kw] = chebyl(ord,rip,l0);
[zm,pm,km] = chebyl(ord/2,rip,[lo hi]);
[zt,pt,kt] = chebyl(ord,rip,hi,“high®);

Visualize the zeros and poles of the filters.
zplane([zw zm zt],[pw pm pt])

lg = legend("Woofer®, *Midrange®, "Tweeter®);
1g.Box = "off";
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Imaginary Part

4-24
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*  Woofer: The zeros at = = —1 suppress high frequencies. The poles enhance the
magnitude response between U and the lower crossover frequency.
*  Midrange: The zeros at = = [} and z = 1 suppress high and low frequencies. The poles

enhance the magnitude response between the lower and higher crossover frequencies.
Tweeter: The zeros at = = 1 suppress low frequencies. The poles enhance the
magnitude response between the higher crossover frequency and .

Plot the magnitude responses on the unit circle to see the effect of the different poles and
zeros. Use linear units. Represent the filters as second-order sections.

SwW
sm

zp2sos(zw, pw, kw) ;
zp2sos(zm,pm,km) ;



Speaker Crossover Filters

st = zp2sos(zt,pt,kt);

nf = 1024;

[hw,fw] = fregz(sw,nf,“whole®);
hm = freqz(sm,nf,*whole");

ht = freqz(st,nf, whole™);

plot3(cos(fw),sin(fw), [abs(hw) abs(hm) abs(ht)])
xlabel ("Real ™)

ylabel ("Imaginary®)

view(75,30)

grid

Imaginary

Plot the magnitude responses in dB using fvtool.
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hfvt = fvtool(sw,sm,st);
legend(hfvt, "Woofer”, "Mid-range”, "Tweeter")

Magnitude Response (dB)
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Load an audio file containing a fragment of Handel's "Hallelujah Chorus" sampled at
8192 Hz. Split the signal into three frequency bands by filtering. Plot the bands.

load handel % To hear, type soundsc(y,Fs)
yw = sosfilt(sw,y); % To hear, type soundsc(yw,Fs)
ym = sosfilt(sm,y); % To hear, type soundsc(ym,Fs)
yt = sosfilt(st,y); % To hear, type soundsc(yt,Fs)
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plot((0:length(y)-1)/Fs, [yw ym yt])
xlabel("Time (s)~°)

% To hear all the frequency ranges, type soundsc(yw+ym+yt,Fs)
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FDATool

5-2

The Filter Design and Analysis Tool (FDATool) is a user interface for designing and
analyzing filters quickly. FDATool enables you to design digital FIR or IIR filters by
setting filter specifications, by importing filters from your MATLAB workspace, or by
adding, moving or deleting poles and zeros. FDATool also provides tools for analyzing
filters, such as magnitude and phase response and pole-zero plots.



Filter Design Methods

Filter Design Methods

FDATool gives you access to the following Signal Processing Toolbox filter design

methods.

Design Method Function
Butterworth butter
Chebyshev Type I chebyl
Chebyshev Type 11 cheby?2
Elliptic ellip
Maximally Flat maxflat
Equiripple firpm
Least-squares firls
Constrained least-squares fircls
Complex equiripple cFirpm
Window firl

When using the window method in FDATool, all Signal Processing Toolbox window
functions are available, and you can specify a user-defined window by entering its

function name and input parameter.

Advanced Filter Design Methods

The following advanced filter design methods are available if you have DSP System

Toolbox software.

Design Method Function
Constrained equiripple FIR firceqrip
Constrained-band equiripple FIR fircband
Generalized remez FIR firgr
Equripple halfband FIR firhalfband
Least P-norm optimal FIR firlpnorm
Equiripple Nyquist FIR Ffirnyquist

5-3



5 FDATool: A Filter Design and Analysis GUI

5-4

Design Method Function
Interpolated FIR ifir

ITR comb notching or peaking iircomb
Allpass filter (given group delay) iirgrpdelay
Least P-norm optimal ITR iirlpnorm

Constrained least P-norm IIR

Second-order IIR notch

Second-order IIR peaking (resonator)




Using the Filter Design and Analysis Tool

Using the Filter Design and Analysis Tool

There are different ways that you can design filters using the Filter Design and Analysis
Tool. For example:

You can first choose a response type, such as bandpass, and then choose from the
available FIR or IIR filter design methods.

You can specify the filter by its type alone, along with certain frequency- or time-
domain specifications such as passband frequencies and stopband frequencies. The

filter you design is then computed using the default filter design method and filter
order.
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Analyzing Filter Responses

Once you have designed your filter, you can display the filter coefficients and detailed
filter information, export the coefficients to the MATLAB workspace, and create a C
header file containing the coefficients, and analyze different filter responses in FDATool
or in a separate Filter Visualization Tool (Fvtool). The following filter responses are
available:

* Magnitude response (Freqz)

* Phase response (phasez)

*  Group delay (grpdelay)

* Phase delay (phasedelay)

* Impulse response (impz)

*  Step response (stepz)

* Pole-zero plots (zplane)

* Zero-phase response (zerophase)
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Filter Design and Analysis Tool Panels

The Filter Design and Analysis Tool has sidebar buttons that display particular panels in
the lower half of the tool. The panels are

Design Filter. See “Choosing a Filter Design Method” on page 5-10 for more

information. You use this panel to
Design filters from scratch.

+  Modify existing filters designed in FDATool.

* Analyze filters.

Import filter. You use this panel to

+  Import previously saved filters or filter coefficients that you have stored in the
MATLAB workspace.

+ Analyze imported filters.

Pole/Zero Editor. See “Editing the Filter Using the Pole/Zero Editor” on page 5-20.
You use this panel to add, delete, and move poles and zeros in your filter design.

If you also have DSP System Toolbox product installed, additional panels are available:

Set quantization parameters — Use this panel to quantize double-precision filters
that you design in FDATool, quantize double-precision filters that you import into
FDATool, and analyze quantized filters.

Transform filter — Use this panel to change a filter from one response type to
another.

Multirate filter design — Use this panel to create a multirate filter from your existing
FIR design, create CIC filters, and linear and hold interpolators.

If you have Simulink installed, this panel is available:

Realize Model — Use this panel to create a Simulink block containing the filter
structure.
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Getting Help

At any time, you can right-click or click the What's this? button, ﬂ, to get information
on the different parts of the tool. You can also use the Help menu to see complete Help
information.
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Using FDATool

To open FDATool, type

fdatool
at the MATLAB command prompt.

The Filter Design and Analysis Tool opens with the Design Filter panel displayed.
=il

File Edit Analysis Targets View Window Help
DEEER| 220X ORIk £ [0 Bk @

—Fitter Specification:

= Current Fitter Information

May. (dB)
Structure:  Direct-Form FIR _L
Order: 50 ok
ass
Stahle: Yes '% T
Source; Designed A
fmp
Store Filter I f :
2 a Fores Mot Fs2  fH2)
Fitter Marager ... | P P

— Responze Type — Fitter Croer — Freguency Specifications: — Magnitude Specifications.

+ |Lowpass B ~ Specify order: l10— Units: IHZ d Wi IdB d

i Highpass

(% Minimum oreer Fs I4BUUU

i Bandpass Apass |1

" Bandstop __ Options: Fpass IBEDD

e Astop 50

Difterertistor i i 5
Density Factor: |20 Fstop I12DDD—

[ DesignMethod |

IR | Butterworth B

1+ FIR |Equiripple -

Desigr Fiter:

|Readv

Note that when you open FDATool, Design Filter is not enabled. You must make a
change to the default filter design in order to enable Design Filter. This is true each
time you want to change the filter design. Changes to radio button items or drop down
menu items such as those under Response Type or Filter Order enable Design Filter
immediately. Changes to specifications in text boxes such as Fs, Fpass, and Fstop
require you to click outside the text box to enable Design Filter.

Choosing a Response Type

You can choose from several response types:
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+ Lowpass

* Raised cosine

* Highpass
* Bandpass
*  Bandstop

+ Differentiator
*  Multiband
* Hilbert transformer

* Arbitrary magnitude

Additional response types are available if you have DSP System Toolbox software
installed.

To design a bandpass filter, select the radio button next to Bandpass in the Response
Type region of the GUI.

_ Responze Type

(8 ILDWpass j
(8 IHighpass j
{~ Bandstop

" |Ditterentiator |

Note: Not all filter design methods are available for all response types. Once you choose
your response type, this may restrict the filter design methods available to you. Filter
design methods that are not available for a selected response type are removed from the
Design Method region of the GUL.

Choosing a Filter Design Method
You can use the default filter design method for the response type that you've selected,

or you can select a filter design method from the available FIR and IIR methods listed in
the GUI.
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To select the Remez algorithm to compute FIR filter coefficients, select the FIR radio
button and choose Equiripple from the list of methods.

Dezign hethad

IR IBuﬁerworth vI
& FIR IEquirippIe vI

Setting the Filter Design Specifications

“Viewing Filter Specifications” on page 5-11

“Filter Order” on page 5-12

“Options” on page 5-12

“Bandpass Filter Frequency Specifications” on page 5-13

“Bandpass Filter Magnitude Specifications” on page 5-14

Viewing Filter Specifications

The filter design specifications that you can set vary according to response type and
design method. The display region illustrates filter specifications when you select
Analysis > Filter Specifications or when you click the Filter Specifications toolbar
button.

You can also view the filter specifications on the Magnitude plot of a designed filter by
selecting View > Specification Mask.

#tag. (dE)

T T assT

stopl ASTD[G?

I T
stop pass] pass2 - stop2

0 F F F F Fs2  f(Hz)
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Filter Order

You have two mutually exclusive options for determining the filter order when you
design an equiripple filter:

+ Specify order: You enter the filter order in a text box.

* Minimum order: The filter design method determines the minimum order filter.

Select the Minimum order radio button for this example.

FilterOrder —

© Specify order: I'ID

& Minimum order

Note that filter order specification options depend on the filter design method you choose.
Some filter methods may not have both options available.

Options

The available options depend on the selected filter design method. Only the FIR
Equiripple and FIR Window design methods have settable options. For FIR Equiripple,
the option is a Density Factor. See Firpm for more information. For FIR Window

the options are Scale Passband, Window selection, and for the following windows, a
settable parameter:

Window Parameter

Chebyshev (chebwin) Sidelobe attenuation
Gaussian (gausswin) Alpha

Kaiser (kaiser) Beta

Taylor (taylorwin) Nbar and Sidelobe level
Tukey (tukeywin) Alpha

User Defined Function Name, Parameter

You can view the window in the Window Visualization Tool (wvtool) by clicking the
View button.
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For this example, set the Density factor to 16.

Optiong

Dengity factor: I 16

Bandpass Filter Frequency Specifications

For a bandpass filter, you can set

Units of frequency:

+ Hz
kHz
+ MHz

+ Normalized (0 to 1)
Sampling frequency
Passband frequencies

Stopband frequencies

You specify the passband with two frequencies. The first frequency determines the
lower edge of the passband, and the second frequency determines the upper edge of the
passband.

Similarly, you specify the stopband with two frequencies. The first frequency determines
the upper edge of the first stopband, and the second frequency determines the lower edge
of the second stopband.

For this example:

Keep the units in Hz (default).

Set the sampling frequency (F's) to 2000 Hz.

Set the end of the first stopband (Fstopl) to 200 Hz.
Set the beginning of the passband (Fpassl) to 300 Hz.
Set the end of the passband (Fpass2) to 700 Hz.
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* Set the beginning of the second stopband (Fstop2) to 800 Hz.

— Freguency S pecifications

Units: Iﬁ
Fa: IEDDD—
Fstopl: IZ‘DD—
Fpass1: ISDD—
Fpass2: I?’DD—
Fatop2: IBDD—

Bandpass Filter Magnitude Specifications

For a bandpass filter, you can specify the following magnitude response characteristics:

*  Units for the magnitude response (dB or linear)
* Passband ripple

*  Stopband attenuation

For this example:

+ Keep Units in dB (default).
+ Set the passband ripple (Apass) to 0.1 dB.
+ Set the stopband attenuation for both stopbands (Astopl, Astop2) to 75 dB.

— hagnitude Specifications

|ritz: IdB vl

Aztopl: I Fi]
Apag IEI.1
Aztop2: I Fi]
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Computing the Filter Coefficients

Now that you've specified the filter design, click the Design Filter button to compute the
filter coefficients.

Notice that the Design Filter button is disabled once you've computed the coefficients for
your filter design. This button is enabled again once you make any changes to the filter
specifications.

Analyzing the Filter

+ “Displaying Filter Responses” on page 5-15

+ “Using Data Tips” on page 5-17

* “Drawing Spectral Masks” on page 5-17

* “Changing the Sampling Frequency” on page 5-19
+ “Displaying the Response in FVTool” on page 5-19

Displaying Filter Responses

You can view the following filter response characteristics in the display region or in a
separate window.

* Magnitude response

* Phase response

* Magnitude and Phase responses

*  Group delay response

* Phase delay response

* Impulse response

+  Step response

* Pole-zero plot

+ Zero-phase response — available from the y-axis context menu in a Magnitude or

Magnitude and Phase response plot.

If you have DSP System Toolbox product installed, two other analyses are available:
magnitude response estimate and round-off noise power. These two analyses are the only
ones that use filter internals.
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For descriptions of the above responses and their associated toolbar buttons and other
FDATool toolbar buttons, see fvtool.

You can display two responses in the same plot by selecting Analysis > Overlay
Analysis and selecting an available response. A second y-axis is added to the right side
of the response plot. (Note that not all responses can be overlaid on each other.)

You can also display the filter coefficients and detailed filter information in this region.

For all the analysis methods, except zero-phase response, you can access them from the
Analysis menu, the Analysis Parameters dialog box from the context menu, or by using
the toolbar buttons. For zero-phase, right-click the y-axis of the plot and select Zero-
phase from the context menu.

=R N < A

For example, to look at the filter's magnitude response, select the Magnitude Response
button BJ on the toolbar.

— Magnitude Response (dB)

Magnitude (dB)

———————————————————————————————————————————————————————————————————————

...........................................

0.4 0.5 (81
Frequancy [kHz)

You can also overlay the filter specifications on the Magnitude plot by selecting View >
Specification Mask.

Note: You can use specification masks in FVTool only if FVTool was launched from
FDATool.
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— Magnitude Response (dB)

hlagnituce (dB)

____________________________

————————————————————————————

0.4 04 (o1 <]
Frequency [kHz)

Using Data Tips

You can click the response to add plot data tips that display information about particular
points on the response.

— Magnitude Response (dB)

_______ S T T T
o ! ! Frequency (kHz): 0229324

Magnitude (oB): -15.11089

Magnitude (dB)

———————————————————————————————————————————————————————————————————————

0.3 0.4 0.5 (81 o7 0 09
Frequancy [kHz)

For information on using data tips, see “Display Data Values Interactively” in the
MATLAB documentation.

Drawing Spectral Masks

To add spectral masks or rejection area lines to your magnitude plot, click View > User-
defined Spectral Mask.
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) User-defined Spectral Mask = |EI|5|

[ Enakle Mask

[¥ Mormalized Frequency

Freguency Vector: lg 020307081] Ot

Magnitude Unit=: IdB d

Magnitude Yector; [.?2 F200-72-77

Ok I Cancell Help I Arply, I

The mask is defined by a frequency vector and a magnitude vector. These vectors must be
the same length.

Enable Mask — Select to turn on the mask display.

Normalized Frequency — Select to normalize the frequency between 0 and 1
across the displayed frequency range.

Frequency Vector — Enter a vector of x-axis frequency values.

Magnitude Units — Select the desired magnitude units. These units should match
the units used in the magnitude plot.

Magnitude Vector — Enter a vector of y-axis magnitude values.

The magnitude response below shows a spectral mask.

— Magnitude Response (dB)

al.- | A— A— T I I
0 IS SO 5 S SO SUSU SOOI W W OO SO
o ' '
=4 H H
_g '40 """" :’ """ :’ """ | | | i e e A e e |
E oot
= H .
) P
S I SO 1 (N O N SN SN N

U
| | | | |

O o [o3] 03 o4 05 05
Frequency (kHz)
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Changing the Sampling Frequency

To change the sampling frequency of your filter, right-click any filter response plot and
select Sampling Frequency from the context menu.

-} sampling Frequency o ] oA |

Filter narme: I Filker #1 Z‘
Units: [|H2 -
Fs: | 48
Save az Defaultl Restore Original Defaultsl

0k I Cancell Help I Applyl

To change the filter name, type the new name in Filter name. (In fvtool, if you have
multiple filters, select the desired filter and then enter the new name.)

To change the sampling frequency, select the desired unit from Units and enter the
sampling frequency in Fs. (For each filter in fvtool, you can specify a different
sampling frequency or you can apply the sampling frequency to all filters.)

To save the displayed parameters as the default values to use when FDATool or FVTool
1s opened, click Save as Default.

To restore the default values, click Restore Original Defaults.
Displaying the Response in FVTool

To display the filter response characteristics in a separate window, select View > Filter
Visualization Tool (available if any analysis, except the filter specifications, is in the

display region) or click the Full View Analysis button: O

This launches the Filter Visualization Tool (Fvtool).

Note: If Filter Specifications are shown in the display region, clicking the Full View
Analysis toolbar button launches a MATLAB figure window instead of FVTool. The
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associated menu item is Print to figure, which is enabled only if the filter specifications
are displayed.

You can use this tool to annotate your design, view other filter characteristics, and print
your filter response. You can link FDATool and FVTool so that changes made in FDATool
are immediately reflected in FVTool. See fvtool for more information.

) Figure 1: Filter ¥isualization Tool - Magnitude Response {dB) i ]
File Edit Analysis Insert Wiew ‘Window Help a

DER KOTNN\NE 280X | HE| FB
RINE# 4 M Bk @

agnituce Responss (dB)
T

Magnitude (dB)

0.4 0.5 o1
Frequancy [kHz)

Editing the Filter Using the Pole/Zero Editor

+ “Displaying the Pole-Zero Plot” on page 5-20
+ “Changing the Pole-Zero Plot” on page 5-21

Displaying the Pole-Zero Plot

You can edit a designed or imported filter's coefficients by moving, deleting, or adding
poles and/or zeros using the Pole/Zero Editor panel.
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Note: You cannot generate MATLAB code (File > Generate MATLAB code) if your
filter was designed or edited with the Pole/Zero Editor.

You cannot move quantized poles and zeros. You can only move the reference poles and
ZEros.

Click the Pole/Zero Editor button in the sidebar or select Edit > Pole/Zero Editor to
display this panel.

2} Filter Design & Analysis Tool - [untitled.fda] i 1ol x|
File Edit Analysis Targets Wiew Window Help

DeREl| 220K |0 0|k £ 0~ Bk e

— Currert Fitter Information

— Magnitude Response (dB).

S0 T T T

Structure: Direct-Form FIR 0
Orler: 50
Stable: Ves
Source; Designed

=50

Magnitude (dB)

1/ S 1 ) N I [

Stare Fitter I
Fitter Manager I

[ 25 s

Fitter Gain: lm
PD| E/ZBI'D Cootdinates: m
Ed"nr Magnitude: l—
Angle: l— radians

Imaginary Part

@ Section: 1 -
@ I Conjugste

¥ &uto Update

Real Part

==l
| eady

Poles are shown using x symbols and zeros are shown using o symbols.
Changing the Pole-Zero Plot
Plot mode buttons are located to the left of the pole/zero plot. Select one of the buttons to

change the mode of the pole/zero plot. The Pole/Zero Editor has these buttons from left to
right: move pole, add pole, add zero, and delete pole or zero.
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(IS0 )| |

Wave Md xd Delete paole

pole  pole  zmro ar zr

The following plot parameters and controls are located to the left of the pole/zero plot and
below the plot mode buttons.

Filter gain — factor to compensate for the filter's pole(s) and zero(s) gains
Coordinates — units (Polar or Rectangular) of the selected pole or zero
Magnitude — if polar coordinates is selected, magnitude of the selected pole or zero
Angle — if polar coordinates is selected, angle of selected pole(s) or zero(s)

Real — if rectangular coordinates is selected, real component of selected pole(s) or
zero(s)

Imaginary — if rectangular coordinates is selected, imaginary component of selected
pole or zero

Section — for multisection filters, number of the current section

Conjugate — creates a corresponding conjugate pole or zero or automatically selects
the conjugate pole or zero if it already exists.

Auto update — immediately updates the displayed magnitude response when poles
or zeros are added, moved, or deleted.

The Edit > Pole/Zero Editor has items for selecting multiple poles/zeros, for inverting
and mirroring poles/zeros, and for deleting, scaling and rotating poles/zeros.
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Select Al

Select All Poles

Select All Zeros

Select Inside Unit Circle
Select Outside Unit Circle
Select Below Real Axis
Select Above Real Axis
Select Left Half

Select Right Half

Invert about Ehe Real fxis
Inwerk about Ehe Imaginary: Axis
Inwvert about Ehe Unit Circle

These items ore enobled only
L when one or more poles/zeros
ure selected.

Mirrar ahaut Ehe Real fxis
Iirrar abaut the Imaginaty) fxis
IMirrat: ahaut Ehe Unit Sircle

[elete current
Scale by a Factar
Ratate Caunter-Clockwise

Moving one of the zeros on the vertical axis produces the following result:
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) Filter Design & Analysis Tool - [untitled.fda *]

File Edit Analysis Targets View ‘Window Help

=10

Nedal| 2290 0EMNEUM:+t O BEL N

= Current Fiter Infarmation

Structure:  Direct-Form FIR
Crcler: 50

Stahle: Yes

Source:  Pale/Zero Editar

Store Filter ... I
Filter Manager ... I

— Magnitude Response (dE)

Magnitude (dB)

50

150
o
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Angle: [15574  radians
Section; |1 - I

[V Conjugste

[
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Converting the Filter Structure

Converting to a New Structure

You can use Edit > Convert Structure to convert the current filter to a new structure.

The selected zero pair is shown in green.

When you select one of the zeros from a conjugate pair, the Conjugate check box and

the conjugate are automatically selected.

The Magnitude Response plot updates immediately because Auto update is active.

“Converting to a New Structure” on page 5-24

“Converting to Second-Order Sections” on page 5-26

All filters can be converted to the following representations:

Direct-form I

Direct-form I1

Direct-form I transposed
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+  Direct-form II transposed
+  Lattice ARMA

Note: If you have DSP System Toolbox product installed, you will see additional
structures in the Convert structure dialog box.

In addition, the following conversions are available for particular classes of filters:

*  Minimum phase FIR filters can be converted to Lattice minimum phase
*  Maximum phase FIR filters can be converted to Lattice maximum phase
+ Allpass filters can be converted to Lattice allpass

+ TIIR filters can be converted to Lattice ARMA

Note: Converting from one filter structure to another may produce a result with different
characteristics than the original. This is due to the computer's finite-precision arithmetic
and the variations in the conversion's roundoff computations.

For example:
+ Select Edit > Convert Structure to open the Convert structure dialog box.

+ Select Direct-form I in the list of filter structures.

) Convert Structure i ] B

Convert to;

Direct-Form FIR Transposed
Direct-Farm Symmetric FIR

[

Ok I Cancell
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Converting to Second-Order Sections

You can use Edit > Convert to Second-Order Sections to store the converted filter
structure as a collection of second-order sections rather than as a monolithic higher-order
structure.

Note: The following options are also used for Edit > Reorder and Scale Scale Second-
Order Sections, which you use to modify an SOS filter structure.

The following Scale options are available when converting a direct-form II structure
only:

* None (default)
* L-2 (L* norm)

L-infinity (L” norm)

The Direction (Up or Down) determines the ordering of the second-order sections. The
optimal ordering changes depending on the Scale option selected.

For example:

+ Select Edit > Convert to Second-Order Sections to open the Convert to SOS
dialog box.

Select L-inFinity from the Scale menu for L” norm scaling.

* Leave Up as the Direction option.

Note: To convert from second-order sections back to a single section, use Edit >
Convert to Single Section.

Exporting a Filter Design

+ “Exporting Coefficients or Objects to the Workspace” on page 5-27
+ “Exporting Coefficients to an ASCII File” on page 5-28

+  “Exporting Coefficients or Objects to a MAT-File” on page 5-28

+ “Exporting to SPTool” on page 5-29
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+ “Exporting to a Simulink Model” on page 5-29
+ “Other Ways to Export a Filter” on page 5-32

Exporting Coefficients or Objects to the Workspace

You can save the filter either as filter coefficients variables or as a filter object variable.
To save the filter to the MATLAB workspace:

Select File > Export. The Export dialog box appears.
2 Select Workspace from the Export To menu.

3 Select Coefficients from the Export As menu to save the filter coefficients or
select Objects to save the filter in a filter object.

4 For coefficients, assign variable names using the Numerator (for FIR filters) or
Numerator and Denominator (for IIR filters), or SOS Matrix and Scale Values
(for IIR filters in second-order section form) text boxes in the Variable Names region.

For objects, assign the variable name in the Discrete Filter (or Quantized Filter)
text box. If you have variables with the same names in your workspace and you want
to overwrite them, select the Overwrite Variables check box.

5 Click the Export button.

RIS

— Ewport To
IWorkspace j

— Export Az
Il:oefficients j

— Y ariable Mames

Murneratar Mum

D enarninatar Den

[ Ovenwrite Yariables

0K I Eancell Apply I
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JRT=IE

— Export Ta

IWDrkspace j
— Ewport As

IDbiects j

— Warniable Mames

Discrete filker | Hd

™ Owenwrite Y ariables

ok I I:ancell Apply I

Exporting Coefficients to an ASCII File
To save filter coefficients to a text file,

1 Select File > Export. The Export dialog box appears.
2 Select Coefficients File (ASCII) from the Export To menu.

3 Click the Export button. The Export Filter Coefficients to .FCF File dialog box
appears.

4 Choose or enter a filename and click the Save button.
The coefficients are saved in the text file that you specified, and the MATLAB Editor

opens to display the file. The text file also contains comments with the MATLAB version
number, the Signal Processing Toolbox version number, and filter information.

Exporting Coefficients or Objects to a MAT-File
To save filter coefficients or a filter object as variables in a MAT-file:

1 Select File > Export. The Export dialog box appears.

2 Select MAT-File from the Export To menu.

3 Select Coefficients from the Export As menu to save the filter coefficients or
select Objects to save the filter in a filter object.

4  For coefficients, assign variable names using the Numerator (for FIR filters) or
Numerator and Denominator (for IIR filters), or SOS Matrix and Scale Values
(for IIR filters in second-order section form) text boxes in the Variable Names region.
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For objects, assign the variable name in the Discrete Filter (or Quantized Filter)
text box. If you have variables with the same names in your workspace and you want
to overwrite them, select the Overwrite Variables check box.

5 Click the Export button. The Export to a MAT-File dialog box appears.
6 Choose or enter a filename and click the Save button.
Exporting to SPTool

You may want to use your designed filter in SPTool to do signal processing and analysis.

Select File > Export. The Export dialog box appears.
Select SPTool from the Export To menu.

Assign the variable name in the Discrete Filter (or Quantized Filter) text box.
If you have variables with the same names in your workspace and you want to
overwrite them, select the Overwrite Variables check box.

Click the Export button.

SPTool opens and the current FDATool filter appears in the Filter area list as the
specified variable name followed by (Imported).

Note: If you are using the DSP System Toolbox software and export a quantized
filter, only the values of its quantized coefficients are exported. The reference
coefficients are not exported. SPTool does not restrict the coefficient values, so if you
edit them in SPTool by moving poles or zeros, the filter will no longer be in quantized
form.

Exporting to a Simulink Model

If you have the Simulink product installed, you can export a Simulink block of your filter
design and insert it into a new or existing Simulink model.

You can export a filter designed using any filter design method available in FDATool.

Note: If you have the DSP System Toolbox and Fixed-Point Designer™ installed, you can
export a CIC filter to a Simulink model.
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1  After designing your filter, click the Realize Model sidebar button or select File >
Export to Simulink Model. The Realize Model panel is displayed.

— Model — Optimization
TwEr e Fitter | Optimize for zero gains
Destinatipn: | Current A V| Optimize for unity gains
Untitled | Optimize for negative gaing
b Overwrite generated "Fiter” block | Optimize delay chaing
[

— Build model using basic elements Optimize for unity scale values
[ha}-g
E‘ Input processing: | Columns as channels (frame based) - Realize Model

2 Specify the name to use for your block in Block name.

To insert the block into the current (most recently selected) Simulink model, set the
Destination to Current. To inset the block into a new model, select New. To insert
the block into a user-defined subsystem, select User defined.

4 If you want to overwrite a block previously created from this panel, check
Overwrite generated “Filter' block.

5 If you select the Build model using basic elements check box, your filter is
created as a subsystem block, which uses separate sub-elements. In this mode, the
following optimization(s) are available:

Optimize for zero gains — Removes zero-valued gain paths from the filter
structure.

* Optimize for unity gains — Substitutes a wire (short circuit) for gains
equal to 1 in the filter structure.

Optimize for negative gains — Substitutes a wire (short circuit) for gains
equal to -1 and changes corresponding additions to subtractions in the filter
structure.

+ Optimize delay chains — Substitutes delay chains composed of n unit delays
with a single delay of n.

+ Optimize for unity scale values — Removes multiplications for scale
values equal to 1 from the filter structure.

The following illustration shows the effects of some of the optimizations:
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Output
b1y

Opiimize for zero gains
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Output

Optimize for unity gains
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Output
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b(Z) b2}

(™) } () Optimize delay chains ) p
—_———
Input Cutput Cutput

b1 b1y

Optimization Effects

Note: The Build model using basic elements check box is enabled only when you
have a DSP System Toolbox license and your filter can be designed using a Biquad
Filter block or a Discrete FIR Filter block. For more information, see the
Filter Realization Wizard topic in the DSP System Toolbox documentation.
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6 Set the Input processing parameter to specify whether the generated filter
performs sample- or frame-based processing on the input. Depending on the type of
filter you design, one or both of the following options may be available:

Columns as channels (frame based) — When you select this option, the
block treats each column of the input as a separate channel.

+ Elements as channels (sample based) — When you select this option, the
block treats each element of the input as a separate channel.

7 Click the Realize Model button to create the filter block. When the Build model
using basic elements check box is selected, FDATool implements the filter as a
subsystem block using Sum, Gain, and Delay blocks.

If you double-click the Simulink Filter block, the filter structure is displayed.
Other Ways to Export a Filter

You can also send your filter to a C header file or generate MATLAB code to construct
your filter from the command line. For detailed instructions, see the following sections:

* “Generating a C Header File” on page 5-32
+ “Generating MATLAB Code” on page 5-34

Generating a C Header File

You may want to include filter information in an external C program. To create a C
header file with variables that contain filter parameter data, follow this procedure:

1 Select Targets > Generate C Header. The Generate C Header dialog box appears.
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(34
__“ariable names in C header file
Murneratar: ML Murneratar length: |N|_
Denominator.  [DEN Denaminator length: |D|_

Mumnber of sections:

—

__ Data type to uze in export

{+ Export suggested:

Dauble-precizion

floating point
¢ Export as: ISigned 32-bit integer 'i
Fractional length: 31
ak. I CanceII Help | Apply |

Enter the variable names to be used in the C header file. The particular filter
structure determines the variables that are created in the file

Filter Structure

Variable Parameter

Direct-form I
Direct-form I1
Direct-form I

Numerator, Numerator length*, Denominator,
Denominator length*, and Number of sections (inactive if
filter has only one section)

transposed

Direct-form II

transposed

Lattice ARMA Lattice coeffs, Lattice coeffs length*, Ladder coeffs, Ladder
coeffs length*, Number of sections (inactive if filter has
only one section)

Lattice MA Lattice coeffs, Lattice coeffs length*, and Number of

sections (inactive if filter has only one section)

Direct-form FIR Direct-
form FIR transposed

Numerator, Numerator length*, and Number of sections
(inactive if filter has only one section)

*length variables contain the total number of coefficients of that type.

Note: Variable names cannot be C language reserved words, such as “for.”
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3 Select Export Suggested to use the suggested data type or select Export As and
select the desired data type from the pull-down.

Note: If you do not have DSP System Toolbox software installed, selecting any
data type other than double-precision floating point results in a filter that does not
exactly match the one you designed in the FDATool. This is due to rounding and
truncating differences.

4  Click OK to save the file and close the dialog box or click Apply to save the file, but
leave the dialog box open for additional C header file definitions.

Generating MATLAB Code

You can generate MATLAB code that constructs the filter you designed in FDATool from
the command line. Select File > Generate MATLAB Code > Filter Design Function
and specify the filename in the Generate MATLAB code dialog box.

Note: You cannot generate MATLAB code (File > Generate MATLAB Code > Filter
Design Function) if your filter was designed or edited with the Pole/Zero Editor.

The following is generated MATLAB code for the default lowpass filter in FDATool.

function Hd = ExFilter
%EXFILTER Returns a discrete-time filter object.

% MATLAB Code
% Generated by MATLAB(R) 7.11 and the Signal Processing Toolbox 6.14.

% Generated on: 17-Feb-2010 14:15:37

% Equiripple Lowpass filter designed using the FIRPM function.

% All frequency values are in Hz.
Fs = 48000; % Sampling Frequency

Fpass = 9600; % Passband Frequency
Fstop = 12000; % Stopband Frequency
Dpass = 0.057501127785; % Passband Ripple
Dstop = 0.0001; % Stopband Attenuation
dens = 20; % Density Factor

% Calculate the order from the parameters using FIRPMORD.
[N, Fo, Ao, W] = firpmord([Fpass, Fstop]/(Fs/2), [1 0], [Dpass, Dstop]);

% Calculate the coefficients using the FIRPM function.
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b
Hd

firpm(N, Fo, Ao, W, {dens});
dfilt.dffir(b);

% [EOF]

Managing Filters in the Current Session

You can store filters designed in the current FDATool session for cascading together,
exporting to FVTool or for recalling later in the same or future FDATool sessions.

You store and access saved filters with the Store filter and Filter Manager buttons,
respectively, in the Current Filter Information pane.

__ Currett Fitker Informstion

Structure:  Direct-Farmm FIR

Crrcer: S0
Sections: 1
Stable: Yes

Source: Designed

Stare Fitter .. |

Fitter Manager ...

Store Filter — Displays the Store Filter dialog box in which you specify the filter name
to use when storing the filter in the Filter Manager. The default name is the type of the
filter.

storeFilter x|

Enter fitter name to be stared in the Fiter Manager

Ianpass Equiripple
QK I Cancell

Filter Manager — Opens the Filter Manager.
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_loix

Lowwpass Equiripgle

=
Current fitter: Lowpass Equiripple

[~ Eclit current fiter

Cazcade Renathe Remove I F*Tool |

Cloze I Help |

The current filter is listed below the listbox. To change the current filter, highlight the
desired filter. If you select Edit current filter, FDATool displays the currently selected
filter specifications. If you make any changes to the specifications, the stored filter is
updated immediately.

To cascade two or more filters, highlight the desired filters and press Cascade. A new
cascaded filter is added to the Filter Manager.

To change the name of a stored filter, press Rename. The Rename filter dialog box is
displayed.

To remove a stored filter from the Filter Manager, press Delete.

To export one or more filters to FVTool, highlight the filter(s) and press FVTool.

Saving and Opening Filter Design Sessions

You can save your filter design session as a MAT-file and return to the same session
another time.
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Select the Save session button E to save your session as a MAT-file. The first time
you save a session, a Save Filter Design File browser opens, prompting you for a session
name.

Sawe Filter Design File [ 2 | x|

Save in: Ia signal j il Ir

dey_utilz

fdatoolqui
zigdemos
sighal

zigaIc
sptoolgui

File nane: Iuntitled. fda

Save as lype: I".fda j Cancel |

For example, save this design session as TestFilter.fda in your current working
directory by typing TestFilter in the File name field.

The .fda extension is added automatically to all filter design sessions you save.

Note: You can also use the File > Save session and File > Save session as to save a
session.

You can load existing sessions into the Filter Design and Analysis Tool by selecting the

Open session button, E or File > Open session . A Load Filter Design File browser
opens that allows you to select from your previously saved filter design sessions.
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In this section...

“Import Filter Panel” on page 5-38

“Filter Structures” on page 5-39

Import Filter Panel

The Import Filter panel allows you to import a filter. You can access this region by
clicking the Import Filter button in the sidebar.

— Filter Coefficient

Filker Structure: Sampling Frequency:

| Direct form I transposed x| Mumerator [[0.028 0.0530.071 0.0530.028] Clear | Units' [Momalzed (0t 1] 7|
I Import as second-order-sections  D'enominator: |11 000 -2.026 2,148 -1.159 0.279) Clear | Fs: [Fs

Import Filker |

The imported filter can be in any of the representations listed in the Filter Structure
pull-down menu. You can import a filter as second-order sections by selecting the check
box.

Specify the filter coefficients in Numerator and Denominator, either by entering them
explicitly or by referring to variables in the MATLAB workspace.

Select the frequency units from the following options in the Units menu, and for any
frequency unit other than Normalized, specify the value or MATLAB workspace variable
of the sampling frequency in the F's field.

To import the filter, click the Import Filter button. The display region is automatically
updated when the new filter has been imported.

You can edit the imported filter using the Pole/Zero Editor panel.
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Filter Structures

The available filter structures are:
*  Direct Form, which includes direct-form I, direct-form II, direct-form I transposed,
direct-form II transposed, and direct-form FIR

+ Lattice, which includes lattice allpass, lattice MA min phase, lattice MA max phase,
and lattice ARMA

* Discrete—time Filter (dfi It object)

The structure that you choose determines the type of coefficients that you need to specify
in the text fields to the right.

Direct-form

For direct-form I, direct-form II, direct-form I transposed, and direct-form II transposed,
specify the filter by its transfer function representation

(22 LD +6@)27T +6@)2 7+ Hom + D2
a)+a@)z 7t +a3)Z3 +...an+1)z™"

* The Numerator field specifies a variable name or value for the numerator coefficient
vector b, which contains m+1 coefficients in descending powers of z.

* The Denominator field specifies a variable name or value for the denominator
coefficient vector a, which contains n+1 coefficients in descending powers of z. For FIR
filters, the Denominator is 1.

Filters in transfer function form can be produced by all of the Signal Processing Toolbox
filter design functions (such as Firl, Fir2, firpm, butter, yulewalk). See “Transfer
Function” on page 1-30 for more information.

Importing as second-order sections

For all direct-form structures, except direct-form FIR, you can import the filter in its
second-order section representation:

L -1 -2
H(Z):GH bOk +b1k2 +b2k2

1 2
k=1Qop TA1p2 = +agp2
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The Gain field specifies a variable name or a value for the gain G, and the SOS Matrix
field specifies a variable name or a value for the L-by-6 SOS matrix

bor b1 boy 1 app ag
by big bog 1 ajg agy
SOS =

bor, i bor 1 ay agp

whose rows contain the numerator and denominator coefficients b;, and a;;, of the second-
order sections of H(z).

Filters in second-order section form can be produced by functions such as tf2sos,
Zp2s0s, ss2s0s, and sosTilt. See “Second-Order Sections (SOS)” on page 1-33 for
more information.

Lattice

For lattice allpass, lattice minimum and maximum phase, and lattice ARMA filters,
specify the filter by its lattice representation:

+  For lattice allpass, the Lattice coeff field specifies the lattice (reflection) coefficients,
k(1) to k(N), where N is the filter order.

* For lattice MA (minimum or maximum phase), the Lattice coeff field specifies the
lattice (reflection) coefficients, K(1) to K(N), where N is the filter order.

+ For lattice ARMA, the Lattice coeff field specifies the lattice (reflection) coefficients,
k(1) to k(N), and the Ladder coeff field specifies the ladder coefficients, v(1) to
v(N+1), where N is the filter order.

Filters in lattice form can be produced by tf2latc. See “Lattice Structure” on page 1-34
for more information.

Discrete-time Filter (dfilt object)

For Discrete-time filter, specify the name of the dfi It object. See dfi It for more
information.



Statistical Signal Processing

The following chapter discusses statistical signal processing tools and applications,
including correlations, covariance, and spectral estimation.

“Correlation and Covariance” on page 6-2
“Spectral Analysis” on page 6-5
“Nonparametric Methods” on page 6-9
“Parametric Methods” on page 6-34
“Selected Bibliography” on page 6-47
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Correlation and Covariance

In this section...

“Background Information” on page 6-2
“Using xcorr and xcov Functions” on page 6-3
“Bias and Normalization” on page 6-3

“Multiple Channels” on page 6-4

Background Information
The cross-correlation sequence for two wide-sense stationary random process, x(n) and
y(n) is
R,,(m) = E{x(n+m)y (n)},
where the asterisk denotes the complex conjugate and the expectation is over the
ensemble of realizations that constitute the random processes.
Note that cross-correlation is not commutative, but a Hermitian (conjugate) symmetry
property holds such that:
*
The cross-covariance between x(n) and y(n) is:
* £
For zero-mean wide-sense stationary random processes, the cross-correlation and cross-
covariance are equivalent.

In practice, you must estimate these sequences, because it is possible to access only a
finite segment of the infinite-length random processes. Further, it is often necessary to
estimate ensemble moments based on time averages because only a single realization
of the random processes are available. A common estimate based on N samples of x(n)
and y(n) is the deterministic cross-correlation sequence (also called the time-ambiguity
function)
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N-m-1 .
R 2 x(n+m)y (n), m=0,
ny(m) = n=0

R;x(—m), m<0.

where we assume for this discussion that x(n) and y(n) are indexed from 0 to N — 1, and

Ry, (m) from (N —1) to N — 1.

Using xcorr and xcov Functions

The functions Xcorr and Xcov estimate the cross-correlation and cross-covariance
sequences of random processes. They also handle autocorrelation and autocovariance

as special cases. The xcorr function evaluates the sum shown above with an efficient
FFT-based algorithm, given inputs x(n) and y(n) stored in length N vectors X and y. Its
operation is equivalent to convolution with one of the two subsequences reversed in time.

For example:

x=[11111]";
y = X;
xyc = xcorr(X,y)

Notice that the resulting sequence length is one less than twice the length of the input
sequence. Thus, the Nth element is the correlation at lag 0. Also notice the triangular
pulse of the output that results when convolving two square pulses.

The xcov function estimates autocovariance and cross-covariance sequences. This

function has the same options and evaluates the same sum as xcorr, but first removes
the means of X and y.

Bias and Normalization

An estimate of a quantity is biased if its expected value is not equal to the quantity it
estimates. The expected value of the output of xcorr is

E{R, (m)} =(N ~|m]) Ry (m).



6 Sstafistical Signal Processing

Xcorr provides the unbiased estimate, dividing by N — | m| when you specify an
"unbiased"” flag after the input sequences.

xcorr(X,y, "unbiased”)

Although this estimate is unbiased, the end points (near —(/N — 1) and N — 1) suffer from
large variance because xcorr computes them using only a few data points. A possible
trade-off is to simply divide by N using the "biased” flag:

xcorr(x,y, "biased")

With this scheme, only the sample of the correlation at zero lag (the Nth output element)
is unbiased. This estimate is often more desirable than the unbiased one because it
avoids random large variations at the end points of the correlation sequence.

Xcorr provides one other normalization scheme. The syntax

xcorr(X,y, “coeff")

divides the output by norm(x)*norm(y) so that, for autocorrelations, the sample at zero
lagis 1.

Multiple Channels

For a multichannel signal, Xxcorr and xcov estimate the autocorrelation and cross-
correlation and covariance sequences for all of the channels at once. If S is an M-by-N
signal matrix representing N channels in its columns, Xxcorr(S) returns a (2M — 1)-

by-N? matrix with the autocorrelations and cross-correlations of the channels of S in its
N? columns. If S is a three-channel signal

S = [s1 s2 s3]
then the result of xcorr(S) is organized as
R = [Rslsl Rsls2 Rsl1ls3 Rs2sl Rs2s2 Rs2s3 Rs3sl Rs3s2 Rs3s3]

Two related functions, cov and corrcoef, are available in the standard MATLAB
environment. They estimate covariance and normalized covariance respectively between
the different channels at lag 0 and arrange them in a square matrix.
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Spectral Analysis

In this section...

“Background Information” on page 6-5

“Spectral Estimation Method” on page 6-6

Background Information

The goal of spectral estimation is to describe the distribution (over frequency) of the
power contained in a signal, based on a finite set of data. Estimation of power spectra is
useful in a variety of applications, including the detection of signals buried in wideband
noise.

The power spectral density (PSD) of a stationary random process x(n) is mathematically
related to the autocorrelation sequence by the discrete-time Fourier transform. In terms
of normalized frequency, this is given by

1 z -
P w) =— R m Jom .
xx( ) 2 xx( )e

m=—oo

This can be written as a function of physical frequency f (e.g., in hertz) by using the
relation o = 2mf / f;, where f, is the sampling frequency:

P.(f)= fl Y Ry (e 2miL,

The correlation sequence can be derived from the PSD by use of the inverse discrete-time
Fourier transform:

r £ .
R, . (m)= j Pxx(a))em’mda) = j Pxx(f)eﬂ”mf/fsdf_
- -f./2

The average power of the sequence x(n) over the entire Nyquist interval is represented by
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b5 f./2
R0 = [P (@do= [ P.(fdf.
- —f./2

The average power of a signal over a particular frequency band [w, @s], 0 < w1 < wy <m,
can be found by integrating the PSD over that band:

— , — Q.
Byw= le P, (@do= j_w: P, (o) do.

You can see from the above expression that P, (w) represents the power content of a
signal in an infinitesimal frequency band, which is why it is called the power spectral
density.

The units of the PSD are power (e.g., watts) per unit of frequency. In the case of P.(w),
this is watts/radian/sample or simply watts/radian. In the case of P.(f), the units are
watts/hertz. Integration of the PSD with respect to frequency yields units of watts, as
expected for the average power .

For real-valued signals, the PSD is symmetric about DC, and thus P, (®) for 0 <w < is
sufficient to completely characterize the PSD. However, to obtain the average power over
the entire Nyquist interval, it is necessary to introduce the concept of the one-sided PSD.

The one-sided PSD is given by

0, - <w<0,

Pone-sided(®) = {szx(w), 0<w<n.

The average power of a signal over the frequency band, [w1,w2] With 0 < w; < we <11, can
be computed using the one-sided PSD as

P @,
R0~ J.a, Ponesided (@d0.
1

Spectral Estimation Method

The various methods of spectrum estimation available in the toolbox are categorized as
follows:
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*  Nonparametric methods
* Parametric methods

*  Subspace methods

Nonparametric methods are those in which the PSD is estimated directly from the signal
itself. The simplest such method is the periodogram. Other nonparametric techniques
such as Welch's method [8], the multitaper method (MTM) reduce the variance of the
periodogram.

Parametric methods are those in which the PSD is estimated from a signal that is
assumed to be output of a linear system driven by white noise. Examples are the Yule-
Walker autoregressive (AR) method and the Burg method. These methods estimate

the PSD by first estimating the parameters (coefficients) of the linear system that
hypothetically generates the signal. They tend to produce better results than classical
nonparametric methods when the data length of the available signal is relatively short.
Parametric methods also produce smoother estimates of the PSD than nonparametric
methods, but are subject to error from model misspecification.

Subspace methods, also known as high-resolution methods or super-resolution methods,
generate frequency component estimates for a signal based on an eigenanalysis or
eigendecomposition of the autocorrelation matrix. Examples are the multiple signal
classification (MUSIC) method or the eigenvector (EV) method. These methods are best
suited for line spectra — that is, spectra of sinusoidal signals — and are effective in the
detection of sinusoids buried in noise, especially when the signal to noise ratios are low.
The subspace methods do not yield true PSD estimates: they do not preserve process
power between the time and frequency domains, and the autocorrelation sequence cannot
be recovered by taking the inverse Fourier transform of the frequency estimate.

All three categories of methods are listed in the table below with the corresponding
toolbox function names. More information about each function is on the corresponding
function reference page. See “Parametric Modeling” on page 7-17 for details about

Ipc and other parametric estimation functions.

Spectral Estimation Methods/Functions

Method Description Functions

Periodogram Power spectral density estimate | periodogram

Welch Averaged periodograms of pwelch, cpsd, tfestimate,
overlapped, windowed signal mscohere
sections
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Method

Description

Functions

Multitaper

Spectral estimate from

combination of multiple
orthogonal windows (or
“tapers”)

pmtm

Yule-Walker AR

Autoregressive (AR) spectral
estimate of a time-series from
its estimated autocorrelation
function

pyulear

Burg

Autoregressive (AR) spectral
estimation of a time-series
by minimization of linear
prediction errors

pburg

Covariance

Autoregressive (AR) spectral
estimation of a time-series by
minimization of the forward
prediction errors

pcov

Modified Covariance

Autoregressive (AR) spectral
estimation of a time-series by
minimization of the forward
and backward prediction errors

pmcov

MUSIC

Multiple signal classification

pmusic

Eigenvector

Pseudospectrum estimate

peig
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Nonparametric Methods

The following sections discuss the periodogram, modified periodogram, Welch, and
multitaper methods of nonparametric estimation, along with the related CPSD function,
transfer function estimate, and coherence function.

Periodogram

In general terms, one way of estimating the PSD of a process is to simply find the
discrete-time Fourier transform of the samples of the process (usually done on a grid with
an FFT) and appropriately scale the magnitude squared of the result. This estimate is
called the periodogram.

The periodogram estimate of the PSD of a length-L signal x7(n) is

P.(f)= 1 Iitlx (n)e—j27r}‘h/Fs ’
xx LFS = L ’

where F is the sampling frequency.

In practice, the actual computation of P, (f) can be performed only at a finite number of
frequency points, and usually employs an FFT. Most implementations of the periodogram
method compute the N-point PSD estimate at the frequencies

kF,
=% p=01,.,N-1.
fr N

In some cases, the computation of the periodogram via an FFT algorithm is more efficient
if the number of frequencies is a power of two. Therefore it is not uncommon to pad the
input signal with zeros to extend its length to a power of two.

As an example of the periodogram, consider the following 1001-element signal xn, which
consists of two sinusoids plus noise:

fs = 1000; % Sampling frequency
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t = (0:Fs)/Ts; % One second worth of samples
A=1[12]; % Sinusoid amplitudes (row vector)
f = [150;140]; % Sinusoid frequencies (column vector)

xn = A*sin(2*pi*f*t) + 0.1*randn(size(t));

Note The three last lines illustrate a convenient and general way to express the sum of
sinusoids.

Together they are equivalent to xn = sin(2*pi*150*t) + 2*sin(2*pi*140*t) +
O0.1*randn(size(t));

The periodogram estimate of the PSD can be computed using periodogram. In this case,
the data vector is multiplied by a Hamming window to produce a modified periodogram.

[Pxx,F] = periodogram(xn,hamming(length(xn)), length(xn),fs);
plot(F,10*1og10(Pxx))

xlabel ("Hz™)

ylabel ("dB")

title("Modified Periodogram Power Spectral Density Estimate®)
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Modified Periodogram Power Spectral Density Estimate
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Algorithm

Periodogram computes and scales the output of the FFT to produce the power vs.
frequency plot as follows. For a detailed example, see “Power Spectral Density Estimates
Using FFT” on page 12-2.

1 If the input signal is real-valued, the magnitude of the resulting FFT is symmetric
with respect to zero frequency (DC). For an even-length FFT, only the first
(1 + nFFt/2) points are unique. Determine the number of unique values and keep
only those unique points.

2 Take the squared magnitudes of the unique FFT values. Scale the squared
magnitudes (except for DC) by 2/(F;N), where N is the length of signal prior to any
zero padding. Scale the DC value by 1/(F,N).
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3 Create a frequency vector from the number of unique points, the nFft and the
sampling frequency.

4  Plot the resulting magnitude squared FFT against the frequency.

Performance of the Periodogram

The following sections discuss the performance of the periodogram with regard to the
issues of leakage, resolution, bias, and variance.

Spectral Leakage

Consider the PSD of a finite-length (length L) signal x7(n), as discussed in the
“Periodogram” on page 6-9 section. It is frequently useful to interpret xz(n) as the
result of multiplying an infinite signal, x(n), by a finite-length rectangular window,
wgr(n):

xr,(n) = x(n)wg ().

Because multiplication in the time domain corresponds to convolution in the frequency
domain, the expected value of the periodogram in the frequency domain is

. 2 _p
E{Pxx(f)}ZFlJ.FS/Z sin“(Lx(f —f)/ Fy)

P, (f"Hdf’,
“F2 Lsin®(n(f - )/ F,) o

showing that the expected value of the periodogram is the convolution of the true PSD
with the square of the Dirichlet kernel.

The effect of the convolution is best understood for sinusoidal data. Suppose that x(n) is
composed of a sum of M complex sinusoids:

N .
x(n) =Y Apel".
k=1

Its spectrum is
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N
X =Y Ad0-aw,),
k=1

which for a finite-length sequence becomes
ju N
X() = j 2 ApS(e—ay) Wr(w—¢)de.
V=

The preceding equation is equal to:

N
X(a)) = Z AkWR(a)— Cl)k)
k=1

So in the spectrum of the finite-length signal, the Dirac deltas have been replaced
by terms of the form Wg(w — ), which corresponds to the frequency response of a
rectangular window centered on the frequency w;.

The frequency response of a rectangular window has the shape of a sinc signal, as shown
below.

4]
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-80
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The plot displays a mainlobe and several sidelobes, the largest of which is approximately
13.5 dB below the mainlobe peak. These lobes account for the effect known as spectral
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leakage. While the infinite-length signal has its power concentrated exactly at the
discrete frequency points f;, the windowed (or truncated) signal has a continuum of
power “leaked” around the discrete frequency points f;.

Because the frequency response of a short rectangular window is a much poorer
approximation to the Dirac delta function than that of a longer window, spectral leakage
is especially evident when data records are short. Consider the following sequence of 100

samples:

fs = 1000; % Sampling frequency

t = (0:fs/10)/fs; % One-tenth second worth of samples
A =11 2]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

xn = A*sin(2*pi*f*t) + 0.1*randn(size(t));
[Pxx,F] = periodogram(xn,rectwin(length(xn)), length(xn),fs);
plot(F,10*1og10(Pxx))
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= ' 1 1
3 . U L I R LY . B
z ! : : : : : L
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It is important to note that the effect of spectral leakage is contingent solely on the
length of the data record. It is not a consequence of the fact that the periodogram is
computed at a finite number of frequency samples.

6-14



Nonparametric Methods

Resolution

Resolution refers to the ability to discriminate spectral features, and is a key concept on
the analysis of spectral estimator performance.

In order to resolve two sinusoids that are relatively close together in frequency, it is
necessary for the difference between the two frequencies to be greater than the width of
the mainlobe of the leaked spectra for either one of these sinusoids. The mainlobe width
is defined to be the width of the mainlobe at the point where the power is half the peak
mainlobe power (i.e., 3 dB width). This width is approximately equal to f; / L.

In other words, for two sinusoids of frequencies f; and f5, the resolvability condition
requires that

F,

fo-h >fs-

In the example above, where two sinusoids are separated by only 10 Hz, the data record
must be greater than 100 samples to allow resolution of two distinct sinusoids by a
periodogram.

Consider a case where this criterion is not met, as for the sequence of 67 samples below:

fs = 1000; % Sampling frequency
t = (0:fs/15)/fs; % 67 samples

A =11 2]; % Sinusoid amplitudes
f = [150;140]; % Sinusoid frequencies

xn = A*sin(2*pi*f*t) + 0.1*randn(size(t));
[Pxx,F] = periodogram(xn,rectwin(length(xn)), length(xn),fs);
plot(F,10*1og10(Pxx))
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The above discussion about resolution did not consider the effects of noise since the
signal-to-noise ratio (SNR) has been relatively high thus far. When the SNR is low, true
spectral features are much harder to distinguish, and noise artifacts appear in spectral
estimates based on the periodogram. The example below illustrates this:

fs = 1000; % Sampling frequency

t = (0:fs/10)/fs; % One-tenth second worth of samples
A=1[12]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

xn = A*sin(2*pi*f*t) + 2*randn(size(t));
[Pxx,F] = periodogram(xn,rectwin(length(xn)), length(xn),fs);
plot(F,10*1og10(Pxx))
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Bias of the Periodogram

The periodogram is a biased estimator of the PSD. Its expected value was previously
shown to be.

1 (F/2 sin?(Le(f —f)/ F,) " g
E{P,(f)} =— P (f)df".
! F;IE/ZLsinz(ﬂ(f—f')/Fs) Fd

The periodogram is asymptotically unbiased, which is evident from the earlier
observation that as the data record length tends to infinity, the frequency response of
the rectangular window more closely approximates the Dirac delta function. However, in
some cases the periodogram is a poor estimator of the PSD even when the data record is
long. This is due to the variance of the periodogram, as explained below.

Variance of the Periodogram

The variance of the periodogram can be shown to be

6-17



6 Sstafistical Signal Processing

6-18

P2.(f), 0<f<F,/2,

Var(P(f)={ "
2P, (f), f=0orf=F]/2,

which indicates that the variance does not tend to zero as the data length L tends to
infinity. In statistical terms, the periodogram is not a consistent estimator of the PSD.
Nevertheless, the periodogram can be a useful tool for spectral estimation in situations
where the SNR is high, and especially if the data record is long.

The Modified Periodogram

The modified periodogram windows the time-domain signal prior to computing the DFT
in order to smooth the edges of the signal. This has the effect of reducing the height of
the sidelobes or spectral leakage. This phenomenon gives rise to the interpretation of
sidelobes as spurious frequencies introduced into the signal by the abrupt truncation that
occurs when a rectangular window is used. For nonrectangular windows, the end points
of the truncated signal are attenuated smoothly, and hence the spurious frequencies
introduced are much less severe. On the other hand, nonrectangular windows also
broaden the mainlobe, which results in a reduction of resolution.

The periodogram allows you to compute a modified periodogram by specifying the
window to be used on the data. For example, compare a default rectangular window and
a Hamming window. Specify the same number of DFT points in both cases.

fs = 1000; % Sampling frequency

t = (0:fs/10)/fs; % One-tenth second worth of samples
A=1[12]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

nfft = 1024;

xn = A*sin(*pi*f*t) + 0.1*randn(size(t));
periodogram(xn, rectwin(length(xn)) ,nfft,fs)
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periodogram(xn,hamming(length(xn)) ,nfft,fs);
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You can verify that although the sidelobes are much less evident in the Hamming-
windowed periodogram, the two main peaks are wider. In fact, the 3 dB width of

the mainlobe corresponding to a Hamming window is approximately twice that of a
rectangular window. Hence, for a fixed data length, the PSD resolution attainable with a
Hamming window is approximately half that attainable with a rectangular window. The

competing interests of mainlobe width and sidelobe height can be resolved to some extent
by using variable windows such as the Kaiser window.

Nonrectangular windowing affects the average power of a signal because some of the
time samples are attenuated when multiplied by the window. To compensate for this,
periodogram and pwelch normalize the window to have an average power of unity.
This ensures that the measured average power is generally independent of window
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choice. If the frequency components are not well resolved by the PSD estimators, the
window choice does affect the average power.

The modified periodogram estimate of the PSD is

; X ()P
P (f) = ==,
))Il..llr} I__-:L[L.r

where U 1s the window normalization constant:

1.'\' 1
= 7 X |H'I:H}|3.

r=0

For large values of L, U tends to become independent of window length. The addition of
U as a normalization constant ensures that the modified periodogram is asymptotically
unbiased.

Welch's Method

An improved estimator of the PSD is the one proposed by Welch. The method consists of
dividing the time series data into (possibly overlapping) segments, computing a modified
periodogram of each segment, and then averaging the PSD estimates. The result is
Welch's PSD estimate. The toolbox function pwelch implements Welch's method.

The averaging of modified periodograms tends to decrease the variance of the estimate
relative to a single periodogram estimate of the entire data record. Although overlap
between segments introduces redundant information, this effect is diminished by the use
of a nonrectangular window, which reduces the importance or weight given to the end
samples of segments (the samples that overlap).

However, as mentioned above, the combined use of short data records and
nonrectangular windows results in reduced resolution of the estimator. In summary,
there is a tradeoff between variance reduction and resolution. One can manipulate the
parameters in Welch's method to obtain improved estimates relative to the periodogram,
especially when the SNR is low. This is illustrated in the following example.

Consider a signal consisting of 301 samples:
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fs = 1000; % Sampling frequency

t = (0:0.3*fs)/Ts; % 301 samples

A= [2 8]; % Sinusoid amplitudes (row vector)

T = [150;140]; % Sinusoid frequencies (column vector)

xn = A*sin(2*pi*f*t) + 5*randn(size(t));
periodogram(xn,rectwin(length(xn)),1024,fs)

Periodogram Power Spectral Density Estimate
'1D T T ” T T T T T T T

ot | ]

|
_‘]D ’
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Frequency (Hz)

We can obtain Welch's spectral estimate for 3 segments with 50% overlap using a
rectangular window.

pwelch(xn,rectwin(150),50,512,fs)
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In the periodogram above, noise and the leakage make one of the sinusoids essentially
indistinguishable from the artificial peaks. In contrast, although the PSD produced by
Welch's method has wider peaks, you can still distinguish the two sinusoids, which stand
out from the "noise floor."

However, if we try to reduce the variance further, the loss of resolution causes one of the
sinusoids to be lost altogether.

pwelch(xn,rectwin(100),75,512,fs)
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Bias and Normalization in Welch's Method

Welch's method yields a biased estimator of the PSD. The expected value of the PSD
estimate is:

1 (F/2

=17 Lo WG = PP Pt Fdf

E{Byeean ()}

where L is the length of the data segments, U is the same normalization constant present
in the definition of the modified periodogram, and W(f) is the Fourier transform of the
window function. As is the case for all periodograms, Welch's estimator is asymptotically
unbiased. For a fixed length data record, the bias of Welch's estimate is larger than that
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of the periodogram because the length of the segments is less than the length of the
entire data sample.

The variance of Welch's estimator is difficult to compute because it depends on both the
window used and the amount of overlap between segments. Basically, the variance is
inversely proportional to the number of segments whose modified periodograms are being
averaged.

Multitaper Method

The periodogram can be interpreted as filtering a length L signal, “L\™) through a filter
bank (a set of filters in parallel) of L FIR bandpass filters. The 3 dB bandwidth of each of

these bandpass filters can be shown to be approximately equal to Jo/ L The magnitude
response of each one of these bandpass filters resembles that of a rectangular window.
The periodogram can thus be viewed as a computation of the power of each filtered signal
(i.e., the output of each bandpass filter) that uses just one sample of each filtered signal

and assumes that the PSD of “L\"}is constant over the bandwidth of each bandpass
filter.

As the length of the signal increases, the bandwidth of each bandpass filter decreases,
making it a more selective filter, and improving the approximation of constant PSD
over the bandwidth of the filter. This provides another interpretation of why the PSD
estimate of the periodogram improves as the length of the signal increases. However,
there are two factors apparent from this standpoint that compromise the accuracy of
the periodogram estimate. First, the rectangular window yields a poor bandpass filter.
Second, the computation of the power at the output of each bandpass filter relies on a
single sample of the output signal, producing a very crude approximation.

Welch's method can be given a similar interpretation in terms of a filter bank. In Welch's
implementation, several samples are used to compute the output power, resulting in
reduced variance of the estimate. On the other hand, the bandwidth of each bandpass
filter is larger than that corresponding to the periodogram method, which results in

a loss of resolution. The filter bank model thus provides a new interpretation of the
compromise between variance and resolution.

Thompson's multitaper method (MTM) builds on these results to provide an improved
PSD estimate. Instead of using bandpass filters that are essentially rectangular windows
(as in the periodogram method), the MTM method uses a bank of optimal bandpass
filters to compute the estimate. These optimal FIR filters are derived from a set of
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sequences known as discrete prolate spheroidal sequences (DPSSs, also known as
Slepian sequences).

In addition, the MTM method provides a time-bandwidth parameter with which to
balance the variance and resolution. This parameter is given by the time-bandwidth
product, NW" and it is directly related to the number of tapers used to compute the
spectrum. There are always 2N I1 — 1 tapers used to form the estimate. This means that,
as WW increases, there are more estimates of the power spectrum, and the variance

of the estimate decreases. However, the bandwidth of each taper is also proportional

to NW, so as NW increases, each estimate exhibits more spectral leakage (i.e., wider
peaks) and the overall spectral estimate is more biased. For each data set, there 1s
usually a value for N1V that allows an optimal trade-off between bias and variance.

The Signal Processing Toolbox™ function that implements the MTM method is pmtm.
Use pmtm to compute the PSD of a signal.

fs = 1000; % Sampling frequency

t = (0:fs)/fs; % One second worth of samples
A =11 2]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

xn = A*sin(2*pi*f*t) + 0.1*randn(size(t));
pmtm(xn,4,[],fs)
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By lowering the time-bandwidth product, you can increase the resolution at the expense

of larger variance.

pmtm(xn,1.5,[],fs)

6-27



6 Sstafistical Signal Processing

Thomson Multitaper Power Spectral Density Estimate
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This method is more computationally expensive than Welch's method due to the cost of
computing the discrete prolate spheroidal sequences. For long data series (10,000 points
or more), it is useful to compute the DPSSs once and save them in a MAT-file. dpsssave,

dpssload, dpssdir, and dpssclear are provided to keep a database of saved DPSSs in
the MAT-file dpss.mat.

Cross-Spectral Density Function

The PSD is a special case of the cross spectral density (CPSD) function, defined between
two signals x(n) and y(n) as
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ny(o))zzi D ny(m)e_j‘”m.
T

m=—oo

As is the case for the correlation and covariance sequences, the toolbox estimates the PSD
and CPSD because signal lengths are finite.

To estimate the cross-spectral density of two equal length signals x and y using Welch's
method, the cpsd function forms the periodogram as the product of the FFT of x and the
conjugate of the FFT of y. Unlike the real-valued PSD, the CPSD is a complex function.
cpsd handles the sectioning and windowing of X and y in the same way as the pwelch
function:

Sxy = cpsd(x,y,nwin,noverlap,nfft,fs)

Transfer Function Estimate

One application of Welch's method is nonparametric system identification. Assume that
H is a linear, time invariant system, and x(n) and y(n) are the input to and output of H,
respectively. Then the power spectrum of x(n) is related to the CPSD of x(n) and y(n) by

Pyr(w) = H(w)Prz(w).

An estimate of the transfer function between x(n) and y(n) is

- P.(w
Hw) = — )

P (w)

This method estimates both magnitude and phase information. The tfestimate
function uses Welch's method to compute the CPSD and power spectrum, and then forms
their quotient for the transfer function estimate. Use tfestimate the same way that
you use the cpsd function.

Generate a signal consisting of two sinusoids embedded in white Gaussian noise.

rng(“default®)
fs = 1000; % Sampling frequency
t = (0:Fs)/Ts; % One second worth of samples
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A
f

[1 2]; % Sinusoid amplitudes
150;140]; % Sinusoid frequencies
q

xn = A*sin(2*pi*f*t) + 0.1*randn(size(t));

Filter the signal xn with an FIR moving-average filter. Compute the actual magnitude
response and the estimated response.

h = ones(1,10)/10; % Moving-average filter
yn = filter(h,1,xn);

[HEST,¥] = tfestimate(xn,yn,256,128,256,fs);
H = freqz(h,1,f,fs);

Plot the results.

subplot(2,1,1)

plot(f,abs(H))

title("Actual Transfer Function Magnitude®)
yl = ylim;

grid

subplot(2,1,2)

plot(f,abs(HEST))

title("Transfer Function Magnitude Estimate®)
xlabel ("Frequency (Hz)")

ylim(yl)

grid
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Coherence Function

The magnitude-squared coherence between two signals x(n) and y(n) is

| Poy(w)? |
'[Tr,.-.-J W] = ——————.
v(@) = B () Pyw)

This quotient is a real number between 0 and 1 that measures the correlation between
x(n) and y(n) at the frequency w.

The mscohere function takes sequences Xn and yn, computes their power spectra and
CPSD, and returns the quotient of the magnitude squared of the CPSD and the product
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of the power spectra. Its options and operation are similar to the cpsd and tfestimate
functions.

Generate a signal consisting of two sinusoids embedded in white Gaussian noise.

rng("default®)

fs = 1000; % Sampling frequency

t = (0:Ffs)/fs; % One second worth of samples
A =11 2]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

xn = A*sin(2*pi*f*t) + 0.1*randn(size(t));

Filter the signal xn with an FIR moving-average filter. Compute and plot the coherence
function of Xn and the filter output yn as a function of frequency.

h = ones(1,10)/10; % Moving-average fTilter
yn = filter(h,1,xn);

mscohere(xn,yn, 256,128,256, fs)

6-32



Nonparametric Methods

0.9

Magnitude
o o o o o o
a2 E= n [=3] | =]

=
[

0.1

Coherence Estimate via Welch

b ™

(

% ‘
]

Y

IW

e
| |I

B e il

50

100

150

200

250

300

Frequency (Hz)

350

400

450

500

If the input sequence length, window length, and number of overlapping data points in a
window are such that mscohere operates on only a single record, the function returns all

ones. This is because the coherence function for linearly dependent data is one.
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Parametric methods can yield higher resolutions than nonparametric methods in cases
when the signal length is short. These methods use a different approach to spectral
estimation; instead of trying to estimate the PSD directly from the data, they model the
data as the output of a linear system driven by white noise, and then attempt to estimate
the parameters of that linear system.

The most commonly used linear system model is the all-pole model, a filter with all of its
zeroes at the origin in the z-plane. The output of such a filter for white noise input is an
autoregressive (AR) process. For this reason, these methods are sometimes referred to as
AR methods of spectral estimation.

The AR methods tend to adequately describe spectra of data that is “peaky,” that is, data
whose PSD is large at certain frequencies. The data in many practical applications (such
as speech) tends to have “peaky spectra” so that AR models are often useful. In addition,
the AR models lead to a system of linear equations which is relatively simple to solve.

Signal Processing Toolbox AR methods for spectral estimation include:

* Yule-Walker AR method (autocorrelation method)
*  Burg method
+  Covariance method

* Modified covariance method

All AR methods yield a PSD estimate given by

€p

A 1

P(f)=— .
(f) 7 p . 5
1-Y a, (ke 72/ E,

k=1

The different AR methods estimate the parameters slightly differently, yielding different
PSD estimates. The following table provides a summary of the different AR methods.
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AR Methods
Burg Covariance Modified Yule-Walker
Covariance
Characteristics |Does not apply Does not apply Does not apply Applies window to
window to data window to data window to data data
Minimizes Minimizes the Minimizes Minimizes the
the forward forward prediction |the forward forward prediction
and backward error in the least |and backward error in the least
prediction errors |squares sense prediction errors |squares sense
in the least in the least
squares sense, squares sense (also called
with the AR “Autocorrelation
coefficients method”)
constrained to
satisfy the L-D
recursion
Advantages High resolution for | Better resolution |High resolution for | Performs as well
short data records [than Y-W for short data records |as other methods
short data records for large data
(more accurate records
estimates)
Always produces a |Able to extract Able to extract Always produces a
stable model frequencies from |frequencies from |stable model
data consisting data consisting
of p or more pure |of p or more pure
sinusoids sinusoids
Does not suffer
spectral line-
splitting
Disadvantages |Peak locations May produce May produce Performs
highly dependent |unstable models |unstable models |relatively poorly
on initial phase for short data
records

May suffer
spectral line-
splitting for
sinusoids in noise,

Frequency bias
for estimates of
sinusoids in noise

Peak locations
slightly dependent
on initial phase

Frequency bias
for estimates of
sinusoids in noise
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Burg Covariance Modified Yule-Walker
Covariance
or when order is
very large
Frequency bias Minor frequency
for estimates of bias for estimates
sinusoids in noise of sinusoids in
noise
Conditions for Order must be Order must be Because of
Nonsingularity less than or equal |less than or equal |the biased
to half the input |to 2/3 the input estimate, the
frame size frame size autocorrelation
matrix is
guaranteed to
positive-definite,
hence nonsingular
Yule-Walker AR Method

The Yule-Walker AR method of spectral estimation computes the AR parameters by
solving the following linear system, which give the Yule-Walker equations in matrix

form:

r(0)
r(1)

r(1)
r(0)

rip—1 r(p-2)

r*(p—l) a() r@)
o2 a(:2) _ r(:2) ‘
0 : :
ro a(p) r(p)

In practice, the biased estimate of the autocorrelation is used for the unknown true
autocorrelation.The Yule-Walker AR method produces the same results as a maximum
entropy estimator. For more information, see page 155 of item [2] in the “Selected
Bibliography” on page 6-47.

The use of a biased estimate of the autocorrelation function ensures that the
autocorrelation matrix above is positive definite. Hence, the matrix is invertible and

a solution is guaranteed to exist. Moreover, the AR parameters thus computed always
result in a stable all-pole model. The Yule-Walker equations can be solved efficiently via
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Levinson’s algorithm, which takes advantage of the Hermitian Toeplitz structure of the
autocorrelation matrix.

The toolbox function pyulear implements the Yule-Walker AR method. For example,
compare the spectrum of a speech signal using Welch's method and the Yule-Walker AR
method:

load mtlb
[Pxx,F] = pwelch(mtlb,hamming(256),128,1024,Fs);
plot(F,10*1og10(Pxx))

rgwes -ioix

File Edit Wiew Insert Tools Desktop Window Help

DEeE& hRAM®|E 0B |00

YWelch Power Spectral Density Estimate
<0 : : : : : : :

Powerfrequency (dB/Hz)

| i i i
0.s 1 15 2 248 3 348
Frequency (kHz)

order = 14;
[Pxx,F] = pyulear(mtlb,order,1024,fs);
plot(F,10*10g10(Pxx))

6-37



6 Sstafistical Signal Processing

6-38

-ioix
-

File Edit Wiew Insert Tools Desktop Window Help

DeES K RAM®|E 08|50

Yule-Walker Power Spectral Density Estimate
'20 T T T T T T T

Powerfrequency (dB/Hz)

| i i i i
0.s 1 15 2 248 3 348
Frequency (kHz)

]

The Yule-Walker AR spectrum is smoother than the periodogram because of the simple
underlying all-pole model.

Burg Method

The Burg method for AR spectral estimation is based on minimizing the forward

and backward prediction errors while satisfying the Levinson-Durbin recursion (see
Marple [3], Chapter 7, and Proakis [6], Section 12.3.3). In contrast to other AR estimation
methods, the Burg method avoids calculating the autocorrelation function, and instead
estimates the reflection coefficients directly.

The primary advantages of the Burg method are resolving closely spaced sinusoids in
signals with low noise levels, and estimating short data records, in which case the AR
power spectral density estimates are very close to the true values. In addition, the Burg
method ensures a stable AR model and is computationally efficient.

The accuracy of the Burg method is lower for high-order models, long data records, and
high signal-to-noise ratios (which can cause line splitting, or the generation of extraneous
peaks in the spectrum estimate). The spectral density estimate computed by the Burg
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method is also susceptible to frequency shifts (relative to the true frequency) resulting
from the initial phase of noisy sinusoidal signals. This effect is magnified when analyzing
short data sequences.

The toolbox function pburg implements the Burg method. Compare the spectrum of the
speech signal generated by both the Burg method and the Yule-Walker AR method. They
are very similar for large signal lengths:

load mtlb

order = 14;

[Pburg,F] = pburg(mtlb(1:512),o0rder,1024,fs);
plot(F,10*1og10(Pburg))

rgwes -ioix

File Edit Wiew Insert Tools Desktop Window Help
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[Pxx,F] = pyulear(mtlb(1:512),0RDER,1024,fs);
plot(F,10*10g10(Pxx))

6-39



6 Sstafistical Signal Processing

Drgwes -ioix

File Edit Wiew Insert Tools Desktop Window Help

DeES K RAM®|E 08|50

Yule-Walker Power Spectral Density Estimate
'20 T T T T T T T

Powerfrequency (dB/Hz)

| i i i i
0.s 1 15 2 248 3 348
Frequency (kHz)

]

Compare the spectrum of a noisy signal computed using the Burg method and the Welch

method:

fs = 1000; % Sampling frequency

t = (0:Fs)/Ts; % One second worth of samples
A=1[12]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

xn = A*sin(@*pi*f*t) + 0.1*randn(size(t));
pwelch(xn,hamming(256),128,1024,fs)
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pburg(xn, 14,1024 ,fs)
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Note that, as the model order for the Burg method is reduced, a frequency shift due to
the initial phase of the sinusoids will become apparent.

Covariance and Modified Covariance Methods

The covariance method for AR spectral estimation is based on minimizing the forward
prediction error. The modified covariance method is based on minimizing the forward
and backward prediction errors. The toolbox functions pcov and pmcov implement the
respective methods.

Compare the spectrum of the speech signal generated by both the covariance method and
the modified covariance method. They are nearly identical, even for a short signal length:

load mtlb
pcov(mtlb(1:64),14,1024,Fs)
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pmcov(mtlb(1:64),14,1024,fs)
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MUSIC and Eigenvector Analysis Methods

The pmusic function and peig functions provide two related spectral analysis methods:

*  pmusic provides the multiple signal classification (MUSIC) method developed by
Schmidt

* peig provides the eigenvector (EV) method developed by Johnson

Both of these methods are frequency estimator techniques based on eigenanalysis of the
autocorrelation matrix. This type of spectral analysis categorizes the information in a
correlation or data matrix, assigning information to either a signal subspace or a noise
subspace.

Eigenanalysis Overview

Consider a number of complex sinusoids embedded in white noise. You can write the
autocorrelation matrix R for this system as the sum of the signal autocorrelation matrix
(S) and the noise autocorrelation matrix (W):
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R =S+ W. There is a close relationship between the eigenvectors of the signal
autocorrelation matrix and the signal and noise subspaces. The eigenvectors v of S

span the same signal subspace as the signal vectors. If the system contains M complex
sinusoids and the order of the autocorrelation matrix is p, eigenvectors vy, through vy,
span the noise subspace of the autocorrelation matrix.

Frequency Estimator Functions

To generate their frequency estimates, eigenanalysis methods calculate functions of

the vectors in the signal and noise subspaces. Both the MUSIC and EV techniques
choose a function that goes to infinity (denominator goes to zero) at one of the sinusoidal
frequencies in the input signal. Using digital technology, the resulting estimate has
sharp peaks at the frequencies of interest; this means that there might not be infinity
values in the vectors.

The MUSIC estimate is given by the formula

S 1
Pyusic(H = —;

z ‘e(f)Hvk‘g ’

k=p+1

where the v, are the eigenvectors of the noise subspace and e(f) is a vector of complex
sinusoids:

Here v represents the eigenvectors of the input signal's correlation matrix; v, is the kth
eigenvector. H is the conjugate transpose operator. The eigenvectors used in the sum
correspond to the smallest eigenvalues and span the noise subspace (p is the size of the
signal subspace).

The expression e(f)" vy, is equivalent to a Fourier transform (the vector e(f) consists of
complex exponentials). This form is useful for numeric computation because the FFT can

be computed for each v, and then the squared magnitudes can be summed.

The EV method weights the summation by the eigenvalues of the correlation matrix:
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Bey(f)= M#z
> [,
k=p+1

The pmusic and peig functions in this toolbox interpret their first input either as a
signal matrix or as a correlation matrix (if the "corr” input flag is set). In the former
case, the singular value decomposition of the signal matrix is used to determine the
signal and noise subspaces. In the latter case, the eigenvalue decomposition of the
correlation matrix is used to determine the signal and noise subspaces.
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Windows
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In this section...

“Why Use Windows?” on page 7-2

“Basic Shapes” on page 7-3

“Available Window Functions” on page 7-2

“Graphical User Interface Tools” on page 7-3

Why Use Windows?

In both digital filter design and spectral estimation, the choice of a windowing function
can play an important role in determining the quality of overall results. The main role
of the window is to damp out the effects of the Gibbs phenomenon that results from

truncation of an infinite series.

Available Window Functions

Window Function
Bartlett-Hann window barthannwin
Bartlett window bartlett
Blackman window blackman
Blackman-Harris window blackmanharris
Bohman window bohmanwin
Chebyshev window chebwin

Flat Top window flattopwin
Gaussian window gausswin
Hamming window hamming
Hann window hann

Kaiser window kaiser

Nuttall's Blackman-Harris window

nuttallwin




Windows

Window Function
Parzen (de la Vallée-Poussin) window parzenwin
Rectangular window rectwin
Tapered cosine window tukeywin
Triangular window triang

Graphical User Interface Tools

Two graphical user interface tools are provided for working with windows in the Signal
Processing Toolbox product:

* Window Design and Analysis Tool (wintool)

+ Window Visualization Tool (wvtool)

Refer to the reference pages for these tools for detailed information.

Basic Shapes

The basic window is the rectangular window, a vector of ones of the appropriate length. A
rectangular window of length 50 is

n
w

50;
rectwin(n);

This toolbox stores windows in column vectors by convention, so an equivalent expression
s

w = ones(50,1);
To use the Window Design and Analysis Tool to create this window, type
wintool

wintool opens with a default Hamming window. In the Current Window Information
panel, set Type = Rectangular and Length = 50 and then press Apply.
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File View Tools Window Help L]

D&ER|(D @< O Ee

Window Viewer

Time domain Frequency domain

Amplitude
=
=
Magnitude [dB)

=
=

=
P

10 20 30 40 50 0 0.2 0.4 0.6 0.8
Samples ized Fi {7 radisamp
Leakage Factor: 9.25 % Relative sidelobe attenuation: -13.3 dB Mainlobe width (-3dB): 0.035156

Window List Current Window Information

Select windows to display: MName: window _1 | -

Add a new window Type: Rectangular

Copy window Length: -
[ ]

Apply

Save to workspace

&
&

The Bartlett (or triangular) window is the convolution of two rectangular windows.

The functions bartlett and triang compute similar triangular windows, with three
important differences. The bartlett function always returns a window with two zeros
on the ends of the sequence, so that for n odd, the center section of bartlett(n+2) is
equivalent to triang(n):

Bartlett = bartlett(7);
isequal(Bartlett(2:end-1),triang(5))

ans =
1

7-4



Windows

For n even, bartlett is still the convolution of two rectangular sequences. There is no
standard definition for the triangular window for n even; the slopes of the line segments
of the triang result are slightly steeper than those of bartlett in this case:

w = bartlett(8);
[w(2:7) triang(6)]

You can see the difference between odd and even Bartlett windows in WinTool.

ra ™

File View Tools Window Help L]

DaR| D &<« id B

Window Viewer

Time domain Frequency domain

Amplitude
Magnitude [dB)

2 3 4 5 7 8 0 0.2 0.4 0.6 0.8
Samples Normalized Frequency (== rad/sample)
Leakage Factor: 0.28 % Relative sidelobe attenuation: -25.2 dB Mainlobe width (-3dB): 0.36719
Window List Current Window Information

Select windows to display: MName: Bartlett_&

Add a new window Type: Bartlett

Copy window

Save to workspace

Symmetric

&
&

Apply

The final difference between the Bartlett and triangular windows is evident in the
Fourier transforms of these functions. The Fourier transform of a Bartlett window is
negative for n even. The Fourier transform of a triangular window, however, is always
nonnegative.
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The following figure, which plots the zero-phase responses of 8-point Bartlett and
Triangular windows, illustrates the difference.

zerophase(bartlett(8))

hold on

zerophase(triang(8))
legend("Bartlett”, "Triangular®)
axis([0.3 1 -0.2 0.5]D)

u Figure 3 =RRE X
File Edit View Insert Tools Desktop Window Help k]
NEde |k ARRODLRL- 2| 01E v
Zero-phase response
0.5 T T T T T T T
\ Bartlett
| 1 Triangular
0.4} . il
0.3} i
II|
S o2t \ = i
= \ .
= \ ",
01 e \\ E
\ \ \
\.\. ‘\\
- Y
0} X
'\\\
O01F . 4
_DZ | | | | | |
0.3 0.4 0.5 0.6 0.7 0.8 0.9 1
Normalized Frequency ( = « rad/sample)

A

This difference can be important when choosing a window for some spectral estimation
techniques, such as the Blackman-Tukey method. Blackman-Tukey forms the spectral
estimate by calculating the Fourier transform of the autocorrelation sequence. The

resulting estimate might be negative at some frequencies if the window's Fourier
transform is negative (see Kay [1], pg. 80).
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Generalized Cosine Windows

Blackman, flat top, Hamming, Hann, and rectangular windows are all special cases of
the generalized cosine window. These windows are combinations of sinusoidal sequences
with frequencies that are multiples of 2r/(N — 1), where N is the window length. One
special case is the Blackman window:

N = 128;

A = 0.42;

B = 0.5;

C = 0.08;

ind = (0:N-1)"*2*pi/(N-1);

w = A - B*cos(ind) + C*cos(2*ind);

Changing the values of the constants A, B, and C in the previous expression generates
different generalized cosine windows like the Hamming and Hann windows. Adding
additional cosine terms of higher frequency generates the flat top window. The concept
behind these windows is that by summing the individual terms to form the window,
the low frequency peaks in the frequency domain combine in such a way as to decrease
sidelobe height. This has the side effect of increasing the mainlobe width.

The Hamming and Hann windows are two-term generalized cosine windows, given by
A=0.54,B=0.46 for the Hamming and A=0.5, B=0.5 for the Hann.

Note that the definition of the generalized cosine window shown in the earlier MATLAB
code yields zeros at samples 1 and n for A=0.5and B=0.5.

This WinTool screen shot compares Blackman, Hamming, Hann, and Flat Top windows.
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p
. Window Design & Analysis Tool

File View Tools Window Help

DaR| D &<« id B

Viewer

Time domain

Amplitude

Frequency domain

Magnitude [dB)
g

e Hamming
Blackman

—— Hamn

Delete

|

=100
.02 . . . . . . 150
10 20 30 40 50 60 0 0.4 0.6 0.8
Samples d Fi (= radisamph
Leakage Factor: 0.03 % Relative sidelobe attenuation: -42.5 dB Mainlobe width (-3dB): 0.039063
List r~Current Information
Select windows to display: Name: Hamming | -
e Hamming |~
MATLAB code:
Copy window Length:
Parameter: l:l
Parameter2: l:l

Apply
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Kaiser Window

The Kaiser window is an approximation to the prolate-spheroidal window, for which the
ratio of the mainlobe energy to the sidelobe energy is maximized. For a Kaiser window
of a particular length, the parameter f controls the sidelobe height. For a given g, the
sidelobe height is fixed with respect to window length. The statement kaiser(n,beta)
computes a length n Kaiser window with parameter beta.

Examples of Kaiser windows with length 50 and £ parameters of 1, 4, and 9 are shown in
this wintool example.

B Window Design & Analysis Toal |ﬂl

File View Tools Window Help L]

I EIECEY =S

Window Viewer
Time demain Frequency doemain

B/

\ \ | W"[L fy ]lf 0y |Jf(‘u”\“f

Amplitude
Magnitude [dB)
&

N -100

02t \
b
0 L= L : -150
30 40 50 0 0.2 0.4 0.6 0.8
Samples Normalized Frequency (== rad/sample)
Leakage Factor: 6.47 % Relative sidelobe attenuation: -14.7 dB Mainlobe width (-3dB): 0.035156
Window List Current Window Information
Select windows to display: Name: Kaizer! v'
Kaiser1 - . : 1
Kaiser4 Type: Kaiser =)
Lengtn: 50
Beta: 1
Save to workspace
Symmetric

To create these Kaiser windows using the MATLAB command line, type the following:

n = 50;
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kaiser(n,1);

kaiser(n,4);

kaiser(n,9);
freqz(wl/sum(wl),1,512,2);

[w2,f] freqz(w2/sum(w2),1,512,2);

[w3,f] freqz(w3/sum(w3),1,512,2);
plot(f,20*1ogl0(abs([W1 W2 W3])))

grid

legend("\beta = 1","\beta = 47,"\beta = 97)

wl
w2
w3

[wi,f]

7-10
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|"|

-Figureﬁ- |':'|IEI| 2
File Edit View Inset Tools Desktop Window Help &

A IR AN E Y

0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1

As f increases, the sidelobe height decreases and the mainlobe width increases.
This WinTool screen shot shows how the sidelobe height stays the same for a fixed g
parameter as the length is varied.
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File View Tools Window Help L]

DaR| D &<« id B

rWindow Viewer

Time domain Frequency domain

— gisa 150
Kaisar20
Kaisar101

Amplitude
Magnitude [dB)

B0 100 1] 0.2 . . 0.8

Leakage Factor: 0.11 % Relative sidelobe attenuation: -30.8 dB Mainlobe width (-3dB): 0.045875

Window List r~Current Window Information

Select windows to display:

Kaisers0 | =

Add a new window E Kaiser ~

Copy window : -

: T
Save to workspace ar l:l

Apply

&
&

To create these Kaiser windows using the MATLAB command line, type the following:
wl kaiser(50,4);

w2 kaiser(20,4);

w3 kaiser(101,4);

[wi,f] freqz(wl/sum(wl),1,512,2);

w2,¥] freqz(w2/sum(w2),1,512,2);

[w3,f] freqz(w3/sum(w3),1,512,2);
plot(f,20*1ogl0(abs([W1 W2 W31)))

grid

legend("length = 50°,"length = 20", "length = 101%)
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Kaiser Windows in FIR Design

parameter is

There are two design formulas that can help you design FIR filters to meet a set of filter

specifications using a Kaiser window. To achieve a sidelobe height of —a dB, the fbeta
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0.1102(c —8.7), o > 50,
B=10.5842(ct —21)°* +0.07886(cx —21), 50 > > 21,
0, a<21.

For a transition width of Aw rad/sample, use the length

a-8
n=—w-H—H——
2.285Aw

Filters designed using these heuristics will meet the specifications approximately, but
you should verify this. To design a lowpass filter with cutoff frequency 0.5 rad/sample,
transition width 0.2 rad/sample, and 40 dB of attenuation in the stopband, try

[n,wn,beta] = kaiserord([0.4 0.6]*pi,[1 0],[0-01 0.01],2*pi);
h = firl(n,wn,kaiser(n+l,beta), "noscale®);

The kaiserord function estimates the filter order, cutoff frequency, and Kaiser window
beta parameter needed to meet a given set of frequency domain specifications.

The ripple in the passband is roughly the same as the ripple in the stopband. As you can
see from the frequency response, this filter nearly meets the specifications:

fvtool(h,1)



Kaiser Window
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Chebyshev Window

The Chebyshev window minimizes the mainlobe width, given a particular sidelobe
height. It is characterized by an equiripple behavior, that is, its sidelobes all have the
same height.

B Window Design & Analysis Toal |ﬂl
File View Tools Window Help L]
Dal| D a<w ddEw
Window Viewer
Time demain n Frequency doemain
i —
o[\ ]
\
08} '|I
@ O | 1
3 = AAAAAN A A f\
206} @ f \ A N
g g0 r""n VAV '|p'(‘"'rl'r'ri
. T
o
04l = |
02} 60 )
0 . . . L 80 . . . .
10 20 30 40 50 0 0.2 0.4 0.6 0.8
Samples Normalized Frequency (== rad/sample)
Leakage Factor: 0.18 % Relative sidelobe attenuation: -40 dB Mainlobe width (-3dB): 0.046875
Window List Current Window Information
Select windows to display: Name: Chebyshev v'
Chebyshev - 1
Type: Chebyshev v
Length: 50
Sidelobe Atten: 40
Save to workspace
Symmetric
i Apply
\ J

As shown in the Time Domain plot, the Chebyshev window has large spikes at its outer
samples.
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Parametric Modeling

In this section...

“What is Parametric Modeling” on page 7-17
“Available Parametric Modeling Functions” on page 7-17

“Time-Domain Based Modeling” on page 7-18

“Frequency-Domain Based Modeling” on page 7-21

What is Parametric Modeling

Parametric modeling techniques find the parameters for a mathematical model
describing a signal, system, or process. These techniques use known information about
the system to determine the model. Applications for parametric modeling include
speech and music synthesis, data compression, high-resolution spectral estimation,
communications, manufacturing, and simulation.

Available Parametric Modeling Functions

The toolbox parametric modeling functions operate with the rational transfer function
model. Given appropriate information about an unknown system (impulse or frequency
response data, or input and output sequences), these functions find the coefficients of a
linear system that models the system.

One important application of the parametric modeling functions is in the design of filters
that have a prescribed time or frequency response.

Here is a summary of the parametric modeling functions in this toolbox.

Domain Functions Description

Time arburg Generate all-pole filter coefficients that model an
input data sequence using the Levinson-Durbin
algorithm.

arcov Generate all-pole filter coefficients that model an
input data sequence by minimizing the forward
prediction error.
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Domain Functions Description

armcov Generate all-pole filter coefficients that model an
input data sequence by minimizing the forward
and backward prediction errors.

aryule Generate all-pole filter coefficients that model
an input data sequence using an estimate of the
autocorrelation function.

Ipc, levinson Linear Predictive Coding. Generate all-pole
recursive filter whose impulse response matches a
given sequence.

prony Generate IIR filter whose impulse response
matches a given sequence.
stmcb Find IIR filter whose output, given a specified
input sequence, matches a given output sequence.
Frequency invfreqz, Generate digital or analog filter coefficients given
invfreqgs complex frequency response data.

Time-Domain Based Modeling

The Ipc, prony, and stmcb functions find the coefficients of a digital rational transfer
function that approximates a given time-domain impulse response. The algorithms differ
in complexity and accuracy of the resulting model.

Linear Prediction

Linear prediction modeling assumes that each output sample of a signal, x(k), is a

linear combination of the past n outputs (that is, it can be linearly predicted from these
outputs), and that the coefficients are constant from sample to sample:

k) = —a@xk -1l —aBxk-2y- . —an+ Lixk-n)

An nth-order all-pole model of a signal X is
a = lIpc(x,n)

To illustrate Ipc, create a sample signal that is the impulse response of an all-pole filter
with additive white noise:
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x = impz(1,[1 0.1 0.1 0.1 0.1],10) + randn(10,1)/10;
The coefficients for a fourth-order all-pole filter that models the system are
a = lpc(x,4)

Ipc first calls xcorr to find a biased estimate of the correlation function of x, and then
uses the Levinson-Durbin recursion, implemented in the levinson function, to find
the model coefficients a. The Levinson-Durbin recursion is a fast algorithm for solving a
system of symmetric Toeplitz linear equations. IpcC's entire algorithm for n = 4 is

r = xcorr(x);
r(1:length(x)-1) = []; % Remove corr. at negative lags
a = levinson(r,4)

You could form the linear prediction coefficients with other assumptions by passing a
different correlation estimate to levinson, such as the biased correlation estimate:

r = xcorr(x, "biased”);
r(1:length(>x)-1) = [1; % Remove corr. at negative lags
a = levinson(r,4)

Prony's Method (ARMA Modeling)

The prony function models a signal using a specified number of poles and zeros. Given a
sequence X and numerator and denominator orders n and m, respectively, the statement

[b,a] = prony(x,n,m)

finds the numerator and denominator coefficients of an IIR filter whose impulse response
approximates the sequence X.

The prony function implements the method described in [4] Parks and Burrus

(pgs. 226-228). This method uses a variation of the covariance method of AR modeling to
find the denominator coefficients a, and then finds the numerator coefficients b for which
the resulting filter's impulse response matches exactly the first n + 1 samples of x. The
filter is not necessarily stable, but it can potentially recover the coefficients exactly if the
data sequence is truly an autoregressive moving-average (ARMA) process of the correct
order.

Note The functions prony and stmcb (described next) are more accurately described as
ARX models in system identification terminology. ARMA modeling assumes noise only
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at the inputs, while ARX assumes an external input. prony and stmcb know the input
signal: it is an impulse for prony and is arbitrary for stmcb.

A model for the test sequence X (from the earlier Ipc example) using a third-order ITR
filter is

[b,a] = prony(x,3,3)

The impz command shows how well this filter's impulse response matches the original
sequence:

format long
[x impz(b,a,10)]

Notice that the first four samples match exactly. For an example of exact recovery,
recover the coefficients of a Butterworth filter from its impulse response:

[b,a] = butter(4,.2);
h = impz(b,a,26);
[bb,aa] = prony(h,4,4);

Try this example; you'll see that bb and aa match the original filter coefficients to within
a tolerance of 1072,

Steiglitz-McBride Method (ARMA Modeling)

The stmcb function determines the coefficients for the system b(z)/a(z) given an
approximate impulse response X, as well as the desired number of zeros and poles. This
function identifies an unknown system based on both input and output sequences that
describe the system's behavior, or just the impulse response of the system. In its default
mode, stmcb works like prony.

[b,a] = stmcb(x,3,3)
stmcb also finds systems that match given input and output sequences:

y = filter(d,[1 1].%x); % Create an output signal.
[b,a] = stmcb(y,x,0,1)

In this example, stmcb correctly identifies the system used to create y from x.

The Steiglitz-McBride method is a fast iterative algorithm that solves for the numerator
and denominator coefficients simultaneously in an attempt to minimize the signal error
between the filter output and the given output signal. This algorithm usually converges
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rapidly, but might not converge if the model order is too large. As for prony, stmcb's
resulting filter is not necessarily stable due to its exact modeling approach.

stmcb provides control over several important algorithmic parameters; modify these
parameters if you are having trouble modeling the data. To change the number of
iterations from the default of five and provide an initial estimate for the denominator
coefficients:

n 10; % Number of iterations
a Ipc(x,3); % Initial estimates for denominator
[b,a] = stmcb(x,3,3,n,a);

The function uses an all-pole model created with prony as an initial estimate when you
do not provide one of your own.

To compare the functions Ipc, prony, and stmcb, compute the signal error in each case:

al = Ipc(x,3);

[b2,a2] = prony(x,3,3);

[b3,a3] = stmcb(x,3,3);

[x-impz(1,al,10) x-impz(b2,a2,10) x-impz(b3,a3,10)]

In comparing modeling capabilities for a given order ITR model, the last result shows
that for this example, stmcb performs best, followed by prony, then Ipc. This relative
performance is typical of the modeling functions.

Frequency-Domain Based Modeling

The invFfreqgs and invfreqz functions implement the inverse operations of freqs and
freqz; they find an analog or digital transfer function of a specified order that matches
a given complex frequency response. Though the following examples demonstrate
invfreqz, the discussion also applies to invfregs.

To recover the original filter coefficients from the frequency response of a simple digital
filter:

[b,a] butter(4,0.4) % Design Butterworth lowpass
[h,w] freqz(b,a,64); % Compute frequency response
[b4,a4] = invfreqz(h,w,4,4) % Model: n =4, m = 4

The vector of frequencies w has the units in rad/sample, and the frequencies need not be
equally spaced. invfreqz finds a filter of any order to fit the frequency data; a third-
order example is

7-21



7 Special Topics

7-22

[b4,a4] = invfreqz(h,w,3,3) % Find third-order 1IR

Both invfreqs and invfregz design filters with real coefficients; for a data point at
positive frequency T, the functions fit the frequency response at both f and -F.

By default invfreqz uses an equation error method to identify the best model from the
data. This finds b and a in

n
min Y wiik)|hik)Alwik)) - Bluw(k)|?
b,a
T h=1

by creating a system of linear equations and solving them with the MATLAB \ operator.
Here A(w(k)) and B(w(k)) are the Fourier transforms of the polynomials a and b

respectively at the frequency w(k), and n is the number of frequency points (the length of
h and w). wi(k) weights the error relative to the error at different frequencies. The syntax

invfreqz(h,w,n,m,wt)

includes a weighting vector. In this mode, the filter resulting from invfreqz is not
guaranteed to be stable.

invfreqz provides a superior (“output-error”’) algorithm that solves the direct problem of
minimizing the weighted sum of the squared error between the actual frequency response
points and the desired response

n
2
min ¥ wt[k;‘h[k}—M‘
b,ak=1

Aok
To use this algorithm, specify a parameter for the iteration count after the weight vector
parameter:

wt = ones(size(W)); % Create unity weighting vector
[b30,a30] = invfreqz(h,w,3,3,wt,30) % 30 iterations

The resulting filter is always stable.

Graphically compare the results of the first and second algorithms to the original
Butterworth filter with FVTool (and select the Magnitude and Phase Responses):

fvtool(b,a,b4,a4,b30,a30)
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.} Figure No. 1: Filter Yisualization Tool - Magnitude (dB) and Phasé 10l =l
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To verify the superiority of the fit numerically, type

sum(abs(h-freqz(b4,a4,w)) ."2) % Total error, algorithm 1
sum(abs(h-freqz(b30,a30,w))-~2) % Total error, algorithm 2
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Resampling
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In this section...

“Available Resampling Functions” on page 7-24
“resample Function” on page 7-24
“decimate and interp Functions” on page 7-25

“upfirdn Function” on page 7-26

“spline Function” on page 7-26

Available Resampling Functions

The toolbox provides a number of functions that resample a signal at a higher or lower
rate.

Operation Function
Apply FIR filter with resampling |upFirdn
Cubic spline interpolation spline
Decimation decimate
Interpolation interp
Other 1-D interpolation interpl
Resample at new rate resample

resample Function

The resample function changes the sampling rate for a sequence to any rate that is a
ratio of two integers. The basic syntax for resample is

y = resample(x,p,q)

where the function resamples the sequence X at p/q times the original sampling rate.
The length of the result y is p/q times the length of x.

One resampling application is the conversion of digitized audio signals from one
sampling rate to another, such as from 48 kHz (the digital audio tape standard) to 44.1
kHz (the compact disc standard).



Resampling

The example file contains a length 4001 vector of speech sampled at 7418 Hz:

clear

load mtlb

whos

Name Size Bytes Class
Fs 1x1 8 double array
mtlb 4001x1 32008 double array

Grand total is 4002 elements using 32016 bytes

Fs

Fs =

7418

To play this speech signal on a workstation that can only play sound at 8192 Hz, use the
rat function to find integers p and q that yield the correct resampling factor:

[p.q] = rat(8192/Fs,0.0001)
p =
127
q =
115
Since p/q*Fs = 8192.05 Hz, the tolerance of 0.0001 is acceptable; to resample the
signal at very close to 8192 Hz:

y = resample(mtlb,p,q);

resample applies a lowpass filter to the input sequence to prevent aliasing during
resampling. It designs this filter using the Firls function with a Kaiser window. The
syntax

resample(X,p,q,1,beta)

controls the filter's length and the beta parameter of the Kaiser window. Alternatively,
use the function IntFilt to design an interpolation filter b and use it with

resample(x,p,q,b)

decimate and interp Functions

The decimate and interp functions do the same thing as resample with p =1 and

q = 1, respectively. These functions provide different anti-alias filtering options, and
they incur a slight signal delay due to filtering. The interp function is significantly less
efficient than the resample function with q = 1.
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upfirdn Function

The toolbox also contains a function, upfirdn, that applies an FIR filter to an input
sequence and outputs the filtered sequence at a sample rate different than its original.
See “Multirate Filter Bank Implementation” on page 1-8.

spline Function

The standard MATLAB environment contains a function, spline, that works with
irregularly spaced data. The MATLAB function interpl performs interpolation, or table
lookup, using various methods including linear and cubic interpolation.



Cepstrum Analysis

Cepstrum Analysis
What Is a Cepstrum?

Cepstrum analysis is a nonlinear signal processing technique with a variety of
applications in areas such as speech and image processing.

The complex cepstrum of a sequence x is calculated by finding the complex natural

logarithm of the Fourier transform of x, then the inverse Fourier transform of the
resulting sequence:

|7
= — [ log
2r J_»

The toolbox function cceps performs this operation, estimating the complex cepstrum for
an input sequence. It returns a real sequence the same size as the input sequence.

X (&))" dw.

Try using cceps in an echo detection application. First, create a 45 Hz sine wave sampled
at 100 Hz. Add an echo of the signal, with half the amplitude, 0.2 seconds after the
beginning of the signal.

t = 0:0.01:1.27;
sl = sin(2*pi*45*t);
s2 sl + 0.5*[zeros(1,20) s1(1:108)]:

Compute and plot the complex cepstrum of the new signal.

c = cceps(s2);
plot(t,c)
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The complex cepstrum shows a peak at 0.2 seconds, indicating the echo.

The real cepstrum of a signal x, sometimes called simply the cepstrum, is calculated
by determining the natural logarithm of magnitude of the Fourier transform of x, then
obtaining the inverse Fourier transform of the resulting sequence:

X ()| " duw.

Cp = — log

il =

The toolbox function rceps performs this operation, returning the real cepstrum for

a sequence. The returned sequence is a real-valued vector the same size as the input
vector.



Cepstrum Analysis

The rceps function also returns a unique minimum-phase sequence that has the same
real cepstrum as the input. To obtain both the real cepstrum and the minimum-phase
reconstruction for a sequence, use [y,ym] = rceps(x), where y is the real cepstrum
and ym is the minimum phase reconstruction of X. The following example shows that one
output of rceps is a unique minimum-phase sequence with the same real cepstrum as X.

y = [4 15]; % Non-minimum phase sequence
[xhat,yhat] = rceps(y);
xhat2= rceps(yhat);
[xhat® xhat2"]
ans =
1.6225 1.6225

0.3400 0.3400
0.3400 0.3400

Inverse Complex Cepstrum

To invert the complex cepstrum, use the icceps function. Inversion is complicated by
the fact that the cceps function performs a data-dependent phase modification so that
the unwrapped phase of its input is continuous at zero frequency. The phase modification
1s equivalent to an integer delay. This delay term is returned by cceps if you ask for a
second output:

X = 1:10;
[xhat,delay] = cceps(x)
xXhat =
Columns 1 through 7
2.2428 -0.0420 -0.0210 0.0045 0.0366 0.0788 0.1386
Columns 8 through 10

0.2327 0.4114 0.9249

delay =
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To invert the complex cepstrum, use icceps with the original delay parameter:

icc = icceps(xhat,?2)

icc =
Columns 1 through 7
2.0000 3.0000 4._.0000 5.0000 6.0000 7.0000 8.0000
Columns 8 through 10

9.0000 10.0000 1.0000

As shown in the above example, with any modification of the complex cepstrum, the
original delay term may no longer be valid. You will not be able to invert the complex
cepstrum exactly.
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FFT-Based Time-Frequency Analysis

The Signal Processing Toolbox™ product provides a function, spectrogram, that returns
the time-dependent Fourier transform for a sequence, or displays this information

as a spectrogram. The time-dependent Fourier transform is the discrete-time Fourier
transform for a sequence, computed using a sliding window. This form of the Fourier
transform, also known as the short-time Fourier transform (STFT), has numerous
applications in speech, sonar, and radar processing. The spectrogram of a sequence is the
magnitude of the time-dependent Fourier transform versus time.

To display the spectrogram of a linear FM signal:

fs = 10000;

t = 0:1/Fs:2;

X = vco(sawtooth(2*pi*t,0.75),[0.1 0.4]*fs,fs);
spectrogram(x,kaiser(256,5),220,512,fs, "yaxis®")
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Median Filtering

Median Filtering

The function medfi Itl implements one-dimensional median filtering, a nonlinear
technique that applies a sliding window to a sequence. The median filter replaces the
center value in the window with the median value of all the points within the window [5].
In computing this median, medfi ltl assumes zeros beyond the input points.

When the number of elements n in the window is even, medfi 1tl sorts the numbers,
then takes the average of the n/2 and n/2 + 1 elements.

Two simple examples with fourth- and third-order median filters are

medfiltl([4 3 5 2 8 9 1].4)

ans =

1.500 3.500 3.500 4.000 6.500 5.000 4.500
medfiltl([4 3 5 2 8 9 1].3)
ans =

3 4 3 5 8 8 1

See the medfi 12 function in the Image Processing Toolbox™ for information on two-
dimensional median filtering.
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Communications Applications

In this section...

“Modulation” on page 7-34

“Demodulation” on page 7-35

“Voltage Controlled Oscillator” on page 7-37

Modulation

Modulation varies the amplitude, phase, or frequency of a carrier signal with reference
to a message signal. The modulate function modulates a message signal with a specified
modulation method.

The basic syntax for the modulate function is
y = modulate(x,fc,fs, 'method',opt)
where:

* X 1is the message signal.

+ Fcis the carrier frequency.

+ Fsis the sampling frequency.

* method is a flag for the desired modulation method.

* optis any additional argument that the method requires. (Not all modulation

methods require an option argument.)

The table below summarizes the modulation methods provided; see the documentation
for modulate, demod, and vco for complete details on each.

Method Description

amdsb-sc or am Amplitude modulation, double sideband, suppressed carrier
amdsb-tc Amplitude modulation, double sideband, transmitted carrier
amssb Amplitude modulation, single sideband

fm Frequency modulation

pm Phase modulation

ppm Pulse position modulation
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Method Description
pwm Pulse width modulation
gam Quadrature amplitude modulation

If the input X is an array rather than a vector, modulate modulates each column of the
array.

To obtain the time vector that modulate uses to compute the modulated signal, specify a
second output parameter:

[y.t] = modulate(x,fc,fs,"method",opt)

Demodulation

The demod function performs demodulation, that is, it obtains the original message
signal from the modulated signal:

The syntax for demod is
X = demod(y,fc,fs, "method" ,opt)

demod uses any of the methods shown for modulate, but the syntax for quadrature
amplitude demodulation requires two output parameters:

[X1,X2] = demod(y,fc,fs,“"qgam")
If the input y is an array, demod demodulates all columns.

Try modulating and demodulating a signal. A 50 Hz sine wave sampled at 1000 Hz is

t
X

(0:1/1000:2);
sin(2*pi*50*t);

With a carrier frequency of 200 Hz, the modulated and demodulated versions of this
signal are

modulate(x,200,1000, "am®);
demod(y,200,1000, "am®);

y
z

To plot portions of the original, modulated, and demodulated signal:

figure; plot(t(1:150),x(1:150)); title("Original Signal®);
figure; plot(t(1:150),y(1:150)); title("Modulated Signal™);
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figure; plot(t(1:150),z(1:150)); title("Demodulated Signal™);
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Note The demodulated signal is attenuated because demodulation includes two steps:
multiplication and lowpass filtering. The multiplication produces a component with
frequency centered at 0 Hz and a component with frequency at twice the carrier
frequency. The filtering removes the higher frequency component of the signal, producing
the attenuated result.

Voltage Controlled Oscillator

The voltage controlled oscillator function vco creates a signal that oscillates at a
frequency determined by the input vector. The basic syntax for vco is

y = vco(x,fc,fs)
where fc is the carrier frequency and fs is the sampling frequency.

To scale the frequency modulation range, use

y = vco(X, [Fmin Fmax],fs)
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In this case, vco scales the frequency modulation range so values of X on the interval
[-1 1] map to oscillations of frequency on [Fmin Fmax].

If the input X is an array, vco produces an array whose columns oscillate according to
the columns of x.

See “FFT-Based Time-Frequency Analysis” on page 7-31 for an example using the vco
function.
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Deconvolution

Deconvolution, or polynomial division, is the inverse operation of convolution.
Deconvolution is useful in recovering the input to a known filter, given the filtered
output. This method is very sensitive to noise in the coefficients, however, so use caution
in applying it.

The syntax for deconv is
[q,r] = deconv(b,a)

where b is the polynomial dividend, a is the divisor, g is the quotient, and r is the
remainder.

To try deconv, first convolve two simple vectors a and b .

[123];
[4 5 6];
conv(a,b)

O0To

4 13 28 27 18

Now use deconv to deconvolve b from c:
[q,r] = deconv(c,a)
q =

4 5 6

0] 0] 0 0 0
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Chirp Z-Transform

The chirp Z-transform (CZT), useful in evaluating the Z-transform along contours other
than the unit circle. The chirp Z-transform is also more efficient than the DFT algorithm
for the computation of prime-length transforms, and it is useful in computing a subset
of the DFT for a sequence. The chirp Z-transform, or CZT, computes the Z-transform
along spiral contours in the z-plane for an input sequence. Unlike the DFT, the CZT is
not constrained to operate along the unit circle, but can evaluate the Z-transform along

contours described by z, = AW' ¢=0,...,M—1, where A is the complex starting point, W

1s a complex scalar describing the complex ratio between points on the contour, and M is
the length of the transform.

One possible spiral is

0.8*exp(J*pi/6);
0.995*exp(-J*pi*.05);
91;
A*W-~(=(0:M-1)));
zplane([]1.,z-7)

NZ=2>
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czt(x,M,W,A) computes the Z-transform of X on these points.
An interesting and useful spiral set is m evenly spaced samples around the unit circle,

parameterized by A = 1 and W = exp(-j*pi/M). The Z-transform on this contour is
simply the DFT, obtained by

y = czt(x)
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czt may be faster than the FFt function for computing the DFT of sequences with
certain odd lengths, particularly long prime-length sequences.
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Discrete Cosine Transform

The discrete cosine transform (DCT), closely related to the DFT. The DCT's energy
compaction properties are useful for applications like signal coding. The toolbox function
dct computes the unitary discrete cosine transform, or DCT, for an input vector or
matrix. Mathematically, the unitary DCT of an input sequence x is

n(2n-1)(k-1)

N
k)=wk
y(k) = w( )Zx(n)cos ~

n=1

k=1,...,N,

where

,_N,

2
—, 2<k<N.
N’

The DCT is closely related to the discrete Fourier transform; the DFT is actually one
step in the computation of the DCT for a sequence. The DCT, however, has better energy
compaction properties, with just a few of the transform coefficients representing the
majority of the energy in the sequence. The energy compaction properties of the DCT
make it useful in applications such as data communications.

w(k) =

The function idct computes the inverse DCT for an input sequence, reconstructing a
signal from a complete or partial set of DCT coefficients. The inverse discrete cosine
transform is

N
=Y w(k)y(k)cos%, n=1,.,N,

k=1

where
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Because of the energy compaction mentioned above, it is possible to reconstruct a signal
from only a fraction of its DCT coefficients. For example, generate a 25 Hz sinusoidal
sequence, sampled at 1000 Hz:

t
X

(0:1/999:1);
sin(2*pi*25*t);

Compute the DCT of this sequence and reconstruct the signal using only those
components with value greater than 0.1 (64 of the original 1000 DCT coefficients):

y = dct(X) % Compute DCT

y2 = find(abs(y) < 0.9); % Use 17 coefficients

y(y2) = zeros(size(y2)); % Zero out points < 0.9

z = idct(y); % Reconstruct signal w/inverse DCT

Plot the original and reconstructed sequences:

subplot(2,1,1)

plot(t,x)

title("Original Signal™)
subplot(2,1,2)

plot(t,z)

axis([0 1 -1 1]
title("Reconstructed Signal*®)



Discrete Cosine Transform
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One measure of the accuracy of the reconstruction is

norm(x-z)/norm(x)

that is, the norm of the difference between the original and reconstructed signals, divided
by the norm of the original signal. In this case, the relative error of reconstruction is
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0.1443. The reconstructed signal retains approximately 85% of the energy in the original
signal.
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Hilbert Transform

The Hilbert transform facilitates the formation of the analytic signal. The analytic signal
is useful in the area of communications, particularly in bandpass signal processing. The
toolbox function hi lbert computes the Hilbert transform for a real input sequence X
and returns a complex result of the same length, y = hilbert(x), where the real part
of y is the original real data and the imaginary part is the actual Hilbert transform.

y is sometimes called the analytic signal, in reference to the continuous-time analytic
signal. A key property of the discrete-time analytic signal is that its Z-transform is 0

on the lower half of the unit circle. Many applications of the analytic signal are related
to this property; for example, the analytic signal is useful in avoiding aliasing effects
for bandpass sampling operations. The magnitude of the analytic signal is the complex
envelope of the original signal.

The Hilbert transform is related to the actual data by a 90-degree phase shift; sines
become cosines and vice versa. To plot a portion of data and its Hilbert transform, use

t
X

y

0:1/1024:1;
sin(2*pi*60*t);
hilbert(x);

plot(t(1:50),real(y(1:50)))

hold on

plot(t(1:50), imag(y(1:50)))

hold off

axis([0 0.05 -1.1 2])

legend("Real Part®,"Imaginary Part™)
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The analytic signal is useful in calculating instantaneous attributes of a time series, the
monocomponent.

attributes of the series at any point in time. The procedure requires that the signal be

7-48



Walsh-Hadamard Transform

Walsh-Hadamard Transform

The Walsh-Hadamard transform is a non-sinusoidal, orthogonal transformation
technique that decomposes a signal into a set of basis functions. These basis functions
are Walsh functions, which are rectangular or square waves with values of +1 or —1.
Walsh-Hadamard transforms are also known as Hadamard (see the hadamard function
in the MATLAB software), Walsh, or Walsh-Fourier transforms.

The first eight Walsh functions have these values:

Index Walsh Function Values
0 11111111
1111-1-1-1-1
11-1-1-1-111
11-1-111-1-1
1-1-111-1-11
1-1-11-111-1
1-11-1-11-11
1-11-11-11-1

N | OO | Ot | W[N]

The Walsh-Hadamard transform returns sequency values. Sequency is a more
generalized notion of frequency and is defined as one half of the average number of zero-
crossings per unit time interval. Each Walsh function has a unique sequency value. You
can use the returned sequency values to estimate the signal frequencies in the original
signal.

Three different ordering schemes are used to store Walsh functions: sequency,
Hadamard, and dyadic. Sequency ordering, which is used in signal processing
applications, has the Walsh functions in the order shown in the table above. Hadamard
ordering, which is used in controls applications, arranges them as 0, 4, 6, 2, 3, 7, 5, 1.
Dyadic or gray code ordering, which is used in mathematics, arranges them as 0, 1, 3, 2,
6,7,5,4.

The Walsh-Hadamard transform is used in a number of applications, such as image

processing, speech processing, filtering, and power spectrum analysis. It is very useful for
reducing bandwidth storage requirements and spread-spectrum analysis. Like the FFT,
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the Walsh-Hadamard transform has a fast version, the fast Walsh-Hadamard transform
(fwht). Compared to the FFT, the FWHT requires less storage space and is faster to
calculate because it uses only real additions and subtractions, while the FFT requires
complex values. The FWHT is able to represent signals with sharp discontinuities more
accurately using fewer coefficients than the FFT. Both the FWHT and the inverse FWHT
(1fwht) are symmetric and thus, use identical calculation processes. The FWHT and
IFWHT for a signal x(f) of length N are defined as:

| —

N-
2 i WAL(n, 1),

.22

1
x; = Y ¥y, WAL(n,i),

4

~
Il
o

where i =0,1, ..., N— 1 and WAL(n,i) are Walsh functions. Similar to the Cooley-Tukey
algorithm for the FFT, the N elements are decomposed into two sets of N/2 elements,
which are then combined using a butterfly structure to form the FWHT. For images,
where the input is typically a 2-D signal, the FWHT coefficients are calculated by first
evaluating across the rows and then evaluating down the columns.

For the following simple signal, the resulting FWHT shows that x was created using
Walsh functions with sequency values of 0, 1, 3, and 6, which are the nonzero indices of
the transformed X. The inverse FWHT recreates the original signal.

x=[422002-20]
y = fwht(x)
X =

4 2 2 0 0 2 -2 0
y =

1 1 0 1 0 0 1 0
x1 = ifwht(y)
X1 =

4 2 2 0 0 2 -2 0
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Using Walsh-Hadamard Transform for Spectral Analysis and
Compression of ECG Signals

The following example uses an electrocardiogram (ECG) signal to illustrate working
with the Walsh-Hadamard transform. ECG signals typically are very large and need to
be stored for analysis and retrieval at a future time. Walsh-Hadamard transforms are
particularly well-suited to this application because they provide compression and thus
require less storage space. They also provide rapid signal reconstruction.

Start with an ECG signal. Replicate it to create a longer signal and insert some
additional random noise.

xe ecg(512);
Xr repmat(xe,1,8);
X = Xr + 0.1.*randn(1, length(xr));

Transform the signal using the fast Walsh-Hadamard transform. Plot the original signal
and the transformed signal.

y = fwht(x);

subplot(2,1,1)

plot(x)

xlabel ("Sample index®)
ylabel ("Amplitude®)
title("ECG Signal*™)

subplot(2,1,2)
plot(abs(y))

xlabel ("Sequency index")
ylabel (*"Magnitude®)
title("WHT Coefficients®)
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Magnitude

7-52

Amplitude
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The plot shows that most of the signal energy is in the lower sequency values below
approximately 1100. Store only the first 1024 coefficients (out of 4096) and see if the
signal can be accurately reconstructed from only these stored coefficients.

y(1025:1ength(x)) = 0;
xHat = 1fwht(y);

figure

plot(x)

hold on

plot(xHat)

xlabel ("Sample index")

ylabel ("ECG signal amplitude™)
legend("Original”, "Reconstructed®)



Walsh-Hadamard Transform
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The reproduced signal is very close to the original but has been compressed to a quarter
of the size. Storing more coefficients is a tradeoff between increased resolution and
increased noise, while storing fewer coefficients may cause loss of peaks.
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Eliminate Outliers Using Hampel Identifier

This example shows a naive implementation of the procedure used by hampel to detect
and remove outliers. The actual function is much faster.

Generate a random signal, X, containing 24 samples. Reset the random number
generator for reproducible results.

rng default

Ix = 24;
x = randn(1,1x);

Generate an observation window around each element of x. Take k = 2 neighbors at

either side of the sample. The moving window that results has a length of 2 % 2+ 1 = 5
samples.

=~
1
N

iLo (1:1x)-k;
i (1:Ix)+k;

Truncate the window so that the function computes medians of smaller segments as it
reaches the signal edges.

iLo(iLo<l) = 1;
iHIi(IHi>Ix) = Ix;

Record the median of each surrounding window. Find the median of the absolute
deviation of each element with respect to the window median.

for j = 1:1Ix
w = x(iLo@):iHi(d)):;
medj = median(w);
mmed(jJ) = medj;
mmad(§) median(abs(w-medj));

end

Scale the median absolute deviation with

v2erf "(1/2)
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to obtain an estimate of the standard deviation of a normal distribution.
sd = mmad/(erfinv(1/2)*sqrt(2));

Find the samples that differ from the median by more than nd = 2 standard deviations.
Replace each of those outliers by the value of the median of its surrounding window. This
is the essence of the Hampel algorithm.

nd = 2;
ki = abs(x-mmed) > nd*sd;
yu

yu(ki) = mmed(ki);

Use the hampel function to compute the filtered signal and annotate the outliers.
Overlay the filtered values computed in this example.

hampel (x, k,nd)
hold on

plot(yu,0")
hold off
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SPTool: An Interactive Signal Processing Environment

8-2

In this section...

“SPTool Overview” on page 8-2

“SPTool Data Structures” on page 8-2

SPTool Overview

SPTool is an interactive GUI for digital signal processing used to

Analyze signals
Design filters
Analyze (view) filters
Filter signals

Analyze signal spectra

You can accomplish these tasks using four GUIs that you access from within SPTool:

The “Signal Browser” on page 8-7 is for analyzing signals. You can also play
signals using your computer's audio hardware.

fdatool is available for designing or editing FIR and IIR digital filters. Most Signal
Processing Toolbox filter design methods available at the command line are also
available in FDATool. Additionally, you can use FDATool to design a filter by using
the “Pole/Zero Editor” on page 8-47 to graphically place poles and zeros on the z-
plane.

The “Filter Visualization Tool” on page 8-11 (FVTool) is for analyzing filter
characteristics.

The “Spectrum Viewer” on page 8-13 is for spectral analysis. You can use Signal
Processing Toolbox spectral estimation methods to estimate the power spectral
density of a signal.

SPTool Data Structures

You can use SPTool to analyze signals, filters, or spectra that you create at the MATLAB
command line.




SPTool: An Interactive Signal Processing Environment

You can bring signals, filters, or spectra from the MATLAB workspace into the SPTool
workspace using File > Import. For more information, see “Importing Filters and
Spectra” on page 8-31. Signals, filters, or spectra that you create in (or import into)

the SPTool workspace exist as MATLAB structures. See the MATLAB documentation for
more information on MATLAB structures.

When you use File > Export to save signals, filters, and spectra that you create or
modify in SPTool, these are also saved as MATLAB structures. For more information on
exporting, see “Exporting Signals, Filters, and Spectra” on page 8-27.
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Opening SPTool

To open SPTool, type

sptool
B SPTool: startup.spt B ]
File Edit Window | Help | o
Signals Filters Spectra
i [vector] ____JAlLShp [desig W sz fauto] [N
chirp [vector] PZlp [imported] chirpse [auto]
train [wector] FIRbp [de=ign] trainse [auto]
[ View | View | View |
[ New ] [ Create ]
( Edit | Update |
[ Apply ]

When you first open SPTool, it contains a collection of default signals, filters, and
spectra. To specify your own preferences for what signals, filters, and spectra to see when
SPTool opens see “Setting Preferences” on page 8-42.

You can access these three GUIs from SPTool by selecting a signal, filter, or spectrum
and clicking the appropriate View button:

+ Signal Browser
+ Filter Visualization Tool

*  Spectrum Viewer
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Opening SPTool

You can access FDATool by clicking New to create a new filter or Edit to edit a selected
filter. Clicking Apply applies a selected filter to a selected signal.

Create opens the Spectrum Viewer and creates the power spectral density of the selected
signal. Update opens the Spectrum Viewer for the selected spectrum.
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Getting Contexi-Sensitive Help

8-6

To find information on a particular feature or setting of the “Signal Browser” on page
8-7:

* In any Measurements panel, right-click anywhere on the panel and select What's
this?.

In any dialog box where you see the \) icon in the lower left corner, right-click on

any parameter and select What's this?.

To find information on a particular region of “FDAToo0l” on page 8-10 or “Spectrum
Viewer” on page 8-13:

Click What's this? ..

2 Click on the region of the GUI you want information on.

You can also use Help > What's This? to launch context-sensitive help.



Signal Browser

Signal Browser

In this section...

“Overview of the Signal Browser” on page 8-7

“Opening the Signal Browser” on page 8-7

Overview of the Signal Browser

You can use the Signal Browser to display and analyze signals listed in the Signals list
box in SPTool.

Using the Signal Browser, you can:

* Analyze and compare vector or array (matrix) signals.
+ Zoom in on portions of signal data.

* Measure a variety of characteristics of signal data.

+  Compare multiple signals.

* Play portions of signal data on audio hardware.

*  Print signal plots.

Opening the Signal Browser

To open the Signal Browser from SPTool:

1  Select one or more signals in the Signals list in SPTool.

2 Click View under the Signals list.
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n Signal Browser
File Teols View Help

gla<i |0 HEEE $E)

Amplitude

Time (secs)

The Signal Browser has the following components:

+ A display region for analyzing signals

* A panels section on the right side of the scope window, which shows statistics and
information about your signals

* A toolbar with buttons for convenient access to frequently used functions

lcon

Description

=

Print the current scope window.

P

Play an audio signal. The function soundsc is used to
play the signal.

H

Show multiple displays of signals.

@ rar 3

Zoom the signal in and out.

H

Scale the axes.




Signal Browser

Icon Description
IE‘ Toggle the legends on and off.
[ Toggle the Cursor Measurements panel. This

panel allows you to see screen cursors and get
measurements of time and amplitude values at the
Cursors.

E m Toggle the Signal Statistics, Bilevel Measurements,
and Peak Finder panels, which display various
measurements about the selected signal.

For more information on the Signal Browser, see the sptool function reference page.
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FDATool

You can use the Filter Design and Analysis Tool (fdatool) to design and edit filters.

To open FDATool from SPTool, click New under the Filters list to create a new filter or
select one of the filters in the Filters list in SPTool and click Edit to edit that filter.

8-10

.} Filter Design & Analysis Tool - (filt1) = | Dlﬂ
File Edit Analysis Targets Wiew Window Help
FEHER (2L LK TR RN &1~ Bk @&
— Current Fitter Information — Magnitude Response (dB)
Structure: Direct-Form FIR 5
Drcler: 78 h=%
Stable: Yes § -
Source: Desigred =
g
=
(s} 0.5 1 1.6 2
Frequancy (kHz)
— Responze Type _Filtet Orider — Freguency Specifications — Magnitude Specifications
O |Lowpass - Eg Urits: |Hz E| Units: |dB =l
{~ Highpass
% Minimurn orcer Fa: 000
{* Banhdpass Astopd: F’S
™ Banhdstop __ Options Fatopt: EDD
Apass |D1
" pitterentistor = Density Factor: ED
Fpass1: F’SD
[ Design Method tastopl: l-?s
||| R IEiut'terWorth - === 250
=]
ffﬂ = FR IEquirippIe - Fstop2:  [1500
<25l
E Desion Fifter |
|Designing Filter ... Done

Note When you open FDATool from SPTool, a reduced version of FDATool that is

compatible with SPTool opens.




Filter Visualization Tool

Filter Visualization Tool

In this section...

“Connection between FVTool and SPTool” on page 8-11
“Opening the Filter Visualization Tool” on page 8-11

“Analysis Parameters” on page 8-12

Connection between FVTool and SPTool

You can use the Filter Visualization Tool to analyze response characteristics of the
selected filter(s). See Fvtool for detailed information about FVTool.

If you start FVTool by clicking the SPTool Filter View button, that FVTool is linked to
SPTool. Any changes made in SPTool to the filter are immediately reflected in FVTool.
The FVTool title bar includes "SPTool" to indicate the link.

If you start an FVTool by clicking the New button or by selecting File > New from
within FVTool, that FVTool is a standalone version and is not linked to SPTool.

Note Every time you click the Filter View button a new, linked FVTool starts. This
allows you to view multiple analyses simultaneously.

Opening the Filter Visualization Tool

You open FVTool from SPTool as follows.

1 Select one or more filters in the Filters list in SPTool.
2 Click the View button under the Filters list.

When you first open FVTool, it displays the selected filter's magnitude plot.
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) Figure 1: Filter Yisualization Tool - Magnitude Response (dB) - |EI|5|
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Analysis Parameters

In the plot area of any filter response plot, right-click and select Analysis Parameters
to display details about the displayed plot. See “Analysis Parameters” in the FDATool
online help for more information.

You can change any parameter in a linked FVTool, except the sampling frequency. You
can only change the sampling frequency using the SPTool Edit > Sampling Frequency
or the SPTool Filters Edit button.
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Spectrum Viewer

In this section...

“Spectrum Viewer Overview” on page 8-13

“Opening the Spectrum Viewer” on page 8-13

Spectrum Viewer Overview

You can use the Spectrum Viewer for estimating and analyzing a signal's power spectral
density (PSD). You can use the PSD estimates to understand a signal's frequency
content.

The Spectrum Viewer provides the following functionality.

* Analyze and compare spectral density plots.

+ Use different spectral estimation methods to create spectra:

Burg (pburg)
+  Covariance (pcov)
+ FFT (fFft)

*  Modified covariance (pmcov)
MTM (multitaper method) (pmtm)
MUSIC (pmusic)

+ Welch (pwelch)

* Yule-Walker AR (pyulear)

*  Modify power spectral density parameters such as FFT length, window type, and
sample frequency.

* Print spectral plots.
Opening the Spectrum Viewer

To open the Spectrum Viewer and create a PSD estimate from SPTool:

1  Select a signal from the Signal list box in SPTool.
2 Click Create in the Spectra list.
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3 Click Apply in the Spectrum Viewer.
To open the Spectrum Viewer with a PSD estimate already listed in SPTool:

1  Select a PSD estimate from the Spectra list box in SPTool.
2 Click View in the Spectra list.

For example:

1  Select mtlb in the default Signals list in SPTool.
2 Click Create in SPTool to open the Spectrum Viewer.
3 Click Apply in the Spectrum Viewer to plot the spectrum.

1=
File Options Markers Window Help
SR|INXI swme Tt #| AN
Signal: mth
4001 k-1 real FFT Spectrum Estimate
Fs= 7418 20 T T T T T T T
Parameters 10 ‘ i
Method [ 3| [ |
N1ﬂ|1024 0 ‘ T
ok } 4
20k | 4
1]l o
30k 4
401 ‘
_50 1 1 1 1 ‘I 1 1
0 500 1000 1500 2000 2500 3000 3500
Frequency
I'""‘"“"“’“ :I' Marker 1 * 1228 748 Marker 2 % |2470.252 ax 1231.5039
| | ¥ -21.523543 — ¥ -2418231 dy: -2 5346826

The Spectrum Viewer has the following components:

+ A signal identification region that provides information about the signal whose power
spectral density estimate is displayed

* A Parameters region for modifying the PSD parameters

+ A display region for analyzing spectra and an Options menu for modifying display
characteristics

*  Spectrum management controls
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Spectrum Viewer

+ Inherit from menu to inherit PSD specifications from another PSD object listed

in the menu

Revert button to revert to the named PSD's original specifications

+  Apply button for creating or updating PSD estimates

* A toolbar with buttons for convenient access to frequently used functions

lcon Description

EAEY Print and print preview

RIS T A MM Zoom the signal in and out

e Select one of several loaded signals

Set the display color and line style of a signal

Toggle the markers on and off

Set marker types

Turn on the What's This help
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Filtering and Analysis of Noise

8-16

In this section...

“Overview” on page 8-16

“Importing a Signal into SPTool” on page 8-16
“Designing a Filter” on page 8-18

“Applying a Filter to a Signal” on page 8-20

“Analyzing a Signal” on page 8-22

“Spectral Analysis in the Spectrum Viewer” on page 8-24

Overview

The following sections provide an example of using the GUI-based interactive tools to:

* Design and implement an FIR bandpass digital filter
*  Apply the filter to a noisy signal

* Analyze signals and their spectra
The steps include:

1  “Importing a Signal into SPTool” on page 8-16

2 Designing a bandpass filter using FDATool

3 Applying the filter to the original noise signal to create a bandlimited noise signal
4

Comparing the time domain information of the original and filtered signals using the
Signal Browser

5 Comparing the spectra of both signals using the Spectrum Viewer

Importing a Signal into SPTool

To import a signal into SPTool from the workspace or disk, the signal must be either:

+ A special MATLAB signal structure, such as that saved from a previous SPTool
session
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A signal created as a variable (vector or matrix) in the MATLAB workspace

For this example, create a new signal at the command line and then import it as a
structure into SPTool:

1

Create a random signal in the MATLAB workspace by typing

X = randn(5000,1);
If SPTool is not already open, open SPTool by typing

sptool

The SPTool window is displayed.
Select File > Import. The Import to SPTool dialog opens.

J Import to SPTool i il
Source — “orkspace Contents — r Import As: ISignaI v I—

' From "Workspace
™ Fram Digk

. ['at

s Tfile Mamme: =2 =4

Browse... |

Sampling Frequency
o = | K

— Mame
ok, I Cancel | Help | I =gl

The variable X is displayed in the Workspace Contents list. (If it is not, select the
From Workspace radio button to display the contents of the workspace.)

Select the signal and import it into the Data field:

a Select the signal variable x in the Workspace Contents list.
b Make sure that Signal is selected in the Import As pull-down menu.
Click on the arrow to the left of the Data field or type X in the Data field.

[« TN o)

Type 5000 in the Sampling Frequency field.
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e Name the signal by typing noise in the Name field.
f  Click OK.

The signal noise[vector] appears and is selected in SPTool's Signals list.

Note You can import filters and spectra into SPTool in much the same way as you import
signals. See “Importing Filters and Spectra” on page 8-31 for specific details.

You can also import signals from MAT-files on your disk, rather than from the
workspace. See “Loading Variables from the Disk” on page 8-35 for more information.

Type hellp sptool for information about importing from the command line.

Designing a Filter

You can import an existing filter into SPTool, or you can design and edit a new filter
using FDATool.

In this example, you

1  Open a default filter in FDATool.
2 Specify an equiripple bandpass FIR filter.

Opening FDATool

To open FDATool, click New in SPTool. FDATool opens with a default filter named
filtl.

Specifying the Bandpass Filter

Design an equiripple bandpass FIR filter with the following characteristics:

+  Sampling frequency of 5000 Hz

+  Stopband frequency ranges of [0 500] Hz and [1500 2500] Hz
* Passband frequency range of [750 1250] Hz

* Ripple in the passband of 0.01 dB

+ Stopband attenuation of 75 dB
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To modify the filter in FDATool to meet these specifications, you need to

Select Bandpass from the Response Type list.
2 Verify that FIR Equiripple is selected as the Design Method.

3 Verify that Minimum order is selected as the Filter Order and that the Density
Factor is set to 20.

4 Under Frequency Specifications, set the sampling frequency (Fs) and the
passband (Fpassl, Fpass2) and stopband (Fstopl, Fstop2) edges:

Units Hz
Fs 5000
Fstopl 500
Fpassl 750
Fpass2 1250
Fstop2 1500

5 Under Magnitude Specifications, set the stopband attenuation (Astopl, Astop2)
and the maximum passband ripple (Apass):

Units dB
Astopl 75
Apass 0.01
Astop2 75

6 Click Design Filter to design the new filter. When the new filter is designed, the
magnitude response of the filter is displayed.

8-19



8 sPlool: A Signal Processing GUI Suite

8-20

) Filter Design & Analysis Tool - (Filt1)
File Edit Analysis Targets Yiew Window Help

= =]

FHSR 2L LK D |(NHEA LM  BHiL 6N
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[z
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— Current Fitter Infortmation

Structure:  Direct-Form FIR
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Stakle: Yes
SOUrCE: Desighed
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© |Lowpass -
" Highpass
{* Bandpass
" Bandstop

1 |Ditferentiator -
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Fatop2: 500

Units: IdE hd l
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Apass: |.D1
Aztop2: F’S

Design Fifter |

|Designing Filter ... Done

The resulting filter is an order-78 bandpass equiripple filter.

In SPTool, select the signal noise[vector] from the Signals list and select the

Applying a Filter to a Signal

filter (named Filtl[design]) from the Filters list.

When you apply a filter to a signal, you create a new signal in SPTool representing the
filtered signal.

To apply the filter FilItl you just created to the signal noise,
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<} SPTool: startup.spt =] 3
File Edit ‘Window Help

Signals Filters Spechtra
mitlb [vector] | |LSIp [design] - a
chirp [wector] _I FElp [imported] J chirpze [auto]

train [vector FleE desiin trainze [auta]

[ [~ [
et I Yiew I et I
Mew I Create I
Edit | Update |
Apply |

Click Apply under the Filters list.

JRT=IE

Input Signal}]

oize

Fitter I(irt1

AR (nirect-Form FIR ]

Output Signalls

iyl

QK | Cancel |

Leave the Algorithm as Direct-Form FIR.

Note You can apply one of two filtering algorithms to FIR filters. The default
algorithm is specific to the filter structure, which is shown in the FDATool Current
Filter Info frame. Alternately for FIR filters, FFT based FIR (FftFfilt) uses the
algorithm described in FFEFilt.
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For IIR filters, the alternate algorithm is a zero-phase IIR that uses the algorithm
described in FiltFilt.

Enter bInoise as the Output Signal name.

5 Click OK to close the Apply Filter dialog box.
The filter is applied to the selected signal, and the filtered signal blnoise[vector]
is listed in the Signals list in SPTool.

Analyzing a Signal

You can analyze and print signals using the Signal Browser. You can also play the
signals if your computer has audio output capabilities.

For example, compare the signal noise to the filtered signal blnoise:

1

Shift+click on the noise and bInoise signals in the Signals list of SPTool to select
both signals.

Click View under the Signals list.
The Signal Browser is activated, and both signals are displayed in the display

region. (The names of both signals are shown above the display region.) Initially, the
original noise signal covers up the bandlimited blnoise signal.

Push the selection button ﬂ on the toolbar to select the blnoise signal.
The display area is updated. Now you can see the blnoise signal superimposed

on top of the noise signal. The signals are displayed in different colors in both the
display region and the panner. You can change the color of the selected signal using
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+#|Signal Browser M=l B3
File Markers ‘wWindow Help
@R g 1R T ¢ w1 =482

noise, binoise

4 T T T T T T | T T T

~n 0.1 0.2 03 0.4 0.5 06 07 0.8 0.9
Tirne
5
E
& |l ki Illﬂllm M“‘”‘I 'm m“lm " ! "m i ““m“ “ M m“"”” |ﬂllu“ll*
Marker 1 # [ 0.3332 Marker 2 * | 06666 o 0.3334
v: -0.091656 — — 07872 dy: -0.63555

Playing a Signal

When you click Play in the Signal Browser toolbar, ﬁ, the active signal is played on the
computer's audio hardware:

1 To hear a portion of the active (selected) signal

a Use the vertical markers to select a portion of the signal you want to play.

Vertical markers are enabled by the u and ﬂ buttons.
b Click Play.
2 To hear the other signal

a Select the signal as in step 3above. You can also select the signal directly in the
display region.

b Click Play again.
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Printing a Signal

You can print from the Signal Browser using the Print button, @

You can use the line display buttons to maximize the visual contrast between the signals
by setting the line color for noise to gray and the line color for blnoise to white. Do this
before printing two signals together.

Note You can follow the same rules to print spectra, but you can't print filter responses
directly from SPTool.

Use the Signal Browser region in the Preferences dialog box in SPTool to suppress
printing of both the panner and the marker settings.

To print both signals, click Print in the Signal Browser toolbar.

Spectral Analysis in the Spectrum Viewer

You can analyze the frequency content of a signal using the Spectrum Viewer, which
estimates and displays a signal's power spectral density.

For example, to analyze and compare the spectra of noise and bInoise:

1 Create a power spectral density (PSD) object, spectl, that is associated with the
signal noise, and a second PSD object, spect2, that is associated with the signal
blnoise.

2 Open the Spectrum Viewer to analyze both of these spectra.
3 Print both spectra.

Creating a PSD Object From a Signal

1 Click on SPTool, or select Window > SPTool in any active open GUI. SPTool is now
the active window.
2 Select the noise[vector] signal in the Signals list of SPTool.

3 Click Create in the Spectra list.

The Spectrum Viewer is activated, and a PSD (spectl) corresponding to the noise
signal is created in the Spectra list. The PSD is not computed or displayed yet.
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4  Click Apply in the Spectrum Viewer to compute and display the PSD estimate
spectl using the default parameters.

The PSD of the noise signal is displayed in the display region. The identifying
information for the PSD's associated signal (noise) is displayed above the
Parameters region.

The PSD estimate spectl is within 2 or 3 dB of 0, so the noise has a fairly "flat"
power spectral density.

5 Follow steps 1 through 4 for the bandlimited noise signal blnoise to create a second
PSD estimate spect2.

The PSD estimate spect? is flat between 750 and 1250 Hz and has 75 dB less power
in the stopband regions of i It1.

Opening the Spectrum Viewer with Two Spectra

Reactivate SPTool again, as in step 1 above.
2 Shift+click on spectl and spect?2 in the Spectra list to select them both.

3 Click View in the Spectra list to reactivate the Spectrum Viewer and display both
spectra together.

¢ Spectium Viewer
File Opbor: Maikers Window Help
[BR|oXTewme | -1 =tH Aayv e
Tiandl noise
5000-by-1 real P3D
Fs - E]JD 'm T T T T
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Method [y/elch = -0 \ E
hite [ 1024 |
Nuwind [ 255 60+ [ | 4
{
Window | hanning 'I ! \
B0 | ]
|
Overlap [0 | \
-100 | Y, L
P o \ -
\ A ANy ITAVARNIVAVAAVAY
120 | 1 1 1
0 500 1000 1500 2000 2500
Fraguency
[inhert from =l Marker 1 [ 834 3609 Marker 2 * [ 16650391 dic 83007813
I T I w-33.8209 — — y-344254 dy: 060451
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Printing the Spectra

Before printing the two spectra together, use the color and line style selection button,

To print both spectra:

1
Click Print Preview @ in the toolbar on the Spectrum Viewer.

2 From the Spectrum Viewer Print Preview window, drag the legend out of the display
region so that it doesn't obscure part of the plot.

3 Click Print in the Spectrum Viewer Print Preview window.



Exporting Signals, Filters, and Spectra

Exporting Signals, Filters, and Spectra

In this section...

“Opening the Export Dialog Box” on page 8-27
“Exporting a Filter to the MATLAB Workspace” on page 8-27

Opening the Export Dialog Box

To save the filter Fi Itl you just created in this example, open the Export dialog box
with Filtl preselected:

1 Select Filtl in the SPTool Filters list.
2 Select File > Export.

The Export dialog box opens with filtl preselected.

<) Export from SPTool =0 =]

— Export List

Signal: mtlbk [wvector] d
Signal: chirp [wector]
Signal: train [wector]
Filter: LE21lp [design]
Filter: PElp [imported]
Filter: FIPbp [design] =
Filter: filtl [desicm] Export to disk... I
Spectrum: mtlbhse [auto]

Spectrum: chirpse [autc Expart to warkspace |
Spectrum: trainse [autc

[~ Export fiters as TF objects

Cancel I

Help I

! o™

Shiowe: IAII - I

Exporting a Filter to the MATLAB Workspace

To export the filter filt1 to the MATLAB workspace:
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1 Select Filtl from the Export List and deselect all other items using Ctrl+click.
2 Click Export to Workspace.
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Accessing Filter Parameters

In this section...

“Accessing Filter Parameters in a Saved Filter” on page 8-29

“Accessing Parameters in a Saved Spectrum” on page 8-30

Accessing Filter Parameters in a Saved Filter

The MATLAB structures created by SPTool have several associated fields, many of which
are also MATLAB structures. See the MATLAB documentation for general information
about MATLAB structures.

For example, after exporting a filter filt1 to the MATLAB workspace, type

filtl

to display the fields of the MATLAB filter structure. The tF field of the structure
contains information that describes the filter.

The #f Field: Accessing Filter Coefficients

The tf field is a structure containing the transfer function representation of the filter.
Use this field to obtain the filter coefficients;

« Filtl.tf._num contains the numerator coefficients.

+ filtl.tf.den contains the denominator coefficients.

The vectors contained in these structures represent polynomials in descending powers of
z. The numerator and denominator polynomials are used to specify the transfer function

_B@) _bD)+b@z" +-+bnb+ D2
A2 g +a@zt+- +aa +1)z ™"

H(z)

where:

* b is a vector containing the coefficients from the tF.num field.
* ais a vector containing the coefficients from the tf.den field.

* m 1s the numerator order.
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* n1is the denominator order.

You can change the filter representation from the default transfer function to another
form by using the tF2ss or tF2zp functions.

Note The FDAspecs field of your filter contains internal information about FDATool and
should not be changed.

Accessing Parameters in a Saved Spectrum

The following structure fields describe the spectra saved by SPTool.

Field Description

P The spectral power vector.

f The spectral frequency vector.

confid A structure containing the confidence intervals data

* The confid. level field contains the chosen confidence
level.

* The confid.Pc field contains the spectral power data for
the confidence intervals.

+ The confid.enable field contains a 1 if confidence levels
are enabled for the power spectral density.

signalLabel The name of the signal from which the power spectral density
was generated.

Fs The associated signal's sample rate.

You can access the information in these fields as you do with every MATLAB structure.
For example, if you export an SPTool PSD estimate spectl to the workspace, type
spectl.P

to obtain the vector of associated power values.
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Importing Filters and Spectra

In this section...

“Similarities to Other Procedures” on page 8-31
“Importing Filters” on page 8-31
“Importing Spectra” on page 8-33

Similarities to Other Procedures

The procedures are very similar to those explained in

+ “Importing a Signal into SPTool” on page 8-16 for loading variables from the
workspace

* “Loading Variables from the Disk” on page 8-35 for loading variables from your
disk

Importing Filters

When you import filters, first select the appropriate filter form from the Form list.
SPTool does not currently support the import of filter objects.

) Import to SPTool x|
Source — "Workspace Contents — - Import As: Iﬁ
%' Fram "Warkspace <no selection> Farm; I ; J
™ Fram Digk

T -file Name: _>|
-3 |

Browse... |

Fur
State Space
Zeros, Poles, Gain

I_ 2nd Order Sections

Sampling Frequency
A=)l

— Mame

ok | Ceveal Help | [
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8-32

For every filter you specify a variable name or a value for the filter's sampling frequency
in the Sampling Frequency field. Each filter form requires different variables.

Transfer Function

For Transfer Function, you specify the filter by its transfer function representation:

B b +b@)z +- 4 bm+ Dz

H(z)= =
‘ Al2) g+ a2zt + +an+1)z™"

* The Numerator field specifies a variable name or value for the numerator coefficient
vector b, which contains m+1 coefficients in descending powers of z.

* The Denominator field specifies a variable name or value for the denominator
coefficient vector a, which contains n+1 coefficients in descending powers of z.

State Space
For State Space, you specify the filter by its state-space representation:

x =Ax+ Bu
y=Cx+Du

The A-Matrix, B-Matrix, C-Matrix, and D-Matrix fields specify a variable name or a
value for each matrix in this system.

Zeros, Poles, Gain
For Zeros, Poles, Gain, you specify the filter by its zero-pole-gain representation:

Z(2) _ i (z—2DN2-2(2))---(2—2(m))

H(z) = =
P(2) (2= p(D))z - p(2))---(z- p(n))

* The Zeros field specifies a variable name or value for the zeros vector z, which
contains the locations of m zeros.
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+ The Poles field specifies a variable name or value for the zeros vector p, which
contains the locations of n poles.

* The Gain field specifies a variable name or value for the gain k.

Second Order Sections

For 2nd Order Sections you specify the filter by its second-order section
representation:

L L -1 -2
bop +bipz " + bz

H(z) =[] Hp2) = [ 22225222
i) k=1 1+aq2 " +agz

The SOS Matrix field specifies a variable name or a value for the L-by-6 SOS matrix

bor b1 b1 1 a; ag;
b bo 1 a a
sos=| 02 b1.2 2 0 T2 722

bor, bir bar 1 a1, agp,

whose rows contain the numerator and denominator coefficients b;, and a;;, of the second-
order sections of H(z).

Note If you import a filter that was not created in SPTool, you can only edit that filter
using the Pole/Zero Editor.

Importing Spectra
When you import a power spectral density (PSD), you specify:

* A variable name or a value for the PSD vector in the PSD field

+ A variable name or a value for the frequency vector in the Freq. Vector field

The PSD values in the PSD vector correspond to the frequencies contained in the Freq.
Vector vector; the two vectors must have the same length.
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J Import to SPTool

Source

File Cantents

" From ‘Workspace

MAT-file Mame:

Browse... |

i

rImport As ISpectlum vl—

I PSD
I Freq. Wector

Cancel

Help I

— Mame

spect]
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Loading Variables from the Disk

To import variables representing signals, filters, or spectra from a MAT-file on your disk;
1 Select the From Disk radio button and do either of the following:

Type the name of the file you want to import into the MAT-file Name field and
press either the Tab or the Enter key on your keyboard.

Select Browse, and then find and select the file you want to import using Select
> File to Open. Click OK to close that dialog.

In either case, all variables in the MAT-file you selected are displayed in the File
Contents list.

2 Select the variables to be imported into SPTool.

You can now import one or more variables from the File Contents list into SPTool, as
long as these variables are scalars, vectors, or matrices.
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Saving and Loading Sessions

8-36

In this section...

“SPTool Sessions” on page 8-36

“Filter Formats” on page 8-36

SPTool Sessions

When you start SPTool, the default startup.spt session is loaded. To save your work
in the startup SPTool session, use File > Save Session or to specify a session name, use
File > Save Session As.

To recall a previously saved session, use File > Open Session.

Filter Formats

When you start SPTool or open a session, the current filter design format preference is
compared to the filter formats in the session. See “Setting Preferences” on page 8-42.

+ If the formats match, the session opens.

+ If the filter preference is FDATool, but the session contains Filter Designer filters,
this warning displays:

+) Convert filters to use FDATool? o ] oA |

Filterz in thiz sezsion were created with Filker Designer and are not
compatible with FOAT ool,

Select "Conwert if pou want to zet FOAT ool az the prefered filker design
toal and permanently canvert all filters in this session to an FDAT ool
format.

Mote: Corvverting to an FOAT ool format cannot be undore,

Select "o not uze FOAT ool bo continue uzing Filter Degigner.

Mote: Filter Degigner will be removed in a future release.

Convert Do not use FDATool
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Click Convert to convert the filters to FDATool format. Click Don't Use FDATool
to leave the filters in Filter Designer format and change the preference to Use Filter
Designer.

If the filter preference is Use Filter Designer, but the session contains FDATool
filters, this warning displays:

) Design filters using =101 x|

Filters in thiz session were created with FDAT ool and are not compatible
with Filter Degigner. Switching to Filker Designer will delete all filkers

it thiz sezsion,

Do vou want to use Filter Dezsigner and delete your current filkers?

Mate: Filter Dezsigner will be remaoved in a future release.
Yes I No |

Click Yes to remove the current filters. Click No to leave the filters in FDATool.
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Selecting Signals, Filters, and Spectra

8-38

All signals, filters, or spectra listed in SPTool exist as special MATLAB structures. You
can bring data representing signals, filters, or spectra into SPTool from the MATLAB
workspace. In general, you can select one or several items in a given list box. An item is
selected when it is highlighted.

The Signals list shows all vector and array signals in the current SPTool session.
The Filters list shows all designed and imported filters in the current SPTool session.
The Spectra list shows all spectra in the current SPTool session.

You can select a single data object in a list, a range of data objects in a list, or multiple
separate data objects in a list. You can also have data objects simultaneously selected in
different lists:

* To select a single item, click it. All other items in that list box become deselected.

* To add or remove a range of items, Shift+click on the items at the top and bottom of
the section of the list that you want to add. You can also drag your mouse pointer to
select these items.

* To add a single data object to a selection or remove a single data object from a
multiple selection, Ctrl+click on the object.
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Editing Signals, Filters, or Spectra
You can edit selected items in SPTool by

1  Selecting the names of the signals, filters, or spectra you want to edit.

2 Selecting the appropriate Edit menu item:

* Duplicate to copy an item in an SPTool list

+ Clear to delete an item in an SPTool list
Name to rename an item in an SPTool list
Sampling Frequency to modify the sampling frequency associated with either a
signal (and its associated spectra) or filter in an SPTool list

The pull-down menu next to each menu item shows the names of all selected items.

You can also edit the following signal characteristics by right-clicking in the display
region of the Signal Browser, the Filter Visualization Tool, or the Spectrum Viewer:

* The signal name
*  The sampling frequency

* The line style properties

Note If you modify the sampling frequency associated with a signal's spectrum using the

right-click menu on the Spectrum Viewer display region, the sampling frequency of the
associated signal is automatically updated.
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Making Signal Measurements with Markers

8-40

You can use the markers on the Signal Browser or the Spectrum Viewer to make
measurements on either of the following:

+ A signal in the Signal Browser

* A power spectral density plotted in the Spectrum Viewer

The following marker buttons are included

B = A

Icon Description

Toggle markers on/off

i3

Vertical markers

Horizontal markers

Vertical markers with tracking

Vertical markers with tracking and slope

Display peaks (local maxima)

SEEIE

You can find peaks in a signal from the command line with
findpeaks

l? Display valleys (local minima)

To make a measurement:

1 Select a line to measure (or play, if you are in the Signal Browser).
2 Select one of the marker buttons to apply a marker to the displayed signal.

3 Position a marker in the main display area by grabbing it with your mouse and
dragging:



Making Signal Measurements with Markers

a Select a marker setting. If you choose the Vertical, Track, or Slope buttons,
you can drag a marker to the right or left. If you choose the Horizontal button,
you can drag a marker up or down.

b Move the mouse over the marker (1 or 2) that you want to drag.

The hand cursor with the marker number inside it &I is displayed when your
mouse passes over a marker.

¢ Drag the marker to where you want it on the signal
As you drag a marker, the bottom of the Signal Browser shows the current position
of both markers. Depending on which marker setting you select, some or all of the

following fields are displayed — x1, y1, x2, y2, dx, dy, m. These fields are also
displayed when you print from the Signal Browser, unless you suppress them.

You can also position a marker by typing its x1 and x2 or y1 and y2 values in the region
at the bottom.
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Setting Preferences

In this section...

“Overview of Setting Preferences” on page 8-42
“Summary of Settable Preferences” on page 8-43

“Setting the Filter Design Tool” on page 8-43

Overview of Setting Preferences

Use File > Preferences to customize displays and certain parameters for SPTool and
its four component GUIs. If you change any preferences, a dialog box displays when you
close SPTool asking if you want to save those changes. If you click Yes, the new settings
are saved on disk and are used when you restart SPTool from the MATLAB workspace.

Note You can set MATLAB preferences that affect the Filter Visualization Tool only from
within FVTool by selecting File > Preferences. You can set FVTool-specific preferences
using Analysis > Analysis Parameters.

When you first select Preferences, the Preferences dialog box opens with Markers

selected by default.
-} Preferences for SPTool |i |
— Markers
Colos Marker I:Dlorl RIGED
Signal Browser
Spectium Yiewer Marker Style I a j
Filter Desigres :
Default Session Marker S'2'3| 8
plug-ing
Initial Type I track j
Help... | Factory Settings Hewvert Fanel K Cancel

8-42



Setting Preferences

Change any marker settings, if desired. To change settings for another category, click its
name in the category list to display its settings. Most of the fields are self-explanatory.
Details of the Filter Design options are described below.

Summary of Settable Preferences

In the Preferences regions, you can

Select colors and markers for all displays.
Select colors and line styles for displayed signals.

Configure labels, and enable/disable markers, panner, and zoom in the Signal
Browser.

Configure display parameters, and enable/disable markers and zoom in the Spectrum
Viewer.

Select whether to use the default FDATool or the Filter Designer to design filters.
FDATool is the recommended designer.

Enable/disable use of a default session file.
Export filters for use with Control System Toolbox software.

Enable/disable search for plug-ins at startup.

Setting the Filter Design Tool

The Filter Designer options include radio buttons to select the filter design tool.

8-43



8 sPlool: A Signal Processing GUI Suite

8-44

) Preferences for SPTool

Markers

Colors

Signal Browser
Spectrum Viewer
Filter Designer

Default Session
Exporting Components
plug-ins

Help...

=101 x|
— Filter Designer
A FFT Length IWQ'B
{¥ Use FDATool
™ Use Fitter Designer (to be removed)
[¥ | Display grid lines
[~ Auto Design
r Stay in zoom mode after zoom
|
| Factory Settings Revert Panel 0K Cancel

FDATool is the default and recommended tool. You can use Filter Designer, but Filter
Designer will be removed in a future release. You cannot change this preference if either
FDATool or the Filter Designer is open.

Note Filters in any one SPTool session must be in the same format — either FDATool
format or Filter Designer format. You can convert filters from the Filter Designer format
to FDATool format, but you cannot convert FDATool filters to Filter Designer format.

If you change the preference from Use FDATool to Use Filter Designer, a warning
message appears. The warning message informs you that filters created with FDATool
are not compatible with Filter Designer and that Filter Designer will be removed in the

future.
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| Design filters using

Filkers in thiz zezsion were created with FDAT ool and are not compatible
with Filter D esigner. Switching to Filker Designer will delete all filkers

i thiz sezgz0n.

Lo pou want o use Filter Designer and delete wour current filkers?

Mate: Filker Designer will be removed in a future releasze.

Yez

MNo

=101 x|

See “Saving and Loading Sessions” on page 8-36 for more information.

When you change the preference from Use Filter Designer to Use FDATool, a

confirmation message appears indicating that switching will convert your filters to

FDATool format. See “Saving and Loading Sessions” on page 8-36 for information on this

message.

Changes to Filter Designer format are saved only if you save the session. Exiting the
session prompts you to save changes to the sigprefs.mat and startup.spt files.
Starting SPTool with Filter Designer specified as the filter design tool results in the

warning:

Designe

SPToaol loads preferences from the sigprefs mat file. Fiter
Designet iz currertly selected a= fiter design toal.

Mate: Fitter Designet will be removed in a future release.

[” Do not =how me this again

=101 ]

Close |

The warning appears each time SPTool initializes unless you opt to not show the

warning.
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Using the Filter Designer

8-46

In this section...

“Filter Designer” on page 8-46

“Filter Types” on page 8-46

“FIR Filter Methods” on page 8-46

“IIR Filter Methods” on page 8-47

“Pole/Zero Editor” on page 8-47

“Spectral Overlay Feature” on page 8-47

“Opening the Filter Designer” on page 8-47

“Accessing Filter Parameters in a Saved Filter” on page 8-49
“Designing a Filter with the Pole/Zero Editor” on page 8-52
“Positioning Poles and Zeros” on page 8-53

“Redesigning a Filter Using the Magnitude Plot” on page 8-55

Filter Designer

“FDATool” on page 8-10 is the recommended filter design tool. Filter Designer will be
removed in a future release. The following information is provided for users that choose
to use Filter Designer while they transition to FDATool. Filter Designer, provides an
interactive graphical environment for the design of digital ITR and FIR filters based on
specifications that you enter on a magnitude or pole-zero plot.

Filter Types

You can design filters of the following types using the Filter Designer:
+ Bandpass

+ Lowpass

*  Bandstop

* Highpass

FIR Filter Methods

You can use the following filter methods to design FIR filters:



Using the Filter Designer

*  Equiripple
* Least squares
* Window

IIR Filter Methods

You can use the following filter methods to design IIR filters:

*  Butterworth

*  Chebyshev Type I
+  Chebyshev Type II
- Elliptic

Pole/Zero Editor

You can use the Pole/Zero Editor to design arbitrary FIR and IIR filters by placing and
moving poles and zeros on the complex z-plane.

Spectral Overlay Feature

You can also superimpose spectra on a filter's magnitude response to see if the filtering
requirements are met.

Opening the Filter Designer

Open the Filter Designer from SPTool by either:

+ Clicking New in the Filters list in SPTool

+  Selecting a filter you want to edit from the Filters list in SPTool, and then clicking
Edit
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<} Filter Designer = E3
File  ‘Window Help

|8 DX E 6 womEN

Filter Sampling Frequency Algorithm
[t [ =l | G192 |Equiipple FIR =l
Specifications Meazurements
Frequency Response
V' Minimurn Order 10 : : :
i Order 22

LU T—. 'l

Passhand —— Passhand

Fp I 4095 & Actual Bp 3937
= .
& Weight 1
=

Re[3 =
=
7 -

Stopbard————————————| = Stopband ————

Fs I E14.4 Actual As 17.63

‘wieight 1.71
Rs | 20
. H i i
I Auto Design 2000 3000 4000
Eevert | Spply | Frequency

The Filter Designer has the following components:

* A pull-down Filter menu for selecting a filter from the list in SPTool
* A Sampling Frequency text box

+ A pull-down Algorithm menu for selecting a filter design method or a pole-zero plot
display

A Specifications area for viewing or modifying a filter's design parameters or pole-zero
locations

+ A plot display region for graphically adjusting filter magnitude responses or the pole-
zero locations

* A Measurements area for viewing the response characteristics and stability of the
current filter

* A toolbar with the following buttons

Icon Description

EAEY Print and print preview
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Icon Description
TN T A& b Zoom 1n and out
) Passband view

Overlay spectrum

Turn on the What's This help

Accessing Filter Parameters in a Saved Filter

The MATLAB structures created by SPTool have several associated fields, many of which
are also MATLAB structures. See the MATLAB documentation for general information
about MATLAB structures.

For example, after exporting a filter filtl to the MATLAB workspace, type
filtl

to display the fields of the MATLAB filter structure. The tF, Fs, and specs fields of the
structure contain the information that describes the filter.

The #f Field: Accessing Filter Coefficients

The tf field is a structure containing the transfer function representation of the filter.
Use this field to obtain the filter coefficients;
+ Filtl.tf._num contains the numerator coefficients.

+ fFiltl.tf.den contains the denominator coefficients.

The vectors contained in these structures represent polynomials in descending powers of
z. The numerator and denominator polynomials are used to specify the transfer function

_B(z) _ WD)+b@)z 7+ bnb+ D™

Hiz) = =
‘ A2 o) +a@zt +- +ama +1)z™"

where:
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b is a vector containing the coefficients from the tf.num field.
a is a vector containing the coefficients from the tF.den field.
m 1s the numerator order.

n 1s the denominator order.

You can change the filter representation from the default transfer function to another
form by using the tF2ss or tF2zp functions.

The Fs Field: Accessing Filter Sample Frequency

The Fs field contains the sampling frequency of the filter in hertz.

The specs Field: Accessing other Filter Parameters

The specs field is a structure containing parameters that you specified for the filter
design. The first field, specs.currentModule, contains a string representing the
most recent design method selected from the Filter Designer's Algorithm list before
you exported the filter. The possible contents of the currentModule field and the
corresponding design methods are shown below.

Contents of the currentModule field Design Method
fdbutter Butterworth IIR
fdchebyl Chebyshev Type I IIR
fdcheby?2 Chebyshev Type II IIR
fdellip Elliptic ITR

fdfirls Least Squares FIR
fdkaiser Kaiser Window FIR
fdremez Equiripple FIR

Following the specs.currentModule field, there may be up to seven additional fields,
with labels such as specs.fdremez, specs.fdfirls, etc. The design specifications
for the most recently exported filter are contained in the field whose label matches the
currentModule string. For example, if the specs structure is

Ffiltl._specs

ans

currentModule: "fdremez*
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fdremez: [1x1 struct]

the filter specifications are contained in the fdremez field, which is itself a data
structure.

The specifications include the parameter values from the Specifications region of the
Filter Designer, such as band edges and filter order. For example, the filter above has the
following specifications stored in Fi Itl.specs.fdremez:

filtl._specs.fdremez

ans =
setOrderFlag: O
type: 3
f: [0 0.2000 0.3000 0.5000 0.6000 1]
m: [6x1 double]

Rp: 0.0100

Rs: 75

wt: [3.2371 1 3.2371]
order: 78

Because certain filter parameters are unique to a particular design, this structure has a
different set of fields for each filter design.

The table below describes the possible fields associated with the filter design specification
field (the specs field) that can appear in the exported structure.

Parameter Description

Beta Kaiser window B parameter.

L Contains a vector of band-edge frequencies, normalized so that 1
Hz corresponds to half the sample frequency.

Fpass Passband cutoff frequencies. Scalar for lowpass and highpass
designs, two-element vector for bandpass and bandstop designs.

Fstop Stopband cutoff frequencies. Scalar for lowpass and highpass
designs, two-element vector for bandpass and bandstop designs.

m The response magnitudes corresponding to the band-edge
frequencies in F.

order Filter order.

Rp Passband ripple (dB)
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Parameter Description
Rs Stopband attenuation (dB)
setOrderFlag Contains 1 if the filter order was specified manually (i.e.,

the Minimum Order box in the Specifications region was
not selected). Contains O if the filter order was computed

automatically.

type Contains 1 for lowpass, 2 for highpass, 3 for bandpass, or 4 for
bandstop.

w3db -3 dB frequency for Butterworth IIR designs.

wind Vector of Kaiser window coefficients.

wn Cutoff frequency for the Kaiser window FIR filter when

setOrderFlag = 1.

wt Vector of weights, one weight per frequency band.

Designing a Filter with the Pole/Zero Editor

To design a filter transfer function using the Filter Designer Pole/Zero Editor:

1 Select the Pole/Zero Editor option from the Algorithm list to open the Pole/Zero
Editor in the Filter Designer display.

E quiripple FIR

Least Squares FIR
F.aizer Window FIR
Butterwarth [1R
Chebyshey Type 1 1IR
Chebyzhew Tope 2 IR
Elliptic: 1R

2 Enter the desired filter gain in the Gain edit box.

3 Select a pole or zero (or conjugate pair) by selecting one of the % (pole) or £ (zero)
symbols on the plot.

4  Choose the coordinates to work in by specifying Polar or Rectangular from the
Coordinates list.

5 Specify the new location(s) of the selected pole, zero, or conjugate pair by typing
values into the Mag and Angle fields (for angular coordinates) or X and Y (for
rectangular coordinates) fields. Alternatively, position the poles and zeros by
dragging the x and < symbols.
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6 Use the Conjugate pair check box to create a conjugate pair from a lone pole or
zero, or to break a conjugate pair into two individual poles or zeros.

Design a new filter or edit an existing filter in the same way.

Note Keep the Filter Visualization Tool (FVTool) open while designing a filter with the
Pole/Zero Editor. Any changes that you make to the filter transfer function in the Pole/
Zero Editor are then simultaneously reflected in the response plots of FVTool.

Positioning Poles and Zeros

You can use your mouse to move poles and zeros around the pole/zero plot and modify
your filter design.

Icon Description

L_}e Enable moving poles or zeros by dragging on the plot
xﬁJ Add pole

ERJ Add zero

E Erase poles or zeros

You can move both members of a conjugate pair simultaneously by manipulating just one
of the poles or zeros.

To ungroup conjugates, select the desired pair and clear Conjugate pair in the
Specifications region on the Filter Designer.
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When you place two or more poles (or two or more zeros) directly on top of each other,

a number is displayed next to the symbols (on the left for poles, and on the right for
zeros) indicating the number of poles or zeros at that location (e.g., ©3 for three zeros).
This number makes it easy to keep track of all the poles and zeros in the plot area, even
when several are superimposed on each other and are not visually differentiable. Note,
however, that this number does not indicate the multiplicity of the poles or zeros to which
it is attached.

To detect whether or not a set of poles or zeros are truly multiples, use the zoom tools to
magnify the region around the poles or zeros in question. Because numerical limitations
usually prevent any set of poles or zeros from sharing exactly the same value, at a high
enough zoom level even truly multiple poles or zeros appear distinct from each other.

A common way to assess whether a particular group of poles or zeros contains multiples

is by comparing the mutual proximity of the group members against a selected threshold
value. As an example, the residuez function defines a pole or zero as being a multiple
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of another pole or zero if the absolute distance separating them is less than 0.1% of the
larger pole or zero's magnitude.

Redesigning a Filter Using the Magnitude Plot

After designing a filter in the Filter Designer, you can redesign it by dragging the
specification lines on the magnitude plot. Use the specification lines to change passband
ripple, stopband attenuation, and edge frequencies.

In the following example, create a Chebyshev filter and modify it by dragging the
specification lines:

AW N —

Select Chebyshev Type I 1R from the Algorithm menu.
Select highpass from the Type menu.
Type 2000 in the Sampling Frequency field.

Set the following parameters:

+ Fp =800
Fs =700
Rp=2.5

+ Rs=35

Select Minimum Order so the Filter Designer can calculate the lowest filter order
that produces the desired characteristics.

Click Apply to compute the filter and update the response plot.

Position the cursor over the horizontal filter specification line for the stopband. This
is the first (leftmost) horizontal specification line you see.

The cursor changes to the up/down drag indicator.
Drag the line until the Rs (stopband attenuation) field reads 100.

Note The Order value in the Measurements region changes because a higher filter
order is needed to meet the new specifications.
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Supported Functions

Code generation from MATLAB is a restricted subset of the MATLAB language that
provides optimizations for:

* Generating efficient, production-quality C/C++ code and MEX files for deployment
in desktop and embedded applications. For embedded targets, the subset restricts
MATLAB semantics to meet the memory and data type requirements of the target
environments.

Depending on which feature you wish to use, there are additional required products. For
a comprehensive list, see “Installing Prerequisite Products” in the MATLAB Coder™
documentation.

Code generation from MATLAB supports Signal Processing Toolbox functions listed in
the table. To generate C code, you must have the MATLAB Coder software. If you have
the Fixed-Point Designer software, you can use Fiaccel to generate MEX code for fixed-
point applications.

To follow the examples in this documentation:

* To generate C/C++ code and MEX files with codegen, install the MATLAB Coder

software, the Signal Processing Toolbox, and a C compiler. For the Windows®
platform, MATLAB supplies a default C compiler. Run mex -setup at the MATLAB
command prompt to set up the C compiler.

*  Change to a folder where you have write permission.

Note: Many Signal Processing Toolbox functions require constant inputs in generated
code. To specify a constant input for codegen, use coder.Constant.

Function Remarks/Limitations

barthannwin Window length must be a constant. Expressions or variables are allowed
if their values do not change.

bartlett Window length must be a constant. Expressions or variables are allowed
if their values do not change.

besselap Filter order must be a constant. Expressions or variables are allowed if
their values do not change.
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Function Remarks/Limitations

bitrevorder —

blackman Window length must be a constant. Expressions or variables are allowed
if their values do not change.

blackmanharris Window length must be a constant. Expressions or variables are allowed
if their values do not change.

bohmanwin Window length must be a constant. Expressions or variables are allowed
if their values do not change.

buttap Filter order must be a constant. Expressions or variables are allowed if
their values do not change.

butter Filter coefficients must be constants. Expressions or variables are allowed
if their values do not change.

buttord All inputs must be constants. Expressions or variables are allowed if their
values do not change.

cFirpm All inputs must be constants. Expressions or variables are allowed if their
values do not change.

cheblap All inputs must be constants. Expressions or variables are allowed if their
values do not change.

cheb2ap All inputs must be constants. Expressions or variables are allowed if their
values do not change.

cheblord All inputs must be constants. Expressions or variables are allowed if their
values do not change.

cheb2ord All inputs must be constants. Expressions or variables are allowed if their
values do not change.

chebwin All inputs must be constants. Expressions or variables are allowed if their
values do not change.

chebyl All Inputs must be constants. Expressions or variables are allowed if
their values do not change.

cheby?2 All inputs must be constants. Expressions or variables are allowed if their
values do not change.

db2pow —
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Function Remarks/Limitations

dct C and C++ code generation for dct requires DSP System Toolbox
software.
Length of transform dimension must be a power of two. If specified, the
pad or truncation value must be constant. Expressions or variables are
allowed if their values do not change.

downsample —

dpss All inputs must be constants. Expressions or variables are allowed if their
values do not change.

ellip Inputs must be constant. Expressions or variables are allowed if their
values do not change.

ellipap All inputs must be constants. Expressions or variables are allowed if their
values do not change.

ellipord All inputs must be constants. Expressions or variables are allowed if their
values do not change.

filtfilt Filter coefficients must be constants. Expressions or variables are allowed
if their values do not change.

findpeaks —

firl All inputs must be constants. Expressions or variables are allowed if their
values do not change.

fir2 All inputs must be constants. Expressions or variables are allowed if their
values do not change.

fircls All inputs must be constants. Expressions or variables are allowed if their
values do not change.

firclsl All inputs must be constants. Expressions or variables are allowed if their
values do not change.

firls All inputs must be constants. Expressions or variables are allowed if their
values do not change.

firpm All inputs must be constants. Expressions or variables are allowed if their
values do not change.

firpmord All inputs must be constants. Expressions or variables are allowed if their
values do not change.
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Function

Remarks/Limitations

flattopwin

All inputs must be constants. Expressions or variables are allowed if their
values do not change.

freqz

* Does not support variable-size inputs.

*  When called with no output arguments, and without a semicolon at
the end, freqz returns the complex frequency response of the input
filter, evaluated at 512 points.

If the semicolon is added, the function produces a plot of the
magnitude and phase response of the filter.

See “freqz With No Output Arguments” on page 9-15.

gausswin

All inputs must be constant. Expressions or variables are allowed if their
values do not change.

hamming

All inputs must be constant. Expressions or variables are allowed if their
values do not change.

hann

All inputs must be constant. Expressions or variables are allowed if their
values do not change.

idct

C and C++ code generation for idct requires DSP System Toolbox
software.

Length of transform dimension must be a power of two. If specified, the
pad or truncation value must be constant. Expressions or variables are
allowed if their values do not change.

intfilt

All inputs must be constant. Expressions or variables are allowed if their
values do not change.

kaiser

All inputs must be constant. Expressions or variables are allowed if their
values do not change.

kaiserord

levinson

C and C++ code generation for levinson requires DSP System Toolbox
software.

If specified, the order of recursion must be a constant. Expressions or
variables are allowed if their values do not change.
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Function

Remarks/Limitations

maxflat

All inputs must be constant. Expressions or variables are allowed if their
values do not change.

nuttallwin

All inputs must be constant. Expressions or variables are allowed if their
values do not change.

parzenwin All inputs must be constant. Expressions or variables are allowed if their
values do not change.

pow2db —

rcosdesign All inputs must be constant. Expressions or variables are allowed if their
values do not change.

rectwin All inputs must be constant. Expressions or variables are allowed if their
values do not change.

resample The upsampling and downsampling factors must be specified as
constants. Expressions or variables are allowed if their values do not
change.

sgolay All inputs must be constant. Expressions or variables are allowed if their
values do not change.

sosfTilt —

taylorwin All inputs must be constant. Expressions or variables are allowed if their
values do not change.

triang All inputs must be constant. Expressions or variables are allowed if their
values do not change.

tukeywin All inputs must be constant. Expressions or variables are allowed if their
values do not change.

upfirdn C and C++ code generation for upFirdn requires DSP System Toolbox

software.
Filter coefficients, upsampling factor, and downsampling factor must
be constants. Expressions or variables are allowed if their values do not

change.

Variable-size inputs are not supported.
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Function Remarks/Limitations

upsample Either declare input n as constant, or use the assert function in the
calling function to set upper bounds for n. For example,
assert(n<10)

Xcorr —

yulewalk If specified, the order of recursion must be a constant. Expressions or

variables are allowed if their values do not change.
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Specifying Inputs in Code Generation from MATLAB

9-8

In this section...

“Defining Input Size and Type” on page 9-8

“Inputs must be Constants” on page 9-9

Defining Input Size and Type

When you use Signal Processing Toolbox functions for code generation, you must define
the size and type of the function inputs. One way to do this is with the —args compilation
option. The size and type of inputs must be defined because C is a statically typed
language. . To illustrate the need to define input size and type, consider the simplest call
to Xcorr requiring two input arguments. The following demonstrates the differences in
the use of xcorr in MATLAB and in Code Generation from MATLAB.

Cross correlate two white noise vectors in MATLAB:

X randn(512,1); %real valued white noise
y randn(512,1); %real valued white noise

[C,lags] = xcorr(X,y);

x_circ = randn(256,1)+1j*randn(256,1); %circular white noise
y_circ = randn(256,1)+1j*randn(256,1); %circular white noise
[C1,lagsl] = xcorr(x_circ,y circ);

Xcorr does not require the size and type of the input arguments. Xcorr obtains this
information at runtime. Contrast this behavior with a MEX-file created with codegen.
Create the file myxcorr.min a folder where you have read and write permission. Ensure
that this folder is in the MATLAB search path. Copy and paste the following two lines of
code into myxcorr.m and save the file. The compiler tag %#codegen must be included in
the file.

function [C,Lags]=myxcorr(Xx,y) %#codegen
[C,Lags]=xcorr(x,y);

Enter the following command at the MATLAB command prompt:
codegen myxcorr -args {zeros(512,1),zeros(512,1)} -0 myxcorr
Run the MEX-file:

x = randn(512,1); %real valued white noise
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y = randn(512,1); %real valued white noise
[C,Lags] = myxcorr(X,y):

Define two new inputs X1 and y1 by transposing X and Y.

x1
yl

X"; %x1 is 1x512
y"; %yl is 1x512

Attempt to rerun the MEX-file with the tranposed inputs.

[C,Lags] = myxcorr(x1,yl); %Errors

The preceding program errors with the message ??? MATLAB expression is

not of the correct size: expected [512x1] found [1x512].

X

The error results because the inputs are specified to be 512x1 real-valued column vectors
at compilation. For complex-valued inputs, you must specify that the input is complex
valued. For example:

codegen myxcorr -o ComplexXcorr ...
-args {complex(zeros(512,1)),complex(zeros(512,1))}

Run the MEX-file at the MATLAB command prompt with complex-valued inputs of the
correct size:

x_circ randn(512,1)+1j*randn(512,1); %circular white noise
y_circ randn(512,1)+1j*randn(512,1); %circular white noise
[C,Lags] = ComplexXcorr(x_circ,y_circ);

Attempting to run ComplexXcorr with real valued inputs results in the error: ???
MATLAB expression "x" is not of the correct complexness.

Inputs must be Constants

For a number of supported Signal Processing Toolbox functions, the inputs or a subset
of the inputs must be specified as constants at compilation time. Functions with this
behavior are noted in the right column of the table “Supported Functions” on page 9-2.
Use coder.Type with the —args compilation option, or enter the constants directly in
the source code.

Specifying inputs as constants at compilation time results in significant advantages in
the speed and efficiency of the generated code. For example, storing filter coefficients or
window function values as vectors in the C source code improves performance by avoiding
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costly computation at runtime. Because a primary purpose of Code Generation from
MATLAB is to generate optimized C code for desktop and embedded systems, emphasis
is placed on providing the user with computational savings at runtime whenever
possible.

To illustrate the constant input requirement with butter, create the file
myLowpassFilter.min a folder where you have read and write permission. Ensure that
this folder is in the MATLAB search path. Copy and paste the following lines of code into
myLowpassFilter.m and save the file.

function output = mylLowpassFilter(input,N,Wn) %#codegen
[B,A] = butter(N,Wn,"low");
output = Ffilter(B,A, input);

If you have the MATLAB Coder software, enter the following command at the MATLAB
command prompt:

codegen myLowpassFilter -o myLowpassFilter ...
-args {zeros(512,1), coder.newtype(“constant”,5),coder.newtype("constant”,0.1) } -repol

Once the program compiles successfully, the following message appears in the command
window: Code generation successful: View report.

Click on View report. Click on the C code tab on the top left and open the target
source file myLowpassFilter.c.

Note that the numerator and denominator filter coefficients are included in the source
code.

static real_T dvO[6

1 = { 5-.9795780369978346E-5, 0.00029897890184989173,
static real _T dvi[6] = { 1

.0, -3.9845431196123373, 6.4348670902758709,
Run the MEX-file without entering the constants:
output = myLowpassFilter(randn(512,1));

If you attempt to run the MEX-file by inputting the constants, you receive the error ???
Error using ==> myLowpassFilter 1 input required for entry-point
"myLowpassFilter-.

You may also enter the constants in the MATLAB source code directly. Edit the
myLowPassFi lter.m file and replace the MATLAB code with the lines:

function output = myLowpassFilter(input) %#codegen
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[B,A] = butter(5,0.1,"low");
output = Ffilter(B,A,input);

Enter the following command at the MATLAB command prompt:

codegen myLowpassFilter -args {zeros(512,1)} -o myLowpassFilter
Run the MEX-file by entering the following at the MATLAB command prompt:
output = myLowpassFilter(randn(512,1));

See “Apply Window to Input Signal” on page 9-12 ,“Apply Lowpass Filter to Input
Signal” on page 9-14, and “Zero Phase Filtering” on page 9-16 for additional
examples of the constant input requirement.
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Code Generation Examples

In this section...

“Apply Window to Input Signal” on page 9-12

“Apply Lowpass Filter to Input Signal” on page 9-14

“Cross Correlate or Autocorrelate Input Data” on page 9-14
“freqz With No Output Arguments” on page 9-15

“Zero Phase Filtering” on page 9-16

Apply Window to Input Signal
In this example, apply a Hamming window to an input data vector of size 512x1.

Create a file called window_data.m by typing

>>edit window_data
at the MATLAB command prompt.

Copy and paste the code provided into the editor and save the file.

function output_data=window_data(input_data,N) %#codegen
Win=hamming(N);
output_data=input_data.*Win;

Use codegen to generate a MEX—file window_data.m.
codegen window_data -args {zeros(512,1),coder.newtype("constant”,512)} -o window_data

The -args option defines the input specifications for the MEX —file. input_data
is a 512x1 real valued vector. Because the input to hamming must be a constant,
coder .newtype is used to specify the window length. In a conventional MATLAB
program, you can read the input data length at runtime and construct a Hamming
window of the corresponding length.

Alternatively, edit the code for window_data.m as follows:
function output_data=window_data(input_data) %#codegen

Win=hamming(512);
output_data=input_data.*Win;

9-12



Code Generation Examples

The preceding code specifies the length of the Hamming window in the source code as
opposed to using coder .newtype. Use codegen to generate a MEX—file and C code:

codegen window_data -args {zeros(512,1)} -o window_data -report

The -report flag generates a compilation report. If the codegen operation is successful,
you obtain: Code generation successful: View report.

Click on View report to view the Code Generation Report.

Select the C-code tab and select window_data.c as the Target Source File.

[B, code Generation Report =B %

MATLAB code  Call stack € code File: window_data.c (h:\mfiles\codegen\mex\window data\window data.c}
1€ /% Named Constants */

Target Source Files

Z rt_nonfintte.h 18 /* Va

E) rtwtypes.h e

] window data.h .

Z) window data apic

) window data apih

€] window data_initialire.c
el itk void window_data(const real T input_data[512], real T ocutput &

window data mex.c 27 o - - - - -

window data terminate.c 28 int32 T i;

ions */

window data terminate.h 23 static real T dv0[512] = { 0.080000000000000016, 0.0800347)
) window _data tvpes.h for (i = 0: 1 < 512; 144) { £
5 output_data[i] = input_data[i] * dvO[i]:

-/

End of code generation (vindow_data.c)

Summary All Messages (0) Target Build Log
C source code generated on: 18-Oct-2010 10:24:42

Coding target: C MEX Function
Number of errors: o
Humber of warnings: [

Provide Feedback

We value your feedback. Please take a few minutes to answer this short survey regarding the Code
Generation Report.

>>Take Survey

Note from the location bar that the C source code is in the codegen/mex/
<FUNCTION_NAME> folder. Running codegen creates this folder and places the C source
code, C header files, and MEX files in the folder. Each function that you create produces
a codegen/mex/<FUNCTION_NAME> folder.

Scroll through the C code to see that the values of the Hamming window are included
directly in the C source code.

Run the MEX-file on a white noise input:
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% Window white noise input
output_data=window_data(randn(512,1));

Apply Lowpass Filter to Input Signal

Assuming a sampling frequency of 20 kHz, create a 4—th order Butterworth filter with a
3—dB frequency of 2.5 kHz. Use the Butterworth filter to lowpass filter a 10000x1 input
data vector.

Create a file called ButterFilt.m. Copy and paste the following code into the file.

function output_data=ButterFilt(input_data) %#codegen
[b,a]l=butter(4,0.25);
output_data=Ffilter(b,a, input_data);

Run the codegen command to obtain the C source code ButterFilt.c and MEX file:

codegen ButterFilt -args {zeros(10000,1)} -o ButterFilt -report
The C source code includes the five numerator and denominator coefficients of the 4—th
order Butterworth filter as constants.

static real_T dvO[5]
static real_T dvi[5]

{ 0.010209480791203124, 0.040837923164812495, 0.061256884747218
{ 1.0, -1.9684277869385174, 1.7358607092088851, -0.724470829507:

Apply the filter using the MEX-file:

Fs=20000;

%Create 10000x1 input signal

t=0:(1/Fs):0.5-(1/Fs);
input_data=(cos(2*pi*1000*t)+sin(2*pi*500*t)+0.2*randn(size(t)))";
%Filter data

output_data=ButterFilt(input_data);

Cross Correlate or Autocorrelate Input Data

Estimate the cross correlation or autocorrelation of two real-valued input vectors to lag
50. Output the estimate at the nonnegative lags.

Create a file called myxcorr.m. Copy and paste the following code into the file:
function [C,Lags]=myxcorr(Xx,y) %#codegen

[c,lags]=xcorr(x,y,50, "coeff");
C=c(51l:end);
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Lags=lags(51:end);
Run the codegen command at the MATLAB command prompt:
codegen myxcorr -args {zeros(512,1), zeros(512,1)} -o myxcorr -report

Use the MEX-file to compute and plot the autocorrelation of a white noise input:

rng(0, "twister"™)

%White noise input

input_data=randn(512,1);

%Compute autocorrelation with MEX-File
[C,Lags]=myxcorr(input_data, input_data);

% Plot the result

stem(Lags,C); axis([-0.5 51 -1.1 1.1])

xlabel ("Lags®); ylabel("Autocorrelation Function®);

B Figure 1 =68 =
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freqz With No Output Arguments

In Code Generation from MATLAB, freqz with no output arguments behaves differently
than in the standard MATLAB language. In standard MATLAB, freqz with no output
arguments produces a plot of the magnitude and phase response of the input filter. The
plot is produced regardless of whether the call to freqz terminates in a semicolon or not.
No frequency response or phase vectors are returned.

freqz with no output arguments and no terminating semicolon:
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9-16

B = [0.05 0.9 0.05]; %Numerator coefficients
freqz(B,1) %no semicolon. Plot is produced

freqz with no output arguments and terminating in a semicolon:

B = [0.05 0.9 0.05]; %Numerator coefficients
freqz(B,1); %semicolon. Plot is produced

The behavior shown in the preceding examples differs from the expected behavior of a
MEX-file using freqgz with code generation support. To illustrate this difference create a
program called myfreqz.m.

Copy and paste the following code into the file:

function myfreqz(B,A) %#codegen
freqz(B,A)

Run the following command at the MATLAB command prompt:
codegen myfreqz -args {zeros(1,3), zeros(1,1)} -o myfreqz

Calling the MEX-file writes a 512x1 complex-valued vector to the workspace and
displays the output. The vector is the frequency response. No plot is produced.

myfreqz([0.05 0.9 0.05],1);
Change the code in myfreqz.m by adding a terminating semicolon:

function myfreqz(B,A) %#codegen
freqz(B,A);

Run the following command at the MATLAB command prompt:
codegen myfreqz -args {zeros(1,3), zeros(1,1)} -o myfreqz

Calling the MEX-file produces a plot of the magnitude and phase response of the filter.
The output of the complex-valued frequency response is suppressed.

myfreqz([0.05 0.9 0.05],1);

Zero Phase Filtering

Design a lowpass Butterworth filter with a 1 kHz 3—-dB frequency to implement zero
phase filtering on data with a sampling frequency of 20 kHz.
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[B,A] = butter(20,0.314,"low");
Create the program myZerophaseFilt.m.

function output = myZerophaseFilt(input) %#codegen
B=1e-3 *[
0.0000
0.0001
0.0010
0.0060
0.0254
0.0814
0.2035
0.4071
0.6615
0.8820
0.9702
0.8820
0.6615
0.4071
0.2035
0.0814
0.0254
0.0060
0.0010
0.0001
0.0000];
A=[1.0000
-7.4340
28.2476
-71.6333
134.6222
-197.9575
235.1628
-230.2286
188.0901
-129.1746
74.8284
-36.5623
15.0197
-5.1525
1.4599
-0.3361
0.0613
-0.0085
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0.0009
-0.0001
0.0000];
output = Filtfilt(B,A,input);

Run the following command at the MATLAB command prompt:

codegen myZerophaseFilt -args {zeros(1,20001)} -o myZerophaseFilt

Filter input data with myZerophaseFilt:

Fs = 20000;

t = 0:(1/Fs):1;

Comp500Hz = cos(2*pi*500*t);

Signal = Comp500Hz+sin(2*pi*4000*t)+0.2*randn(size(t));
FilteredData = myZerophaseFilt(Signal);

plot(t(1:500) .*1000,Comp500Hz(1:500));

xlabel("msec®); ylabel("Amplitude®);

axis([0 25 -1.8 1.8]); hold on;
plot(t(1:500).-*1000,FilteredData(1:500),"r", "linewidth*",2);

legend("500 Hz component®,"Zero phase lowpass filtered data“, ...

"Location”, "NorthWest");

=10l x|
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Convolution and Correlation

“Linear and Circular Convolution” on page 10-2

“Confidence Intervals for Sample Autocorrelation” on page 10-5
“Residual Analysis with Autocorrelation” on page 10-7
“Autocorrelation of Moving Average Process” on page 10-17
“Cross-Correlation of Two Moving Average Processes” on page 10-21
“Cross-Correlation of Delayed Signal in Noise” on page 10-23
“Cross-Correlation of Phase-Lagged Sine Wave” on page 10-26
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Linear and Circular Convolution

10-2

This example shows how to establish an equivalence between linear and circular
convolution.

Linear and circular convolution are fundamentally different operations. However, there
are conditions under which linear and circular convolution are equivalent. Establishing
this equivalence has important implications. For two vectors, X and y, the circular
convolution is equal to the inverse discrete Fourier transform (DFT) of the product of the
vectors' DFTs. Knowing the conditions under which linear and circular convolution are
equivalent allows you to use the DFT to efficiently compute linear convolutions.

The linear convolution of an N-point vector, X, and an L-point vector, y, has length N+ L
- 1.

For the circular convolution of x and y to be equivalent, you must pad the vectors with
zeros to length at least N + L - 1 before you take the DFT. After you invert the product of
the DFTs, retain only the first N + L - 1 elements.

Create two vectors, X and y, and compute the linear convolution of the two vectors.

[2 12 1];
[123];
n = conv(X,y);

X
y
cl
The output has length 4+3-1.

Pad both vectors with zeros to length 4+3-1. Obtain the DFT of both vectors, multiply the
DFTs, and obtain the inverse DFT of the product.

Xpad [x zeros(1,6-length(x))1;

ypad [y zeros(1,6-length(y))1;
ccirc = ifft(fft(xpad) - *fft(ypad));

The circular convolution of the zero-padded vectors, xpad and ypad, is equivalent to the
linear convolution of X and y. You retain all the elements of ccirc because the output
has length 4+3-1.

Plot the output of linear convolution and the inverse of the DFT product to show the
equivalence.

subplot(2,1,1)
stem(clin,“filled")



Linear and Circular Convolution

yhim([0 11])
title("Linear Convolution of x and y")

subplot(2,1,2)

stem(ccirc, "filled)

yhim([0 11])

title("Circular Convolution of xpad and ypad®);

Linear Convolution of xand y

10 L -

L ] ]

L. . . . .

1 1.5 2 25 3 35 & 4.5 5 55 G

Circular Convolution of xpad and ypad

10 L -
’ .

Pad the vectors to length 12 and obtain the circular convolution using the inverse DFT
of the product of the DFTs. Retain only the first 4+3-1 elements to produce an equivalent
result to linear convolution.

N = length(x)+length(y)-1;
xpad = [x zeros(1,12-length(x))]:
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ypad = [y zeros(l,12-length(y))];
ccirc = ifft(fft(xpad) .*fft(ypad));

ccirc = ccirc(1:N);

The Signal Processing Toolbox™ software has a function, cconv, that returns the
circular convolution of two vectors. You can obtain the linear convolution of X and y using
circular convolution with the following code.

ccirc2 = cconv(X,y,6);

cconv internally uses the same DFT-based procedure illustrated in the previous
example.
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Confidence Intervals for Sample Autocorrelation

This example shows how to create confidence intervals for the autocorrelation sequence
of a white noise process. Create a realization of a white noise process with length

I. = 1000 samples. Compute the sample autocorrelation to lag 20. Plot the sample
autocorrelation along with the approximate 95%-confidence intervals for a white noise
process.

Create the white noise random vector. Set the random number generator to the default
settings for reproducible results. Obtain the normalized sampled autocorrelation to lag
20.

rng default

L = 1000;

x = randn(L,1);

[xc,lags] = xcorr(x,20, "coeff");

Create the lower and upper 95% confidence bounds for the normal distribution
) } .
N0, 1/L }, whose standard deviation is 1/ VL. For a 95%-confidence interval, the critical

3 e p—1 B ] . . .
value is ¥V 2erf (0.95) = L.96 314 the confidence interval is

verit = sqrt(2)*erfinv(0.95)
Iconf -verit/sqre(l);
upconf = vecrit/sqgrt(L);

verit =

1.9600

Plot the sample autocorrelation along with the 95%-confidence interval.

stem(lags,xc, "filled")

hold on

plot(lags, [Iconf;upconf]*ones(size(lags)),"r")
hold off

ylim([Iconf-0.03 1.05])
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10-6

title("Sample Autocorrelation with 95% Confidence Intervals®)

Sample Autocorrelation with 95% Confidence Intervals

1F ) 1

0.9r 7

0.8 b

0.6 7

0.5 7

You see in the above figure that the only autocorrelation value outside of the 95%-
confidence interval occurs at lag 0 as expected for a white noise process. Based on this
result, you can conclude that the data are a realization of a white noise process.



Residual Analysis with Autocorrelation

Residual Analysis with Autocorrelation

This example shows how to use autocorrelation with a confidence interval to analyze the
residuals of a least-squares fit to noisy data. The residuals are the differences between
the fitted model and the data. In a signal-plus-white noise model, if you have a good fit
for the signal, the residuals should be white noise.

Create a noisy data set consisting of a 1st-order polynomial (straight line) in additive
white Gaussian noise. The additive noise is a sequence of uncorrelated random variables
following a N(0,1) distribution. This means that all the random variables have mean
zero and unit variance. Set the random number generator to the default settings for
reproducible results.

X = -3:0.01:3;

rng default

y = 2*x+randn(size(x));
plot(x,y)
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Use polyTit to find the least-squares line for the noisy data. Plot the original data along
with the least-squares fit.

coeffs = polyfit(x,y,1);
yfit = coeffs(2)+coeffs(1)*x;

plot(x,y)
hold on
plot(x,yfit, "linewidth",2)
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Find the residuals. Obtain the autocorrelation sequence of the residuals to lag 50.

residuals
[xc, lags]

y - yfit;
xcorr(residuals,50, "coeff");

When you inspect the autocorrelation sequence, you want to determine whether or not
there is evidence of autocorrelation. In other words, you want to determine whether

the sample autocorrelation sequence looks like the autocorrelation sequence of white
noise. If the autocorrelation sequence of the residuals looks like the autocorrelation of a
white noise process, you are confident that none of the signal has escaped your fit and
ended up in the residuals. In this example, use a 99%-confidence interval. To construct
the confidence interval, you need to know the distribution of the sample autocorrelation
values. You also need to find the critical values on the appropriate distribution between
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which lie 0.99 of the probability. Because the distribution in this case is Gaussian, you
can use complementary inverse error function, erfcinv. The relationship between this
function and the inverse of the Gaussian cumulative distribution function is described on
the reference page for erfcinv.

Find the critical value for the 99%-confidence interval. Use the critical value to construct
the lower and upper confidence bounds.

conf99 = sqrt(2)*erfcinv(2*.01/2);
Iconf = -conf99/sqrt(length(x));
upconf = conf99/sqrt(length(x));

Plot the autocorrelation sequence along with the 99%-confidence intervals.
figure

stem(lags,xc, "filled")

ylim([Iconf-0.03 1.05])

hold on

plot(lags, lconf*ones(size(lags)),"r~, "linewidth",2)
plot(lags,upconf*ones(size(lags)), "r", "linewidth",2)
title("Sample Autocorrelation with 99% Confidence Intervals®)



Residual Analysis with Autocorrelation

Sample Autocorrelation with 99% Confidence Intervals

10 ] -

0.8 b

0.6 7

-50 40 -30 =20 -10 0 10 20 30 40 50

Except at zero lag, the sample autocorrelation values lie within the 99%-confidence
bounds for the autocorrelation of a white noise sequence. From this, you can conclude
that the residuals are white noise. More specifically, you cannot reject that the residuals
are a realization of a white noise process.

Create a signal consisting of a sine wave plus noise. The data are sampled at 1 kHz. The
frequency of the sine wave is 100 Hz. Set the random number generator to the default
settings for reproducible results.

Fs = 1000;

t = 0:1/Fs:1-1/Fs;

rng default

X = cos(2*pi*100*t)+randn(size(t));
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Use the discrete Fourier transform (DFT) to obtain the least-squares fit to the sine
wave at 100 Hz. The least-squares estimate of the amplitude is 2 / N times the DFT
coefficient corresponding to 100 Hz, where N is the length of the signal. The real part
1s the amplitude of a cosine at 100 Hz and the imaginary part is the amplitude of a
sine at 100 Hz. The least-squares fit is the sum of the cosine and sine with the correct
amplitude. In this example, DFT bin 101 corresponds to 100 Hz.

xdft = FFe(x);
ampest = 2/length(x)*xdft(101);
xFit = real(ampest)*cos(2*pi*100*t)+imag(ampest)*sin(2*pi*100*t);

figure

plot(t,x)

hold on
plot(t,xfit, " linewidth",2)
axis([0 0.30 -4 4]

xlabel ("Seconds*™)

ylabel ("Amplitude®)



Residual Analysis with Autocorrelation

Amplitude

0 0.05 0.1 0.15 0.2 0.25 0.3
Seconds

Find the residuals and determine the sample autocorrelation sequence to lag 50.

x-xFit;
xcorr(residuals,50, "coeff");

residuals
[xc, lags]

Plot the autocorrelation sequence with the 99%-confidence intervals.
figure

stem(lags,xc, "Tilled®)

ylim([lconf-0.03 1.05])

hold on

plot(lags, lconf*ones(size(lags)),"r~, " linewidth",2)
plot(lags,upconf*ones(size(lags)),"r","linewidth",2)
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title("Sample Autocorrelation with 99% Confidence Intervals®)

Sample Autocorrelation with 99% Confidence Intervals

1+ [ -

08 1

0.6 7

-50 =40 -30 =20 -10 0 10 20 30 40 50

Again, you see that except at zero lag, the sample autocorrelation values lie within the
99%-confidence bounds for the autocorrelation of a white noise sequence. From this, you
can conclude that the residuals are white noise. More specifically, you cannot reject that
the residuals are a realization of a white noise process.

Finally, add another sine wave with a frequency of 200 Hz and an amplitude of 3/4. Fit
only the sine wave at 100 Hz and find the sample autocorrelation of the residuals.

X = X+3/4*sin(2*pi*200*t);

xdft = FFt(X);
ampest = 2/length(x)*xdft(101);

10-14



Residual Analysis with Autocorrelation

xFit = real (ampest)*cos(2*pi*100*t)+imag(ampest)*sin(2*pi*100*t);
residuals = x-xfit;
[xc,lags] = xcorr(residuals,50, “coeff");

Plot the sample autocorrelation along with the 99%-confidence intervals.
figure

stem(lags,xc, "filled™)

ylim([Iconf-0.12 1.05])

hold on

plot(lags, Iconf*ones(size(lags)), "r-, "linewidth",2)
plot(lags,upconf*ones(size(lags)),"r", "linewidth",2)
title("Sample Autocorrelation with 99% Confidence Intervals™)

Sample Autocorrelation with 99% Confidence Intervals

1+ [ -

L RN
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In this case, the autocorrelation values clearly exceed the 99%-confidence bounds for a
white noise autocorrelation at many lags. Here you can reject the hypothesis that the
residuals are a white noise sequence. The implication is that the model has not accounted
for all the signal and therefore the residuals consist of signal plus noise.
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Autocorrelation of Moving Average Process

This example shows how to introduce autocorrelation into a white noise process by
filtering. When we introduce autocorrelation into a random signal, we manipulate its
frequency content. A moving average filter attenuates the high-frequency components of
the signal, effectively smoothing it.

Create the impulse response for a 3-point moving average filter. Filter an N(0,1) white
noise sequence with the filter. Set the random number generator to the default settings
for reproducible results.

h = 1/3*ones(3,1);
rng default

X randn(1000,1);
y Ffilter(h,1,x);

Obtain the biased sample autocorrelation out to 20 lags. Plot the sample autocorrelation
along with the theoretical autocorrelation.

[xc,lags] = xcorr(y,20, biased™);

Xc = zeros(size(xc));
Xc(19:23) = [1 2 3 2 1]/9*var(X);

stem(lags,xc, "filled")
hold on
stem(lags,Xc,".", " linewidth",2)

Ig = legend("Sample autocorrelation”®, "Theoretical autocorrelation®);

lg.Location = "NorthEast”;
lg.Box = "off";
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The sample autocorrelation captures the general form of the theoretical autocorrelation,
even though the two sequences do not agree in detail.

In this case, it is clear that the filter has introduced significant autocorrelation only
over lags [-2,2]. The absolute value of the sequence decays quickly to zero outside of that

range.

To see that the frequency content has been affected, plot Welch estimates of the power
spectral densities of the original and filtered signals.

[pxx,wx]
[pyy.wyl

pwelch(x);
pwelch(y);



Autocorrelation of Moving Average Process

figure

plot(wx/pi, 20*10g10(pyy))

20*1og10(pxx) ,wy/pi,
Ig = legend("Original sequence®,"Filtered sequence®);
lg.Location = "SouthWest®;

xlabel ("Normalized Frequency (\times\pi rad/sample)®)
ylabel ("Power/frequency (dB/rad/sample)®)
title("Welch Power Spectral Density Estimate®)

grid
Welch iner Epe::tral Den5|t:,f Estlmate
0 T .
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L |
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The white noise has been "colored" by the moving average filter.

External Websites

. Ellis, Dan. About Colored Noise. http://www.ee.columbia.edu/~dpwe/noise/

10-20


http://www.ee.columbia.edu/~dpwe/noise/

Cross-Correlation of Two Moving Average Processes

Cross-Correlation of Two Moving Average Processes

This example shows how to find and plot the cross-correlation sequence between two
moving average processes. The example compares the sample cross-correlation with

the theoretical cross-correlation. Filter an V(0. 1) white noise input with two different
moving average filters. Plot the sample and theoretical cross-correlation sequences.

Create an V(0. 1) white noise sequence. Set the random number generator to the default
settings for reproducible results. Create two moving average filters. One filter has

impulse response din) + d(n = 1) The other filter has impulse response d(n) —d(n—1)

rng default

w = randn(100,1);
x = Filter([1 1],1,w);
y = filter([1 -1].,1,w);

Obtain the sample cross-correlation sequence up to lag 20. Plot the sample cross-
correlation along with the theoretical cross-correlation.

[xc,lags] = xcorr(X,y,20,"biased");
Xc = zeros(size(xc));

Xc(20)
Xc(22)

1;

stem(lags,xc, "filled")
hold on
stem(lags,Xc,".", "linewidth",2)

g = legend("Sample cross-correlation®, "Theoretical cross-correlation®);
gq-Location = "NorthWest";

q-FontSize = 9;

q-Box = "off";
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The theoretical cross-correlation is —1 at lag —1, 1 at lag 1, and zero at all other lags. The
sample cross-correlation sequence approximates the theoretical cross-correlation.

As expected, there is not perfect agreement between the theoretical cross-correlation and
sample cross-correlation. The sample cross-correlation does accurately represent both the
sign and magnitude of the theoretical cross-correlation sequence values at lag —1 and lag
1.
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Cross-Correlation of Delayed Signal in Noise

This example shows how to use the cross-correlation sequence to detect the time delay
in a noise-corrupted sequence. The output sequence is a delayed version of the input
sequence with additive white Gaussian noise. Create two sequences. One sequence is a

AT o
delayed version of the other. The delay is 3 samples. Add N1{0.0.3%) white noise to the
delayed signal. Use the sample cross-correlation sequence to detect the lag.

Create and plot the signals. Set the random number generator to the default settings for
reproducible results.

rng default

X = triang(20);
y = [zeros(3,1);x]+0.3*randn(length(x)+3,1);
subplot(2,1,1)

stem(x, "filled")
axis([0 22 -1 2])
title(" Input Sequence®)

subplot(2,1,2)

stem(y, “"filled")
axis([0 22 -1 2])
title("Output Sequence®)
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Obtain the sample cross-correlation sequence and use the maximum absolute value to
estimate the lag. Plot the sample cross-correlation sequence.

[xc,lags] = xcorr(y,Xx);
[-.11 = max(abs(xc));

figure

stem(lags,xc, "filled™)
legend(sprintf("Maximum at lag %d",lags(l)))
title("Sample Cross-Correlation Sequence®)



Cross-Correlation of Delayed Signal in Noise

10

0

Sample Cross-Correlation Sequence

WTT

-25 =20 -1 -10

The maximum cross correlation sequence value occurs at lag 3 as expected.

“. ® Maximum at lag 3
ﬁ‘ *
' -
[ ]
[ ]
]
o 4
] ® ]
[ ] . .
* ® ]
-5 0 5 10 15 20 2

5

10-25



] 0 Convolution and Correlation

Cross-Correlation of Phase-Lagged Sine Wave

10-26

This example shows how to use the cross-correlation sequence to estimate the phase

lag between two sine waves. The theoretical cross-correlation sequence of two sine
waves at the same frequency also oscillates at that frequency. Because the sample cross-
correlation sequence uses fewer and fewer samples at larger lags, the sample cross-
correlation sequence also oscillates at the same frequency, but the amplitude decays as
the lag increases.

Create two sine waves with frequencies of 27 /10 rad/sample. The starting phase of
one sine wave is 0, while the starting phase of the other sine wave is — 7 radians. Add

- el
N(0.0.257) white noise to the sine wave with the phase lag of m radians. Set the random
number generator to the default settings for reproducible results.

rng default

t = 0:99;
X = cos(2*pi*1/10*t);
y = cos(2*pi*1/10*t-pi)+0.25*randn(size(t));

Obtain the sample cross-correlation sequence for two periods of the sine wave (10
samples). Plot the cross-correlation sequence and mark the known lag between the two
sine waves (5 samples).

[xc,lags] = xcorr(y,x,20, "coeff");
stem(lags(21l:end),xc(21l:end), "filled")

hold on
plot([5 5],.[-1 1])

ax = gca;
ax.XTick = 0:5:20;



Cross-Correlation of Phase-Lagged Sine Wave

15

20

You see that the cross-correlation sequence peaks at lag 5 as expected and oscillates with

a period of 10 samples.
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Downsampling -- Signal Phases

This example shows how to use downsample to obtain the phases of a signal.
Downsampling a signal by M can produce M unique phases. For example, if you have a
discrete-time signal, x, with x(0) x(1) x(2) x(3), ..., the M phases of x are x(nM + k) with k =
0,1, ..., M-1.

The M signals are referred to as the polyphase components of x.

Create a white noise vector and obtain the 3 polyphase components associated with
downsampling by 3.

Reset the random number generator to the default settings to produce a repeatable
result. Generate a white noise random vector and obtain the 3 polyphase components
associated with downsampling by 3.

rng default
X = randn(36,1);

X0 = downsample(x,3,0);
x1 = downsample(x,3,1);
x2 = downsample(x,3,2);

The polyphase components have length equal to 1/3 the original signal.

Upsample the polyphase components by 3 using upsample.

y0 = upsample(x0,3,0);
y1l = upsample(x1,3,1);
y2 = upsample(x2,3,2);

Plot the result.

subplot(4,1,1)

stem(x, "Marker*" ,"none*®)
title("Original Signal™)
yhim([-4 4D
subplot(4,1,2)

stem(yO0, "Marker*®, "none®)
ylabel ("Phase 07)

ylim([-4 41)

subplot(4,1,3)
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Fhase 1 Fhasze 0

Fhasze 2

stem(yl, "Marker®, "none*")
ylabel ("Phase 17)

ylin([-4 41)

subplot(4,1,4)
stem(y2, "Marker®, "none*")
ylabel ("Phase 27)

ylim([-4 41)

Original Signal

4 T T T T T T T
2f | -
0 H | | 1 B 1 | I | 1 1 L 11y | N I
2k 5
_4 i i i i i i i

0 5 10 15 20 25 30 35 40
4 T T T T T T T
2 - -
0 1 | | i
I J
_4 i i i i i i i

0 5 10 15 20 25 30 35 40
4 T T T T T T T
2r | T
0 1 |
2k 4
_4 i i i i i i i

0 5 10 15 20 25 30 35 40
4 T T T T T T T
2| | -
D | | | | 1 | 1 :
I J
_4 i i i i i i i

0 5 10 15 20 25 30 35 40

If you sum the upsampled polyphase components you obtain the original signal.

Create a discrete-time sinusoid and obtain the 2 polyphase components associated with

downsampling by 2.
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Create a discrete-time sine wave with an angular frequency of /4 rad/sample. Add a
DC offset of 2 to the sine wave to help with visualization of the polyphase components.
Downsample the sine wave by 2 to obtain the even and odd polyphase components.

n = 0:127;

X = 2+cos(pi/4*n);

X0 = downsample(x,2,0);
x1 = downsample(x,2,1);

Upsample the two polyphase components.

upsample(x0,2,0);
upsample(x1,2,1);

yO0
yl

Plot the upsampled polyphase components along with the original signal for comparison.

subplot(3,1,1)

stem(x, "Marker*® ,"none*®)
ylim([0.5 3.5])
title(C"Original Signal®);

subplot(3,1,2)

stem(yO0, "Marker*® ,"none®)
ylim([0.5 3.5])

ylabel ("Phase 0%)

subplot(3,1,3)

stem(yl, "Marker®,"none®)
ylim([0.5 3.5])

ylabel ("Phase 1%)
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If you sum the two upsampled polyphase components (Phase 0 and Phase 1), you obtain

the original sine wave.
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Downsampling -- Aliasing

11-6

This example shows how to avoid aliasing when downsampling a signal. If a discrete-

time signal's baseband spectral support is not limited to an interval of width 2m /M
radians, downsampling by M results in aliasing. Aliasing is the distortion that occurs
when overlapping copies of the signal's spectrum are added together. The more the

signal's baseband spectral support exceeds 2m /M radians, the more severe the aliasing.

Demonstrate aliasing in a signal downsampled by two. The signal's baseband spectral
support exceed T radians in width.

Create a signal with baseband spectral support equal to 2™/ 2 radians. Use Fir2 to
design the signal. Plot the signal's spectrum.

F [0 0.2500 0.5000 0.7500 1.0000];

A [1.00 0.6667 0.3333 0 0];

Order = 511;

B1 = fir2(Order,F,A);

[Hx,W] = freqz(B1,1,8192, "whole™);

Hx = [Hx(4098:end) ; Hx(1:4097)];
omega = -pi+(2*pi/8192):(2*pi)/8192:pi;

plot(omega,abs(Hx))
xtim([-pi pi])

grid

title("Magnitude Spectrum®)
xlabel ("Radians/Sample®)
ylabel ("Magnitude®)



Downsampling -- Aliasing

Magnitude Spectrum
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Downsample the signal by a factor of 2 and plot the downsampled signal's spectrum with
the spectrum of the original signal.

y = downsample(B1,2,0);
[Hy,W] = freqz(y,1,8192, whole");
Hy = [Hy(4098:end) ; Hy(1:4097)];

hold on

plot(omega,abs(Hy), "r", " linewidth",2)

legend("Original Signal®, "Downsampled Signal*)
text(-2.5,0.35,"\downarrow aliasing”, "HorizontalAlignment®, "center”)
text(2.5,0.35, "aliasing \downarrow", "HorizontalAlignment®, "center"™)
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hold off

Magnitude Spectrum
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In addition to an amplitude scaling of the spectrum, the superposition of overlapping

I
T2

spectral replicas causes distortion of the original spectrum for || = 1

Increase the baseband spectral support of the signal to [~7#/8,77/8] and downsample
the signal by 2. Plot the original spectrum along with the spectrum of the downsampled
signal.

F [0 0.2500 0.5000 0.7500 7/8 1.0000];
A [1.00 0.7143 0.4286 0.1429 0 0];
Order = 511;

B2 = fir2(Order,F,A);
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[Hx,W] = freqz(B2,1,8192, whole");
Hx = [Hx(4098:end) ; Hx(1:4097)];
omega = -pi+(2*pi/8192):(2*pi)/8192:pi;

plot(omega,abs(Hx))
xbim([-pi pil)

y = downsample(B2,2,0);
[Hy,W] = freqz(y,1,8192, whole");
Hy = [Hy(4098:end) ; Hy(1:4097)];

hold on
plot(omega,abs(Hy), "r", "linewidth",2);

grid

legend("Original Signal®, "Downsampled Signal*)
xlabel ("Radians/Sample™)

ylabel (*"Magnitude®)

hold off
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The increased spectral width results in more pronounced aliasing in the spectrum of the

downsampled signal because more signal energy is outside [-m/2,7/2]

Finally, construct a signal with baseband spectral support limited to [-m/2,7/2]

Downsample the signal by a factor of 2 and plot the spectrum of the original and
downsampled signals. The downsampled signal is full band, but the shape of the
spectrum is preserved because the spectral copies do not overlap. There is no aliasing.

F [0 0.250 0.500 0.7500 1];

A [1.0000 0.5000 0 O 0];

Order = 511;

B3 = fir2(Order,F,A);

[Hx,W] = freqz(B3,1,8192,"whole");



Downsampling -- Aliasing

Hx = [Hx(4098:end) ; Hx(1:4097)];
omega = -pi+(2*pi/8192):(2*pi)/8192:pi;

plot(omega,abs(Hx))
xbim([-pi pil)

y = downsample(B3,2,0);
[Hy,W] = freqz(y,1,8192, whole");
Hy = [Hy(4098:end) ; Hy(1:4097)];

plot(omega,abs(Hx))

hold on

plot(omega,abs(Hy), "r","linewidth*,2)

grid

legend("Original Signal®, "Downsampled Signal*)
xlabel ("Radians/Sample™)

ylabel (*"Magnitude®)

hold off
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You see in the preceding figure that the shape of the spectrum is preserved. The
spectrum of the downsampled signal is a stretched and scaled version of the original
signal's spectrum, but there is no aliasing.
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Filtering Before Downsampling

This example shows how to filter before downsampling to mitigate the distortion caused
by aliasing. You can use decimate or resample to filter and downsample with one
function. Alternatively, you can lowpass filter your data and then use downsample.
Create a signal with baseband spectral support greater than w radians. Use decimate to
filter the signal with a 10th-order Chebyshev type I lowpass filter prior to downsampling.

Create the signal and plot the magnitude spectrum.

F = [0 0.2500 0.5000 0.7500 1.0000];
A = [1.00 0.6667 0.3333 0 0];
Order = 511;

B = fir2(Order,F,A);

[Hx,W] = freqz(B,1,8192, whole");

Hx = [Hx(4098:end) ; Hx(1:4097)];
omega = -pi+(2*pi/8192):(2*pi)/8192:pi;

plot(omega,abs(Hx))
xtim([-pi pi])

grid

title("Magnitude Spectrum®)
xlabel ("Radians/Sample™)
ylabel (*"Magnitude®)
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Filter the signal with a 10th-order type I Chebyshev lowpass filter and downsample
by 2. Plot the magnitude spectra of the original signal along with the filtered and
downsampled signal.

y = decimate(B,2,10);
[Hy,W] = freqz(y,1,8192, whole");
Hy = [Hy(4098:end) ; Hy(1:4097)];

hold on

plot(omega,abs(Hy),"r", "linewidth",2)
legend("Original Signal®, "Downsampled Signal*)
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The lowpass filter reduces the amount of aliasing distortion outside the interval
[-m/2,7/2]
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Upsampling -- Imaging Artifacts

11-16

This example shows how to upsample a signal and how upsampling can result in images.
Upsampling a signal contracts the spectrum. For example, upsampling a signal by
2 results in a contraction of the spectrum by a factor of 2. Because the spectrum of

a discrete-time signal is 27-periodic, contraction can cause replicas of the spectrum

normally outside of the baseband to appear inside the interval [~ 7],

Create a discrete-time signal whose baseband spectral support is [~7. 7], Plot the
magnitude spectrum.

F = [0 0.250 0.500 0.7500 1];
A = [1.0000 0.5000 0 0 0];
Order = 511;

B = fir2(Order,F,A);

[Hx,W] = freqz(B,1,8192, whole™);

Hx = [Hx(4098:end) ; Hx(1:4097)];
omega = -pi+(2*pi/8192):(2*pi1)/8192:pi;

plot(omega,abs(Hx))
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y = upsample(B,2);

[Hy,W] = freqz(y,1,8192, whole");
Hy = [Hy(4098:end) ; Hy(1:4097)];
hold on

Upsample the signal by 2. Plot the spectrum of the upsampled signal.

plot(omega,abs(Hy), "r", " linewidth",2)
xbim([-pi pil)

xlabel ("Radians/Sample™)

legend("Original Signal®, “Upsampled Signal*®)
ylabel (*"Magnitude™)

text(-2,0.5, "\leftarrow Imaging”, "HorizontalAlignment~”, "center”)
text(2,0.5, "Imaging \rightarrow®, "HorizontalAlignment”, "center”)
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You can see in the preceding figure that the contraction of the spectrum has drawn

subsequent periods of the spectrum into the interval [~ 7],
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Filtering After Upsampling -- Interpolation

This example shows how to upsample a signal and apply a lowpass interpolation filter
with interp. Upsampling by L inserts L - 1 zeros between every element of the original
signal. Upsampling can create imaging artifacts. Lowpass filtering following upsampling
can remove these imaging artifacts. In the time domain, lowpass filtering interpolates
the zeros inserted by upsampling.

Create a discrete-time signal whose baseband spectral support is [~7/2.7/2] Plot the
magnitude spectrum.

F [0 0.250 0.500 0.7500 1];

A [1.0000 0.5000 0 O 0];

Order = 511;

B = fir2(Order,F,A);

[Hx,W] = freqz(B,1,8192, "whole™);

Hx = [Hx(4098:end) ; Hx(1:4097)];
omega = -pi+(2*pi/8192):(2*pi1)/8192:pi;

plot(omega,abs(Hx))
xbim([-pi pi])

xlabel ("Radians/Sample™)
ylabel ("Magnitude®)
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Upsample the signal and apply a lowpass filter to remove the imaging artifacts. Plot the
magnitude spectrum.

y = interp(B,2);
[Hy,W] = freqz(y,1,8192, whole");
Hy = [Hy(4098:end) ; Hy(1:4097)];

hold on

plot(omega,abs(Hy),"r", "linewidth",2)
legend("Original Signal”,"Upsampled Signal*®)
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Upsampling still contracts the spectrum, but the imaging artifacts are removed by the

lowpass filter.
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Simulate a Sample-and-Hold System

This example shows several ways to simulate the output of a sample-and-hold system by
upsampling and filtering a signal.

Construct a sinusoidal signal. Specify a sample rate such that 16 samples correspond to
exactly one signal period. Draw a stem plot of the signal. Overlay a stairstep graph for
sample-and-hold visualization.

fs = 16;
t = 0:1/Fs:1-1/Fs;

X = _9*sin(2*pi*t);
stem(t,x)
hold on

stairs(t,x)
hold off
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System
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Upsample the signal by a factor of four. Plot the result alongside the original signal.

upsample increases the sample rate of the signal by adding zeros between the existing

samples.
ups = 4;

fu
tu

fs*ups;
0:1/fu:1-1/fu;

y = upsample(x,ups);
stem(tu,y, "--x")

hold on
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stairs(t,x)
hold off

04r
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Filter with a moving-average FIR filter to fill in the zeros with sample-and-hold values.

h

ones(ups,1);

z filter(h,1,y);
stem(tu,z," --.%)
hold on
stairs(t,x)

hold off
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You can obtain the same behavior using the MATLAB® function interpl with nearest-
neighbor interpolation. In that case, you must shift the origin to line up the sequence.

V4 |

dl

floor(ups/2);

interpl(t,x,tu, "nearest”);

stem(tu(l+dl:end),zi(l:end-dl), " --_%)

hold on
stairs(t,x)
hold off
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The function resample produces the same result when you set the last input argument
to zero.

q = resample(X,ups,1,0);
stem(tu(l+dl:end),q(1:end-dl),"—-_")
hold on

stairs(t,x)
hold off
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Changing Signal Sampling Rate

11-28

This example shows how to change the sampling rate of a signal. The example has two
parts. Part one changes the sampling rate of a sinusoidal input from 44.1 kHz to 48 kHz.
This workflow is common in audio processing. The sampling rate used on compact discs is
44.1 kHz, while the sampling rate used on digital audio tape is 48 kHz. Part two changes
the sampling rate of a recorded speech sample from 7418 Hz to 8192 Hz.

Create an input signal consisting of a sum of sine waves sampled at 44.1 kHz. The sine
waves have frequencies of 2, 4, and 8 kHz.

Fs = 44_.1e3;
t = 0:1/Fs:1-(1/Fs);
X = cos(2*pi*2000*t)+1/2*sin(2*pi*4000*(t-pi/4))+1/4*cos(2*pi*8000*t) ;

To change the sampling rate from 44.1 to 48 kHz, you have to determine a rational
number (ratio of integers), P/, such that P/@ times the original sampling rate, 44100, is
equal to 48000 within some specified tolerance.

To determine these factors, use rat. Input the ratio of the new sampling rate, 48000, to
the original sampling rate, 44100.

[P,Q] = rat(48e3/Fs);
abs(P/Q*Fs-48000)

You see that P/Q*Fs only differs from the desired sampling rate, 48000, on the order of
107"

Use the numerator and denominator factors obtained with rat as inputs to resample to
output a waveform sampled at 48 kHz.

xnew = resample(x,P,Q);

If your computer can play audio, you can play the two waveforms. Set the volume to a
comfortable level before you play the signals. Execute the play commands separately so
that you can hear the signal with the two different sampling rates.

P44 1 = audioplayer(x,44100);
P48 = audioplayer(xnew,48000);
play(P44_1)

play(P48)

Change the sampling rate of a speech sample from 7418 Hz to 8192 Hz. The speech
signal is a recording of a speaker saying “MATLAB”.



Changing Signal Sampling Rate

Load the speech sample.

load mtlb

Loading the file mtlb.mat brings the speech signal, mtlb, and the sampling rate, Fs,
into the MATLAB workspace.

Determine a rational approximation to the ratio of the new sample rate, 8192, to the
original sample rate. Use rat to determine the approximation.

[P.Q] = rat(8192/Fs);
Resample the speech sample at the new sampling rate.

mtlb_new = resample(mtlb,P,Q);

If your computer has audio output capability, you can play the two waveforms at
their respective sampling rates for comparison. Set the volume on your computer to
a comfortable listening level before playing the sounds. Execute the play commands
separately to compare the speech samples at the different sampling rates.

Pmtlb = audioplayer(mtlb,Fs);
Pmtlb_new = audioplayer(mtlb_new,8192);
play(Pmtlb)

play(Pmtlb_new)
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Power Spectral Density Estimates Using FFT

12-2

This example shows how to obtain nonparametric power spectral density (PSD) estimates
equivalent to the periodogram using FFt. The examples show you how to properly scale
the output of FFt for even-length inputs, for normalized frequency and hertz, and for
one- and two-sided PSD estimates. Obtain the periodogram for an even-length signal
sampled at 1 kHz using both ¥Ft and periodogram. Compare the results.

Create a signal consisting of a 100 Hz sine wave in N(0,1) additive noise. The sampling
frequency is 1 kHz. The signal length is 1000 samples. Use the default settings of the
random number generator for reproducible results.

rng default
Fs = 1000;
t = 0:1/Fs:1-1/Fs;

X = cos(2*pi*100*t) + randn(size(t));

Obtain the periodogram using Fft. The signal is real-valued and has even length.
Because the signal is real-valued, you only need power estimates for the positive or
negative frequencies. In order to conserve the total power, multiply all frequencies
that occur in both sets -- the positive and negative frequencies -- by a factor of 2. Zero
frequency (DC) and the Nyquist frequency do not occur twice. Plot the result.

N = length(x);

xdft = ffe(x);
xdft = xdft(1:N/2+1);
psdx = (1/(Fs*N)) * abs(xdft)."2;

psdx(2:end-1) = 2*psdx(2:end-1);
freq = 0:Fs/length(x):Fs/2;

plot(freq,10*1ogl0(psdx))

grid on

title("Periodogram Using FFTT)
xlabel ("Frequency (Hz)")

ylabel ("Power/Frequency (dB/Hz)")
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Compute and plot the periodogram using periodogram. Show that the two results are
identical.

periodogram(x, rectwin(length(x)), length(x),Fs)

mxerr = max(psdx”-periodogram(x,rectwin(length(x)), length(x),Fs))

mxerr =

3.4694e-18
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Use Fft to produce a periodogram for an input using normalized frequency. Create a
signal consisting of a sine wave in N(0,1) additive noise. The sine wave has an angular

frequency of /4 rad/sample. Use the default settings of the random number generator
for reproducible results.

rng default
0:999;
cos(pi/4*n) + randn(size(n));

n =
X =
Obtain the periodogram using FFt. The signal is real-valued and has even length.

Because the signal is real-valued, you only need power estimates for the positive or
negative frequencies. In order to conserve the total power, multiply all frequencies
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that occur in both sets -- the positive and negative frequencies -- by a factor of 2. Zero
frequency (DC) and the Nyquist frequency do not occur twice. Plot the result.

N = length(x);

xdft = FFt(X);

xdft = xdft(1:N/2+1);

psdx = (1/(2*pi*N)) * abs(xdft)."2;
psdx(2:end-1) = 2*psdx(2:end-1);
freq = 0:(2*pi)/N:pi;

plot(freq/pi,10*1og1l0(psdx))

grid on

title("Periodogram Using FFT®)

xlabel ("Normalized Frequency (\times\pi rad/sample)®)
ylabel ("Power/Frequency (dB/rad/sample)*®)
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Periodogram Using FFT
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Compute and plot the periodogram using periodogram. Show that the two results are
identical.

periodogram(x, rectwin(length(x)), length(x))

mxerr = max(psdx”-periodogram(x,rectwin(length(x)), length(x)))

mxerr =

1.4211e-14
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Use fft to produce a periodogram for a complex-valued input with normalized frequency.

The signal is a complex exponential with an angular frequency of /4 rad/sample in
complex-valued N(0,1) noise. Set the random number generator to the default settings for
reproducible results.

rng default
n 0:999;
x = exp(1j*pi/Z4*n) + [1 1lj]*randn(2,length(n))/sqrt(2);

Use fFt to obtain the periodogram. Because the input is complex-valued, obtain the

periodogram from (—m, 7] rad/sample. Plot the result.

N = length(X);
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xdft = FFe(x);
psdx = (1/(2*pi*N)) * abs(xdft)."2;
freq = 0:(2*pi)/N:2*pi-(2*pi)/N;

plot(freq/pi,10*1ogl0(psdx))

grid on

title("Periodogram Using FFTT)

xlabel ("Normalized Frequency (\times\pi rad/sample)”)
ylabel ("Power/Frequency (dB/rad/sample)®)

Periodogram Using FFT
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Use periodogram to obtain and plot the periodogram. Compare the PSD estimates.

periodogram(x, rectwin(length(x)), length(x), "twosided")
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Bias and Variability in the Periodogram

This example shows how to reduce bias and variability in the periodogram. Using a
window can reduce the bias in the periodogram, and using windows with averaging can
reduce variability.

Use wide-sense stationary autoregressive (AR) processes to show the effects of bias and
variability in the periodogram. AR processes present a convenient model because their
PSDs have closed-form expressions. Create an AR(2) model of the following form:

y(n) —0.75y(n — 1) + 0.5y(n — 2) = g(n),

where 171} is a zero mean white noise sequence with some specified variance. In this
example, assume the variance and the sampling period to be 1. To simulate the preceding
AR(2) process, create an all-pole (IIR) filter. View the filter's magnitude response.

B2 = 1;

A2 = [1 -0.75 0.5];
fvtool (B2,A2)
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This process is bandpass. The dynamic range of the PSD is approximately 14.5 dB, as you
can determine with the following code.

[H2,w2] = freqz(B2,A2,1e3,1);
dr2 = max(20*1og10(abs(H2)))-min(20*1og10(abs(H2)))
dar2 =

14.4984

By examining the placement of the poles, you see that this AR(2) process is stable. The
two poles are inside the unit circle.

fvtool (B2,A2, "Analysis”®, "polezero”)
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Pole/Zero Plot

0.8 o ' 1
06 : % i
0.4 : : _

0.2 : - - .

Imaginary Part
=

©

g
T
1

Real Part

Next, create an AR(4) process described by the following equation:

yln) — 2760Ty(n — 1) + 3.8106y(n — 2) — 2.6535y(n — 3) + 0.9238y(n — 4) = =(n).

Use the following code to view the magnitude response of this IIR system.

B4 = 1;
A4 = [1 -2.7607 3.8106 -2.6535 0.9238];
fvtool (B4,A4)
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Examining the placement of the poles, you can see this AR(4) process is also stable. The

four poles are inside the unit circle.

fvtool (B4,A4, " Analysis®, "polezero®)
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The dynamic range of this PSD is approximately 65 dB, much larger than the AR(2)
model.

[H4,w4] = freqz(B4,A4,1e3,1);
dr4 = max(20*log10(abs(H4)))-min(20*1ogl0(abs(H4)))

dr4 =

64.6213

To simulate realizations from these AR(p) processes, use randn and filter. Set the
random number generator to the default settings to produce repeatable results. Plot the
realizations.

rng default
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X = randn(le3,1);

y2 = filter(B2,A2,X);

y4 = filter(B4,A4,X);

subplot(2,1,1)

plot(y2)

title("AR(2) Process”®)

xlabel ("Time")

subplot(2,1,2)

plot(y4)

title("AR(4) Process”®)

xlabel ("Time")
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Compute and plot the periodograms of the AR(2) and AR(4) realizations. Compare
the results against the true PSD. Note that periodogram converts the frequencies to
millihertz for plotting.

Fs

:1;
NFFT =

length(y2);

subplot(2,1,1)

periodogram(y2,rectwin(NFFT) ,NFFT,Fs)

hold on

plot(1000*W2,20*1og10(abs(H2)),"r", " linewidth",2)
title("AR(2) PSD and Periodogram®)

subplot(2,1,2)

periodogram(y4,rectwin(NFFT) ,NFFT,Fs)

hold on

plot(1000*W4,20*1og10(abs(H4)),"r", " linewidth",2)
title("AR(4) PSD and Periodogram®)

text(350,20, "\downarrow Bias")
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In the case of the AR(2) process, the periodogram estimate follows the shape of the true
PSD but exhibits considerable variability. This is due to the low degrees of freedom. The
pronounced negative deflections (in dB) in the periodogram are explained by taking the
log of a chi-square random variable with two degrees of freedom.

In the case of the AR(4) process, the periodogram follows the shape of the true PSD at
low frequencies but deviates from the PSD in the high frequencies. This is the effect
of the convolution with Fejer's kernel. The large dynamic range of the AR(4) process
compared to the AR(2) process is what makes the bias more pronounced.

Mitigate the bias demonstrated in the AR(4) process by using a taper, or window. In this
example, use a Hamming window to taper the AR(4) realization before obtaining the
periodogram.
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figure

periodogram(y4,hamming(length(y4)) ,NFFT,Fs)

hold on

plot(1000*W4,20*1og10(abs(H4)), "r", " linewidth",2)
title(CAR(4) PSD and Periodogram with Hamming Window®)
legend("Periodogram®, *AR(4) PSD%)

AR(4) PSD and Periodogram with Hamming Window
T T I T T T T T T T

50

Periodogram
AR{4) PSD | -

of N

10 i 7
|

Fowerffrequency (dB/Hz)

10} Ll iyl h| w W

_3 D i i i i i i i i i
0 50 o0 150 200 250 300 350 400 450 500

Frequency (mHz)

Note that the periodogram estimate now follows the true AR(4) PSD over the entire
Nyquist frequency range. The periodogram estimates still only have two degrees of
freedom so the use of a window does not reduce the variability of periodogram, but it does
address bias.

12-18



Bias and Variability in the Periodogram

Fowerffrequency (dB/Hz)

_3 D i i i i i i i i i
0 50 00 150 200 250 300 350 400 450 500

Frequency (mHz)

In nonparametric spectral estimation, two methods for increasing the degrees of freedom
and reducing the variability of the periodogram are Welch's overlapped segment
averaging and multitaper spectral estimation.

Obtain a multitaper estimate of the AR(4) time series using a time half bandwidth
product of 3.5. Plot the result.

NW = 3.5;

figure

pmtm(y4 ,NW,NFFT,Fs)

hold on

plot(1000*W4,20*1og1l0(abs(H4)),"r", " linewidth",2)
legend("Multitaper Estimate®,“AR(4) PSD®)

Thomson Multitaper Power Spectral Density Estimate

A4

40 [ 7

80

Multitaper Estimate
AR(4) PSD -
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The multitaper method produces a PSD estimate with significantly less variability than
the periodogram. Because the multitaper method also uses windows, you see that the
bias of the periodogram is also addressed.
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Cross Spectrum and Magnitude-Squared Coherence

This example shows how to use the cross spectrum to obtain the phase lag between
sinusoidal components in a bivariate time series. The example also uses the magnitude-
squared coherence (MSC) to identify significant frequency-domain correlation at the sine
wave frequencies.

Create the bivariate time series. The individual series consist of two sine waves with
frequencies of 100 and 200 Hz embedded in additive white Gaussian noise and sampled
at 1 kHz. The sine waves in the X-series both have amplitudes equal to 1. The 100 Hz
sine wave in the y-series has amplitude 0.5 and the 200 Hz sine wave in the y-series
has amplitude 0.35. The 100 Hz and 200 Hz sine waves in the y-series are phase-lagged

by /4 radians and 7/ radians respectively. You can think of y-series as the noise-
corrupted output of a linear system with input X. Set the random number generator to
the default settings for reproducible results.

rng default

Fs = 1000;

t = 0:1/Fs:1-1/Fs;

X = cos(2*pi*100*t)+sin(2*pi*200*t)+0.5*randn(size(t));

y = 0.5*%cos(2*pi*100*t-pi/4)+0.35*sin(2*pi*200*t-pi/2)+ ...

0.5*randn(size(t));

Obtain the magnitude-squared coherence (MSC) for the bivariate time series. The
magnitude-squared coherence enables you to identify significant frequency-domain
correlation between the two time series. Phase estimates in the cross spectrum are only
useful where significant frequency-domain correlation exists.

To prevent obtaining a magnitude-squared coherence estimate, which is identically 1
for all frequencies, you must use an averaged MSC estimator. Both Welch's overlapped
segment averaging (WOSA) and mulitaper techniques are appropriate. mscohere
implements a WOSA estimator.

Set the window length to 100 samples. This window length contains 10 periods of the
100 Hz sine wave and 20 periods of the 200 Hz sine wave. Use an overlap of 80 samples
with the default Hamming window. Input the sample rate explicitly to get the output
frequencies in Hz. Plot the magnitude-squared coherence.

[Pxy,F] = mscohere(x,y,hamming(100),80,100,Fs);
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12-22

plot(F,Pxy)

title("Magnitude-Squared Coherence®)
xlabel ("Frequency (Hz)")

grid
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You see that the magnitude-squared coherence is greater than 0.8 at 100 and 200 Hz.

Obtain the cross spectrum of X and y using cpsd. Use the same parameters to obtain the
cross spectrum that you used in the MSC estimate. Plot the phase of the cross spectrum

and indicate the frequencies with significant coherence between the two times. Mark the
known phase lags between the sinusoidal components.

[Cxy,F] = cpsd(x,y,hamming(100),80,100,Fs);



Cross Spectrum and Magnitude-Squared Coherence

plot(F,-angle(Cxy)/pi)
title("Cross Spectrum Phase®)
xlabel ("Frequency (Hz)")
ylabel ("Lag (\times\pi rad)")

ax = gca;

ax._XTick = [100 200];

ax.YTick = [-1 -1/2 -1/4 0 1/4 1/2 1];
grid
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You see that, at 100 Hz and 200 Hz, the phase lags estimated from the cross spectrum
are close to the true values.
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In this example, the cross spectrum estimates are spaced at 1000/100 = 10 Hz. You can

return the phase estimates at those frequency bins. Keep in mind that the first frequency
bin corresponds to 0 Hz, or DC.

phil00
phi200

—angle(Cxy(11));
-angle(Cxy(21));

You see that phi100 and phi200 are close to T/4 and —7/2

1ag100 = phil1l00/pi
1ag200 = phi200/pi
1agl00 =

-0.2488
1ag200 =

-0.5086
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Amplitude Estimation and Zero Padding

This example shows how to use zero padding to obtain an accurate estimate of the
amplitude of a sinusoidal signal. Frequencies in the discrete Fourier transform (DFT) are

spaced at intervals of F, -""ﬁ"r, where F* is the sample rate and V is the length of the input
time series. Attempting to estimate the amplitude of a sinusoid with a frequency that
does not correspond to a DFT bin can result in an inaccurate estimate. Therefore, zero
padding the data before you obtain the DFT can often increase the frequency resolution
and thus improve the amplitude estimate.

Create a signal consisting of two sine waves. The two sine waves have frequencies of 100
and 202.5 Hz. The sample rate is 1000 Hz and the signal is 1000 samples in length.

Fs = 1e3;
t = 0:0.001:1-0.001;
X = cos(2*pi*100*t)+sin(2*pi*202.5*1);

Obtain the DFT of the signal. The DFT bins are spaced at 1 Hz. Accordingly, the 100 Hz
sine wave corresponds to a DFT bin, but the 202.5 Hz sine wave does not.

Because the signal is real-valued, use only the positive frequencies from the DFT to
estimate the amplitude. Scale the DFT by the length of the input signal and multiply all
frequencies except 0 and the Nyquist by 2.

Plot the result with the known amplitudes for comparison.

xdft = FFe(x);
xdft = xdft(1l:length(x)/2+1);
xdft = xdft/length(x);

xdft(2:end-1) = 2*xdft(2:end-1);
freq = O:Fs/length(x):Fs/2;

plot(freq,abs(xdft))

hold on

plot(freq,ones(length(x)/2+1,1), "LineWidth",2)
xlabel ("Hz")

ylabel ("Amplitude®)
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The amplitude estimate at 100 Hz is accurate because that frequency corresponds to
a DFT bin. However, the amplitude estimate at 202.5 Hz is not accurate because that
frequency does not correspond to a DFT bin.

You can interpolate the DFT by zero padding. While zero padding does not improve the
frequency resolution of the DFT, zero padding can allow you to obtain more accurate
amplitude estimates of resolvable signal components.

Pad the DFT out to length 2000. With this length, the spacing between DFT bins is

F /2000 = 0.5 Hz, 1y, thig case, the energy from the 202.5 Hz sine wave falls directly in a
DFT bin. Obtain the DFT and plot the amplitude estimates. Use zero padding out to 2000
samples.
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xdft = FFt(x,2000);
xdft = xdft(1l:length(xdft)/2+1);
xdft = xdft/length(x);

xdft(2:end-1) = 2*xdft(2:end-1);
freq = 0:Fs/(2*length(x)):Fs/2;

figure

plot(freq,abs(xdft));

hold on
plot(freq,ones(2*length(x)/2+1,1),"LineWidth",2)
xlabel ("Hz")

ylabel ("Amplitude®)
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The use of zero padding enables you to estimate the amplitudes of both frequencies
correctly.
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Significance Testing for Periodic Component

This example shows how to assess the significance of a sinusoidal component in white
noise using Fisher's g-statistic. Fisher's g-statistic is the ratio of the largest periodogram
value to the sum of all the periodogram values over 1/2 of the frequency interval, (0,
Fs/2). A detailed description of the g-statistic and exact distribution can be found in the
references.

Create a signal consisting of a 100 Hz sine wave in white Gaussian noise with zero mean
and variance 1. The amplitude of the sine wave is 0.25. The sample rate is 1 kHz. Set the
random number generator to the default settings for reproducible results.

rng default
Fs = 1e3;

t 0:1/Fs:1-1/Fs;
X = 0.25*cos(2*pi*100*t)+randn(size(t));

Obtain the periodogram of the signal using periodogram. Exclude 0 and the Nyquist
frequency (Fs/2). Plot the periodogram.

[Pxx,F] = periodogram(x,rectwin(length(x)), length(x),Fs);
Pxx = Pxx(2:length(x)/2);

periodogram(x, rectwin(length(x)), length(x),Fs)
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Periodogram Power Spectral Density Estimate
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Find the maximum value of the periodogram. Fisher's g-statistic is the ratio of the
maximum periodogram value to the sum of all periodogram values.

[maxval, index] = max(Pxx);
fisher_g = Pxx(index)/sum(Pxx)

fisher_g =

0.0381

The maximum periodogram value occurs at 100 Hz, which you can verify by finding the
frequency corresponding to the index of the maximum periodogram value.
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F = F(2:end-1);
F(index)

ans =

100

Use the distributional results detailed in the references to determine the significance
level, pval, of Fisher's g-statistic. The following MATLAB® code implements equation (6)
of [2].

N = length(Pxx);
upper = Floor(1/fisher_g);
for nn = 1:3
1(nn) = (-~ (nn-1)*nchoosek(N,nn)*(1-nn*fisher_g)~(N-1);
end
pval = sum(l)

pval =

2.0163e-06

The p-value is less than 0.00001, which indicates a significant periodic component at
100 Hz. The interpretation of Fisher's g-statistic is complicated by the presence of other
periodicities. See [1] for a modification when multiple periodicities may be present.

References

[1] Percival, Donald B. and Andrew T. Walden. Spectral Analysis for Physical
Applications. Cambridge, UK: Cambridge University Press, 1993.

[2] Wichert, Sofia, Konstantinos Fokianos, and Korbinian Strimmer. "Identifying
Periodically Expressed Transcripts in Microarray Time Series Data." Bioinformatics. Vol.
20, 2004, pp. 5-20.

12-31



12 Spectral Analysis

Frequency Estimation by Subspace Methods

12-32

This example shows how to resolve closely spaced sine waves using subspace methods.
Subspace methods assume a harmonic model consisting of a sum of sine waves, possibly
complex, in additive noise. In a complex-valued harmonic model, the noise is also
complex-valued.

Create a complex-valued signal 24 samples in length. The signal consists of two complex
exponentials (sine waves) with frequencies of 0.50 Hz and 0.52 Hz and additive complex
white Gaussian noise. The noise has zero mean and variance 0.2%, In a complex white

noise, both the real and imaginary parts have variance equal to 1/2 the overall variance.

n = 0:23;
rng default
X = exp(1J*2*pi*0.5*n)+exp(1j*2*pi*0.52*n)+ ...

0.2/sgrt(2)*(randn(size(n))+1lj*randn(size(n)));
Using periodogram, attempt to resolve the two sine waves.

periodogram(x, rectwin(length(x)),128,1)



Frequency Estimation by Subspace Methods
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The periodogram shows a broad peak near 1/2 Hz. You cannot resolve the two separate
sine waves because the frequency resolution of the periodogram is 1/_N_, where N is the
length of the signal. In this case, 1/_N_ is greater than the separation of the two sine
waves. Zero padding does not help to resolve two separate peaks.

Use a subspace method to resolve the two closely spaced peaks. In this example, use the
root-MUSIC method. Estimate the autocorrelation matrix and input the autocorrelation
matrix into pmusic. Specify a model with two sinusoidal components. Plot the result.

[X,R]
[S.F]

plot(F,S, " linewidth",2)
xim([0.46 0.60])

corrmtx(x,14,"mod");
pmusic(R,2,[].1, corr");
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xlabel ("Hz")
ylabel ("Pseudospectrum®)
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The root-MUSIC method is able to separate the two peaks at 0.5 and 0.52 Hz. However,
subspace methods do not produce power estimates like power spectral density estimates.
Subspace methods are most useful for frequency identification and can be sensitive to
model-order misspecification.
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Frequency-Domain Linear Regression

This example shows how to use the discrete Fourier transform to construct a linear
regression model for a time series. The time series used in this example is the monthly
number of accidental deaths in the United States from 1973 to 1979. The data are
published in Brockwell and Davis (2006). The original source is the U. S. National Safety
Council.

Enter the data. Copy the exdata matrix into the MATLAB® workspace.

exdata = [

9007 7750 8162 7717 7792 7836
8106 6981 7306 7461 6957 6892
8928 8038 8124 7776 7726 7791
9137 8422 7870 7925 8106 8129
10017 8714 9387 8634 8890 9115
10826 9512 9556 8945 9299 9434
11317 10120 10093 10078 10625 10484
10744 9823 9620 9179 9302 9827
9713 8743 8285 8037 8314 9110
9938 9129 8433 8488 8850 9070
9161 8710 8160 7874 8265 8633
8927 8680 8034 8647 8796 9240] ;

exdata is a 12-by-6 matrix. Each column of exdata contains 12 months of data. The first
row of each column contains the number of U.S. accidental deaths for January of the
corresponding year. The last row of each column contains the number of U.S. accidental
deaths for December of the corresponding year.

Reshape the data matrix into a 72-by-1 time series and plot the data for the years 1973 to
1978.

ts = reshape(exdata,72,1);

years = linspace(1973,1979,72);
plot(years,ts, "0-", "MarkerFaceColor","auto®)
xlabel ("Year")

ylabel ("Number of Accidental Deaths")
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A visual inspection of the data indicates that number of accidental deaths varies in a
periodic manner. The period of the oscillation appears to be roughly 1 year (12 months).
The periodic nature of the data suggests that an appropriate model may be

-Jllil. -.llL
X(n)=p+ Z (zl;, oS N + B cos jr ) b e(n),

where ! is the overall mean, IV is the length of the time series, and © (1) is a white

noise sequence of independent and identically-distributed (iid) Gaussian random
variables with zero mean and some variance. The additive noise term accounts for the
randomness inherent in the data. The parameters of the model are the overall mean and
the amplitudes of the cosines and sines. The model is linear in the parameters.
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To construct a linear regression model in the time domain, you have to specify which
frequencies to use for the cosines and sines, form the design matrix, and solve the normal
equations in order to obtain the least-squares estimates of the model parameters. In this
case, it is easier to use the discrete Fourier transform to detect the periodicities, retain
only a subset of the Fourier coefficients, and invert the transform to obtain the fitted
time series.

Perform a spectral analysis of the data to reveal which frequencies contribute
significantly to the variability in the data. Because the overall mean of the signal is
approximately 9,000 and is proportional to the Fourier transform at 0 frequency, subtract
the mean prior to the spectral analysis. This reduces the large magnitude Fourier
coefficient at 0 frequency and makes any significant oscillations easier to detect. The
frequencies in the Fourier transform are spaced at an interval that is the reciprocal of
the time series length, 1/72. Sampling the data monthly, the highest frequency in the
spectral analysis is 1 cycle/2 months. In this case, it is convenient to look at the spectral
analysis in terms of cycles/year so scale the frequencies accordingly for visualization.

tsdft = fft(ts-mean(ts));
freq = 0:1/72:1/2;

plot(freq-*12,abs(tsdft(1:length(ts)/2+1)),"0-",
"MarkerFaceColor®, "auto™)

xlabel ("Cycles/Year™)

ylabel (*"Magnitude®)

ax = gca;

ax.XTick = [1/6 1 2 3 4 5 6];
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Based on the magnitudes, the frequency of 1 cycle/12 months is the most significant
oscillation in the data. The magnitude at 1 cycle/12 months is more than twice as large
as any other magnitude. However, the spectral analysis reveals that there are also other
periodic components in the data. For example, there appears to be periodic components

at harmonics (integer multiples) of 1 cycle/12 months. There also appears to be a periodic
component with a period of 1 cycle/72 months.

Based on the spectral analysis of the data, fit a simple linear regression model using a

cosine and sine term with a frequency of the most signficant component: 1 cycle/year (1
cycle/12 months).

Determine the frequency bin in the discrete Fourier transform that corresponds to 1
cycle/12 months. Because the frequencies are spaced at 1/72 and the first bin corresponds
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to 0 frequency, the correct bin is 72/12+1. This is the frequency bin of the positive
frequency. You must also include the frequency bin corresponding to the negative
frequency: -1 cycle/12 months. With MATLAB indexing, the frequency bin of the negative
frequency is 72-72/12+1.

Create a 72-by-1 vector of zeros. Fill the appropriate elements of the vector with the
Fourier coefficients corresponding to a positive and negative frequency of 1 cycle/12
months. Invert the Fourier transform and add the overall mean to obtain a fit to the
accidental death data.

freqgbin = 72/12;

fregbins = [fregbin 72-fregbin]+1;
tsfit = zeros(72,1);
tsfit(fregbins) = tsdft(fregbins);
tsfit = ifft(tsfit);

mu = mean(ts);

tsfit = mu+tsfit;

Plot the original data along with the fitted series using two Fourier coefficients.
plot(years,ts, "0-", "MarkerFaceColor”®,"auto®)

xlabel ("Year")

ylabel (*Number of Accidental Deaths™)

hold on

plot(years, tsfit, " linewidth",2)

legend("Data”, "Fitted Model™)

hold off
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the initial conclusion that data oscillate with a cycle of 1 year.

To assess how adequately the single frequency of 1 cycle/12 months accounts for
the observed time series, form the residuals. If the residuals resemble a white noise
sequence, the simple linear model with one frequency has adequately modeled the time

series.

To assess the residuals, use the autocorrelation sequence with 95%-confidence intervals
for a white noise.

resid = ts-tsfit;
[xc, lags]
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Correlation Coefficient

stem(lags(61:end),xc(51:end), "filled")
hold on

Iconf = -1.96*0ones(51,1)/sqrt(72);
uconf = 1.96*ones(51,1)/sqrt(72);
plot(lags(51:end),lconf, r")
plot(lags(51:end),uconf, "r")

xlabel ("Lag™)

ylabel ("Correlation Coefficient”)
title("Autocorrelation of Residuals®)

e | | Alljtnc:nrlrelatinln of Rfa-sil:lmllls | |

0.4 -.. " * 1
N 01 R S O

0 5] 5 f J.ll Ll l'I‘ M ll&b IR

0 5 10 15 20 25 30 35
Lag

The autocorrelation values fall outside the 95% confidence bounds at a number of lags.
It does not appear that the residuals are white noise. The conclusion is that the simple
linear model with one sinusoidal component does not account for all the oscillations in
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the number of accidental deaths. This is expected because the spectral analysis revealed
additional periodic components in addition to the dominant oscillation. Creating a
model that incorporates additional periodic terms indicated by the spectral analysis will
improve the fit and whiten the residuals.

Fit a model which consists of the three largest Fourier coefficient magnitudes. Because
you have to retain the Fourier coefficients corresponding to both negative and positive
frequencies, retain the largest 6 indices.

tsfit2dft = zeros(72,1);

[Y,1] = sort(abs(tsdft), "descend”);
indices = 1(1:6);
tsfit2dft(indices) = tsdft(indices);

Demonstrate that preserving only 6 of the 72 Fourier coefficients (3 frequencies) retains
most of the signal's energy. First, demonstrate that retaining all the Fourier coefficients
yields energy equivalence between the original signal and the Fourier transform.

norm(1/sqrt(72)*tsdft,2)/norm(ts-mean(ts),2)

ans =

1.0000

The ratio is 1. Now, examine the energy ratio where only 3 frequencies are retained.

norm(1/sqrt(72)*tsfit2dft,2)/norm(ts-mean(ts),2)

ans =

0.8991
Almost 90% of the energy is retained. Equivalently, 90% of the variance of the time series
is accounted for by 3 frequency components.

Form an estimate of the data based on 3 frequency components. Compare the original
data, the model with one frequency, and the model with 3 frequencies.

tsfit2 = mu+tiffr(tsfit2dft, "symmetric™);
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plot(years,ts, "o-", "markerfacecolor”,"auto®)

xlabel ("Year")

ylabel (*Number of Accidental Deaths®)

hold on

plot(years, tsfit, "linewidth",2)
plot(years,tsfit2,"linewidth",2)
legend("Data®,"1 Frequency”, "3 Frequencies”®)

hold off

11500

11000

10500

10000

8500

80004

8500

8000

7200

000

—CO— Data
1 Frequency
3 Freguencies

6500
1973

1974

1975

1976 1977 1978 1979
Year

Using 3 frequencies has improved the fit to the original signal. You can see this by
examining the autocorrelation of the residuals from the 3-frequency model.

resid = ts-tsfit2;
[xc, lags]

= xcorr(resid,50, "coeff");
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Correlation Coefficient
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stem(lags(61:end),xc(51:end), “filled")
hold on

Iconf = -1.96*0ones(51,1)/sqrt(72);
uconf = 1.96*ones(51,1)/sqrt(72);
plot(lags(51:end),Iconf, r")
plot(lags(51:end),uconf,"r")

xlabel ("Lag™)

ylabel ("Correlation Coefficient”)
title("Autocorrelation of Residuals®)
hold off

Autocorrelation of Residuals
1* T T T T T T T T T

04r 7

[

SiLlIENAY 'lTTlUuTL'TLJ’ oo

0 5 10 15 20 25 30 35 40 45 50

Using 3 frequencies has resulted in residuals that more closely approximate a white
noise process.



Frequency-Domain Linear Regression

Demonstrate that the parameter values obtained from the Fourier transform are
equivalent to a time-domain linear regression model. Find the least-squares estimates
for the overall mean, the cosine amplitudes, and the sine amplitudes for the three
frequencies by forming the design matrix and solving the normal equations. Compare the
fitted time series with that obtained from the Fourier transform.

X = ones(72,7);

X(z,2) = cos*pi/72*(0:71))";
X(z,3) = sin(@*pi/72*(0:71))";
X(:,4) = cos(R*pi*6/72*(0:71))";
X(z,5) = sin(@*pi*6/72*(0:71))";
X(z,6) = cos(*pi*12/72*(0:71))";
X(z,7) = sin(Q*pi*12/72*(0:71))";

beta = X\ts;
tsfit_Im = X*beta;
max(abs(tsfit_Im-tsfit2))

ans =

7.2760e-12

The two methods yield identical results. The maximum absolute value of the difference
between the two waveforms is on the order of 10-12. In this case, the frequency-domain
approach was easier than the equivalent time-domain approach. You naturally use a
spectral analysis to visually inspect which oscillations are present in the data. From
that step, it is simple to use the Fourier coefficients to construct a model for the signal
consisting of a sum cosines and sines.

For more details on spectral analysis in time series and the equivalence with time-
domain regression see (Shumway and Stoffer, 2006).

While spectral analysis can answer which periodic components contribute significantly to
the variability of the data, it does not explain why those components are present. If you
examine these data closely, you see that the minimum values in the 12-month cycle tend
to occur in February, while the maximum values occur in July. A plausible explanation
for these data is that people are naturally more active in summer than in the winter.
Unfortunately, as a result of this increased activity, there is an increased probability of
the occurrence of fatal accidents.

References

12-45



12 Spectral Analysis

Brockwell, Peter J., and Richard A. Davis. Time Series: Theory and Methods. New York:
Springer, 2006.

Shumway, Robert H., and David S. Stoffer. Time Series Analysis and Its Applications
with R Examples. New York: Springer, 2006.

12-46



Measure Total Harmonic Distortion

Measure Total Harmonic Distortion

This example shows shows how to measure the total harmonic distortion (THD) of a
sinusoidal signal. The example uses the following scenario: A manufacturer of audio
speakers claims the model A speaker produces less than 0.09% harmonic distortion
at 1 kHz with a 1 volt input. The harmonic distortion is measured with respect to the
fundamental (THD-F).

Assume you record the following data obtained by driving the speaker with a 1 kHz tone
at 1 volt. The data is sampled at 44.1 kHz for analysis.

Fs = 44_.1e3;

t 0:1/Fs:1;

X = cos(2*pi*1000*t)+8e-4*sin(2*pi*2000*t)+2e-5*cos(2*pi*3000*t-pi/4)+...
8e-6*sin(2*pi*4000*t);

Obtain the total harmonic distortion of the input signal in dB. Specify that six harmonics
are used in calculating the THD. This includes the fundamental frequency of 1 kHz.
Input the sampling frequency of 44.1 kHz. Determine the frequencies of the harmonics
and their power estimates.

nharm = 6;
[thd_db, harmpow,harmfreq] = thd(x,Fs,nharm);

The function thd outputs the total harmonic distortion in dB. Convert the measurement
from dB to a percentage to compare the value against the manufacturer's claims.

percent_thd 100* (10~ (thd_db/20))

percent_thd

0.0800
The value you obtain indicates that the manufacturer's claims about the THD for speaker
model A are correct.

You can obtain further insight by examining the power (dB) of the individual harmonics.

T = table(harmfreq, harmpow, "VariableNames® ,{"Frequency”, "Power"})
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T =
Frequency Power
1000 -3.0103
2000 -64.949
3000 -96.99
4000 -104.95
4997.9 -306.11
5998.9 -310.56

The total harmonic distortion is approximately —fi2 dB. If you examine the power of the
individual harmonics, you see that the major contribution comes from the harmonic at

2 kHz. The power at 2 kHz is approximately 62 dB below the power of the fundamental.
The remaining harmonics do not contribute significantly to the total harmonic distortion.
Additionally, the synthesized signal contains only four harmonics, including the
fundamental. This is confirmed by the table, which shows a large power reduction after
4 kHz. Therefore, repeating the calculation with only four harmonics does not change the
total harmonic distortion significantly.

Plot the signal spectrum, display the total harmonic distortion on the figure title, and
annotate the harmonics.

thd(x,Fs,nharm);
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Practical Introduction to Frequency-Domain Analysis

This example shows how to perform and interpret basic frequency-domain signal
analysis. The example discusses the advantages of using frequency-domain versus time-
domain representations of a signal and illustrates basic concepts using simulated and
real data. The example answers basic questions such as: what is the meaning of the
magnitude and phase of an FFT?, Is my signal periodic?, How do I measure power?, Is
there one, or more than one signals in this band?.

Frequency-domain analysis is a tool of utmost importance in signal processing
applications. Frequency-domain analysis is widely used in such areas as
communications, geology, remote sensing, and image processing. While time-domain
analysis shows how a signal changes over time, frequency-domain analysis shows how
the signal's energy is distributed over a range of frequencies. A frequency-domain
representation also includes information on the phase shift that must be applied to each
frequency component in order to recover the original time signal with a combination of all
the individual frequency components.

A signal can be converted between the time and frequency domains with a pair of
mathematical operators called a transform. An example is the Fourier transform, which
decomposes a function into the sum of a (potentially infinite) number of sine wave
frequency components. The 'spectrum' of frequency components is the frequency domain
representation of the signal. The inverse Fourier transform converts the frequency
domain function back to a time function. The fft and ifft functions in MATLAB allow
you to compute the Discrete Fourier transform (DFT) of a signal and the inverse of this
transform respectively.

Magnitude and Phase Information of the FFT

The frequency-domain representation of a signal carries information about the signal's
magnitude and phase at each frequency. This is why the output of the FFT computation
is complex. A complex number, , has a real, ¥r, and an imaginary part, i, such

. L] ]
that = ¥+ + i%i The magnitude of = is computed as V [Tr T 77 ], and the phase of

r is computed as #TCtAN (71 /T ) You can use MATLAB functions abs and angle to
respectively get the magnitude and phase of any complex number.

Use an audio example to develop some insight on what information is carried by the
magnitude and the phase of a signal. To do this, load an audio file containing 15 seconds
of acoustic guitar music. The sample rate of the audio signal is 44.1 kHz.

12-50



Practical Introduction to Frequency-Domain Analysis

Fs = 44100;
y = audioread("guitartune.wav®);

Use fft to observe the frequency content of the signal.

NFFT = length(y);

Y = FFt(y,NFFT);

F = ((0:1/NFFT:1-1/NFFT)*Fs).";

The output of the FFT is a complex vector containing information about the frequency
content of the signal. The magnitude tells you the strength of the frequency components
relative to other components. The phase tells you how all the frequency components align
in time.

Plot the magnitude and the phase components of the frequency spectrum of the
signal. The magnitude is conveniently plotted in a logarithmic scale (dB). The phase
is unwrapped using the unwrap function so that we can see a continuous function of
frequency.

magnitudeY = abs(Y); % Magnitude of the FFT
phaseY = unwrap(angle(Y)); % Phase of the FFT

helperFrequencyAnalysisPlotl(F,magnitudeY,phaseY,NFFT)
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Magnitude response of the audio signal
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You can apply an inverse Fourier transform to the frequency domain vector, Y, to recover
the time signal. The 'symmetric' flag tells ifft that you are dealing with a real-valued
time signal so it will zero out the small imaginary components that appear on the inverse
transform due to numerical inaccuracies in the computations. Notice that the original
time signal, y, and the recovered signal, y1, are practically the same (the norm of their
difference is on the order of 1e-14). The very small difference between the two is also

due to the numerical inaccuracies mentioned above. Play and listen the un-transformed
signal y1.

yl = ifFt(Y,NFFT, "symmetric”);
norm(y-yl)

ans =
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3.9112e-14

hplayer = audioplayer(yl, Fs);
play(hplayer);

To see the effects of changing the magnitude response of the signal, remove frequency
components above 1 kHz directly from the FFT output (by making the magnitudes equal
to zero) and listen to the effect this has on the sound of the audio file. Removing high
frequency components of a signal is referred to as lowpass filtering.

Yip = Y;
YIp(F>=1000 & F<=Fs-1000) = O;

helperFrequencyAnalysisPlotl(F,abs(YIlp),unwrap(angle(YIp)),NFFT, ...
"Frequency components above 1 kHz have been zeroed®)
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Magnitude response of the audio signal
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Get the filtered signal back into time domain using ifft.
ylp = ifft(Ylp, "symmetric™);

Play the signal. You can still hear the melody but it sounds like if you had covered your
ears (you filter high frequency sounds when you do this). Even though guitars produce
notes that are between 400 and 1 kHz, as you play a note on a string, the string also
vibrates at multiples of the base frequency. These higher frequency components, referred
to as harmonics, are what give the guitar its particular tone. When you remove them, you
make the sound seem "opaque".

hplayer = audioplayer(ylp, Fs);
play(hplayer);
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The phase of a signal has important information about when in time the notes of the
song appear. To illustrate the importance of phase on the audio signal, remove the phase
information completely by taking the magnitude of each frequency component. Note that
by doing this you keep the magnitude response unchanged.

% Take the magnitude of each FFT component of the signal

Yzp = abs(Y);

helperFrequencyAnalysisPlotl(F,abs(Yzp),unwrap(angle(Yzp)) ,NFFT,[1,---
"Phase has been set to zero®)

Magnitude response of the audio signal

0 5 10 15 20
Frequency in kHz
Phase response of the audio signal

Phase has been set to zero
1 T T T T

_1 i i i i
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Frequency in kHz

Get the signal back in the time domain and play the audio. You cannot recognize the
original sound at all. The magnitude response is the same, no frequency components
have been removed this time, but the order of the notes has disappeared completely. The
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12-56

signal now consists of a group of sinusoids all aligned at time equal to zero. In general,
phase distortions caused by filtering can damage a signal to the point of rendering it
unrecognizable.

yzp = 1fft(Yzp, "symmetric”);
hplayer = audioplayer(yzp, Fs);
play(hplayer);

Finding Signal Periodicities

The frequency domain representation of a signal allows you to observe several
characteristics of the signal that are either not easy to see, or not visible at all when you
look at the signal in the time domain. For instance, frequency-domain analysis becomes
useful when you are looking for cyclic behavior of a signal.

Analyzing Cyclic Behavior of the Temperature in an Office Building

Consider a set of temperature measurements in an office building during the winter
season. Measurements were taken every 30 minutes for about 16.5 weeks. Look at
the time domain data with the time axis scaled to weeks. Could there be any periodic
behavior on this data?

load officetemp.mat
Fs = 1/(60*30); % Sample rate is 1 sample every 30 minutes
t = (O:length(temp)-1)/Fs;

helperFrequencyAnalysisPlot2(t/(60*60*24*7) ,temp, . - .
"Time in weeks®,"Temperature (Fahrenheit)")
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It is almost impossible to know if there is any cyclic behavior on the office temperatures
by looking at the time-domain signal. However, the cyclic behavior of the temperature
becomes evident if we look at its frequency-domain representation.

Obtain the frequency-domain representation of the signal. If you plot the magnitude

of the FFT output with a frequency axis scaled to cycles/week, you can see that there
are two spectral lines that are clearly larger than any other frequency component. One
spectral line lies at 1 cycle/week, the other one lies at 7 cycles/week. This makes sense
given that the data comes from a temperature-controlled building on a 7 day calendar.
The first spectral line indicates that building temperatures follow a weekly cycle with
lower temperatures on the weekends and higher temperatures during the week. The
second line indicates that there is also a daily cycle with lower temperatures during the
night and higher temperatures during the day.
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NFFT = length(temp); % Number of FFT points
F = ( : 1/NFFT : 1/2-1/NFFT)*Fs; % Frequency vector

TEMP = fft(temp,NFFT);
TEMP(1) = 0; % remove the DC component for better visualization

helperFrequencyAnalysisPlot2(F*60*60*24*7 ,abs(TEMP(1:NFFT/2)), - - .
"Frequency (cycles/week)", *Magnitude®,[]1,[1,[0 10])
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Measuring Power

The periodogram function computes the signal's FFT and normalizes the output to
obtain a power spectral density, PSD, or a power spectrum from which you can measure
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power. The PSD describes how the power of a time signal is distributed with frequency, it
has units of watts/Hz. You compute the power spectrum by integrating each point of the
PSD over the frequency interval at which that point is defined (i.e. over the resolution
bandwidth of the PSD). The units of the power spectrum are watts. You can read power
values directly from the power spectrum without having to integrate over an interval.
Note that the PSD and power spectrum are real, so they do not contain any phase
information.

Measuring Harmonics at the Output of a Non-Linear Power Amplifier

Load the data measured at the output of a power amplifier that has third order distortion
—— i v . . .
of the form ¥e = Vi + 0.75u7 + (.52 i, where s is the output voltage and i is the input

voltage. The data was captured with a sample rate of 3.6 kHz. The input i consists of
a 60 Hz sinusoid with unity amplitude. Due to the nature of the non-linear distortion,
you should expect the amplifier output signal to contain a DC component, a 60 Hz
component, and second and third harmonics at 120 and 180 Hz.

Load 3600 samples of the amplifier output, compute the power spectrum, and plot the
result in a logarithmic scale (decibels-watts or dBW).

load ampoutputl.mat
Fs = 3600;
NFFT = length(y);

% Power spectrum is computed when you pass a "power® flag input
[P.F] = periodogram(y,[1.NFFT,Fs, “power®);

helperFrequencyAnalysisPlot2(F,10*1og10(P), "Frequency in Hz",...
“"Power spectrum (dBW)",[1,[1,.[-0-5 200])
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The plot of the power spectrum shows three of the four expected peaks at DC, 60, and 120
Hz. It also shows several more spurious peaks that must be caused by noise in the signal.
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Note that the 180 Hz harmonic is completely buried in the noise.

Measure the power of the visible expected peaks:

PdBW = 10*10g10(P);

power_at _DC_dBW = PdBW(F==0)

[peakPowers_dBW, peakFreqldx] = findpeaks(PdBW, "minpeakheight®,-11);

peakFreqs_Hz F(peakFreqldx)

peakPowers_dBW

12-60

% dBW




Practical Introduction to Frequency-Domain Analysis

power_at DC_dBW =

-7.8873

peakFreqs_Hz =

60
120

peakPowers_dBW =

-0.3175
-10.2547

Improving Power Measurements for Noisy Signals

As seen on the plot above, the periodogram shows several frequency peaks that are not
related to the signal of interest. The spectrum looks very noisy. The reason for this is that
you only analyzed one short realization of the noisy signal. Repeating the experiment
several times and averaging would remove the spurious spectral peaks and yield more
accurate power measurements. You can achieve this averaging using the pwelch
function. This function will take a large data vector, break it into smaller segments of

a specified length, compute as many periodograms as there are segments, and average
them. As the number of available segments increases, the pwelch function will yield a
smoother power spectrum (less variance) with power values closer to the expected values.

Load a larger observation consisting of 500e3 points of the amplifier output. Keep the
number of points used to perform the FFTs as 3600 so that floor(500e3/3600) = 138 FFTs
are averaged to obtain the power spectrum.

load ampoutput2._mat
SegmentLength = NFFT;

% Power spectrum is computed when you pass a "power® flag input
[P,F] = pwelch(y,ones(SegmentLength,1),0,NFFT,Fs, "power");

helperFrequencyAnalysisPlot2(F,10*1og10(P), "Frequency in Hz",...
“"Power spectrum (dBW)",[1,[1,[-0-5 200])

12-61



12 Spectral Analysis

Fower spectrum (dBW)
o

i [
! Moa W (T i __-nl_ M Mo ™ || M T P A LT LY, i P
-~ \-'Ir-u"' l""w-""\! II'-.- Ve A "‘.‘I|I. “ W;‘ Ll W LN I“_..I l'h-v-\.-' |I| Ii - ety I vy Ul

=257

—3'} i i i i i i i i i
0 20 40 G0 80 100 120 140 180 180 200

Frequency in Hz

As seen on the plot, pwelch effectively removes all the spurious frequency peaks caused
by noise. The spectral component at 180 Hz that was buried in noise is now visible.

Averaging removes variance from the spectrum and this effectively yields more accurate
power measurements.

Measuring Total Average Power and Power Over a Frequency Band
Measuring the total average power of a time-domain signal is an easy and common
task. For the amplifier output signal, y, the total average power is computed in the time

domain as:

pwr = sum(y-~2)/length(y) % in watts
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pwr =

8.1697

In the frequency-domain, the total average power is computed as the sum of the power
of all the frequency components of the signal. The value of pwrl consists of the sum of
all the frequency components available in the power spectrum of the signal. The value
agrees with the value of pwr computed above using the time domain signal:

pwrl sum(P) % in watts

pwrl =

8.1698

But what if you wanted to measure the total power available over a band of frequencies?
You can use the bandpower function to compute the power over any desired frequency
band. You can pass the time-domain signal directly as an input to this function to
obtain the power over a specified band. In this case, the function will estimate the power
spectrum with the periodogram method.

Compute the power over the 50 Hz to 70 Hz band. The result will include the 60 Hz
power plus the noise power over the band of interest:

pwr_band = bandpower(y,Fs,[50 70]);
pwr_band_dBW = 10*logl0(pwr_band) % dBW
pwr_band_dBW =

0.0341

If you want to control the computation of the power spectrum used to measure the power
in a band, you can pass a PSD vector to the bandpower function. For instance, you can
use the pwelch function as you did before to compute the PSD and ensure averaging of
the noise effects:

% Power spectral density is computed when you specify the "psd® option

[PSD,F] = pwelch(y,ones(SegmentLength,1),0,NFFT,Fs,"psd”);
pwr_bandl = bandpower(PSD,F,[50 70], "psd®);
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pwr_band_dBW1 = 10*loglO0(pwr_bandl) % dBW

pwr_band_dBW1

0.0798

Finding Spectral Components

A signal might be composed of one more frequency components. The ability to observe
all the spectral components depends on the frequency resolution of your analysis. The
frequency resolution or resolution bandwidth of the power spectrum is defined as R = Fs/
N, where N is the length of the signal observation. Only spectral components separated
by a frequency larger than the frequency resolution will be resolved.

Analyzing a Building's Earthquake Vibration Control System

Active Mass Driver (AMD) control systems are used to reduce vibration in a building
under an earthquake. An active mass driver is placed on the top floor of the building

and, based on displacement and acceleration measurements of the building floors, a
control system sends signals to the driver so that the mass moves to attenuate ground
disturbances. Acceleration measurements were recorded on the first floor of a three story
test structure under earthquake conditions. Measurements were taken without the active
mass driver control system (open loop condition), and with the active control system
(closed loop condition).

Load the acceleration data and compute the power spectrum for the acceleration of

the first floor. The length of the data vectors is 10e3 and the sample rate is 1 kHz.

Use pwelch with segments of length 64 data points to obtain floor(10e3/64) = 156

FFT averages and a resolution bandwidth of Fs/64 = 15.625 Hz. As was shown before,
averaging reduces noise effects and yields more accurate power measurements. Use 512
FFT points. Using NFFT > N effectively interpolates frequency points rendering a more
detailed spectrum plot (this is achieved by appending NFFT-N zeros at the end of the
time signal and taking the NFFT-point FFT of the zero padded vector).

The open loop and close loop acceleration power spectra show that when the control
system 1is active, the acceleration power spectrum decreases between 4 and 11 dB. The
maximum attenuation occurs at about 23.44 kHz. An 11 dB reduction means that the
vibration power is reduced by a factor of 12.6. The total power is reduced from 0.1670 to
0.059 watts, a factor of 2.83.

load quakevibration.mat
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Acceleration Power Spectrum in dB

Fs = 1e3; % sample rate
NFFT = 512; % number of FFT points
segmentLength = 64; % segment length

% open loop acceleration power spectrum
[P1_OL,F] = pwelch(gfloorlOL,ones(segmentLength,1),0,NFFT,Fs, "power”);

% closed loop acceleration power spectrum
P1 CL = pwelch(gfloorlCL ,ones(segmentLength,1),0,NFFT,Fs, "power”);

helperFrequencyAnalysisPlot2(F,10*1ogl0([(P1_0L) (P1_CLYD),---
"Frequency in Hz","Acceleration Power Spectrum in dB",...
"Resolution bandwidth = 15.625 Hz",{"Open loop", "Closed loop"},[0 100])
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You are analyzing vibration data and you know that vibrations have a cyclic behavior.
Then how is it that the spectrum plots shown above do not contain any sharp spectral
lines typical of cyclic behavior? Maybe you are missing those lines because they are not
resolvable with the resolution obtained with 64 point segment lengths? Increase the
frequency resolution to see if there are spectral lines that were not resolvable before. Do
this by increasing the data segment length used in the pwelch function to 512 points.
This yields a new resolution of Fs/512 = 1.9531 Hz. In this case, the number of FFT
averages is reduced to floor(10e3/512) = 19. Clearly, there is a trade-off between number
of averages and frequency resolution when using pwelch. Keep the number of FFT
points equal to 512.

NFFT = 512; % number of FFT points
segmentLength = 512; % segment length

[P1_OL,F]
P1 CL

pwelch(gfloorlOL,ones(segmentLength,1),0,NFFT,Fs, "power™);
pwelch(gfloorlCL,ones(segmentLength,1),0,NFFT,Fs, "power™);

helperFrequencyAnalysisPlot2(F,10*1og1l0([(P1_0OL) (P1_CL)D),---
"Frequency in Hz","Acceleration Power Spectrum in dB",...
"Resolution bandwidth = 1.95 Hz",{"Open loop", "Closed loop"},[0 1001)
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Acceleration Power Spectrum in dB
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Notice how the increase in frequency resolution allows you to observe three peaks

on the open loop spectrum and two on the close loop spectrum. These peaks were not
resolvable before. The separation between the peaks on the open loop spectrum is about
11 Hz which is smaller than the frequency resolution obtained with segments of length
64 but larger than the resolution obtained with segments of length 512. The cyclic
behavior of the vibrations is now visible. The main vibration frequency is at 5.86 Hz,
and the equispaced frequency peaks suggest that they are harmonically related. While
it has already been observed that the control system reduces the overall power of the
vibrations, the higher resolution spectra shows that another effect of the control system
is to notch the harmonic component at 17.58 Hz. So the control system not only reduces
the vibration but also brings it closer to a sinusoid.
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It is important to note that frequency resolution is determined by the number of

signal points, not by the number of FFT points. Increasing the number of FFT points
interpolates the frequency data to give you more details on the spectrum but it does not
improve resolution.

Conclusions

In this example you learned how to perform frequency-domain analysis of a signal using
the fft, ifft, periodogram, pwelch, and bandpower functions. You understood the
complex nature of the FFT and what is the information contained in the magnitude and
the phase of the frequency spectrum. You saw the advantages of using frequency domain
data when analyzing the periodicity of a signal. You learned how compute the total power
or power over a particular band of frequencies of a noisy signal. You understood how
increasing the frequency resolution of the spectrum allows you to observe closely spaced
frequency components and you learned about the tradeoff between frequency resolution
and spectral averaging.

Further Reading
For more information on frequency domain analysis see the Signal Processing Toolbox.

Reference: J.G. Proakis and D. G. Manolakis, "Digital Signal Processing. Principles,
Algorithms, and Applications", Prentice Hall, 1996.

Appendix
The following helper functions are used in this example.

* helperFrequencyAnalysisPlot1l.m
* helperFrequencyAnalysisPlot2.m
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Spectral Analysis of Nonuniformly Sampled Signals

This example shows how to perform spectral analysis on nonuniformly sampled signals.
It helps you determine if a signal is uniformly sampled or not, and if not, it shows how to
compute its spectrum or its power spectral density.

The example introduces the Lomb-Scargle periodogram, which can compute spectra of
nonuniformly sampled signals.

Nonuniformly Sampled Signals

Nonuniformly sampled signals are often found in the automotive industry, in
communications, and in fields as diverse as medicine and astronomy. Nonuniform
sampling might be due to imperfect sensors, mismatched clocks, or event-triggered
phenomena.

The computation and study of spectral content is an important part of signal analysis.
Conventional spectral analysis techniques like the periodogram and the Welch method
require the input signal to be uniformly sampled. When the sampling is nonuniform, one
can resample or interpolate the signal onto a uniform sample grid. This, however, can
add undesired artifacts to the spectrum and might lead to analysis errors.

A better alternative is to use the Lomb-Scargle method, which works directly with the
nonuniform samples and thus makes it unnecessary to resample or interpolate. The
algorithm has been implemented in the plomb function.

Spectral Analysis of Signals with Missing Data

Consider a temperature monitoring system in which a microcontroller records the
temperature of a room and transmits this reading every 15 minutes to a cloud-based
server that stores it. It is known that glitches in internet connectivity prevent the cloud-
based system from receiving some of the readings sent by the microcontroller. Also, at
least once during the measurement period the microcontroller's battery ran out, leading
to a large gap in the sampling.

Load the temperature readings and the corresponding timestamps.

load("nonuniformdata.mat”, "roomtemp®, "tl")

figure
plot(tl/(60*60*24*7),roomtemp, "LineWidth",1.2)

grid
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xlabel ("Time (weeks)®)
ylabel ("Temperature (\circF)")
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An easy way to determine if a signal is uniformly sampled is to take a histogram of the
intervals between successive sample times.

Plot a histogram of sampling intervals (time differences) in minutes. Include only points
at which samples are present.

tAtPoints = tl(~isnan(roomtemp))/60;
TimelntervalDiff = diff(tAtPoints);

figure

hist(TimelntervalDiff,0:100)
grid
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Ocourrences

xlabel ("Sampling intervals (minutes)”)
ylabel ("Occurrences”®)
xIim([10 100]1)
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The majority of the measurements are spaced approximately 15 minutes apart, as
expected. However, a fair number of occurrences have sampling intervals of around

30 and 45 minutes, which correspond to one or two consecutive dropped samples. This
causes the signal to be nonuniformly sampled. Furthermore, the histogram shows
some jitter surrounding the bars showing high occurrences. This could relate to TCP/IP
latency.

Use the Lomb-Scargle method to compute and visualize the spectral content of the
signal. To help visualize the spectrum better, consider frequencies up to 0.02 mHz, which
correspond to about 13 cycles per week.
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[Plomb,flomb] = plomb(roomtemp,tl,2e-5, "power®);

figure
plot(flomb*60*60*24*7 ,Plomb)

grid

xlabel ("Frequency (cycles/week) ™)
ylabel ("Power (dBW)*®)
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The spectrum shows dominant periodicities at 7 cycles per week and 1 cycle per week.
This is understandable, given that the data comes from a temperature-controlled
building on a seven-day calendar. The spectral line showing a peak at 1 cycle per

week indicates that the temperature in the building follows a weekly cycle, with lower
temperatures on weekends and higher temperatures during the week. The spectral line
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of 7 cycles per week indicates that there is also a daily cycle with lower temperatures at
night and higher temperatures during the day.

Spectral Analysis of Signals with Unevenly Spaced Samples

Heart-rate variability (HRV) signals, which represent the physiological variation in time
between heartbeats, are typically unevenly sampled because human heart rates are not
constant. HRV signals are derived from electrocardiogram (ECG) readings.

The sample points of an HRV signal are located at the R-Peak times of the ECG. The
amplitude of each point is computed as the inverse of the time difference between
consecutive R-Peaks and is placed at the instant of the second R-Peak.

% Load the signal, the timestamps, and the sample rate
load("nonuniformdata.mat”, "ecgsig”, "t2","Fs")

% Find the ECG peaks
[pks, locs] = findpeaks(ecgsig,Fs, -
"MinPeakProminence®,0.3, "MinPeakHeight",0.2);

% Determine the RR intervals
RLocsInterval = diff(locs);

% Derive the HRV signal
tHRV = locs(2:end);
HRV = 1./RLocslInterval;

% Plot the signals
figure

al = subplot(2,1,1);
plot(t2,ecgsig, "b",locs,pks, "*rv)
grid

a2 = subplot(2,1,2);
plot(tHRV,HRV)

grid
xlabel (@2, "Time(s) ")
ylabel(al,"ECG (mV)*™)
ylabel (a2, "HRV (Hz)*")
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The varying intervals between the R-peaks cause the sample-time nonuniformity in
the HRV data. Consider the peak locations of the signal and plot a histogram of their
separations in seconds.

figure
hist(RLocsInterval)

grid

xlabel ("Sampling interval (s)")
ylabel (*RR distribution®)
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The typical frequency bands of interest in HRV spectra are:

* Very Low Frequency (VLF), from 3.3 to 40 mHz,
*  Low Frequency (LF), from 40 to 150 mHz,
* High Frequency (HF), from 150 to 400 mHz.

These bands approximately confine the frequency ranges of the distinct biological
regulatory mechanisms that contribute to HRV. Fluctuations in any of these bands have

biological significance.

Use plomb to calculate the spectrum of the HRV signal.

figure
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Fowerffrequency (dBWW/Hz)

plomb(HRV, tHRV, "Pd" ,[0.95, 0.5])

Lomb-Scargle Power Spectral Density Estimate
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The dashed lines denote 95% and 50% detection probabilities. These thresholds measure
the statistical significance of peaks. The spectrum shows peaks in all three bands of
interest listed above. However, only the peak located at 23.2 mHz in the VLF range
shows a detection probability 95%, while the other peaks have detection probabilities

of less than 50%. The peaks lying below 40 mHz are thought to be due to long-term
regulatory mechanisms, such as the thermoregulatory system and hormonal factors.



Measure Mean Frequency, Power, Bandwidth

Measure Mean Frequency, Power, Bandwidth

Generate 1024 samples of a chirp sampled at 1024 kHz. The chirp has an initial
frequency of 50 kHz and reaches 100 kHz at the end of the sampling. Add white
Gaussian noise such that the signal-to-noise ratio is 40 dB.

nSamp = 1024;
Fs = 1024e3;
SNR = 40;

t = (0:nSamp-1)*"/Fs;

X
X

chirp(t,50e3,nSamp/Fs,100e3);
x+randn(size(x))*std(x)/db2mag(SNR) ;

Estimate the 99% occupied bandwidth of the signal and annotate it on a plot of the power
spectral density (PSD).

obw(x,Fs);
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99% Occupied Bandwidth: 55.377 kHz
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Compute the power in the band and verify that it is 99% of the total.
[bw,flo,fhi,powr] = obw(x,Fs);

pcent = powr/bandpower (x)*100

pcent

99

Generate another chirp. Specify an initial frequency of 200 kHz, a final frequency of 300
kHz, and an amplitude that is twice that of the first signal. Add white Gaussian noise.
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Fowerffrequency (dB/Hz)

X2
X2

2*chirp(t,200e3,nSamp/Fs,300e3);
x2+randn(size(x2))*std(x2)/db2mag(SNR) ;

Add the two chirps to form a new signal. Plot the PSD of the signal and annotate its
median frequency.

medfreq([x+x2],Fs);

Median Frequency Estimate: 237.563 kHz
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Plot the PSD and annotate the mean frequency.

meanfreq([x+x2],Fs);
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Mean Frequency Estimate: 214.962 kHz
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Now consider each chirp to represent a separate channel. Estimate the mean frequency
of each channel. Annotate the mean frequencies on a plot of the PSDs.

meanfreq([x x2],Fs)

ans =
1.0e+05 *

0.7503 2.4999
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Fowerffrequency (dB/Hz)
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Estimate the half-power bandwidth of each channel. Annotate the 3-dB bandwidths on a
plot of the PSDs.

powerbw([x x2],Fs)

ans =
1.0e+04 *

4.4386 9.2208
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Fowerffrequency (dB/Hz)
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Periodogram of Data Set with Missing Samples

Galileo Galilei observed the motion of Jupiter's four largest satellites during the winter
of 1610. When the weather allowed, Galileo recorded the satellites' locations. Use his
observations to estimate the orbital period of one of the satellites, Callisto.

Callisto's angular position is measured in minutes of arc. Missing data due to cloudy
conditions are specified using NaN's. The first observation is dated January 15.

yg = [10.5 NaN 11.5 10.5 NaN NaN NaN -5.5 -10.0 -12.0 -11.5 -12.0 -7.5 ...
NaN NaN NaN NaN 8.5 12.5 12.5 10.5 NaN NaN NaN -6.0 -11.5 -12.5 ...
-12.5 -10.5 -6.5 NaN 2.0 8.5 10.5 NaN 13.5 NaN 10.5 NaN NaN NaN ...
-8.5 -10.5 -10.5 -10.0 -8.0]";

plot(yg,"0")

ax = gca;
nights = [1 18 32 46];

ax.XTick = nights;

ax.XTickLabel = char(datetime(1610,1,nights+14));
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Estimate the power spectrum of the data using plomb. Investigate frequencies up to half
the sample rate of one observation per day. Specify an oversampling factor of 10.

Fs = 1;
Fmax = Fs/2;
[pxx,F] = plomb(yg,Fs,Fmax,10, "power™);

Use Findpeaks to determine the location of the only prominent peak of the spectrum.
Plot the power spectrum and show the peak.

[pk,f0] = findpeaks(pxx, ¥, "MinPeakHeight®,10);

plot(f,pxx,f0,pk,"0")
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Determine Callisto's orbital period (in days) as the inverse of the frequency of maximum
energy. The result differs by less than 1% from the value published by NASA.

Period = 1/f0

NASA = 16.6890184;
PercentDiscrep = (Period-NASA)/NASA*100

Period =

16.6454

12-85



12 Spectral Analysis

PercentDiscrep =

-0.2613
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Welch Spectrum Estimates

Create a signal consisting of three noisy sinusoids and a chirp, sampled at 200 kHz

for 0.1 second. The frequencies of the sinusoids are 1 kHz, 10 kHz, and 20 kHz. The
sinusoids have different amplitudes and noise levels. The noiseless chirp has a frequency
that starts at 20 kHz and increases linearly to 30 kHz during the sampling.

Fs = 200e3;

Fc = [1 10 20]"*1e3;

Ns = 0.1*Fs;

t = (0:Ns-1)/Fs;

X = [1 1/10 10]*sin(2*pi*Fc*t)+[1/200 1/2000 1/20]*randn(3,Ns);
x = x+chirp(t,20e3,t(end),30e3);

Compute the Welch PSD estimate and the maximum-hold and minimum-hold spectra of
the signal. Plot the results.

[pxx,f] = pwelch(x,[1.[1.[1.Fs);
pmax = pwelch(x,[1,[1.[1,Fs, "maxhold™);
pmin = pwelch(x,[1,[1.[1,Fs, " minhold™);

plot(Ff,pow2db(pxx))

hold on

plot(f,pow2db([pmax pmin]),":")

hold off

xlabel ("Frequency (Hz)")

ylabel (*PSD (dB/Hz) ")
legend("pwelch™, "maxhold”, "minhold")
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Repeat the procedure, this time computing centered power spectrum estimates.

[pxx,F] = pwelch(x,[1,[1.[],Fs, centered”, "power™);
pmax = pwelch(x,[1,[1.[1,Fs, "maxhold", "centered”, "power");
pmin = pwelch(x,[1,[1.[1,Fs, "minhold", "centered”, "power");

plot(F,pow2db(pxx))

hold on

plot(f,pow2db([pmax pmin]),":")

hold off

xlabel ("Frequency (Hz)")

ylabel ("Power (dB)")
legend("pwelch®, "maxhold®, "minhold™)
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Prediction Polynomial

This example shows how to obtain the prediction polynomial from an autocorrelation
sequence. The example also shows that the resulting prediction polynomial has an
inverse that produces a stable all-pole filter. You can use the all-pole filter to filter

a wide-sense stationary white noise sequence to produce a wide-sense stationary
autoregressive process.

Create an autocorrelation sequence defined by

: 27

%, , 97 .
rk)y==2"W_Z_3 ¥ =012
' a 10

k = 0:2;
rk = (24/5)*2_~(-k)-(27/10)*3."(-k);

Use ac2poly to obtain the prediction polynomial of order 2, which is

A = ac2poly(rk);
Examine the pole-zero plot of the FIR filter to see that the zeros are inside the unit circle.

zplane(A,1)
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The inverse all-pole filter is stable with poles inside the unit circle.

zplane(1,A)
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Use the all-pole filter to produce a realization of a wide-sense stationary AR(2) process
from a white-noise sequence. Set the random number generator to the default settings for
reproducible results.

rng default

X
y

randn(1000,1);
Ffilter(1,A,x);

Compute the sample autocorrelation of the AR(2) realization and show that the sample
autocorrelation is close to the true autocorrelation.

[xc,lags] = xcorr(y,2, "biased™);
[xc(3:end) rk*]
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ans

2.2401
1.6419
0.9980

2.1000
1.5000
0.9000
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Formant Estimation with LPC Coefficients

13-6

This example shows how to estimate vowel formant frequencies using linear predictive
coding (LPC). The formant frequencies are obtained by finding the roots of the prediction
polynomial.

This example uses the speech sample mtlb.mat, which is part of Signal Processing
Toolbox™. The speech is lowpass-filtered. Because of the low sampling frequency, this
speech sample is not optimal for this example. The low sampling frequency limits the
order of the autoregressive model you can fit to the data. In spite of this limitation, the
example illustrates the technique for using LPC coefficients to determine vowel formants.

Load the speech signal. The recording is a woman saying "MATLAB". The sampling
frequency is 7418 Hz.

load mtlb
The MAT file contains the speech waveform, mtlb, and the sampling frequency, Fs.

Use the spectrogram function to identify a voiced segment for analysis.
segmentlen = 100;

noverlap = 90;

NFFT = 128;

spectrogram(mtlb,segmentlen,noverlap,NFFT,Fs, "yaxis®)
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Extract the segment from 0.1 to 0.25 seconds for analysis. The extracted segment

corresponds roughly to the first vowel, /ae/, in "MATLAB".

dt 1/Fs;

10 round(0.1/dt);
lend = round(0.25/dt);
x = mtlb(10:1end);
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Two common preprocessing steps applied to speech waveforms before linear predictive

coding are windowing and pre-emphasis (highpass) filtering.
Window the speech segment using a Hamming window.

x1 = x.*hamming(length(x));
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Apply a pre-emphasis filter. The pre-emphasis filter is a highpass all-pole (AR(1)) filter.

preemph = [1 0.63];
x1 = filter(1,preemph,x1);

Obtain the linear prediction coefficients. To specify the model order, use the general rule
that the order is two times the expected number of formants plus 2. In the frequency
range, [0, | Fs|/2], you expect three formants. Therefore, set the model order equal to 8.
Find the roots of the prediction polynomial returned by Ipc.

A = Ipc(x1,8);
rts = roots(A);

Because the LPC coefficients are real-valued, the roots occur in complex conjugate pairs.
Retain only the roots with one sign for the imaginary part and determine the angles
corresponding to the roots.

rts = rts(imag(rts)>=0);
angz = atan2(imag(rts),real(rts));

Convert the angular frequencies in rad/sample represented by the angles to Hz and
calculate the bandwidths of the formants.

The bandwidths of the formants are represented by the distance of the prediction
polynomial zeros from the unit circle.

[frgs,indices] = sort(angz.*(Fs/(2*pi)));
bw = -1/2*(Fs/(2*pi))*log(abs(rts(indices)));

Use the criterion that formant frequencies should be greater than 90 Hz with bandwidths
less than 400 Hz to determine the formants.

nn = 1;
for kk = 1:length(frqgs)
it (frgs(kk) > 90 && bw(kk) <400)
formants(nn) = frgs(kk);
nn = nn+l;
end
end
formants

formants =



Formant Estimation with LPC Coefficients

1.0e+03 *

0.8697 2.0265 2.7380

The first three formants are 869.70, 2026.49, and 2737.95 Hz.

References

[1] Snell, Roy C., and Fausto Milinazzo. "Formant location from LPC analysis data."
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AR Order Selection with Partial Autocorrelation Sequence

13-10

This example shows how to assess the order of an autoregressive model using the partial
autocorrelation sequence. For these processes, you can use the partial autocorrelation
sequence to help with model order selection. For a stationary time series with values

X(1), X(2), X(3),...,- X(k+ 1} the partial autocorrelation sequence at lag F is
the correlation between X [1} and X (¥ + 1) after regressing X(1) ang Xk + 1) on

the intervening observations, X(2), X(3), X(4),...,- N (%), For a moving average
process, you can use the autocorrelation sequence to assess the order. However,

for an autoregressive (AR) or autoregressive moving average (ARMA) process, the
autocorrelation sequence does not help in order selection. Consider the AR(2) process
defined by

X(n)+15X(n—-1)+0.75X(n — 2) =e(n),

where £(1) is an V(0. 1) Gaussian white noise process. The following example:

* Simulates a realization of the AR(2) process
* Graphically explores the correlation between lagged values of the time series
+  Examines the sample autocorrelation sequence of the time series

*  Fits an AR(15) model to the time series by solving the Yule-Walker equations
(aryule)

*  Uses the reflection coefficients returned by aryule to compute the partial
autocorrelation sequence

+ Examines the partial autocorrelation sequence to select the model order

Simulate a 1000-sample time series from the AR(2) process defined by the difference
equation. Set the random number generator to the default settings for reproducible
results.

A =[1 1.5 0.75];

rng default
x = Filter(1,A,randn(1000,1));

View the frequency response of the AR(2) process.

freqz(1,A)
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The AR(2) process acts like a highpass filter in this case.

Graphically examine the correlation in x by producing scatter plots of X(n)yg, X(1) for
n=2345

x12 = x(1:end-1);
x21 = x(2:end);
subplot(2,2,1)
plot(x12,x21,"*")
xlabel ("X_1%)
ylabel ("X_2%)

x13
x31

x(1:end-2);
x(3:end);
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subplot(2,2,2)
plot(x13,x31,"*")
xlabel ("X_1%)
ylabel ("X_3")

x14 = x(1:end-3);
x41 = x(4:end);
subplot(2,2,3)
plot(x14,x41,"*")
xlabel ("X_1%)
ylabel ("X_47)

x15 = x(1:end-4);
x51 = x(5:end);
subplot(2,2,4)
plot(x15,x51,"*")
xlabel ("X_1%)
ylabel ("X_5%)



AR Order Selection with Partial Autocorrelation Sequence

In the scatter plot, you see there is a linear relationship between X(1) and X(2) ana
between <% (1} and X ["!‘]', but not between <% (1} and either X (4} or X (3},

The points in the top row scatter plots fall approximately on a line with a negative slope
in the top left panel and positive slope in the top right panel. The scatter plots in the
bottom two panels do not show any apparent linear relationship.

The negative correlation between X(1) and X(2) and the positive correlation between
X(1) and X(3) are explained by the highpass-filter behavior of the AR(2) process.

Find the sample autocorrelation sequence out to lag 50 and plot the result.

[xc,lags] = xcorr(x,50, "coeff");
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ACF

13-14

figure

stem(lags(61l:end),xc(51:end), “filled")
xlabel ("Lag™)

ylabel ("ACF")

title("Sample Autocorrelation Sequence®)

o Sample Autocorrelation Sequence
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Lag

The sample autocorrelation sequence shows a negative value at lag 1 and a positive
value at lag 2. Based on the scatter plot, this is the expected result. However, you cannot
determine from the sample autocorrelation sequence what order is appropriate for the
AR model.

Fit an AR(15) model using aryule. Return the reflection coefficients. The negative of the
reflection coefficients is the partial autocorrelation sequence.



AR Order Selection with Partial Autocorrelation Sequence

[arcoefs,E,K] = aryule(x,15);
pacf = -K;

Plot the partial autocorrelation sequence along with the large-sample 95% confidence
intervals. If the data are generated by an autoregressive process of order P, the values of

the sample partial autocorrelation sequence for lags greater than P follow a N(0,1/N)
distribution, where IV is the length of the time series.

stem(pacf, "filled™)

xlabel ("Lag™)

ylabel ("Partial Autocorrelation®)
xhim([1 151)

uconf = 1.96/sqrt(1000);

Iconf = -uconf;

hold on

plot([1 15],[1 1]"*[1conf uconf],"r")
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Partial Autocorrelation

13-16
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The only values of the partial autocorrelation sequence outside the 95% confidence
bounds occur at lags 1 and 2. This indicates that the correct model order for the AR
process is 2.

In this example, you generated the time series to simulate an AR(2) process. The partial
autocorrelation sequence only confirms that result. In practice, you have only the
observed time series without any prior information about model order. In a realistic
scenario, the partial autocorrelation is an important tool for appropriate model order
selection in stationary autoregressive time series.
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Complex Cepstrum -- Fundamental Frequency Estimation

14-2

This example shows how to estimate a speaker's fundamental frequency using the
complex cepstrum. The example also estimates the fundamental frequency using a zero-
crossing method and compares the results.

Load the speech signal. The recording is a woman saying "MATLAB". The sampling
frequency is 7418 Hz. The following code loads the speech waveform, mtlb, and the
sampling frequency, Fs, into the MATLAB® workspace.

load mtlb

Use the spectrogram to identify a voiced segment for analysis.
segmentlen = 100;

noverlap = 90;

NFFT = 128;

spectrogram(mtlb,segmentlen,noverlap,NFFT,Fs, "yaxis®)



Complex Cepstrum -- Fundamental Frequency Estimation
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Extract the segment from 0.1 to 0.25 seconds for analysis. The extracted segment
corresponds roughly to the first vowel, /ae/, in "MATLAB".

dt = 1/Fs;

10 = round(0.1/dt);

lend = round(0.25/dt);

x = mtlb(10:1end);

Obtain the complex cepstrum.

c = cceps(X);
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Plot the cepstrum for times ranging from 2 to 10 ms corresponding to a frequency range
of approximately 100 to 500 Hz. Identify the peak in the cepstrum and find the frequency
corresponding to the peak. Use the peak as the estimate of the fundamental frequency.

t = 0:dt:length(xX)*dt-dt;

plot(t(15:75).*1e3,c(15:75))
xlabel ("ms*®)

[~,1] = max(c(15:55));
fprintf("Complex cepstrum FO estimate is %3.2F Hz.\n", 1/(t(1+15)))

Complex cepstrum FO estimate is 231.81 Hz.

|
05F Ill | | | || i
TR
AF ‘ || -
|

A5 U 1

_2 1 1 1 1 1 1 1 1

1 2 3 4 5 G 7 ) 9 10

ms

14-4



Complex Cepstrum -- Fundamental Frequency Estimation

Use a zero-crossing detector on a lowpass-filtered and rectified form of the vowel to
estimate the fundamental frequency.

[b0O,a0]=butter(2,325/(Fs/2));

xin = abs(x);
xin = filter(b0,a0,xin);
Xin = xin-mean(xin);

x2 = zeros(length(xin),1);

x2(1:1length(x)-1) = xin(2:length(x));
zc=length(Find((xin>0 & x2<0) | (Xin<0 & x2>0)));
FO=0.5*Fs*zc/length(x);

fprintf("Zero-crossing FO estimate is %3.2Ff Hz.\n",F0)

Zero-crossing FO estimate is 233.27 Hz.

The estimate of the fundamental frequency obtained with the complex cepstrum is 231.81
Hz and the estimate with the zero-crossing detector is 233.27 Hz.

14-5



] 4 Transforms

Analytic Signal for Cosine

14-6

This example shows how to determine the analytic signal. The example also
demonstrates that the imaginary part of the analytic signal corresponding to a cosine is a
sine with the same frequency. If the cosine has a nonzero mean (DC shift), then the real
part of the analytic signal is the original cosine with the same mean, but the imaginary
part has zero mean.

Create a cosine with a frequency of 100 Hz. The sampling frequency is 10 kHz. Add a DC
offset of 2.5 to the cosine.

t
X

0:le-4:1;
2 _5+cos(2*pi*100*t);

Use the hilbert function to obtain the analytic signal. The real part is equal to the
original signal. The imaginary part is the Hilbert transform of the original signal. Plot
the real and imaginary parts for comparison.

= hilbert(x);

clf

plot(t,real(y))
hold on
plot(t, imag(y))
xhim([0 0.1])
grid on
text([0.015 0.015],[3-7 1.2],
{"Real Part \downarrow"'lmaglnary Part \downarrow"})



Analytic Signal for Cosine
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You see that the imaginary part is a sine with the same frequency as the cosine real part
However, the imaginary part has a mean of zero, while the real part has a mean of 2.5.

The original signal is

x(t) = 2.5 4 cos(27 10008 ).
The resulting analytic signal is

2(t) = 2.5 4 /27100,

Plot 10 periods of the complex-valued analytic signal
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prds = 1:1000;

figure
plot3(t(prds),real (y(prds)), imag(y(prds)))

xlabel ("Time")

ylabel ("Re \{z(t)\}")
zlabel (" Im \{z(t)\}")
axis square

Im {z(t}}
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Envelope Extraction Using the Analytic Signal

Envelope Extraction Using the Analytic Signal

This example shows how to extract the signal envelope using the analytic signal.

Create a double sideband amplitude-modulated signal. The carrier frequency is 1 kHz.
The modulation frequency is 50 Hz. The modulation depth is 100%. The sampling
frequency is 10 kHz.

t
X

0:1e-4:1;
[1+cos(2*pi*50*t)] -*cos(2*pi*1000*t);

plot(t,x)
xim([0 0.1])
xlabel ("Seconds™)
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0.5 ‘

=

_2 i i i i
0 001 o002 003 004 005 006 007 008 009 01
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Obtain the analytic signal. Extract the envelope, which is the magnitude (modulus) of the
analytic signal. Plot the envelope along with the original signal.

y = hilbert(x);
env = abs(y);

plot(t,x)

hold on

plot(t,[-1;1]*env, "r", "LineWidth",2)
xIim([O0 0.1])

xlabel ("Seconds*™)

2_5 T T T T T T T T T
2
1.5

.1

Hib

-1.5

-2

_2-5 i i i i i i i i
0 01 002 003 004 005 006 007 008 009 01

Seconds

The magnitude of the analytic signal captures the slowly varying features of the signal,
while the phase contains the high-frequency information.
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Analytic Signal and Hilbert Transform

Analytic Signal and Hilbert Transform

The hilbert function finds the exact analytic signal for a finite block of data. You can
also generate the analytic signal by using an FIR Hilbert transformer filter to compute
an approximation to the imaginary part.

Generate a sequence composed of three sinusoids with frequencies 203, 721, and 1001
Hz. The sequence is sampled at 10 kHz for about 1 second. Use the hi lbert function to
compute the analytic signal. Plot it between 0.01 seconds and 0.03 seconds.

fs = le4;
t = 0:1/fs:1;
X = 2.5+cos(2*pi*203*t)+sin(2*pi*721*t)+cos(2*pi*1001*t);

y = hilbert(x);

plot(t,real(y).t,imag(y))
xIim([0.01 0.03])

legend("real”,"imaginary®)
title(C"hilbert Function®)
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Compute Welch estimates of the power spectral densities of the original sequence and the
analytic signal. Divide the sequences into Hamming windowed nonoverlapping sections
of length 256. Verify that the analytic signal has no power at negative frequencies.

pwelch([x;y]-",256,0,[1,fs, “centered™)
legend("Original ™, "hilbert™)
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Analytic Signal and Hilbert Transform
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Use the designfi It function to design a 60th-order Hilbert transformer FIR filter.
Specify a transition width of 400 Hz. Visualize the frequency response of the filter. Filter
the sinusoidal sequence to approximate the imaginary part of the analytic signal.

fo = 60;

d = designfilt("hilbertfir®, “FilterOrder”,fo,
"TransitionWidth®,400, "SampleRate” ,fs);

freqz(d,1024,fs)

hb = Ffilter(d,x);
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Magnitude Response (dB) and Phase Response
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The group delay of the filter, grd, is equal to one-half the filter order. Compensate for
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this delay. Remove the first grd samples of the imaginary part and the last grd samples
of the real part and the time vector. Plot the result between 0.01 seconds and 0.03

seconds.
grd = fo/2;
y2 x(1:end-grd) + 1lj*hb(grd+l:end);

t2 = t(l:end-grd);
plot(t2,real (y2),t2,imag(y2))
x1im([0.01 0.03])
legend("real ", "imaginary”)
title(C°FIR Filter™)
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Analytic Signal and Hilbert Transform

FIR Filter
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Estimate the PSD of the approximate analytic signal and compare it to the hilbert
result.

pwelch([y;[y2 zeros(l,grd)]]-".,256,0,[],fs, "centered”)
legend("hilbert”,"FIR Filter™)
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Hilbert Transform and Instantaneous Frequency

Hilbert Transform and Instantaneous Frequency

The Hilbert transform estimates the instantaneous frequency of a signal for
monocomponent signals only. A monocomponent signal is described in the time-frequency
plane by a single "ridge." The set of monocomponent signals includes single sinusoids, but
also includes signals like chirps.

Generate a chirp sampled at 1 kHz for two seconds. Specify the chirp so its frequency is
initially 100 Hz and increases to 200 Hz after one second.

Fs = 1000;
t = 0:1/Fs:2-1/Fs;
y = chirp(t,100,1,200);

Estimate the spectrum of the chirp using the short-time Fourier transform implemented
in the spectrogram function. Divide the signal into sections of length 100, windowed
with a Hamming window. Specify 80 samples of overlap between adjoining sections and

evaluate the spectrum at [100/2 + 1] = 51 frequencies.
spectrogram(y,100,80,100,Fs, "yaxis™)

view(-27,62)
shading interp
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The signal is well described by a single peak frequency at each point in time.

Compute the analytic signal and differentiate its phase to measure the instantaneous
frequency. The scaled derivative yields a meaningful estimate.

z = hilbert(y);
instfreq = Fs/2*pi)*diff(unwrap(angle(z)));

plot(t(2:end), instfreq)

xlabel ("Time")

ylabel ("Hz")

grid on

title(" Instantaneous Frequency™)
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Hilbert Transform and Instantaneous Frequency

Instantaneous Frequency
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Repeat the procedure, this time for a signal that is not monocomponent.
Generate a sum of two sinusoids of frequencies 60 Hz and 90 Hz, sampled at 1023

Hz for two seconds. Compute and plot the spectrogram. Use Hamming-windowed
sections that have lengths of 200 and sample overlaps of 180. Evaluate the spectrum at

|256/2 + 1] 129 frequencies.

Fs = 1023;

t = 0:1/Fs:2;

X = sin(2*pi*60*t)+sin(2*pi*90*t);

spectrogram(x,200,180,256,Fs, "yaxis")
ax = gca;
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ax.YTick = [60 90];
shading interp
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Each time point shows the presence of the two components.

Compute the analytic signal and differentiate its phase. Zoom in to the region enclosing
the frequencies of the sinusoids.

z = hilbert(x);

instfreq = Fs/@*pi)*diff(unwrap(angle(z)));
plot(t(2:end), instfreq)

ylim([60 90])
xlabel ("Time")
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ylabel ("Hz")
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The analytic signal predicts an instantaneous frequency that is the average of the
sinusoid frequencies.
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Single-Sideband Amplitude Modulation

14-22

This example shows how to use the Hilbert transform to carry out single-sideband (SSB)
amplitude modulation (AM) of a signal. Single-sideband AM signals have less bandwidth
than normal AM signals.

Generate 512 samples of a simulated broadband signal using the sinc function. Specify

a bandwidth of /4 rad/sample.

N = 512;
n = 0:N-1;
bw = 1/4;

x = sinc((n-N/2)*bw) ;

Add white Gaussian noise such that the signal-to-noise ratio is 20 dB. Reset the random
number generator for reproducible results. Use the periodogram function to estimate
the power spectral density (PSD) of the signal.

rng default
SNR = 20;
noise = randn(size(x))*std(x)/db2mag(SNR);

X = X + noise;

periodogram(x)



Single-Sideband Amplitude Modulation

Fowerffrequency (dB/rad/sample)
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Amplitude modulate the signal using a cosine of carrier frequency “'c = ™ /2 . Multiply

by V2 50 that the power of the modulated signal equals the power of the original signal.

Estimate the PSD.
wc = pi/2;
x1 = x.*cos(wc*n)*sqrt(2);

periodogram(x1)
legend("Modulated™)
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SSB amplitude modulation reduces the bandwidth of the signal by half. To carry out
SSB amplitude modulation, you must first compute the Hilbert transform of the signal.
Then, amplitude modulate the signal using a sine with the same carrier frequency, ', as
before, and add it to the previous signal.
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Single-Sideband Amplitude Modulation
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Design a Hilbert transformer using the designfi It function. Specify a filter order of 64
and a transition width of 0.1. Filter the signal.

Hhilbert = designfilt("hilbertfir®, "FilterOrder”,64, ...
"TransitionWidth",0.1);

xh = Filter(Hhilbert,x);

Use the grpdelay function to determine the delay, gd, introduced by the filter.
Compensate for the delay by discarding the first gd points of the filtered signal and
padding with zeros at the end. Amplitude modulate the result and add it to the original.
Compare the PSDs.

gd = mean(grpdelay(Hhilbert));
xh = xh(gd+1l:end);
eh = zeros(size(X));

eh(1:length(xh)) = xh;

x2 = eh.*sin(wc*n)*sqrt(2);
y = X1+x2;
periodogram([x1;y]1")

legend("Modulated®, "SSB*)
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Downconvert the signal and estimate the PSD.
ym = y.*cos(wc*n)*sqrt(2);

periodogram(ym)
legend("Downconverted™)
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Lowpass filter the modulated signal to recover the original. Specify a 64th-order FIR

lowpass filter with a cutoff frequency of T2 Compensate for the delay introduced by the
filter.

d = designfilt("lowpassfir”®, "FilterOrder-,64,
"CutoffFrequency”,0.5);
dem = filter(d,ym);

gd = mean(grpdelay(d));
dem = dem(gd+1l:end);

dm = zeros(size(X));
dm(1:length(dem)) = dem;
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Estimate the PSD of the filtered signal and compare it to that of the original.

periodogram([x;dm]")
legend("Original”, "Recovered™)
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Use the snr function to compare the signal-to-noise ratios of the two signals. Plot the two
signals in the time domain.

snrOrig = snr(x,noise)
snrRecv = snr(dm,noise)

plot(n, [x;dm]*")
legend("Original®, "Recovered”)
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15 Signal Generation

Display Time-Domain Data in Signal Browser

In this section...

“Import and Display Signals” on page 15-3
“Configure the Signal Browser Properties” on page 15-6

“Modify the Signal Browser Display” on page 15-9

“Inspect Your Data (Scaling the Axes and Zooming)” on page 15-10

This example shows how to use and configure the SPTool Signal Browser to display time-
domain signals. First, open SPTool by typing

sptool
at the MATLAB command line. SPTool opens.

u 5PTool: startup.spt E@
File Edit Window | Help | u
Signals Filters Spectra

- . g - -
chirp [vector] PZlp [imported] chirpse [auto]
train [wector] FIRbp [de=ign] trainze [auto]
[ View | View | View |
[ Hew ] [ Create ]
( Edit | Update |
l Apply J
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Display Time-Domain Data in Signal Browser

Import and Display Signals
Displaying Multiple Signals

You can display multiple signals in the Signal Browser by selecting more than one entry
in the SPTool Signals list. In the Signals list, first select mtlb [vector]. Next, press
the Ctrl key, and select chirp [vector]. Finally, click the View button. The Signal
Browser opens, displaying both signals.

Any signals that you select in SPTool are now visible in the Signal Browser. You can also
select multiple entries using the Shift key. In the SPTool Signals list, first select mtlb
[vector]. Next, press the Shift key, and select train [vector]. The Signal Browser
automatically updates to display all three signals, as shown in the following figure.

n Signal Browser EI@

File Tools View Help El

8 Q< d |0 HEEEE $PE)| S

Amnplitude

Time (secs)
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15-4

Importing New Signals

Using SPTool, you can import signals from variables in the MATLAB workspace. First,
create a 3-second signal, sampled at 10 kHz, that is the sum of two sine waves. At the
MATLAB command line, enter the following commands:

Fs = 1le4;
t 0:1/Fs:3;
S sum(sin(2*pi*[350;440]*t));

To import the signal from these variables, in the SPTool menu, select File > Import.
Alternatively, you can press the Ctrl+I keyboard shortcut. The Import to SPTool dialog
box opens.

Import te SPTeol EI =] @
Source Workspace Contents — r Import As: Signal -
® From Workspace
From Disk s Data

t

Sampling Freguency
1

— Name

0K Cancel Help sig1

From the Workspace Contents list, select s. Click the right arrow (| —= [) button to
the left of the Data box. Next, from the Workspace Contents list, select Fs. Click the
right arrow (| —= ) button to the left of the Sampling Frequency box. You can assign

the signal a name in the Name box, but since you will rename the signal later in this
example, leave it as sigl for now.

Click OK. The SPTool Signals list now contains a signal named sigl [vector].
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Selecting a Signal and Playing Audio

In the SPTool Signals list, select sigl [vector], and click the View button. The
Signal Browser reappears in front. To play audio for the signal, click the Play selected
signal ( 'iilﬂ) button. Signal Browser sends the audio signal to the speaker. For more
information, see sound in the MATLAB documentation.

If you have multiple signals selected in SPTool, you can use the Trace Selection
panel to choose which signal to make active. In the SPTool Signals list, press the Ctrl
key, and select mtlb [vector]. The Signal Browser now displays two signals. In the
Signal Browser menu, select Tools > Measurements > Trace Selection. The Trace
Selection panel appears as shown in the following figure.

* ¥ Trace Selection

MNoisy Sine Wave

Moisy Sine YWave

Fitered Moisy Sine Wave

In the Trace Selection panel drop-down list, select sigl. Then, click the Play selected

signal ( 'iilﬂ) button. Signal Browser sends the audio signal to the speaker.

Note: To hear audio when you click the Play selected signal ( "iilﬂ) button, your computer

sound card must be able to support the sample rate of the signal. In this example, the
sample rate of the signal, sigl [vector], is 10 kHz. If your sound card supports this
or a greater sample rate, such as 44.1 kHz, then you can hear the audio on your speaker.
For more information, see sound in the MATLAB documentation.

Change Signal Names from the Legend

When multiple signals are displayed, Signal Browser shows a legend by default. To turn

off the legend, click the Show all legends (IE ) button. Click the button again to turn the

legend back on. You can modify the names of the signal directly in the legend. To do so,
when the legend is visible, click and drag it to any location on the display.

You can change the name of any signal directly within the legend. In the legend, double-
click the signal name sigl. A cursor appears, indicating that you can now change this
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name. Highlight the text, and type Dial Tone. The legend now shows Dial Tone as
the name of that signal. In the SPTool Signals list, the last item is now also named Dial
Tone.

Configure the Signal Browser Properties

First, configure the appearance of the Signal Browser window. In the SPTool Signals
list, first select mtlb [vector]. Next, press the Shift key, and select train
[vector]. The Signal Browser automatically updates to display all three signals.

Multiple Displays

You can display multiple signals on different displays in the Signal Browser window. In
the SPTool Signals list, first ensure all three signals are selected. In the Signal Browser

toolbar, click the Layout () button. Select row 3, column 1, as shown in the following

figure.

||
||

| Cancel

After you make this selection, the Signal Browser is separated into three displays.
Configure Appearance

In the Signal Browser menu, select View > Properties. The Visuals:Time Domain
Options dialog box opens, as shown in the following figure.
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4\ Visuals - Time Domain Properties: Signal Browser | 2 |

Main Display

Time units: [Metric (based on Time Span) T]

Time-axis labels: [AII

7)

Show time-axis label

Maximize axes: [Auto

7)

0K ] [ Cancel Apply

In the Visuals:Time Domain Options dialog box, click the Main tab. Choose the
appropriate parameter settings for the Main tab, as shown in the following table.

Parameter

Setting

Time units

Metric (based on Time Span)

Show time-axis labels

Bottom Displays Only

Maximize axes

On

When you change the Maximize axes parameter to On, the axes are expanded to fill the
entire display. To conserve space, titles and axis labels are not shown in each display.

Click Apply.

Set Display Properties

In the Visuals:Time Domain Options dialog box, click the Display tab. You can change
the value of the Select display parameter to make different settings for each display.
Set the parameters to the values shown in the following table.
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Parameter Display 1 Setting Display 2 Setting Display 3 Setting
Select display 1 2 3

Title mtlb chirp train
Show legend Selected Selected Selected
Show grid Selected Selected Selected
Plot signal(s) as Cleared Cleared Cleared
magnitude and

phase

Minimum Y-limit [-2.5 -1 -1.5
Maximum Y-limit |2.5 1 1.5

Y-axis label Amplitude Amplitude Amplitude

Click OK to save your changes and close the Visuals:Time Domain Options dialog box.
The Signal Browser appears as shown in the following figure.
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Modify the Signal Browser Display
Use the Style dialog box to modify the appearance of the axes and the lines for each of

the selected signals in SPTool. In the Signal Browser menu, select View > Style. The
Style dialog box opens, as shown in the following figure.

uSignaI Browser - Style E' (=] @
Figure color: | & - Plot type: |Line -

Select display: |

Axes colors: M \i_vj

Properties for line: | mtlb il
[¥] Visible
Line: « | 05 A i'
Marker: none - |

I Ok ‘ I Cancel ‘ I Apply ‘

Modify Axes Colors and Line Properties

You can change the value of the Select display parameter to make different settings for
each display. Set the parameters to the values shown in the following table.

Parameter Display 1 Setting Display 2 Setting Display 3 Setting
Select display 1 2 3

Axes background |Black Black Black

color

Ticks, labels, and |White White White

grid colors
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Parameter

Display 1 Setting

Display 2 Setting

Display 3 Setting

Line color

Yellow

Cyan

Magenta

These settings enable the Signal Browser to display line colors in the same manner as
the Simulink Scope block. Click OK to save your changes and close the Style dialog box.

The Signal Browser now appears as shown in the following figure.

Show and Hide Toolbar

To hide the toolbar, from the Signal Browser menu, select View > Toolbar. Doing so
removes the toolbar from the Signal Browser window and also removes the check mark
beside the Toolbar option in the View menu. You can choose to show the toolbar again

at any time by selecting View > Toolbar.

Inspect Your Data (Scaling the Axes and Zooming)

So far, you have manually set the y-axis limits. Use one of the following options to let
Signal Browser scale the axes:

*  From the Signal Browser menu, select Tools > Scale Axes Limits.
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*  From the Signal Browser toolbar, click the Scale Axes Limits (|::|) button.

+  With the Signal Browser as your active window, press Ctrl + A.

Use the Zoom Tools

The zoom tools allow you to zoom in simultaneously in the directions of both the x- and y-
axes , or in either direction individually. For example, to zoom in on the signal between 0
and 0.5 seconds, you can use the Zoom X option.

* To activate the Zoom X tool, select Tools > Zoom X, or press the corresponding
toolbar button (*3*). The Signal Browser indicates that the Zoom X tool is active by
indenting the toolbar button and placing a check mark next to the Tools > Zoom X
menu option.

* Next, zoom in on the region between 0 and 0.5 seconds. In the Signal Browser
window, click on the 0-second mark and drag to the 0.5-second mark. All three
displays reflect this new x-axis setting, as shown in the following figure.

*  To zoom out of the Signal Browser window, right-click inside the window, and select
Zoom Out. Alternatively, you can return to the original view of your signal by right-
clicking inside the Signal Browser window and selecting Reset to Original View.
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RMS Value of Periodic Waveforms

16-2

This example shows how to find the root mean square (RMS) value of a sine wave, a
square wave, and a rectangular pulse train using rms. The waveforms in this example
are discrete-time versions of their continuous-time counterparts.

Create a sine wave with a frequency of 7/ rad/sample. The length of the signal is 16
samples, which equals two periods of the sine wave.

n
X

0:15;
cos(pi/Z4*n);

Compute the RMS value of the sine wave.

rmsval = rms(x)

rmsval =

0.7071

The RMS value is equal to 1/ V’:B, as expected.

Create a periodic square wave with a period of 0.1 seconds. The square wave values
oscillate between —2 and 2.

t
X

0:0.01:1;
2*square(2*pi*10*t);

stem(t,x, "fFilled®)
axis([0 1 -2.5 2.5])



RMS Value of Periodic Waveforms

25 1 1 1 1 1 1 T T T

0.5 f 7

0 01 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1

Find the RMS value.

rmsval = rms(x)

rmsval =

2
The RMS value agrees with the theoretical value of 2.

Create a rectangular pulse train sampled at 1 kHz with the following parameters: the
pulse is on, or equal to 1, for 0.025 seconds, and off, or equal to 0, for 0.075 seconds in
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each 0.1 second interval. This means the pulse period is 0.1 seconds and the pulse is on
for 1/4 of that interval. This is referred to as the duty cycle. Use pulstran to create the
rectangular pulse train.

t = 0:0.001:(10*%0.1);

pulsewidth = 0.025;

pulseperiods = [0:10]*0.1;

x = pulstran(t,pulseperiods,@rectpuls,pulsewidth);

plot(t,x)
axis([0O 1 -0.5 1.5])

15 T T T T T T T T T

Find the RMS value and compare it to the RMS of a continuous-time rectangular pulse
waveform with duty cycle 1/4 and peak amplitude 1.
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rmsval = rms(x)
thrms = sqrt(1/4)

rmsval =

0.5007

thrms =

0.5000

The observed RMS value and the RMS value for a continuous-time rectangular pulse

waveform are in good agreement.
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Slew Rate of Triangular Waveform

This example shows how to use the slew rate as an estimate of the rising and falling
slopes of a triangular waveform. Create three triangular waveforms. One waveform

has rising-falling slopes of 42, one waveform has rising-falling slopes of - 2, and one

1
waveform has a rising slope of +2 and a falling slope of ~ 2. Use slewrate to find the
slopes of the waveforms.

Use tripuls to create a triangular waveform with rising-falling slopes of 2. Set the
sampling interval to 0.01 seconds, which corresponds to a sample rate of 100 hertz.

dt = 0.01;
t = -2:dt:2;

X = tripuls(t);

Compute and plot the slew rate for the triangular waveform. Input the sample rate (100
Hz) to obtain the correct positive and negative slope values.

slewrate(x,1/dt)

ans =

2.0000 -2.0000
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1r
||I|| slew rate
I||||I signal
{y |I # upper cross
0.8 \ # lower cross
|" || upper boundary
I,I I|I ---------- upper state
nEt f \ lower boundary
—_ ' \ — — —upper reference
Ln :::::::::::::::::::::::::::::::::J’:::::::::I'::::::::::::::::::::::::::::::::: —
% .......................................... S L R L e e R E R LR R R lower reference
E' 0.4 _ _______ * - —:Jllé ________ upper boundary
T |" R It lower state
= III \ lower boundary
- {, \
|
0.2r \
|' .
f \
oo
0
02 : : : ;
0 1 2

e}

Time (seconds)

1
Change the width of the triangular waveform so it has slopes of T3, Compute and plot
the slew rate.

x = tripuls(t,4);
slewrate(x,1/dt)

ans

0.5000 -0.5000
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slew rate
signal
. upper cross
# lower cross
upper boundary
---------- upper state
lower boundary
— — —upper reference
— — — lower reference
upper boundary
""""" lower state
lower boundary

0 . .
2 3 4

Time (seconds)

[
-

Create a triangular waveform with a rising slope of +2 and a falling slope of
Compute the slew rate.

x = tripuls(t,5/2,-3/5);
s = slewrate(x,1/dt)
S =

2.0000 -0.5000

The first element of s is the rising slope and the second element is the falling slope. Plot
the result.

16-8



Slew Rate of Triangular Waveform

Level (Volts)

slewrate(x,1/dt);

slew rate

signal

. Upper cross

# |lower cross
upper boundary

---------- upper slate
lower boundary
— — —upper reference
— — — lower reference
upper boundary
""""" lower state
lower boundary

Time (seconds)
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Duty Cycle of Rectangular Pulse Waveform

16-10

This example shows how to create a rectangular pulse waveform and measure its duty
cycle. You can think of a rectangular pulse waveform as a sequence of on and off states.
One pulse period is the total duration of an on and off state. The pulse width is the
duration of the on state. The duty cycle is the ratio of the pulse width to the pulse period.
The duty cycle for a rectangular pulse describes the fraction of time that the pulse is on
in one pulse period.

Create a rectangular pulse sampled at 1 gigahertz. The pulse is on, or equal to 1, for a
duration of 1 microsecond. The pulse if off, or equal to 0, for a duration of 3 microseconds.
The pulse period is 4 microseconds. Plot the waveform.

Fs = 1e9;
t = 0:1/Fs:(10*4e-6);

pulsewidth = le-6;
pulseperiods = [0:10]*4e-6;

x = pulstran(t,pulseperiods,@rectpuls,pulsewidth);

plot(t,x)
axis([0 4e-5 -0.5 1.5])



Duty Cycle of Rectangular Pulse Waveform

15 T T T T T T T

0.5 I

0 0.5 1 15 2 25 3 3.5 4
%107
Determine the duty cycle of the waveform using dutycycle. Input both the pulse

waveform and the sample rate to output the duty cycle. dutycycle outputs a duty cycle
value for each detected pulse.

D

dutycycle(x,Fs)

D =
Columns 1 through 7
0.2500 0.2500 0.2500 0.2500 0.2500 0.2500 0.2500

Columns 8 through 9
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0.2500 0.2500

In this example, the duty cycle for each of the detected pulses is identical and equal to
0.25. This is the expected duty cycle because the pulse is on for 1 microsecond and off for
3 microseconds in each 4 microsecond period. Therefore, the pulse is on for 1/4 of each
period. Expressed as a percentage, this is equal to a duty cycle of 25%.

Calling dutycycle with no output arguments produces a plot with all the detected pulse
widths marked.

dutycycle(x,Fs);
1.2 - ' T .
signal
# mid cross
4 R e e e e upper boundary
......................................................................... apper siate
lower boundary
0.8 h 1 — — — mid reference
upper boundary
I I I I | I I e 1 O O lower state
= 06| | lower boundary
=
= sl ol ol * ol * ol % Sl ol Sl Sl
[ub]
o 0.4 |
|
0.2 ] 1
D [ SPIFEFIFEF ) PP PR M DI FEEPEFIPE [P IFEFIPEPIPY ) TPEFIPIIN i FEFEPII I PP ) PP ) S
02 ' : :
0 1 2 3 4

16-12



Duty Cycle of Rectangular Pulse Waveform

Using the same sample rate and pulse period, vary the pulse on time (pulse width) from
1 to 3 microseconds in a loop and calculate the duty cycle. Plot the pulse waveforms and
display the duty cycle value in the plot title for each step through the loop. The duty cycle
increases from 0.25 (1/4) to 0.75 (3/4) as the pulse width increases.

nwid = 3;

for nn = 1:nwid
x = pulstran(t,pulseperiods,@rectpuls,nn*pulsewidth);

subplot(nwid,1,nn)
plot(t,x)
axis([0 4e-5 -0.5 1.5])

D = dutycycle(x,Fs);

title(["Duty cycle is " num2str(mean(D)) 1):;
end
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Duty ::y::le is 0. 25
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Estimate State for Digital Clock

This example shows how to estimate the high and low state levels for digital clock data.
In contrast to analog voltage signals, signals in digital circuits have only two states:
HIGH and LOW. Information is conveyed by the pattern of high and low state levels.

Load clockex.mat into the MATLAB® workspace. clockex.mat contains a 2.3 volt
digital clock waveform sampled at 4 megahertz. Load the clock data into the variable x
and the vector of sampling times in the variable t. Plot the data.

load("clockex.mat®,"x","t")
stem(t,x, "filled")

2.5 T T T T

151 i

0 05 1 15 2 25
%1072
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Determine the high and low state levels for the clock data using statelevels.

levels = statelevels(x)

levels

0.0027 2.3068

This is the expected result for the 2.3 volt clock data, where the noise-free low-state level
is 0 volts and the noise-free high-state level is 2.3 volts.

Use the estimated state levels to convert the voltages into a sequence of zeros and ones.
The sequence of zeros and ones is a binary waveform representation of the two states. To
make the assignment, use the following decision rule:

+ Assign any voltage within a 3%-tolerance region of the low-state level the value 0.

+ Assign any voltage within a 3%-tolerance region of the high-state level the value 1.

Determine the widths of the 3%-tolerance regions around the low- and high-state levels.

tolwd = 3/7100*diff(levels);

Use logical indexing to determine the voltages within a 3%-tolerance region of the low-
state level and the voltages within a 3%-tolerance region of the high-state level. Assign
the value 0 to the voltages within the tolerance region of the low-state level and 1 to the
voltages within the tolerance region of the high-state level. Plot the result.

y = zeros(size(X)):
y(@bs(x-min(levels))<=tolwd)
y(abs(x-max(levels))<=tolwd)

subplot(2,1,1)
stem(t,x, "filled")
ylabel ("Volts*®)
subplot(2,1,2)
stem(t,y, " filled®)
ylabel ("\{0,1\}")
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The decision rule has assigned all the voltages to the correct state.
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Calculate Settling Time with Signal Browser

This example shows how to use the Bilevel Measurements panel in the SPTool Signal
Browser to find the settling time of a clock signal.

First, open SPTool by typing the following at the MATLAB command line.

sptool
SPTool opens.

B SPTool: startup.spt E=H =R
File Edit Window | Help | »
Signals Filters Spectra

chirp [vector] PZlp [imported] chirpse [auto]

train [wector] FIRbp [de=ign] trainze [auto]

[ View | View | View |
[ New ] [ Create ]
[ Edit | Update |
[ Apply ]

In this example, you import a clock signal from the MAT-file named clockex.mat. In
the SPTool menu, select File > Import. Alternatively, you can press the Ctrl+I keyboard
shortcut. The Import to SPTool dialog box opens.

1 Under Source, click From Disk.

2 In the MAT-file box, type clockex, and press Enter. The variables x and t appear
under File Contents.
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3 Under File Contents, click x. Click the right arrow (E) button to the left of the
Data box.

In the Sampling Frequency box, type 4000000.

In the Name box, type Clock.

Click OK. The SPTool Signals list now contains a signal named Clock [vector].

In SPTool, in the Signals list, select Clock [vector], and click the View button.
The Signal Browser appears and displays the clock signal.

N O 00

Because you selected only one signal, the legend is not needed. Turn off the legend by

clicking the Show All Legends (E ) button. Then, use the Style dialog box to modify the

appearance of the axes and the lines for the signal. In the Signal Browser menu, select
View > Style.

Parameter Display 1 Setting
Axes background color Black

Ticks, labels, and grid colors Dark Gray
Line color Yellow

To show the Bilevel Measurements panel, in the Signal Browser menu, select Tools
> Measurements > Bilevel Measurements. To collapse the Transitions pane, click
the pane collapse button ( ¥ ) next to that label. To expand the Settings pane and the
Overshoots / Undershoots pane, click the pane expand button ( » ) next to each label.
The Signal Browser appears as shown in the following figure.
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16-20

B Time Scope =R B =
File Tools View Playback Help E

Qu i@ HEIE £ | &I E

- Settling Time

> Cycles

Processing Offset=0 |T=0

The value for the rising edge Settling Time parameter does not appear in the
Overshoots / Undershoots pane because the Settle Seek parameter is too large. The
Settle Seek value is longer than the entire simulation duration. Enter a value for settle
seek of 2e-6, and press Enter. Signal Browser now displays a rising edge settling time
value of 118.392 ns.

This settling time value displayed is actually the statistical average of the settling times
for all five rising edges. To display the settling time for only one rising edge, you can

zoom in on that transition. In the Signal Browser toolbar, click the Zoom X button ("*<").
Click the display near a value of 2 microseconds on the time-axis. Drag to the right,

and release near a value of 4 microseconds on the time-axis. Signal Browser updates
the rising edge Settling Time value to reflect the new time window, as shown in the
following figure.



Calculate Settling Time with Signal Browser

TimESccpE o= || B ER
File Tools View Playback Help E

QR e @ HEE| Ff | & EEX | E

T ¥ Bilevel Measurements
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Find Peak Amplitudes in Signal Browser

This example shows how to use the Peak Finder panel in the SPTool Signal Browser to
find heart rate, given an electrocardiogram (ECG) signal.

First, open SPTool by typing the following at the MATLAB command line.

sptool
SPTool opens.

B sPToo: startup.spt [E=8(EcR (=<
File Edit Window | Help | |
Signals Filters Spectra

chirp [vector] PZlp [imported] chirpse [auto]

train [vector] FIRbp [design] trainse [auto]

[ View | View | View |
[ New ] [ Create ]
( Edit | Update |
[ Apply ]

Using SPTool, you can import signals from variables in the MATLAB workspace. First,
create an electrocardiogram (ECG) signal, sampled at 4 kHz, and apply the Savitzky-
Golay filter. At the MATLAB command line, enter the following commands:

x1 = 3.5*%ecg(2700).";
yl = sgolayfilt(kron(ones(1,13),x1),0,21);
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n = (1:30000)";

del = round(2700*rand(1));
mhb = yi1(n + del);

ts = 0.00025;

Fs = 1/ts;

To import the signal from these variables, in the SPTool menu, select File > Import.
Alternatively, you can press the Ctrl+I keyboard shortcut. The Import to SPTool dialog
box appears.

1 Under Workspace Contents, click mhb. Click the right arrow ([ —= |) button to the
left of the Data box.

2 Under Workspace Contents, click Fs. Click the right arrow (El) button to the
left of the Sampling Frequency box.

3 Inthe Name box, type ECG.

4 Click OK. The SPTool Signals list now contains a signal named ECG [vector].

5 In SPTool, in the Signals list, select ECG [vector], and click the View button. The
Signal Browser opens and displays the ECG signal.

Because you only selected one signal, the legend is not needed. Turn off the legend by
clicking the Show All Legends (E ) button. Then, use the Style dialog box to modify the

appearance of the axes and the lines for the signal. In the Signal Browser menu, select
View > Style.

Parameter Display 1 Setting
Axes background color Black

Ticks, labels, and grid colors Dark Gray
Line color Yellow

To show the Peak Finder panel, in the Signal Browser menu, select Tools >
Measurements > Peak Finder. To expand the Settings pane, click the pane expand
button () next to that label. In the Max Num of Peaks box, type 10 and press the
Enter key. Signal Browser now displays in the Peaks pane a list of 10 peak amplitude
values, and the times at which they occur, as shown in the following figure.
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T ¥ Peak Finder

¥ Settings
Peak Threshold: gl
n‘|f | | !‘| .
l'|”|'||l

As you can see from the list of peak values, there is a constant time difference of 0.675
seconds between each heartbeat. Therefore, the heart rate detected by the ECG signal is
given by the following equation.

sec
__min __ggggheats
0.675 > min

beat
See Also

sgolay | sgolayfilt
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Analyzing Harmonic Distortion

This example shows how to analyze the harmonic distortion of a weakly non-linear
system in the presence of noise.

Introduction

In this example we will explore the output of a simplified model of an amplifier that

has noise coupled to the input signal and exhibits non-linearity. We will explore how
attenuation at the input can reduce harmonic distortion. We will also give an example of
how to mathematically correct for the distortion at the output of the amplifier.

Viewing the Effects of Non-Linearity
A convenient way to view the effect of the non-linearity of the amplifier is to view
the periodogram of its output when stimulated with a sinusoid. The amplitude of the

sinusoid is set to the maximum allowable voltage of the amplifier. (2 Vpk)

In this example we will source a 2 kHz sinusoid for a duration of 50ms.

VmaxPk = 2; % Maximum operating voltage

Fi = 2000; % Sinusoidal frequency of 2 kHz
Fs = 44_.1e3; % Sample rate of 44._.1kHz

Tstop = 50e-3; % Duration of sinusoid

t = 0:1/Fs:Tstop; % Input time vector

% Use the maximum allowable voltage of the amplifier
inputVmax = VmaxPk*sin(2*pi*Fi*t);
outputVmax = helperHarmonicDistortionAmplifier(inputVmax);

View a zoomed-in region of the output sinusoid. Note that the imperfections of our
amplifier are difficult to see visually when plotted with respect to time.

plot(t, outputVmax);
xlabel ("Time")

ylabel ("Output Voltage®);
axis([0 5e-3 -2.5 2.5]);
title(C"Amplifier output™);
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Output Voltage

16-26
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Now let's view the periodogram of our amplifier output.

helperPlotPeriodogram(outputVmax, Fs, “power®,"annotate”);
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Fower (dB)
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Note that instead of seeing just the 2 kHz sinusoid that we placed at the input, we see
other sinusoids at 4 kHz, 6 kHz, 8 kHz, and 10 kHz. These sinusoids are multiples of the
fundamental 2 kHz frequency and are due to the non-linearity of the amplifier.

We also see a relatively flat band of noise power.

Quantifying Non-Linear Distortion

Let's examine some common distortion metrics for comparison purposes

Our periodogram shows some very well defined harmonics of the fundamental signal.

This suggests we measure the total harmonic distortion of the input signal which returns
the ratio of power of all harmonic content to the fundamental signal.
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thd(outputVmax, Fs)

ans =
-60.3888
THD: -60.39 dB
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Notice that the third and largest harmonic is about 60 dB down from the fundamental.
This is where most of the distortion is occurring.

We can also obtain an estimate of the total noise present in our input. To do this, we call
SNR which returns the ratio of the power of the fundamental to the power of all non-
harmonic content.
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Fower (dB)

snr(outputVmax, Fs)

ans =
130.9300
SNR:130.93dB
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Another useful metric to compute 1s SINAD. This computes the ratio of the power to all
other harmonic and noise content in the signal.

sinad(outputVmax, Fs)
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ans =

60.3888

SINAD: 60.39 dB
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The THD, SNR, and SINAD were -60 dB, 131 dB and 60 dB, respectively. Since the
magnitude of THD is roughly equal to SINAD, we can attribute that most of the
distortion is due to harmonic distortion.

If we inspect the periodogram, we can notice that the third harmonic dominates the
distortion of the output.
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Fower (dB)

Input Attenuation to Reduce Harmonic Distortion

Most analog circuitry performing amplification has an inherent trade-off between
harmonic distortion and noise power. In our example, our amplifier has relatively low
noise power compared to the harmonic distortion. This makes it suitable for detecting
low power signals. If our input can be attenuated to enter this low-power region, we can
recover some of the harmonic distortion.

Let's repeat the measurements by lowering the input voltage by a factor of two.
inputVhalf = (VmaxPk/2) * sin(2*pi*Fi*t);

outputVhalf = helperHarmonicDistortionAmplifier(inputVhalf);
helperPlotPeriodogram(outputVhalf, Fs, “power”,"annotate®);
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Let's redo our metrics again, this time measuring the effect of lowering the input voltage.

thdvhalf = thd(outputVhalf, Fs)
snrVhalf = snr(outputVhalf, Fs)
sinadVhalf = sinad(outputVhalf, Fs)

thdvhalf =

-72.0676

snrVhalf =

124 .8767

sinadVhalf =

72.0676

Notice that simply attenuating the input power level by 6 dB reduces the harmonic
content. The SINAD and THD improved from ~60 dB to ~72 dB. This came at the
expense of lowering the SNR from 131 dB to 125 dB.

SNR THD and SINAD as a Function of Input Attenuation

Can further attenuation improve our overall distortion performance? Let's plot THD,
SNR and SINAD as a function of input attenuation, sweeping the input attenuator from
1 to 30 dB.

% Allocate a table with 30 entries
nReadings = 30;
distortionTable = zeros(nReadings, 3);

% Compute the THD, SNR and SINAD for each of the attenuation settings
for 1 = 1:nReadings
inputVbestAtten = db2mag(-i) * VmaxPk * sin(2*pi*Fi*t);
outputVbestAtten = helperHarmonicDistortionAmplifier(inputVbestAtten);
distortionTable(i,:) = [abs(thd(outputVbestAtten, Fs))
snr(outputVbestAtten, Fs)
sinad(outputVbestAtten, Fs)];
end



Analyzing Harmonic Distortion

% Plot results
plot(distortionTable);

xlabel (" Input attenuation (dB)"), ylabel("Dynamic Range (dB)");

legend(" | THD| ", "SNR", "SINAD", "Location”, "Best");
title("Distortion Metrics vs. Input Attenuation®);

Distortion Metrics vs. Input Attenuation
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The graph shows the usable dynamic range corresponding to each metric. The magnitude
of THD corresponds to the range that is free of harmonics. Similarly, SNR corresponds
to the dynamic range of that is unaffected by noise; SINAD corresponds to the total

dynamic range that is free of distortion.

As can be seen from the graph, SNR degrades as input power attenuation increases. This
is because when you attenuate the signal, only the signal is attenuated, but the noise

floor of the amplifier stays the same.
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Also note that the magnitude of the total harmonic distortion improves steadily until it
intersects the SNR curve, after which the measurement becomes unstable. This happens
when the harmonics have "disappeared" beneath the noise of the amplifier.

A practical choice of amplifier attenuation for the amplifier would be 26 dB (yielding
a SINAD of 103 dB). This would be a reasonable tradeoff between harmonic and noise
distortion.

% Search the table for the largest SINAD reading

[maxSINAD, iAtten] = max(distortionTable(:,3));

fprintf("Max SINAD (%.1f dB) occurs at %.f dB attenuation\n-,
maxSINAD, iAtten);

Max SINAD (103.7 dB) occurs at 26 dB attenuation
Let's plot the periodogram when the attenuator is set to 26 dB.
inputVbestAtten = db2mag(-iAtten) * VmaxPk * sin(2*pi*Fi*t);

outputVbestAtten = helperHarmonicDistortionAmplifier(inputVbestAtten);
helperPlotPeriodogram(outputVbestAtten, Fs, "power”, annotate”,“"shownoise®);
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Fower (dB)

Periodogram Power Spectrum Estimate
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Here we have additionally plotted the level of fotal noise power that is spread across the
spectrum. Note that at this attenuation setting, the second and third harmonic are still
visible in the spectrum but also considerably less than the total noise power. If we were
to have an application that uses a smaller bandwidth of the available spectrum we would
benefit from further increasing the attenuation to reduce the harmonic content.

Post-processing to Remove Distortion
Occasionally we can correct for some of the non-linearity of the amplifier. If the output

of the amplifier is digitized, we can recover more useful dynamic range by digitally post-
processing the captured output and correcting for the non-linearity mathematically.
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In our case, we stimulate the input with a linear ramp and fit a third-order polynomial
that best fits the input.

inputRamp = -2:0.00001:2;
outputRamp = helperHarmonicDistortionAmplifier(inputRamp);
polyCoeff = polyfit(outputRamp, inputRamp, 3)

polyCoeff =

0.0010 -0.0002 1.0000 -0.0250

Now that we have the coefficients we can then perform post-correction at the output and
compare side-by-side with our original uncorrected output

correctedOutputVmax = polyval(polyCoeff, outputVmax);

helperPlotPeriodogram([outputVmax; correctedOutputVmax], Fs, “power®);
subplot(2,1,1);

title("Uncorrected™);

subplot(2,1,2);

title("Polynomial Corrected®);



Analyzing Harmonic Distortion

Fower (dB)

Fower (dB)

Uncorrected
100 . . . ;

|"|
| rl
-100 L ‘J [I i o
T L[.-,I-MJ lum-‘w.n'-" La'f.wr“*u '"mml Wwyr{hﬂmnmnﬁwwm
—2DD 1 1 1 1

0 5 10 15 20
Frequency (kHz)
Polynomial Corrected

100 T T T T
0r i 7
I
|
100 - A B B :
LT I"'F-f, f'lq-' Ly IM'II’F-"I" b (T _l Lo ey Y i "F']"f A 'h-""" b LR
R 2 D D i i i i
0 5 10 15 20

Frequency (kHz)
Note that the second and third harmonics are significantly reduced when using
polynomial correction.

Let's repeat the measurements again with the corrected output.
thdCorrectedVmax = thd(correctedOutputVmax, Fs)
snrCorrectedVmax = snr(correctedOutputVmax, Fs)
sinadCorrectedVmax = sinad(correctedOutputVmax, Fs)

thdCorrectedVmax =

-99.6194
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snrCorrectedVmax =

130.7491

sinadCorrectedVmax =

99.6162

Notice that our SINAD (and THD) dropped from 60 dB down to 99 dB, while preserving
our original SNR of 131 dB.

Combining Techniques

We can combine attenuation with polynomial evaluation to find the ideal operating
voltage that minimizes the overall SINAD of our system.

subplot(1,1,1);
% Add three more columns to our distortion table
distortionTable = [distortionTable zeros(nReadings,3)];
for i = l:nReadings
inputVreduced = db2mag(-i) * VmaxPk * sin(2*pi*Fi*t);
outputVreduced = helperHarmonicDistortionAmplifier(inputVreduced);
correctedOutput = polyval(polyCoeff, outputVreduced);
distortionTable(i,4:6) = [abs(thd(correctedOutput, Fs))
snr(correctedOutput, Fs)
sinad(correctedOutput, Fs)];
end

h = plot(distortionTable);
xlabel (" Input attenuation (dB)");
ylabel ("Dynamic Range (dB)");
for i=1:3
h(i+3).Color = h(i).Color;
h(i+3).LineStyle = "--" ;
end
legend("|THD] (uncorrected)”,"SNR (uncorrected)”,"SINAD (uncorrected)”,
"]THD] (corrected)”,"SNR (corrected)”,"SINAD (corrected)”,"Location”,"Best");
title("Distortion Metrics vs. Input Attenuation and Polynomial Correction®);
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Distortion Metrics vs. Input Attenuation and Polynomial Correction
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Here, we've plotted all three metrics alongside for both the uncorrected and polynomial
corrected amplifier.

As can be seen from the graph, THD has improved considerably, whereas SNR was not
affected by polynomial correction. This is to be expected since the polynomial correction
only affects the harmonic distortion and not the noise distortion.

Let's show the maximum SINAD possible when corrected by the polynomial

[maxSINADcorrected, iAttenCorr] = max(distortionTable(:,6));
fprintf("Corrected: Max SINAD (%.1f dB) at %.f dB attenuation\n-,
maxSINADcorrected, iAttenCorr);

Corrected: Max SINAD (109.7 dB) at 17 dB attenuation
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A good choice of amplifier attenuation for the polynomial corrected amplifier would be
20dB (yielding a SINAD of 109.8 dB).

% Recompute amplifier at maximum SINAD attenuation setting with polynomial
inputVreduced = db2mag(-iAttenCorr) * VmaxPk * sin(2*pi*Fi*t);
outputVreduced = helperHarmonicDistortionAmplifier(inputVreduced);
correctedOutputVbestAtten = polyval (polyCoeff, outputVreduced);

helperPlotPeriodogram(correctedOutputVbestAtten, Fs, “power®,"annotate”, "shownoise®);
title("Periodogram of attenuated and polynomial corrected amplifier™);

Periodogram of attenuated and polynomial corrected amplifier
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Note that all but the second harmonic disappeared entirely with polynomial correction
under the ideal attenuation setting. As noted before the second harmonic appears just
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underneath the power level of the total noisefloor. This provides a reasonable tradeoff in
applications which use the full bandwidth of the amplifier.

Summary
We have shown how polynomial correction can be applied to the output of an amplifier

experiencing distortion and how to pick a reasonable attenuation value to reduce the
effects of harmonic distortion.
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Spurious-Free Dynamic Range (SFDR) Measurement

16-42

This example shows how to analyze a numerically controlled oscillator (NCO) of a digital
down-converter (DDC) implemented in fixed-point arithmetic. The example measures the
spurious free dynamic range (SFDR) of the NCO, and explore the effects of adding phase
dither. The number of dither bits affects hardware implementation choices. The example
shows trade-offs among noise floor level, spurious effects, and number of dither bits. The
DDC in the example, designed to meet the GSM specification, models the Graychip 4016.

Introduction

Numerically controlled oscillators (NCOs) are an efficient means of generating sinusoidal
signals, and are useful when you require a continuous-phase sinusoidal signal with
variable frequency.

A DDC is a key component of digital radios. It translates the high-input sample rates of
a digital radio down to lower sample rates (baseband) for further and easier processing.
Our DDC has an input rate of 69.333 MHz and is tasked with converting the rate down
to 270.833 KHz in accordance with GSM specifications.

The DDC consists of an NCO and a mixer to quadrature down convert the input signal to
baseband. A Cascaded Integrator-Comb (CIC) then low-pass filters the baseband signal,
and along with two FIR decimating filters downsample the signal to achieve the desired
low sample rate, which is then ready for further processing. The final stage, depending
on the application, often includes a resampler that interpolates or decimates the signal
to achieve the desired sample rate. Further filtering can be achieved with the resampler.
See the block diagram of a typical DDC, below. Note that Simulink® handles complex
signals, so we don't have to treat the I and Q channels separately.
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While this example focuses on the analysis of the NCO, an example titled "Implementing
the Filter Chain of a Digital Down-Converter", focusing on designing the three-stage,
multirate, fixed-point filter chain and HDL code generation is available in the DSP
System Toolbox™,

The Numerically Controlled Oscillator

The digital mixer section of the DDC includes a multiplier and an NCO, which provide
channel selection or tuning for the radio. The mixer is basically a sine-cosine generator,
creating complex values for each sine-cosine pair. The typical NCO has four components:
the phase accumulator, the phase adder, the dither generator, and sine-cosine lookup
table.

Here is a typical NCO circuit modeled in Simulink, similar to what you might see in the
Graychip data sheet.

open_system(“ddcnco®);
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32-bit Tuning Freq

Numerically Controlled Oscillator (NCO)

Dither
18-bit Phase Cffset Generator

 Sum and

Sumand retain Sine/Cosine nee nodither
retain » 12 MSBs v Lockup " -
(5/24) = (2822} z! »| zamsEs

16-44

Based on the input frequency, the NCO's phase accumulator produces values that
address a sine-cosine lookup table. The phase adder specifies a phase offset that
modulates the output of the phase accumulator. The Dither Generator provides phase
dithering to reduce amplitude quantization noise, and improving the SFDR of the NCO.
The Sine/Cosine Lookup block produces the actual complex sinusoidal signal, and the
output is stored in the variable nco_nodither.

In the Graychip, the tuning frequency is specified as a normalized value relative to the
chip's clock rate. So for a tuning frequency of F, the normalized frequency is F/Fclk,
where Fclk is the chip's clock rate. The phase offset is specified in radians, ranging from
0 to 2pi. In this example the normalized tuning frequency is set to 5/24 while the phase
offset is set to 0. The tuning frequency is specified as a 32-bit word and the phase offset is
specified as a 16-bit word.

Since the NCO is implemented using fixed-point arithmetic, it experiences undesirable
amplitude quantization effects. These numerical distortions are due to the effects of finite
word length. Basically, sinusoids are quantized creating cumulative, deterministic, and
periodic errors in the time domain. These errors, appear as line spectra or spurs in the
frequency domain. The amount of attenuation from the peak of the signal of interest to
the highest spur is the SFDR.

The SFDR of the Graychip is 106 dB, but the GSM specification requires that the SFDR
be greater than 110 dB. There are several ways to improve the SFDR, and you will
explore adding phase dither to the NCO.

The Graychip's NCO contains a phase dither generator which is basically a random
integer generator used to improve the oscillator's output purity. Dithering causes the
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unintended periodicities of the quantization noise (which causes "spikes" in spectra

and thus poor SFDR) to be spread across a broad spectrum, effectively reducing these
undesired spectral peaks. Conservation of energy applies, however, so the spreading
effectively raises the overall noise floor. That is, the dithering is good for SFDR, but only
up to a point.

Let's run the NCO model and analyze its output in the MATLAB workspace. This model
does not use dithering.

sim("ddcnco*);

whos nco*
Name Size Bytes Class Attributes
nco_nodither 1x1x20545 328720 double complex

The plot below displays the real part of the first 128 samples of the NCO's output, stored
in the variable, nco_nodither.

plot(real (squeeze(nco_nodither(1:128)))); grid
title("Real Part of NCO Output - No Dithering”®)
ylabel ("Amplitude®);

xlabel ("Samples™);
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Amplitude
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Real Part of NCO Output - No Dithering
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SFDR of NCO Output
Let's take a look at the SFDR of the output of the NCO.

Calculate and plot the SFDR of the NCO output

Fs = 69.333€e6;
sfdr(real (nco_nodither),Fs);

140
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Fower (dB)

SFDR: 106.17 dB

or | | 7] | | | ]

SFDR
Fundamental
Spurs
50 OC {excluded)

=100 5

150 y

=200 .'"-. il j N

/_-' . :"I '-.\
{ . A [ |
_2 5D 1 1 i 1 1 1
0 5 10 15 20 25 30

Frequency (MHz)

As expected, the power spectrum plot shows a peak at 14.44 MHz, which is the NCO's
tuning frequency, 5/24*Fs = 14.444 MHz.

The SFDR, however, is about 106.17 dB, which is too high to meet the GSM specification,

which requires 110 dB or more. We can improve this dynamic range by use of phase
dithering.

Exploring the Effects of Dithering
To explore adding dither to the NCO, the NCO circuit shown above has been

encapsulated in a subsystem and duplicated three times. A different amount of dither
was selected for each NCO. Although the NCO allows a range of 1 to 19 bits of dither to

16-47



16 Signal Measurement

be specified, you will try just few values. Running this model will produce three different
NCO outputs based on the amount of dither added.

open_system(“ddcncowithdither®)

—F@—P z’ p| Sumand
retain Sum and

22 MSBs retain Sine/Caosing -
L —.'
(I) FREQ 18 MSBs ™ Lockup n
PHASE( 2

"’ out

Dither
Gener ator

h

Running the simulation will produce three signals in the MATLAB workspace that you
can then analyze using the spectral analysis algorithm defined above. You can run the
simulation from the model or from the command line using the sim command.

sim(“ddcncowithdither®)

After the simulation completes you are left with the signals that are the NCOs' output.
Each signal shows a different amount of dithering.

whos nco*
Name Size Bytes Class Attributes
nco_dither3 1x1x20501 328016 double complex
nco_dither5 1x1x20501 328016 double complex
nco_dither7 1x1x20501 328016 double complex
nco_nodither 1x1x20545 328720 double complex

Compute and plot the SFDR after adding 3 bits of dithering.
figure,

sfdr(real(nco_dither3d),Fs)

ans =
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With three bits of dither added, the highest spur is now about -112 dB. The SFDR is
107.63 dB. It still fails to meet the GSM specification.

Now add 5 bits of dithering.

figure,
sfdr(real (nco_dither5),Fs)

ans =
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Fower (dB)
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123.4065

SFDR: 123.41 dB
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With five bits of dither added, the highest spur is now about -127 dB.
The SFDR is 123.41 dB, exceeding the GSM specification.

It appears that more dither gives better results, so add 7 bits of dithering.

figure,
sfdr(real(nco_dither7),Fs)

ans =
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Fower (dB)
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Note that our computed SFDR degraded to 113.72 dB. This is due to the broadband noise
generated by dithering starting to overtake the power of the spurious content.

Using 7 bits of dithering meets the GSM specification, but is not as effective as using 5
bits of dithering.

Comparing Results

Tabulate the SFDR for each NCO output against the amounts of dithering for each NCO
output.
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Number of Spur Free Dynamic
Dither bits Range(dB)

0 106.17

3 107.63

5 123.41

7 113.72
Summary

This example analyzed the output of an NCO used in a digital down converter for a GSM
application. Spectral analysis was used to measure the SFDR, the difference between
the highest spur and the peak of the signal of interest. Spurs are deterministic, periodic
errors that result from quantization effects. The example also explored the effects of
adding dither in the NCO, which adds random data to the NCO to improve its purity. We
found that using five bits of dithering achieved the highest SFDR.
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Distortion Measurements

Generate 2048 samples of a sinusoid of frequency 2.5 kHz sampled at 50 kHz. Add white
Gaussian noise such that the signal-to-noise ratio (SNR) is 80 dB.

Fs = 5e4;

fO = 2.5e3;

N = 2048;

t = (0:N-1)/Fs;

SNR = 80;

X = cos(@*pi*fO0*t);

x = x+randn(size(x))*std(x)/db2mag(SNR) ;

Pass the result through a weakly nonlinear amplifier represented by a polynomial. The
amplifier introduces spurious tones at the frequencies of the harmonics.

amp = [1e-5 5e-6 -1le-3 6e-5 1 25e-3];
x = polyval(amp,x);

Plot the signal spectrum and annotate the SNR, verifying that it has the expected value.
The snr function computes the power ratio of the fundamental to the noise floor and
ignores the DC component and the harmonics.

snr(x,Fs);
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Plot the signal spectrum and annotate the total harmonic distortion (THD). The thd

function computes the power ratio of the harmonics to the fundamental and ignores the
DC component and the noise floor.

thd(x,Fs);
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Fower (dB)
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Plot the signal spectrum and annotate the signal to noise and distortion ratio (SINAD).
The sinad function computes the power ratio of the fundamental to the harmonics and
the noise floor. It ignores only the DC component.

sinad(x,Fs);
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Fower (dB)
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SINAD: 71.43 dB

| 1

Fundamental
Moise and Distortion
DC (excluded)

IS
o

£0 T

-80 | r
|

100

Y | | Mb" "I W iy

=140 '
0 ] 10 15

Frequency (kHz)

20

Verify that the SNR, THD, and SINAD obey the equation

]U—SHH-' {{1] + ]u'J'JII:I_.-']l'.I — IU—SIHID;‘IH_

lhs = 10~(-snr(x,Fs)/10)+10™N(thd(x,Fs)/10)
rhs = 10”~(-sinad(x,Fs)/10)
lhs =
7.2203e-08
rhs =

25
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Fower (dB)

7.1997e-08

Plot the signal spectrum and annotate the spurious-free dynamic range (SFDR). The
SFDR is the power ratio of the fundamental to the strongest spurious component
("spur"). In this case, the spur corresponds to the third harmonic.

sfdr(x,Fs);

SFDR: 72.16 dB

0 L El | | | SIFDR “

=60 | |
-80 |

-0 |I . ‘ T v r ” !
oo 1 Il[lw ||df"\‘--J .q,.ﬂlfl{l{w.r h{ﬂ“ ’i {l'ﬂ. a*q\ V\P. ”"H 1|| M‘ ) r"n_

Frequency (kHz)
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Measurement of Pulse and Transition Characteristics

This example shows how to analyze pulses and transitions and compute metrics
including rise time, fall time, slew rate, overshoot, undershoot, pulse width, and duty
cycle.

Clock Signal with Noise
First let's view the samples from a noisy clock signal.
load clocksig clockl timel Fs

plot(timel, clockl);
xlabel ("Time (secs)®), ylabel("Voltage®);

'5 T T T T T T T T T

Irll.lrml fﬂl‘lrl | |IJII m I'| r'll'J || |‘||I1L\h

...-"IJ| |

Voltage

0 02 04 06 08 1 12 14 16 18 2
Time (secs) w102
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Count

Level (Volts)

Estimate State Levels

Use statelevels with no output argument to visualize the state levels. State levels are
estimated via histogram.

statelevels(clockl)

ans =

0.0138

5.1848

20
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Samples

Histogram of signal levels (100 bins)
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The computed histogram is divided into two equal sized regions between the first and
last bin. The mode of each region of the histogram is returned as an estimated state level
value in the command window.

Use optional input arguments to specify the number of histogram bins, histogram
bounds, and the state level estimation method.

Measure Rise Time, Fall Time and Slew Rate

Use risetime with no output argument to visualize the rise time of positive-going edges.

risetime(clockl,timel)

ans =
1.0e-04 *

.5919
.8344
.7185
.8970
.6366

oNeoNoNoNe)
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rise time
signal
. upper cross
# lower cross
upper boundary
---------- upper state
lower boundary
— — — upper reference
— — — lower reference
upper boundary
""""" lower state
lower boundary

Time (seconds) w03

The default reference levels for computing rise time and fall time are set at 10% and 90%
of the waveform amplitude.

Specify custom reference and state levels via optional input arguments as shown below
for a fall time measurement.

falltime(clockl,timel, "PercentReferencelLevels®,[20 80], "StateLevels",[0 5])

ans =
1.0e-04 *

0.4294
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0.5727
0.5032
0.4762
ﬁ -
fall time
! |"I signal
"""""" IJ‘1|'1|P.I Al F|"J # upper cross
S R S HEESRERRERY £ | SEEREERRRY ™ 1 BEEREREREENY [ SESSEREEER
nﬂhr] |1I {J |ru|.| | mj |'I‘“ Z lower cross
| | || II upper boundary
F | ---------- upper state

| lower boundary
— — — upper reference

% ar | |ll I| | Il — — — lower reference
= I’ |J upper boundary
- | | """"" lower state

o 2t | | | lower boundary
— | | | |

Time (seconds) 1072

Obtain measurements programmatically by calling functions with one or more output
arguments. For uniformly sampled data, you can provide a sample rate in place of the
time vector. Use slewrate to measure the slope of each positive-going or negative-going

edge.
sr = slewrate(clock1(1:100), Fs)

Sr
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Voltage

7.0840e+04

Analyze Overshoot and Undershoot

Now let's view data from a clock with significant overshoot and undershoot.

load clocksig clock2 time2 Fs
plot(time2, clock2);
xlabel ("Time (secs)"), ylabel("Voltage©);

D T S LT i }—-W lmw-_.hn.

_1 i i i i
0 0.5 1 1.5 2 25 3 3.5

Time (secs)

4
%1073

Underdamped clock signals have overshoots. Overshoots are expressed as a percentage of
the difference between state levels. Overshoots can occur just after an edge, at the start
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of the post-transition aberration region. These are called postshoot overshoots. You can
measure them by using the overshoot function.

overshoot(clock2(95:270),Fs)
legend("Location”, "NorthEast")

ans =
4.9451
2.5399
'E T T T T T T
signal
e | . upper cross i
T et L et . lower cross o
S | %  post-overshoot B
4l upper boundary | |
---------- upper state
. lower boundary
&8 3k — — —upper reference |
g — — — lower reference
%" upper boundary
E st T lower state i
- lower boundary
1k i
I e
D b s ?v—-haﬂumnmwa-mww
__1 1 1 1 1 1 1
1] 1 2 3 4 5 6 7
Time (seconds) w10

Overshoots may also occur just before an edge, at the end of the pre-transition aberration
region. These are called preshoot overshoots. Similarly, you can measure undershoots
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Level (Volts)

in the pre and post-aberration regions. Undershoots are also expressed as a percentage
of the difference between the state levels. Use optional input arguments to specify the
regions in which to measure aberrations.

undershoot(clock2(95:270),Fs, "Region”, "Postshoot")
legend("Location”, "NorthEast")

ans =
3.8499
4.9451
5] T T T T T T
signal
e | F Upper cross i
k'ﬁmhﬂ-&w‘w—mﬁ—t%*ﬂvw o # lower cross o
e N & post-undershoot B
4l upper boundary | |
---------- upper state
lower boundary
3k — — —upper reference | |
— — — lower reference
upper boundary
st lower state i
lower boundary
I e
D b s T T T T T B Y
1 1 1 1 1 i
1] 1 2 3 4 B 6 7
Time (seconds) w10
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Measure Pulse Width and Duty Cycle

Use pulsewidth with no output argument to plot highlighted pulse widths.

pulsewidth(clock2, time2, "Polarity”, "Positive®);

E -
pulse width
signal
5t #. mid cross
D e i e 1L ity L il upper boundary
---------- upper slate
4t lower boundary
— — — mid reference
—_ upper boundary
L:on = ! ! ! tr {1 1 | | | lower state
= lower boundary
e e o e
o 2}
|
1t
0 Bl }_,_._.., ....... Looadnnloaad o
-1 : : : : : : :
0 0.5 1 15 2 25 3 3.5

Time (seconds) w102

This displays pulses of positive polarity. Select negative polarity to see the widths of
negative polarity pulses.

Use dutycycle to compute the ratio of the pulse width to the pulse period for each
positive-polarity or negative-polarity pulse.

d = dutycycle(clock2,time2, "Polarity”, "negative”)
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0.4979
0.5000
0.5000

Use pulseperiod to obtain the periods of each cycle of the waveform. Use this
information to compute other metrics like the average frequency of the waveform or the
total observed jitter.

pp = pulseperiod(clock2, time2);

avgFreq = 1./mean(pp)
totalJitter = std(pp)

avgFreq =

1.2500e+03

totalJitter =

1.9866e-06
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Measuring Signal Similarities

16-68

This example shows how to measure signal similarities. It will help you answer questions
such as: How do I compare signals with different lengths or different sampling rates?
How do I find if there is a signal or just noise in a measurement? Are two signals related?
How to measure a delay between two signals (and how do I align them)? How do I
compare the frequency content of two signals? Similarities can also be found in different
sections of a signal to determine if a signal is periodic.

Comparing Signals with Different Sampling Rates

Consider a database of audio signals and a pattern matching application where you need
to identify a song as it is playing. Data is commonly stored at a low sampling rate to
occupy less memory.

% Load data
load relatedsig.mat;

figure

ax(1l) = subplot(311);
plot((0:numel(T1)-1)/Fs1,T1,"k");
ylabel ("Template 17);

grid on

ax(2) = subplot(312);
plot((0:numel(T2)-1)/Fs2,T2,r");
ylabel ("Template 27);

grid on

ax(3) = subplot(313);
plot((0:numel(S)-1)/Fs,S);

ylabel ("Signal™);

grid on

xlabel ("Time (secs)");
linkaxes(ax(1:3),"x")

axis([0 1.61 -4 4])
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Template 2 Template 1

Signal
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0 02 0.4 0.6 0.8 1 12 14 1.6
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The first and the second subplot show the template signals from the database. The third
subplot shows the signal which we want to search for in our database. Just by looking at
the time series, the signal does not seem to match to any of the two templates. A closer
inspection reveals that the signals actually have different lengths and sampling rates.

[Fsl Fs2 Fs]

ans =

4096 4096 8192
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Different lengths prevent you from calculating the difference between two signals but
this can easily be remedied by extracting the common part of signals. Furthermore, it is
not always necessary to equalize lengths. Cross-correlation can be performed between
signals with different lengths, but it is essential to ensure that they have identical
sampling rates. The safest way to do this is to resample the signal with a lower sampling
rate. The resample function applies an anti-aliasing(low-pass) FIR filter to the signal
during the resampling process.

[P1,Q1] = rat(Fs/Fsl); % Rational fraction approximation
[P2,Q2] = rat(Fs/Fs2); % Rational fraction approximation
Tl = resample(T1,P1,Q1); % Change sampling rate by rational factor
T2 = resample(T2,P2,Q2); % Change sampling rate by rational factor

Finding a Signal in a Measurement

We can now cross-correlate signal S to templates T1 and T2 with the xcorr function to
determine if there is a match.

[C1,1agl] = xcorr(T1,S);
[C2,1ag2] = xcorr(T2,S);
figure

ax(1) = subplot(211);

plot(lagl/Fs,C1,"k");

ylabel ("Amplitude®);

grid on

title("Cross-correlation between Template 1 and Signal*®)
ax(2) = subplot(212);

plot(lag2/Fs,C2,"r");

ylabel ("Amplitude®);

grid on

title("Cross-correlation between Template 2 and Signal*)
xlabel ("Time(secs)");

axis(ax(1:2),[-1.5 1.5 -700 700 1)
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Amplitude

Amplitude

Cross-correlation between Template 1 and Signal
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The first subplot indicates that the signal and template 1 are less correlated while the
high peak in the second subplot indicates that signal is present in the second template.

[~.1] =

max(abs(C2));

SampleDiff = lag2(l)

timeDiff = SampleDiff/Fs

SampleDiff =

499

timeDifF =
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0.0609

The peak of the cross correlation implies that the signal is present in template T2
starting after 61 ms. In other words, signal T2 leads signal S by 499 samples as indicated
by SampleDiff. This information can be used to align the signals.

Measuring Delay Between Signals and Aligning Them

Consider a situation where you are collecting data from different sensors, recording
vibrations caused by cars on both sides of a bridge. When you analyze the signals, you
may need to align them. Assume you have 3 sensors working at same sampling rates and
they are measuring signals caused by the same event.

figure,

ax(1l) = subplot(311);
plot(sl);

ylabel ("s17);

grid on

ax(2) = subplot(312);
plot(s2, "k");

ylabel ("s27);

grid on

ax(3) = subplot(313);
plot(s3,"rv);

ylabel ("s37);

grid on

xlabel ("Samples™)
linkaxes(ax, "xy")
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We can also use the Finddelay function to find the delay between two signals.

t21
t31

finddelay(sl,s2)
finddelay(sl,s3)

t21

-350

t31 =

150
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t21 indicates that s2 lags s1 by 350 samples, and t31 indicates that s3 leads s1 by 150
samples. This information can now used to align the 3 signals by time shifting the
signals. We can also use the alignsignals function directly to align the signals which
aligns two signals by delaying the earliest signal.

sl
s2

alignsignals(sl,s3);
alignsignals(s2,s3);

figure

ax(1l) = subplot(311);
plot(sl);

grid on;

title("sl7);

axis tight

ax(2) = subplot(312);
plot(s2);

grid on;

title("s27);

axis tight

ax(3) = subplot(313);
plot(s3);

grid on;

title("s37);

axis tight
linkaxes(ax, "xy")
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Comparing the Frequency Content of Signals

A power spectrum displays the power present in each frequency. Spectral coherence
identifies frequency-domain correlation between signals. Coherence values tending
towards O indicate that the corresponding frequency components are uncorrelated while
values tending towards 1 indicate that the corresponding frequency components are
correlated. Consider two signals and their respective power spectra.

Fs = FsSig; % Sampling Rate

periodogram(sigl,[].[1.Fs, "power®);
[P2,f2] periodogram(sig2,[].,[1.Fs, "power®);
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16-76

t = (O:numel(sigl)-1)/Fs;
subplot(221);
plot(t,sigl, "k");
ylabel("sl1);

grid on

title("Time Series®)
subplot(223);
plot(t,sig2);

ylabel ("s27);

grid on

xlabel ("Time (secs)”)
subplot(222);
plot(f1,P1,"k");

ylabel ("P1%);

grid on;

axis tight
title("Power Spectrum®)
subplot(224);
plot(f2,P2);

ylabel ("P27);

grid on;

axis tight

xlabel ("Frequency (Hz)")
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Time Series Power Spectrum
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The mscohere function calculates the spectral coherence between the two signals. It
confirms that sigl and sig2 have two correlated components around 35 Hz and 165 Hz. In
frequencies where spectral coherence is high, the relative phase between the correlated
components can be estimated with the cross-spectrum phase.

[Cxy,f] = mscohere(sigl,sig2,[],[].[].Fs);

Pxy = cpsd(sigl,sig2,[1.[1.[1.Fs);

phase = -angle(Pxy)/pi*180;

[pks, locs] = findpeaks(Cxy, "MinPeakHeight®,0.75);
figure

subplot(211);

plot(f,Cxy);

title("Coherence Estimate®);
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grid on;

hgca = gca;

hgca.XTick = f(locs);
hgca.YTick = .75;

axis([0 200 0 1D

subplot(212);

plot(f,phase);
title("Cross-spectrum Phase (deg)®);
grid on;

hgca = gca;

hgca.XTick = f(locs);

hgca.YTick = round(phase(locs));

xlabel ("Frequency (Hz)");
axis([0 200 -180 1801)

Coherence Estimate
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